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Introduction 

INTRODUCTION TO MICROSOFT NAVISION 
DEVELOPMENT I − C/SIDE 
Welcome 

We know training is a vital component of retaining the value of your Microsoft® 
Business Solutions investment. Our quality training from industry experts keeps 
you up-to-date on your solution and helps you develop the skills necessary for 
fully maximizing the value of your solution. Whether you choose Online 
Training, Classroom Training, or Training Materials, there's a type of training to 
meet everyone's needs. Choose the training type that best suits you so you can 
stay ahead of the competition. 

Online Training 
Online Training delivers convenient, in-depth training to you in the comfort of 
your own home or office. Online training provides immediate access to training 
24 hours a day. It's perfect for the customer who doesn't have the time or budget 
to travel. Our newest online training option, eCourses, combine the efficiency of 
online training with the in-depth product coverage of classroom training, with at 
least two weeks to complete each course. 

Classroom Training 
Classroom Training provides serious, in-depth learning through hands-on 
interaction. From demonstrations to presentations to classroom activities, you'll 
receive hands-on experience with instruction from our certified staff of experts. 
Regularly scheduled throughout North America, you can be sure you'll find a 
class convenient for you. 

Training Materials 
Training Materials enable you to learn at your own pace, on your own time with 
information-packed training documents. Our wide variety of training manuals 
feature an abundance of tips, tricks, and insights you can refer to again and again. 
 
Microsoft Business Solutions Training Courseware: The Microsoft Business 
Solutions Training Courseware are very detailed training manuals, designed from 
a training perspective. These include advanced topics as well as training 
objectives, exercises, interactions, and quizzes. 
 
Look for a complete list of manuals available for purchase on the Microsoft 
Business Solutions website: www.microsoft.com/BusinessSolutions. 
In this chapter, we introduce you to the basic objects that are found in Microsoft® 
Business Solutions−Navision® Development I Solutions.  
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In this course, you explore the basics of the objects. This chapter covers the 
following sections:  
 

• About the Course  
• The Basic Objects in Navision  
• C/SIDE Fundamentals  

 

About the Course 
Who is this course designed for? 
This course is designed for anyone who would like to understand the basic 
objects found in the Microsoft® Business Solutions − Navision® Client server 
Integrated Development Environment (C/SIDE). We suggest this course to 
anyone using C/SIDE.  

What benefits do you get out of this course?  
This course gives you a basic understanding of how to create and use the basic 
objects found in C/SIDE. You gain knowledge about all the different object 
designers and experiment with just a few of the dozens of properties for each 
object. The following topics are presented in this course:  
 

• Architecture  
• Programming  
• Data Manipulation  
• Integration 
• Navision Implementation Methodology 
• Development I Sample Test Questions 

 
You must understand this material in order to be certified.  

The Basic Objects in Navision 
What are the basic objects in Navision?  
There are seven basic objects in C/SIDE. The first object you learn about is the 
table object. A table is used to describe how data is stored in the database and 
how it is retrieved. Understanding tables is the key to using all of the other 
objects that you learn about.  
 
The second type of object discussed is the form object. A form is used to display 
data to the user in a familiar and useful way. Most forms allow the user to add 
records to a table, view, and modify records.  
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Next, report objects are discussed. Reports allow the user to summarize and print 
out detail information using the filters and sorting that he or she chooses.  
 
You learn how to design and then create reports using the report designer in 
C/SIDE.  
 
The fourth object discussed is the dataport object. Dataports allow you to export 
or import table data. The dataport and report objects share an underlying 
architecture so you are able to apply what you learned about reports here.  
 
Next, you are shown XMLports. The XMLport object is conceptually related to a 
dataport; you also use XMLports to import and export data, but in XML format. 
XMLports make the process of exchanging data in XML between systems more 
simple and streamlined.  
 
The sixth type of object discussed is the codeunit object. Codeunits allow you, 
the developer, to organize and group the code that you write. This is the only 
object mentioned thus far that you might think does not have anything to do with 
tables, but it actually does.  
 
Finally, there is an introduction of the MenuSuite object. The MenuSuite object 
contains the menus that are displayed in the Navigation Pane and in the 
Navigation Pane Designer. Each menu contains content for a specific 
departmental area, for example, Finance or Manufacturing. 

Is Microsoft Navision object oriented?  
C/SIDE is not object oriented but object-based. This is an important distinction. 
In an object oriented language or environment, the developer can create new 
types of objects based on the ones already in the system. In C/SIDE, you have 
seven types of application objects and that is all. You can create and use Tables, 
Forms, Reports, Dataports, XMLports, Codeunits, and MenuSuites, but nothing 
else.  
 
This may seem like a huge limitation, but, with every limitation, there is an 
increase in freedom. By limiting you to these seven objects, C/SIDE can be 
streamlined to work faster and more efficiently. The greatest benefit from this 
limitation is stability. It is actually somewhat difficult to create a severe bug in 
C/SIDE and this is good for everyone.  
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C/SIDE Fundamentals 
A C/SIDE (Client Server Integrated Development Environment) application is 
composed from seven types of application objects. Each type of application 
object is created using a specific tool called a designer. The application objects 
you create using these designers are all based on some general concepts. A 
fundamental knowledge of these concepts speeds up the C/SIDE application 
development process. This section introduces you to the C/SIDE user interface 
and presents the general concepts that underlie C/SIDE application objects: 
 

• The C/SIDE User Interface  
• What Is a C/SIDE Application?  
• The Physical and the Logical Database  

 

The C/SIDE User Interface  
This section introduces you to the user interface in C/SIDE. If you have not 
already installed C/SIDE, refer to the installation manual. If you have already 
installed C/SIDE, the installation program has created a new group that contains 
all the icons you need to work within C/SIDE. When the Integrated Development 
Environment (IDE) is running, your screen looks like this:  
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The user interface gives you access to a number of tools and functions. Some 
parts of the user interface also provide information about the current state of the 
system. 
 
To... Use the...  
Get Information About the Name and Path of the Current 
Database Title Bar 
Access Functions on Drop-Down Menus  Menu Bar 
Access the Most Commonly Used Functions Quickly Toolbar 
Work with the Application Design Tools Work Area 
See Basic Status Information About Your System (Such as 
the Current Date and Your User ID) Status Bar 

 
a. Depending on the task you are working on, the system automatically changes 
 the icons.  
b. This is also where the user interacts with your applications.  

Designing Application Objects  
Any application designed in C/SIDE is based on seven different types of 
application objects:  
 

 
 
Tables are the fundamental objects that store the actual data; you need other 
application objects to insert, modify, delete or show data from tables. You 
typically use a form to enter or retrieve data from the database and use a report to 
print data. 
 
NOTE: All application objects are identified by an ID number. There are, however, 
restrictions about which numbers you should use when creating your application 
objects. 
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The main tool used for developing applications in C/SIDE is the Object Designer 
(select TOOLS→OBJECT DESIGNER). This is the tool you use to view and design 
Tables, Forms, Reports, Dataports, XMLports, Codeunits and MenuSuites.  
 
In the Object Designer you choose the type of application object you want to 
work on. From the Object Designer you can run an application object or start an 
application object designer to modify the design of an existing application object 
or create a new application object. The following picture shows how to use the 
Object Designer in more detail.  
 

 
 
The table below lists the tools you can access via the Object Designer and when 
you should use them.  
 
Use the… When Working on… 
Table Designer Tables 
Form Designer Forms 
Report Designer Reports 
Dataport Designer Dataports 
XMLport Designer XMLports 
C/AL Editor Codeunits 
Navigation Pane Designer MenuSuites 

 
As you can see, there is a specific designer for each type of application object. 
When creating or modifying an application, you can work on any number of 
application objects at the same time, and each application object is shown in its 
own designer. For example, if you work on three new forms at the same time, 
each form is displayed in its own form designer. The only designer that you 
cannot create more than one copy of is the Object Designer. The designers are 
discussed further throughout this training manual.  
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What Is a C/SIDE Application?  
The C/SIDE Integrated Development Environment (IDE) is specially designed 
for creating accounting and business management applications. Any C/SIDE 
application consists of the same objects as a C/SIDE database. The difference 
between the term database and the term application is that database refers to a 
collection of application objects, whereas application refers to a set of application 
objects tied together to form a coherent whole.  

General C/SIDE Concepts  
You have already learned that there are seven different types of application 
objects in C/SIDE. All seven types are based on some general concepts. Some of 
these concepts are restricted to one type of application object while others apply 
to several types. When these fundamental concepts are understood, you have a 
good foundation for creating applications.  
 
The following table summarizes how the application objects are related to these 
general concepts and explains what each type of application object is used for.  
 
Application 
Object 
Type 

What is it used for? 
Which 
Concepts is it 
based on? 

Table A table is used for storing the actual data. 
Typically a business application has a 
Customer table that stores information such 
as name, address, phone number and contact 
person for each of your customers. 

Properties, 
Fields, Keys, 
C/AL, Triggers 

Form A form is used to access the information in 
your tables. Forms are used both when you 
enter new information and when you view 
existing information. 

Properties, 
C/AL, 
Controls, 
Triggers 

Report A report is used to present data that contains 
summary information. For example, use a 
report to print a list of customers. 

  

Dataport A dataport is used to import and export 
information to and from other programs (a 
comma-separated file from a spreadsheet, for 
example). 

Properties, 
C/AL, 
DataItems, 
RequestForm, 
Triggers 

XMLport XMLports are also used to import and export 
data, but in XML format. XMLports make 
the process of exchanging data in XML 
between systems more simple and 
streamlined. 

Properties, 
C/AL, 
TagNames, 
TagTypes, 
XMLport 
Events 
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Application 
Object 
Type 

What is it used for? 
Which 
Concepts is it 
based on? 

Codeunit A codeunit contains user-defined functions 
written in C/AL code. These functions can be 
used from the other objects in your 
application. This minimizes the size of the 
application because the same code can be 
reused over and over again. 

C/AL, Triggers 

MenuSuite The MenuSuite object contains the menus 
that are displayed in the Navigation Pane and 
in the Navigation Pane Designer. Each menu 
contains content for a specific departmental 
area, for example, Finance or Manufacturing. 

Menu Node, 
Menu Group, 
Menu Item 

 
The terms in the third column have the following descriptions:  
 
Properties: Properties control the appearance and behavior of application objects 
and all sub-objects. Properties are used to control the appearance of data, specify 
default values, specify colors and define relationships.  
 
C/AL: C/AL is the language used for writing functions in C/SIDE. In the table 
above, "C/AL" refers to functions written in this language.  
 
Triggers: When specific things happen to the application objects, the system 
automatically activates a trigger. Inside a trigger, you can add your own C/AL 
code if you want to modify the default behavior of the application object or 
extend its functionality.  
 
Keys: A key defines the order in which data are stored in your tables. Speed up 
searches in your tables by defining several keys to sort information in different 
ways.  
 
Fields: A field is the smallest unit of information in the database. A field 
typically stores information such as a name or a number.  
 
Controls: Controls are objects on a form or report that display data, perform 
actions or decorate the form. Typical examples are command buttons and text 
labels.  
 
Request Form: A request form is a form that is used in a report. Before a report 
is run, a request form appears to let the user specify filters and options for the 
report.  
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Data Items: A data item is a building block used for defining a model of data 
when creating a report. By using a hierarchy of data items, you define which data 
your report should include. A data item represents a table and when you run a 
report, the system cycles through the records in the associated table. A data item 
can have one or more sections.  
 
Sections: A section is a substructure of a data item. A section is where controls 
are placed to display information. You typically use sections defining the body, 
header, and footer in your report.  
 
TagName: TagNames are used to specify the name of a tag in an XML 
document. The name specified is inserted in the TagName field of the XMLport 
Designer of the element or attribute in question. 
 
TagTypes: This property is used to specify whether an XML object is an 
element or an attribute.  
 
Menu Node: Either a Menu Group or a Menu Item. 
 
Menu Group: A collection of Menu Nodes. 
 
Menu Item: The lowest level of the menu tree. It is associated with a form, 
report, batch job, dataport or codeunit. 

The Physical and the Logical Database 
The previous section described the general concepts underlying all seven types of 
application objects in C/SIDE. This section presents another view of C/SIDE 
applications. In this view, you are concerned only with how the information in 
your application is structured.  
 
As a typical database user, you are not concerned with where each piece of data 
is stored on the hard disk or what its size is; you just want to be sure that when 
you refer to a name, for example, the correct value is returned. This is why the 
C/SIDE database system provides a conceptual representation of data that does 
not include too many details of how the data is stored. An abstract data model is 
used for this conceptual representation. This data model uses logical concepts 
(such as objects, their properties and their relations) which are easier to 
understand.  
 
This leads us to distinguish between the logical and the physical database. When 
speaking about the logical database, only be concerned with the structure of the 
data and the relationships between different bits of information. That is, you do 
not deal with how these structures and relations are implemented. When speaking 
about the physical database, you deal with how the structures in the logical 
database and the search paths between them are implemented.  
 
In this document, the term database should be interpreted to mean the logical 
database unless otherwise noted.  
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What the user sees as a coherent set of information in the C/SIDE database 
system can be stored in several physical disk files but, this is transparent to the 
user. The figure below illustrates how one logical database can be physically 
stored on three hard disks but still comprise a single (logical) database.  
 

 
 

The Logical Structures in Your Database  
Access to the data is made possible by a well-defined logical organization 
composed of:  
 
Fields: A field is the smallest logical structure used in the C/SIDE database. A 
field is used to hold a single bit of information, such as a name, "Joe," or an 
amount, "2,352.00." Any particular field can hold information of only one 
specific type. (The C/SIDE database system distinguishes between 17 different 
types of information.) Fields are assembled into a structure called a record. On its 
own, a field is not very useful as it can hold only a limited amount of 
information. By assembling these small bits of information into records, we get a 
much more flexible "information-holder" that is also better organized because it 
keeps together fields that belong together.  
 
Records: A record is a logical structure assembled from an arbitrary number of 
fields. It is used to store a single entry in the database. The fields in a record are 
used to store information about important properties of the entry. Records are 
organized in tables.  
 
Tables: A table can be thought of as an N times M matrix. Each of the N rows 
describes a record and each of the M columns describes a field in the record. 
Tables are organized in companies.  
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Companies: A company is the largest logical structure used in a C/SIDE 
database. A company may be considered as a sub-database; its primary use is to 
separate and group large portions of data in a database. A company can contain 
private tables as well as tables shared with other companies.  
 

 
 

Integration Tools 
The Microsoft Business® Solutions − Navision® Development Integration Tools 
introduces tools that can be used inside or outside of Microsoft Navision to 
accomplish your goal of meeting the integration with other applications as 
requested by your customer. 
 
Please note that a complete installation of Microsoft® Office XP/2000/2003 (or a 
higher version) must be installed on the participant's computer in order to process 
the exercises in this section. 

The Course Design 
This course is designed for anyone seeking to learn how Microsoft Navision can 
be integrated with other applications. The course assumes that the individual 
understands the C/SIDE architecture and how to use C/SIDE objects. The course 
also assumes that the individual is familiar with relational databases as well as 
the following applications and/or tools − Microsoft Office (including Microsoft® 
Word, Microsoft® Excel and Microsoft® Access) and ODBC. 

What You Get Out Of This Course 
This course offers a basic understanding of the different tools used to integrate 
with Microsoft Navision and ways that Microsoft Navision can integrate with 
other applications. The following topics are presented in this course: 
 

• Chapter 1: Basic Tables  
• Chapter 2: Basic Forms  
• Chapter 3: Introduction to C/AL Programming  
• Chapter 4: Intrinsic Data Types Training  
• Chapter 5: Identifiers and Variables  
• Chapter 6: Assignment Statement  
• Chapter 7: Simple Expressions, Terms, and Operators  
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• Chapter 8: Numeric Expressions  
• Chapter 9: Logical and Relational Expressions  
• Chapter 10: The IF and EXIT Statements  
• Chapter 11: Compound Statements and Comments  
• Chapter 12: Arrays  
• Chapter 13: Repetitive Statements 
• Chapter 14: Other Statements 
• Chapter 15: Functions 
• Chapter 16: Using Intrinsic C/AL Functions 
• Chapter 17: Creating Your Own Functions 
• Chapter 18: Reports  
• Chapter 19: Dataports  
• Chapter 20: XMLports  
• Chapter 21: Codeunits  
• Chapter 22: MenuSuites  
• Chapter 23: Using ODBC  
• Chapter 24: Using C/Front 
• Chapter 25: Using OCX Controls Within 
• Chapter 26: Automation Server 

 
Read the material as thoroughly as you can. If you need to go back and review a 
chapter, take time to do that. This material is tested. 

Dataports 
Dataports can be used for integrating other applications. Typically, when first 
setting up a client you may find that you have legacy data you want entered into 
Microsoft Navision. Therefore, normally you would export the data from the 
client's current system and then import the data into Microsoft Navision using a 
dataport. Dataports can also be used to export data out of Microsoft Navision. 
 
Integration through the use of dataports is called "real time" since you have to 
run the dataport to update one system or the other. 
 
Are there any disadvantages of dataports? Yes, dataports require that you write 
code to extract data from the client's legacy system or write code to insert data 
into the client's system if you are trying to create a bridge between the two 
applications. Therefore, you have twice the coding that must be written. 

Page 12 



 

 

Introduction 

What ODBC, OCX, Automation, and C/Front mean 
ODBC is an abbreviation for Open DataBase Connectivity, a standard database 
access method developed by Microsoft Corporation. The goal of ODBC is to 
make it possible to access any data from any application regardless of which 
database management system (DBMS) is handling the data. ODBC manages this 
by inserting a middle layer called a database driver between an application and 
the DBMS. The purpose of this layer is to translate the application's data queries 
into commands that the DBMS understands. For this to work, both the 
application and the DBMS must be ODBC-compliant − that is, the application 
must be capable of issuing ODBC commands and the DBMS must be capable of 
responding to them.  
 
OCX is short for OLE Custom control, an independent program module that can 
be accessed by other programs in a Microsoft® Windows® environment. OCX 
controls end with an .ocx extension. OCX controls represent Microsoft's second 
generation of control architecture, the first being VBX controls written in Visual 
Basic.  
 
Both VBX and OCX controls have now been superseded by Microsoft® 
ActiveX® controls. However, ActiveX is backward compatible with OCX 
controls which means that ActiveX containers such as Microsoft's Internet 
Explorer can execute OCX components.  
 
There is a vast array of commercially available OCXs that perform all kinds of 
tasks and you can develop your own. The creation of OCX controls is not 
covered by this course. However, you can use tools such as Microsoft® Visual 
C++® or Visual Basic to create OCXs that can be called by Microsoft Navision. 
 
Automation is short for OLE Automation. OLE Automation is the name for the 
ability of one program to expose any or all of its capability for another program 
to use. The program that provides the functionality being called is the automation 
server and the program that uses the functionality of the automation server is the 
automation controller (or client). C/SIDE supports automation servers by acting 
as an automation controller and using OCXs (custom controls). However, 
Microsoft Navision is not an automation server. The most common use of 
automation within Microsoft Navision is the controlling of Microsoft 
applications such as Microsoft® Word, Microsoft® Excel, and Microsoft® 
Outlook®. 
 
Both OCX and Automation are part of Microsoft's COM technologies. It is 
recommended that you refer to Chapter 19 in the Application Designer's guide 
for more information about COM. Furthermore, additional information on 
Microsoft's technologies can be found by searching Microsoft's website. 
 
If you plan to use existing COM objects (controls or automation servers) from 
C/SIDE, you do not need a complete understanding of COM. However, it is 
suggested that you understand how to use objects and how you can access the 
COM object. Using the functionality provided by a COM object is no different 
than using any C/AL function. 
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C/FRONT is an application programming interface that can be used to access a 
Microsoft Navision database. C/FRONT facilitates high-level interaction with the 
Microsoft Navision Server, and allows developers to manipulate any Microsoft 
Navision database. The central component of C/FRONT is a library of C 
functions. These functions give you access to every aspect of data storage and 
maintenance, and allow you to integrate both standard and custom applications 
with your Microsoft Navision database. 
 
C/FRONT comes as a DLL for direct linkage with your program and also as an 
OCX that your program can use. 

How These Things Work 
ODBC and C/FRONT are used either to get data from Microsoft Navision or put 
data into a Microsoft Navision database. OCX and Automation are used for 
Microsoft Navision to control other applications and/or components. 
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Student Objectives 
What do you hope to learn by participating in this course? 
 
List three main objectives below. 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 1: BASIC TABLES 
Training Objectives 

In this chapter, you learn about: 
 

• Tables 
• Table and Field Properties 
• Creating Tables 
• Keys 
• Setting Relationships Between Tables 
• Special Table Fields 
• Modifying Some Properties 
• Types of Tables and their Characteristics 
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Tables 
The records in the C/SIDE database are stored in tables. A C/SIDE table may be 
visualized as a two-dimensional matrix consisting of columns and rows. The 
figure below shows a table with nine rows and eight columns. Each row is a 
record, and each column is a field. 
 

 
 
A table consists of two parts − the table data and a table description. The table 
data is the part users often think of as comprising the database because it contains 
the actual records with their data fields. The layout and properties of those fields 
however, are specified by the table description. 
 
The table description is not directly visible to the user. The next figure illustrates 
how the table data and the table description together form a table. 
 

 
 
When you design a table, you assign it a number of characteristics such as a 
name, an ID number and the fields it contains. You also assign a number of 
characteristics (such as name, ID number, data type and initial value) to each 
field. When you design a new table, you also specify which keys you want the 
system to maintain. All these characteristics are stored in the table description 
when you save your table design. 
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The following figure illustrates that a table description contains properties, 
triggers, fields and keys and shows how these are related. 
 

 
 
The table description contains some properties that are related to the table while 
others are related to the fields in the table. Still other properties are related to the 
keys in the table. You can also see from the figure that triggers are defined both 
for the table and for the fields in the table. Do not worry if you are not familiar 
with these terms already. More is discussed about them on the following pages. 

Table and Field Properties 
This section describes how you can use properties in your table design. It 
discusses how to modify and use table and field properties.  

Viewing and Modifying Table Properties 
A table in C/SIDE has a number of properties that describe the behavior of the 
table in your environment. When you create a table, C/SIDE automatically 
defines a number of default values for these properties. Depending on the 
purpose of the table and how it is related to other application objects, you may 
want to change these default values. 
 
Refer to the online Reference Guide for additional information about properties. 
To view or modify table properties: 
 

1. From the Tools menu, choose Object Designer. 

2. Click the Table button in the Object Designer window to get a list of 
the tables. 

3. Select table 18 and click the Design button. C/SIDE displays the 
table in the Table Designer. 
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4. Place the cursor on an empty line in the Table Designer or click 
EDIT→SELECT OBJECT. (If you place the cursor on a line defining one 
of the fields in the table, you get the properties for the field instead of 
those for the table.) 

5. Choose Properties from the View menu. C/SIDE displays the 
Property window. 

6. If you want to modify the setting of a property, simply enter the new 
value on the Property Sheet. When you have entered the new value, 
update the property by either pressing Enter or simply moving the 
cursor away from the field. 

7. To get Help for a property, point at it on the Property Sheet and press 
F1. 

 
EXAMPLE:Use the steps above to look at the LookupFormID property of the 
Customer table (18). This property tells C/SIDE which form should be used to look up 
values in the Customer table. The value of the property is the Customer List form. 

 

Viewing and Modifying Field Properties 
Just like tables, all fields in C/SIDE have a number of properties that describe 
their behavior. When you create a field, C/SIDE automatically suggests a number 
of default values for these properties. Depending on the purpose of the field, you 
sometimes may want to change these default values. 
 
Refer to the online C/SIDE Reference Guide for additional information about the 
above properties. 
 
To view or modify field properties: 
 

1. From the Tools menu, choose Object Designer. 

2. Click the Table button in the Object Designer window to get a list of 
the tables. 

3. Select a table and click the Design button. C/SIDE displays the table 
in the Table Designer. 

4. Place the cursor on the line in the Table Designer that defines the 
field for which you want to access the properties. 

5. From the View menu, choose Properties. C/SIDE displays the 
Property Sheet. 

6. If you want to modify the setting of a property, simply enter the new 
value on the Property Sheet. When you have entered the new value, 
update the property by either pressing Enter or simply moving the 
cursor away from the field. 
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7. To get Help for a property, point at it on the Property Sheet and press 
F1. 

 
EXAMPLE: Use the steps above to look at the NotBlank property of the No. field in 
the Customer table (18). This property keeps the user from leaving the No. field blank. 
It is used on most primary key fields (you learn about these later). 
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Test Your Skills − Investigating Existing Tables 
In this exercise, you are asked questions about tables that already exist in the 
Base application. Answer each question as completely as you can.  
 

1. What is the option string for the Reserve field in the Customer table?  

 

 

2. What is the difference between the calculation formulas of the 
Balance field and the Balance At Date field in the G/L Account 
table? 

 

 

3. What type of field is the Date Filter field in the G/L Account table? 

 

 

4. What is the value of the TableRelation property of the Global 
Dimension 1 Code field in the Customer table? 



 

 

Chapter 1: Basic Tables 

Page 23 

Creating Tables 
When you first create a table, it does not contain any data. When creating the 
table you have to decide which types of information you want stored in it. 
To create a table: 
 

1. Click TOOLS→OBJECT DESIGNER. The Object Designer window 
appears. 

2. In the Object Designer window, click Table. 

3. Click New. The Table Designer window appears: 

 

 
 
In the Table Designer, for each field you add to the table, you enter the field 
number, name, data type and, optionally, a length and a description. The 
following subsections describe how to do this. 

Adding Fields to Your Table 
Designing a field means assigning it a number of characteristics. These 
characteristics depend on what you intend the field to be used for.  
 
After you have added fields to a table in the Table Designer, you must save the 
table before you can add any records. Once you have saved a table, it appears in 
the list of tables in the Object Designer. 
 
All the tables and fields you create have two forms of identification: 
 

• A unique identification number (integer). When you access your 
database using either C/SIDE or C/FRONT, this number uniquely 
identifies all tables and fields. 

• A name (an alphanumeric string) serving as a label (such as 
CUSTOMER or CITY). This name appears on the screen when you 
run the table and should be meaningful and easily understood. This 
name is secondary information and can be changed at any time. 
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Choosing Data Types 
When you have selected an identification number and name for a field, you have 
to select an appropriate data type. You can use 17 different types of fields in the 
C/SIDE database system. Each type is designed to hold a specific kind of 
information, such as text, numbers, dates and so on. 
 
Fields in a record can be of the following types: 
 
Data Type Description Size 

Denotes an integer in the range -2,147,483,647 
to 2,147,483,647. An option field is defined with 
an option string, which is a comma-separated list 
of strings representing each valid value of the 
field. This string is used when a field of type 
Option is formatted and its value is converted 
into a string. An example: The Option field 
"Color" is defined with the option string 
"Red,Green,Blue." Valid values of the field are 
then 0, 1 and 2, with 0 representing "Red" and so 
on. When the "Color" field is formatted, 0 is 
converted into the string "Red", 1 into "Green", 
and 2 into "Blue".  

Option 

The size of the corresponding SQL data type, 
INTEGER, is 4 bytes. (A)(B) 

4 bytes 

Denotes an integer between -2,147,483,647 and 
2,147,483,647. 

Integer 

The size of the corresponding SQL data type, 
INTEGER, is 4 bytes. (A)(B) 

4 bytes 

A decimal number between -10 63 and 10 63. 
The exponent ranges from -63 to +63. Decimal 
numbers are held in memory with 18 significant 
digits. The representation of a decimal number is 
a Binary Coded Decimal (BCD). 

Decimal 

The size of the corresponding SQL data type, 
DECIMAL(38,20), is 17 bytes. (A)(B) 

12 bytes 

Any alphanumeric string. The field must be 
defined to be between 1 and 250 characters. The 
space used by a text field equals the maximum 
length of the text plus one byte. This extra byte 
is used to hold the length of the string. An empty 
text string has the length zero. 

Text 

The size of the corresponding SQL data type, 
VARCHAR, is 1 byte per character in the field's 
value. (A)(B)  

Maximum 
string 
length + 1 
byte (see 
note 
below). 
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Data Type Description Size 

An alphanumeric string, which is right-justified 
if the contents are numbers only. If letters or 
blanks occur among the numbers, the contents 
are left-justified. All letters are converted to 
uppercase upon entry. The field must be defined 
to be between 1 and 250 characters. 
The space used by a code field equals the 
maximum length of the text plus two bytes. The 
first of the extra bytes holds information about 
the length of the string, and the second byte 
stores alignment information. 
In the Microsoft® SQL Server® Option for 
Microsoft Navision, code fields work in a 
different way. You can use the SQL Data Type 
property to indicate whether code fields can 
contain integers or text strings. Refer to the 
online C/SIDE Reference Guide for information 
about the SQL Data Type property. 

Code 

The size of the corresponding SQL data type, 
VARCHAR, is 1 byte per character in the field's 
value. (A)(B) 

Maximum 
string 
length + 2 
bytes (see 
note 
below). 

A date value in the range from January 1, 0 to 
December 31, 9999. An undefined date is 
expressed as 0. All dates have a corresponding 
closing date. The system regards the closing date 
for a given date as a period that follows the 
given date but comes before the next normal 
date; that is, a closing date is sorted immediately 
after the corresponding normal date but before 
the next normal date. 

Date 

In the Microsoft SQL Server Option, dates 
cannot be before 01/01/1754. The size of the 
corresponding SQL data type, DATETIME, is 8 
bytes. (A)(B) 

4 bytes 

Any time in the range 00:00:00 to 23:59:59.999. 
A time field contains 1 plus the number of 
milliseconds since 00:00:00 o'clock, or 0 (zero), 
an undefined time. A time value is calculated in 
the following way: Time = 1 + (number of 
milliseconds since 00:00:00). 

Time 

The size of the corresponding SQL data type, 
DATETIME, is 8 bytes. (A)(B) 

A time field 
is stored as 
an integer 
(four bytes). 
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Data Type Description Size 

Assumes the values TRUE or FALSE. When 
formatted, a Boolean field is shown as "Yes" or 
"No". 

Boolean 

The size of the corresponding SQL data type, 
TINYINT, is 1 byte. (A)(B) 

4 bytes 

Contains binary data. The binary data is stored in 
the record. 

Binary 

The size of the corresponding SQL data type, 
VARBINARY, is the number of bytes in the 
field's value. (A)(B) 

Maximum 
length is 
250 bytes 
(see note 
below). 

Binary Large Object. Used to store bitmaps and 
memos. Notice that the BLOB isn't stored in the 
record, but in the BLOB area of the table. 

BLOB 

The size of the corresponding SQL data type, 
IMAGE, is the number of bytes in the field's 
value. (A)(B) 

8 bytes in 
the record + 
size of 
BLOB data. 
(max. 2 
GB) 

Used to verify the date entered by the user. The 
syntax is (for example): 
30D (=30 days) 
CM+1M (=Current month plus one month) 

Dateformula 
 

D15 (=On the 15th of each month) 

4 bytes 
 

DateTime Represents a point in time as a combined date 
and time. The datetime is stored in the database 
as Coordinated Universal Time (UTC) and is 
always displayed as local time in Microsoft 
Navision. Local time is determined by the time 
zone regional settings used by your computer. 

Stored as 
two 4 byte 
integers 

 

You must always enter datetimes as local time. 
When you enter a datetime as local time, it is 
converted to UTC using the current settings for 
the time zone and daylight saving time. The 
DateTime datatype does not support closing 
dates.  

TableFilter This data type is used to apply a filter to another 
table. 
Currently, this can only be used to apply security 
filters from the Permission table. 

 

BigInteger A 64 bit integer 8 bytes 
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Data Type Description Size 

Duration Represents the difference between two points in 
time, in milliseconds. This value can be 
negative. 

8 bytes 

GUID Globally unique identifier 16 bytes 
RecordID Unique record identifier   

 
A. The calculation of the size of a specific SQL Server record requires more 
 than simply summing the sizes of the field values. Refer to Microsoft's SQL 
 Server documentation for further information. 
B. This is the SQL server data type that Microsoft Navision uses when it creates 
 the data type. For further information, see the application designer's guide. 
 

NOTE: In the Microsoft Navision Server, data is stored with a four byte alignment 
because of performance considerations. The sizes of text, code and binary fields (that 
can have variable lengths) are rounded up to the nearest value that is a multiple of 
four. This means that, for example, a text string of 10 characters occupy 12 bytes. 

 

Creating a Simple Table 
In this exercise, you create a simple table. 
 

1. From the Tool menu, choose Object Designer. 

2. In the Object Designer, click the Table button. 

3. Click New. C/SIDE displays the Table Designer. 

4. Enter the Field Numbers, Field Names, Data Types and Lengths (if 
applicable) for each field: 

 
No Name Type/ Length 
1 Model Code 20 
2 Serial No. Integer 
5 Description Text50 
7 Transmission Option (Automatic,4-Speed, 5-

Speed) 
10 List Price Decimal 
15 Date of Mfg Date 

 
5. Edit the Field Properties, if needed. 
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6. Save the new table by closing the Designer window, click Yes at the 
Save dialog, then enter the Table ID Number (123456750) and Table 
Name (Vehicle) in the Save As dialog. 
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Test Your Skills − Adding Data 
In this exercise, add data to the table created in the previous exercise. 
 

1. From the Tool menu, choose Object Designer. 

2. In the Object Designer, click the Table button. 

3. Find table 123456750 and select it. 

4. Click the Run button.  

You are now viewing the data in the new Vehicle table. Notice that it is currently 
empty. The form you have open was auto-created by the Client application when 
you chose to run the table. This is a basic tabular form. 
 
Now, enter test data for your table and begin testing the functionality. 
 

1. Attempt (notice the word attempt) to put in the following records. 

 
Model Serial 

No. 
Description Transmission List 

Price 
Date of Mfg 

FORD 5000 Red, 
Mustang 

Automatic 18,000 01/15/00 

FORD 2000 Blue, F150 5-Speed 26,000 01/15/00 
TOYOTA 1000 Gold, Camry Automatic 23,000 02/01/01 
FORD 3000 Black, 

Explorer 
Automatic 30,000 01/15/00 

TOYOTA 3000 Black, 
Tacoma 

5-Speed 20,000 12/15/99 

TOYOTA 2000 Gray, Camry Automatic 22,000 01/15/00 
 

2. Answer the following questions: 

What problem did you encounter? 
 
Why can you not enter the second record above? 

 

3. Close the form and let's fix the problem you have discovered. This is 
done in the next exercise. 
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Keys 
A table description contains a list of keys. A key is a sequence of one or more 
field IDs from the table. Up to 40 keys can be associated to a table. The first key 
in the list is the primary key. 
 
The database keeps track of each record by means of the record's primary key. 
Consider the primary key of a record as the name of the record. The name of 
each record in a particular table for a particular company must be unique. This 
name is how the DBMS retrieves and updates records. 
 
The primary key is composed of up to 20 fields in a record. The combination of 
values in fields in the primary key makes it possible for the DBMS to perform a 
unique identification of each record. The primary key determines the logical 
order in which records are stored regardless of their physical placement on disk. 
 
Logically, the records are stored sequentially in ascending order, sorted 
according to the primary key. Before adding a new record to a table, the DBMS 
checks that the information in primary key fields in the record is unique and only 
then inserts the record into its correct logical position. Because the records are 
sorted "as they are entered," the database is always structurally correct. This 
allows fast data manipulation and retrieval. 
 
The primary key is always active; the DBMS keeps the table sorted in primary 
key order and rejects records with duplicate values in primary key fields. 
Therefore, the values in the primary key must always be unique. Be aware that it 
is not the value in each field in the primary key that must be unique, but rather 
the combination of values in all the fields comprising the primary key. 
The C/SIDE database system does not support unkeyed tables. 

Setting the Primary Key 
Changing the primary key of a table: 
 

1. In the Object Designer, click the Table button. 

2. Find table 123456750 and select it. 

3. Click the Design button. This opens the Table Designer window for 
the Vehicle table. 

4. On the main menu, click VIEW→KEYS. This displays the Key 
Designer window. Notice that the primary key contains only one 
field − Model. This means that you cannot enter two records with the 
same Model. For your example this is not a good choice for the 
primary key. If you were to include Serial No. in the primary key, 
then you could enter the same model many times as long as the 
Serial No. field was different for each. 
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5. Click in the Key column on the first line in the Key Designer 
window. 

6. Click the Assist-Edit button. Here you can select more fields to be 
part of this key. 

7. Add the field Serial No. to this list and click the OK button. 

 

 
 

8. Exit the Table Designer window and save and compile the table. The 
primary key has been changed. 

9. Finish entering the data from step 1. Notice that the records are 
sorted in the order of the primary key fields (Model and then Serial 
No.). 

 

 
 

Secondary Keys 
It has already been mentioned that up to 40 keys can be associated to a table and 
that the first is the primary key. All other keys are secondary keys and optional. 
Secondary keys are used to view records in an order different from the one in 
which they are sorted according to the primary key fields. 
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NOTE: The number of fields in the primary key together with all the fields in each 
secondary key must not exceed 20. In other words, each secondary key can contain up 
to 20 unique fields. However, these 20 unique fields must also include all the fields 
from the primary key. The primary key fields that are not mentioned specifically in the 
secondary key are added to the end of the key by the DBMS. 

 
This means that if your primary key includes four distinct fields, then a 
secondary key can include these four fields and at most 16 others.  
 
Correspondingly, if your primary key consists of 20 distinct fields, then your 
secondary keys must consist only of combinations of these fields. 
 
When you define a secondary key and select it as active, the system 
automatically maintains an index reflecting the sorting order defined by the key. 
Several secondary keys may be active at the same time. 
 
A secondary key can be changed into an inactive key. This means that the DBMS 
does not use time during updates to maintain its index. Furthermore, an inactive 
key doesn't occupy database space. 
 
Inactive keys can be reactivated; this process may consume some time depending 
on the size of the table because the DBMS has to scan the entire table to rebuild 
the index. 
 
The fields comprising the secondary keys are not guaranteed to contain unique 
data; the DBMS does not reject records with duplicate data in secondary key 
fields. If two or more records contain identical information in the secondary key, 
the DBMS uses the primary key for the table to solve this conflict. 

Creating Secondary Keys 
For some of your users, the date of manufacture and transmission is more 
important. Those users would like to be able to change the order of the records on 
the form to Date of Mfg., Transmission. To accomplish this you need to set up a 
secondary key. 
 

1. In the Object Designer, click the Table button. 

2. Find table 123456750 and select it. 

3. Click the Design button. This opens the Table Designer window for 
the Vehicle table. 

4. On the main menu, click VIEW→KEYS. This displays the Key 
Designer window. 

5. Click on a blank line (this should be the second line).  

6. Click the Assist-Edit button. Here you can select the fields to be part 
of this key. 
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7. Select the Date of Mfg. field first and then the Transmission field. 
The order of the fields is important. In the order described, the 
records are sorted by Date of Mfg. first and then by Transmission 
(if some of the dates are the same). 

 

 
 

8. Exit the Table Designer window and save and compile the table. The 
secondary key has been created. 
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Test Your Skills − Using Secondary Keys 
In this exercise, use the secondary key created previously. 
 

1. From the Tools menu, choose Object Designer. 

2. In the Object Designer, click the Table button. 

3. Find table 123456750 and select it. 

4. Click the Run button.  

 You are now viewing the data in the new Vehicle table. Notice that 
the data that you previously entered is still there. You may also 
notice that the records are still sorted in primary key order. 

 To change the sorting of the records in the form: 

5. Click the Sort button on the Tool Bar. This displays the Sort 
window. 

 

 
 

6. Choose the new key you created (the second key in the list) and click 
OK. The records should immediately resort themselves using the 
new key. 
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7. Answer the following questions: 

 Look at the records that have a Date of Mfg. of 01/15/00. What order 
are these records in since they have the same date? 

 

 Look at the records that have the same Date of Mfg. and the same 
Transmission. What order are these records in? 

 

 What does this tell you about secondary keys? 
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Setting Relationships Between Tables 
If your database contains tables with related data you can define a relationship 
between them. You relate tables by specifying one or more fields that contain the 
same value in related records. These matching fields often have the same name in 
each table. You can use relationships to: 
 

• Validate data entries. 
• Perform Lookup in other tables. 
• Automatically propagate changes from one table to other tables. 

 

Table Relations and the TableRelation Property 
Table relations are defined using the TableRelation property. This property is 
very flexible and allows you to define both simple and advanced table relations. 
A typical simple table relation consists of just a table ID and an optional field ID, 
while advanced table relations are typically prefixed with a conditional statement 
and include filters.  
 
When you create a table relation, you are specifying which field to look up in 
another table. If the optional field ID is left blank, it is the first field in the 
primary key that the relation is made to. To make a relation to the second or third 
field in a primary key, you must specify the field ID. 
 

NOTE: The field ID specified in the TableRelation property must be in the primary 
key of the table specified by the table ID in the property. If the field specified is not the 
first field in the primary key, the other fields that are before it in the key must be 
filtered to one value. This is not a true requirement of the system, but only makes sense 
in a real application. The user must not be confused when presented with choices. 
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Test Your Skills − Simple Table with Table Relations 
Create a table with the following fields. The table holds information about the 
sale of an item. Do not be concerned here with why you would need this table. It 
is not of any particular use, except in this exercise. 
 
Primary Key Field No. Field Name Data Type 
Yes 1 Line No. Integer 
 3 Salesperson Code Code 10 
 6 Item No. Code 20 
 9 Amount Decimal 

 
Save the table with the name Sales Transaction and the ID 123456751. 
 
Now that the basic table has been created, add two simple table relations. 
 

1. First, open the table designer for table 123456751. 

 

 
 

2. Click the Salesperson Code field. This field holds values from the 
Salesperson/Purchaser table. The user may look up a value from the 
table or type in a value, but it must exist in the Salesperson/Purchaser 
table. Due to these requirements, you need a table relation on this 
field. 

3. Go to the TableRelation property for the Salesperson Code field and 
click the Assist-Edit button. 
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4. In the TableRelation window, place the cursor in the Table field and 
type 13, the ID of the Salesperson/Purchaser table (you can also use 
the lookup button to choose the table or type in the name of the 
table). 

 

 
 

5. Click OK to save your changes to the property. 

6. Close, save and compile the table. 

Now, you need to test your table relation. The following steps demonstrate how 
powerful table relations are. Keep in mind that the lookup buttons on a field that 
has a table relation open the default lookup form for the related table. Without a 
form for the table, the lookup button does not work. In this example, there are 
already forms defined for the Salesperson/Purchaser table. 
 

1. Run table 123456751 (Sales Transaction) from the Object Designer. 

2. Enter 10000 into the Line No. field of the first blank line. 

3. Click the lookup button on the Salesperson Code field to retrieve a 
value from the Salesperson/Purchaser table. 

4. Select AH (Annette Hill) and click OK. Notice that the Salesperson 
Code field now has the value AH. Because the TableRelation was 
only set up to the table (not to any particular field), the lookup 
returns the value from the first primary key field. Because the 
Salesperson/Purchaser table only has one field in the primary key, 
there was no need to specify a field (only primary key fields can be 
chosen in a TableRelation). 

 Answer the following questions: 

5. Delete the value AH from the Salesperson Code field and type just 
an "a". What happens when you press ENTER? 

6. Delete the value again and type in XY. What happens when you 
press ENTER? 

7. Close the table. 
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Test Your Skills − Renaming Records 
Changing the primary key values of a record in a table changes the name of the 
record. You call this renaming a record. In this exercise, you observe the results 
of renaming a record that has other records related to it via a table relation. 
 

1. Run table 13 (Salesperson/Purchaser). 

2. Go to a blank line and add yourself as a salesperson. Use your 
initials (all three) as the Code and your name as the Name. 

 

 
 

3. Close table 13. 

4. Run table 123456751 (Sales Transaction). 

5. Enter the following lines (XXX represents your initials): 

 
Line No. Salesperson Code Item No. Amount 
30000 XXX 70000 123.56 
40000 AH 70000 234.97 
50000 XXX 70010 90.99 

 
6. Close table 123456751. 

7. Run table 13 (Salesperson/Purchaser). 

8. Click on the line that you added earlier (the record with your initials 
and name) and change the primary key value. Instead of your initials, 
change it to the first three letters of your last name. 

9. Click Yes when it asks, do you want to rename the record. 
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 Answer the following questions: 

 How long did it take to change that value? Was it longer than you 
expected? 

 

 Check the data in table 123456751 (Sales Transaction) by running it. 
Did any of the records here change? Why? 

 

10. You may have noticed that you did not put a table relation on the 
Item No. field. Relate the Item No. field to the Item table with a 
simple table relation. 
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Test Your Skills − Filtered Table Relations 
In this exercise, add filters to one of the table relations that you created in the 
previous exercises. 
 
Notice that table 13 (Salesperson/Purchaser) not only holds salespeople but also 
purchasers. In your table, you do not want the user to select purchasers, only 
salespeople, so add a filter to the table relation. Salespeople have commission 
rates, while purchasers do not. This allows you to distinguish between the two. 
 

1. First, open the table designer for table 123456751. 

2. Click the Salesperson Code field. This is the field that you want to 
change. 

3. Open the Properties window and select the TableRelation property. 

4. Click the Assist-Edit button to open the TableRelation dialog. Right 
now, only the Table field is filled in. You need to also give the 
relation a table filter. 

5. Click in the Table Filter field and click the Assist-Edit button to 
bring up the Filter dialog. In this dialog you can specify filters on as 
many fields in the related table as needed. For each field you add to 
the list, you can filter it in three ways − by a constant value, using a 
filter expression or by a field in the current table (123456751). For 
this case use a filter expression. 

6. In the first column, look up and select the Commission % field. This 
stores the commission rate for the salesperson. 

7. In the second column, click the drop-down button and select Filter. 
You must choose filter because of the values that you want to filter 
on, specifically where Commission % is greater than zero. You can 
only use relational operators with the filter option. Const and Field 
options are exact matches only (equal to). 

8. In the third column, type in ">0" without the quotations. 
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9. Click OK to save your table filter. 

 

 
 

10. Click OK to save your table relation. 

11. While the Properties window is open, move your mouse over the 
Value column of the TableRelation property. This displays the 
complete table relation as text. Make sure that it contains the 
following (if not redo this exercise): 

 
Salesperson/Purchaser WHERE (Commission %=FILTER(>0)) 

 
12. Save, compile, and exit the table. 

 
Run table 123456751 to answer the following questions: 
 
When you use the lookup button on the Salesperson Code field do you see all 
the records in the Salesperson/Purchaser table? If not, why? 
 
Can you type in the value AH into the Salesperson Code field? If not, why? 
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Test Your Skills − Conditional Table Relations 
In this exercise, add conditions to one of the table relations created in the 
previous exercises. 
 
In Microsoft Navision you can sell several different types of things. Three of 
these include Items, Resources, and G/L accounts. In your table, you are only 
tracking items. It would be more accurate to have resource numbers and G/L 
account numbers as part of the table as well. 
 
You could add two more fields to hold those values but, it would be more 
efficient to use the one field you already have and let it hold any one of the three 
types. To accomplish this, add a type field to your table so that the user knows 
whether the number is an item number, resource number or G/L account number.  
 

1. First, open the table designer for table 123456751. 

2. Add the following field to the table. Notice that the field number 
used is before the Item No. field. This is not critical, but because the 
Item No. field now depends on the Type field, it is normal for the 
Type field to be filled in first. 

 
Primary 
Key 

Field 
No. 

Field 
Name 

Data Type 

 5 Type Option 
(Account,Item,Resource) 

 
3. Now, change the name of the Item No. field to just No. This is more 

accurate because it may not be an item previously sold. 

4. At this point, it is easier if you save, compile, and exit the table. 
Whenever you add a new field to an existing table, the table 
definition is not updated until the table is saved. This step makes the 
following steps a bit simpler because the new field now shows up in 
the list of fields. 

5. Reopen table 123456751 and click the No. field. The table relation 
for this field needs to be changed. You give it the ability to look up 
into any of the three tables: G/L Account, Item, or Resource. 

6. Open the Properties window for the No. field and click on the 
TableRelation property. 

7. Click the Assist-Edit button to open the TableRelation dialog. 
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8. First enter the names of the three tables in the Table column. Put 
each table on a new line (you may want to delete the previous line 
that was related to the Item table before you begin). However, you 
cannot save the TableRelation like this. You still need to set the 
conditions. Anytime you have more than one line in the 
TableRelation dialog you must have conditions set as well. 

 

 
 

9. The conditions are straightforward. If the Type field is equal to Item 
the relationship must be to the Item table and so on. The table 
relations end up with the following values (we walk through setting 
the first condition next): 

 
Condition Table Field Table 

Filter 
Type=CONST(Account) G/L Account   
Type=CONST(Item) Item   
Type=CONST(Resource) Resource   

 
10. Click in the Condition column on the first line of the Table Relation 

dialog. 

11. Click the Assist-Edit button to open the Table Filter dialog. This is 
the same dialog that we used to set the Table Filters for the table 
relation. However, for a condition we are limited to CONST or 
FILTER choices (FIELD is not available). 

12. In the Field column, select the Type field. 

13. In the Type column, select the value CONST (this should already be 
the default). 

14. In the Filter column, enter the number 0. When you press ENTER or 
TAB, the zero changes into the word Account. 

15. Click OK to save the condition. 
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16. Repeat steps 10-15 for the other two lines in the Table Relation 
dialog. 

 

 
 

17. Click OK on the Table Relation dialog to save your conditional table 
relation. 

18. Close, save, and compile the table. 

 
Run table 123456751 to answer the following questions: 
 
When you use the lookup button on the No. field what form is displayed? What if 
you change the Type field? 
 
Try changing Type to Item and looking up an item number. Now, change Type 
to Resource. What happens? Is the value for No. valid? 
 
Now try retyping the value in the No. field after changing the Type as described 
in the previous question. What error do you get? 
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Special Table Fields 
In addition to the conventional data fields which simply hold values, three kinds 
of specialized fields are available for data retrieval: 
 

• SumIndexFields 
• FlowFields 
• FlowFilter Fields 

 

What are SumIndexFields? 
A SumIndexField is a decimal field that can be attached to a key definition. This 
is the fundamental feature of the Microsoft Navision Database that forms the 
basis for FlowFields. SumIndexFields permit fast calculation of sums of numeric 
columns in tables, even in tables with thousands of records. This occurs because 
SumIndexFields are maintained when the database record is updated. 

What advantages do SumIndexFields offer?  
SumIndexFields allow fast calculation of sums of columns to be performed and 
displayed via FlowFields.  
 
For example, if you want the sum of all the values in the Amount field. In a 
conventional database system, the DBMS is forced to access every record and 
add each value in the field Amount, a very time-consuming operation in a 
database with thousands of records. With Microsoft Navision, it can be as little as 
two accesses (if the best key is used) to sum the Amount for these records. 
 
This special index structure, a SumIndexField, is associated with a key. Each key 
can have at most 20 SumIndexFields. During database design, a decimal field can 
be associated with a key as a SumIndexField.  
 
This tells the DBMS to create and maintain a structure that contains the 
accumulated sum of values in a column. When a new current key is selected, any 
SumIndexFields associated with it becomes accessible. 

FlowFields 
FlowFields are a powerful feature of the C/SIDE database system. The FlowField 
is a fundamental concept that strongly influences the way a C/SIDE application is 
designed. 
 
FlowFields and the underlying concept of SumIndexFields have been designed in 
order to increase the performance in such activities as calculating the balance of 
your customers, which in traditional database systems involves a series of 
accesses and calculations before a result is available. Why such a result is 
immediately available when you use FlowFields are clear as you read through the 
rest of this chapter. 
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FlowFields are not a permanent part of the table data. A FlowField can be 
thought of as a virtual field, which is an extension to the table data. Actually, the 
information in the FlowFields exists only at run time. The values in FlowFields 
are automatically initialized to 0 (zero). To update a FlowField, you must use the 
C/AL function <Record>.CALCFIELDS. Notice that if a FlowField is the direct 
source expression of a control on a form, the FlowField is automatically 
calculated when the form is displayed. 
 
There are seven types of FlowFields: 
 
FlowField 
Type 

Field 
Type 

Description 

Sum Decimal The sum of a specified set within a column in a 
table 

Average Decimal The average value of a specified set within a 
column in a table 

Exist Boolean Indicates whether any records exist within a 
specified set in a table 

Count Integer The number of records within a specified set in a 
table 

Min Any The minimum value in a column within a specified 
set in a table 

Max Any The maximum value in a column within a specified 
set in a table 

Lookup Any Looks up a value in a column in another table 
 

Calculation Formulas and the CalcFormula Property 
A FlowField is always associated with a calculation formula that determines how 
the value in the FlowField is calculated. Below is an example of a valid value for 
the CalcFormula property: 
 
Sum("Cust. Ledger Entry".Amount  
WHERE (Customer No.=FIELD(No.), 
     Global Dimension 1 Code=FIELD(Department Filter), 
     Global Dimension 2 Code=FIELD(Project Filter), 
     Posting Date=FIELD(Date Filter), 
     Currency Code=FIELD(Currency Filter))) 
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Using FlowFilter Fields in the Calculation Formula 
End-users may want to limit calculations so that they include only those values in 
a column that have some specific properties. For example the user may want to 
sum up only the amounts of customer entries that are entered in April. This is 
possible if the application has been designed using FlowFilter fields in 
connection with the FlowFields. 

Exercises in Implementing SIFT 
In this subsection, you add a calculated field to the Salesperson/Purchaser table 
to display the sum of related records in the table 123456751 that you created 
earlier. 
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Test Your Skills − Calculating the Sums Manually 
In this exercise, calculate sums for the data you enter. This information helps us 
confirm the sums that get calculated automatically.  
 

1. Run table 123456751. 

2. Delete all of the current records in the table. This assures that the 
totals you get are the same as the ones in the answer guide. The 
easiest way to delete all records is to click in the upper left gray box 
of the form (this selects all the records) and then press F4 (this 
prompts you for confirmation and then delete the records). 

3. Now that the table is cleared enter the following records into the 
table. Make sure you use the values given. 

 
Line 
No. 

Salesperson 
Code 

Type Item No. Amount

10000 JR Item 70000 300.00 
20000 MF Account 1120 150.00 
30000 JR Account 1140 200.00 
40000 MF Item 70000 100.00 
50000 PS Item 70000 110.00 
60000 JR Item 70010 50.00 
70000 JR Resource LIFT 500.00 
80000 MF Resource LIFT 550.00 
90000 PS Item 70010 75.00 

 
4. Calculate the sum for the entire table and for every unique 

Salesperson Code. Write down the sums in the following table: 

 
Which Total Total Amount 
For JR  
For MF  
For PS  
For ALL  

 
 Note that this would be much easier if you could sort the records by 

Salesperson Code first. Of course, the only way to do this is to add a 
key. So, DO NOT do this yet. 

5. Close the table. 
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Creating a FlowField 
In this exercise, create a FlowField that displays the sum of records in the Sales 
Transaction table (123456751). 
 

1. Design table 13 (Salesperson/Purchaser). 

2. Add a new field to the table with following properties 

 
Primary 
Key 

Field 
No. 

Field Name Data Type 

 91400 Sales Decimal 
 

 The field number must be between 50,000 and 99,999 because table 
13 is a base application table (its number is less than 50,000). 

 The data type must be decimal because you want to display a sum 
(averages require a decimal as well). A sum FlowField calculates a 
decimal value. 

3. Open the Properties window for the new field. 

4. Go to the Field Class property and change it to FlowField 
(FlowFields are used to calculate values from another table). 

5. A new property called CalcFormula is now available. Go to this new 
property. 

6. Click the Assist-Edit button to display the CalcFormula dialog. This 
is where you tell the FlowField how to calculate its value. 

7. Put the following values into the CalcFormula window: 

 
Property Name Value 
Method Sum 
Table 123456751 
Field Amount 
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8. Click OK to save the calculation formula (clicking the x on the 
dialog does not save your changes). 

9. Close, save and compile the table. If you receive a permissions error, 
the ID that you gave the field is incorrect (see step 2). 

 
You have now successfully created a FlowField. The next step is to test it. 
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Test Your Skills − Testing Your FlowField 
In this exercise test your new FlowField. 
 

1. Run table 13 (Salesperson/Purchaser). 

 What happened when you tried to run the table? 

 

 
 

 What caused the error message? 

 

 What do we need to change to correct the problem (hint: read the 
error message very carefully)? 
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Test Your Skills − Creating a SumIndexField 
For a sum to be calculating automatically, you must create a SumIndexField. 
This is a field tied to a key (index) that sums records sorted by that key (index). 
For your FlowField to calculate, you must create a SumIndexField for it. 
 
You can simply let the error message tell you what to do. In a moment, you learn 
the correct procedure. 
 

1. Design the table that the error message indicates (Sales Transaction). 

2. Click VIEW→KEYS to open the Keys Designer. This is where you 
create your key and SumIndexField. 

3. Add the following SumIndexField to the primary key: 

 
Enabled Key SumIndexFields 
Checked Line No. Amount 

 

 
 

4. Close, save and compile the table.  

5. To test your SumIndexField, you need to view your FlowField. Run 
table 13 (Salesperson/Purchaser). Answer the following questions: 

 Were there any errors this time? Why or Why not? 

6. Fill in the following table with the values from the new FlowField, 
Sales. 

 
Which Total Sales 
For JR  
For MF  
For PS  
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 Do the totals seem correct? What is suspected about them? 

 

 Do they match any of the values from your manual sums? Which 
ones do they match? 

 

 What seems to be wrong with your FlowField? 

 



 

 

Chapter 1: Basic Tables 

Page 55 

Test Your Skills − Filtering the FlowField 
In this exercise, correct the FlowField that you started above. The problem with 
the FlowField was that you left out a part of the CalcFormula. For most 
FlowFields, you must use a Table Filter. Table filters allow the user to Sum some 
of the records in the table instead of all the records. 
 
In the FlowField you created above, you only want to sum records in the Sales 
Transaction table that have a particular Salesperson Code. For example, if the 
Code field in the Salesperson/Purchaser table is 'PS', then you only want to sum 
records in the Sales Transaction table that have a Salesperson Code of 'PS'. 
Now, add this logic to your FlowField CalcFormula. 
 

1. Design table 13 (Salesperson/Purchaser). 

2. Click the Sales field. 

3. Open the Properties window and click on the CalcFormula property. 

4. Click the Assist-Edit button to open the CalcFormula dialog. 

5. Notice that you left the Table Filter field blank in the previous 
exercise. This is the part of the CalcFormula that you need to 
complete. When you leave this empty, your FlowField is calculated 
on all records in the table. 

6. Click the Assist-Edit button to open the Table Filter dialog. Set a 
filter like the following: 

 
Field Type Value OnlyMax 

Limit 
ValueIs 
Filter 

Salesperson Code Field Code   
 

 The Field column corresponds to fields in the Sales Transaction table 
(the table you are summing). Because you have the type column set 
to Field, the Value column represents fields in the table you are 
currently designing (Salesperson/Purchaser). 
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7. Click OK to save your filter. 

 

 
 

8. Click OK to save your CalcFormula. 

9. Close, save, and compile the table.  

10. Run the table to see if your changes worked. Answer the following 
questions: 

 What happened when you tried to run the table? 

 

 

 What caused the error message? 

 

 

 What do we need to change to correct the problem (hint: read the 
error message very carefully)? 
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Test Your Skills − Process for Creating a SumIndexField 
In this exercise, you learn the proper procedure for deciding how to create your 
SumIndexFields. 
 
The first thing to do is to look at the FlowField's CalcFormula. This tells you 
how to create your SumIndexField. 
 

1. Design table 13 (Salesperson/Purchaser). 

2. Click on the Sales field 

3. Open the Properties window and click on the CalcFormula property. 

4. Click the Assist-Edit button to open the CalcFormula dialog. 

5. Write the name of the table that is here in the following space. 

Table Name: _____________________________ 
 This is the table that the SumIndexField must be created in. 

6. Write the name of the field that is here in the following space. 

Field Name: _____________________________ 
 This is the field that must be attached to a key, to create the 

SumIndexField you need. This field must be a decimal field and 
must exist in the table you wrote down in step 5. 

7. Click the Assist-Edit button in the Table Filter field to open the 
Table Filter dialog. Write down all of the fields that are mentioned in 
the Field column (the first column). (You may not use all of these 
spaces.) 

Field Name 1: _____________________________ 
Field Name 2: _____________________________ 
Field Name 3: _____________________________ 

 These fields are the fields in the table you are summing that you need 
to sort by. You need a key with all of these fields in it. The order of 
the fields in the key is not important for this FlowField, although, 
you may want to use this key for other things as well. 

8. Now, you know the table, the field and the key. Close this table and 
design the table you identified in step 5. 

9. Click VIEW→KEYS to open the Keys Designer. This is where you 
create your key and the SumIndexField. 
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10. Create a new secondary key that has the following properties: 

 
Enabled Key SumIndexFields 
Checked Salesperson Code Amount 

 
 If this does match what you wrote down in steps 5-7, start over with 

step 1. 

 

 
 

11. Close, save and compile the table.  

12. To test your SumIndexField, you need to view your FlowField. Run 
table 13 (Salesperson/Purchaser). 

 Were there any errors this time? Why or Why not?  
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Test Your Skills − Creating a FlowFilter 
In this exercise, extend the functionality of your FlowField to include a 
FlowFilter. A FlowFilter allows the user to dynamically change the Table Filter 
part of the FlowField. 
 
You create a FlowFilter that allows the user, to change the sum based on the 
Type field in the Sales Transaction table. This allows the user to use your 
FlowField for four different sums − total for accounts sold, total for items sold, 
total for resources sold, or the total of all sales. 
 
You begin by modifying the master table (table 13 Salesperson/Purchaser). 
 

1. Design table 13. 

2. Add a new field that has the following properties: 

 
Primary 
Key 

Field 
No. 

Field Name Data Type 

 91401 Type Filter Option 
(Account,Item,Resource) 

 
3. With the above field chosen, open the Properties window. 

4. Change the Field Class property to FlowFilter. Now this field is a 
FlowFilter field, but you aren't done yet. If you were to run the table 
now, you could change the Type Filter field, but nothing would 
happen. You need to make your FlowField use the new FlowFilter. 

5. Close, save, and compile the table. This step makes the next few 
steps easier. 

6. Design table 13 again. 

7. Click on the Sales field. 

8. Open the Properties window and click on the CalcFormula property. 

9. Click the Assist-Edit button to open the CalcFormula dialog. 

10. Click in the Table Filter field and click the Assist-Edit button to 
open the Table Filter dialog. This is where you need to change the 
FlowField so that it uses the FlowFilter. 
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11. Click on an empty line (this should be the second line in the dialog). 
Enter the following in the empty line: 

 
Field Type Value OnlyMax 

Limit 
ValueIs 
Filter 

Type Field Type Filter   
 

 Remember that the Field column corresponds to fields in the Sales 
Transaction table. Because you have the Type column set to Field, 
the Value column represents fields in the table you are currently 
designing (Salesperson/Purchaser). 

 

 
 

12. Click OK to save your filter. 

13. Click OK to save your CalcFormula. 

14. Close, save and compile the table.  

15. Run the table to see if your changes worked.  

You may not notice any difference, but that is good. It means that nothing broke. 
In the next exercise, you test the FlowFilter itself. 
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Test Your Skills − Using a FlowFilter 
In this exercise, you learn how to use the FlowFilter as the user would. You also 
learn that changes made to a FlowField can have unexpected results. 
 

1. Run table 13 (Salesperson/Purchaser). 

2. Look at the Sales column and double check the values. 

3. You may notice that the Type Filter field does not appear on the 
form. This is because FlowFilters have a special form. Click the 
FlowFilter button on the toolbar or click VIEW→FLOWFILTER to 
display this special form. This is the FlowFilter dialog. This is where 
you can change the value of a FlowFilter. Remember that changing 
the value of the FlowFilter should change the value of your 
FlowField. 

 

 
 

4. In the Filter column for the Type Filter field, select the type Item. 
Nothing has happened yet. You still need to click OK or Apply. 

5. Click OK. 

 Answer the following questions.  

 What happened? 

 

 

 Why did we only get the message after we set the FlowFilter? 

 

 

 What is the error message that you received?
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 Have you seen an error message like this before? 

 

 

 What is the next step that you should take to correct the problem? 

 

 

Correcting the Problem 
 

1. Design table 123456751 (Sales Transaction). 

2. Click VIEW→KEYS. 

3. Add the Type field to the secondary key that you created earlier so 
that the key looks like the following: 

 
Enabled Key SumIndexFields 
Checked Salesperson Code,Type Amount 

 
You could create a whole new key, but that is not necessary. This one key works 
for the FlowField whether you are using the FlowFilter or not. 
 
To test your fix, repeat steps 3-5 from the previous exercise. 
 
Did everything work correctly that time? 

Modifying Some Properties 
In this section, you investigate some very useful properties and why you would 
use them. 
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Test Your Skills − The NotBlank Property 
In this exercise, you discover the need for the NotBlank property. Begin by 
simply entering some records. 
 

1. Run table 123456750 (Vehicle). 

2. Press F3 to insert a new record. 

3. Without entering a value in the Model or Serial No. fields, click the 
Description field. 

4. Enter 'New Vehicle' as the description. 

5. Click on another record in the table (it does not matter which one). 
Notice that your 'New Vehicle' record is inserted into the table.  

 Answer the following questions:  

 What is the "name" of the record (remember that a name is the value 
of the primary key fields)? 

 

 What happens if you repeat steps 2-5 above? 

 

 How could we eliminate blank records being put into the table by 
accident? 

 
6. Design table 123456750 (Vehicle). 

7. Open the Properties window for the Model field. 

8. Change the value of the NotBlank property to Yes. 

9. Close, save, and compile the table. 

10. Run the table. 

11. Repeat steps 2-5. 

 What happens this time? 

 

 What must you do to insert a new record now? 

 
NOTE: If you try to use the NotBlank property on fields that are not in the Primary 
key, it does not behave the same way. Repeat the process above for the Description 
field and see if NotBlank works the same way on it. 
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Test Your Skills − The Editable Property 
In this exercise, you discover the need for the Editable property. Begin by 
modifying some records. Answer the questions along the way.  
 

1. Run table 13 (Salesperson/Purchaser). 

2. Click on the Sales column. Notice that this field is editable (can be 
changed). Remember that this is the FlowField that you created. 
FlowFields are calculated values.  

3. Click on the Sales field for salesperson PS. 

4. Enter 500 for the new Sales value. 

 What happened? 

 

 Did the change last (if you close the table and run it again, is the 
value still 500 for PS)? 

 

 Run table 123456751 (Sales Transaction) and manually calculate the 
sum of the values for PS (you may want to change the sort first). 

 What is the new sum? What was the old sum (section 2.7.1)? What is 
the difference? 

 

 Can you identify the line that may have changed the sum? 

 

 Did you enter this line? How did it get entered? 

 
This is not a good situation. Users looking at this FlowField must not be allowed 
to accidentally change the sum. In fact, for other types of FlowFields, (average, 
exist and so on) the user would receive an immediate error, if they tried to change 
them. So, it is a good practice to make most FlowFields non-editable. 
 
To make a field (FlowField or any other type) non-editable, follow these steps: 
 

1. Design the table (table 13 in this case). 

2. Click on the field that you want to change (the Sales field). 

3. Open the Properties window. 

4. Click on the Editable property (NOT the Enabled property). 
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5. Change the value to No. 

6. Close, save, and compile the table. 

7. Test your change by running the table and trying to edit the field. 

 
NOTE: In some situations, the behavior you observed is exactly what you want to 
happen. This functionality is used in the G/L Budgets, for example, to make it easier 
for the user to enter budget information. You may want to look at the budgets to see 
how this is done. 
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Test Your Skills − The DecimalPlaces Property 
In this exercise, change the DecimalPlaces property of a field to allow for more 
precision.  
 

1. Run table 123456751 (Sales Transaction). 

2. Enter a new record with the following values (notice that the amount 
has three decimal places). 

 
Line No. Salesperson Code Type Item No. Amount 
130000 JR Item 70000 301.155 

 
 Were you able to enter the amount correctly? 

 What error did you get? 

 
By default the DecimalPlaces property is set to 2:2. The number before the colon 
is the minimum number of decimals that are displayed to the user. The number 
after the colon is the maximum number of decimals that the user can enter. 
 
In your case, you cannot enter three decimal places because there is a two after 
the colon. To change this use the following steps: 
 

1. Design table 123456751 (Sales Transaction). 

2. Open the Properties window for the Amount field. 

3. Click on the DecimalPlaces property. 

4. Enter the value "2:3" (without the double quotes). 

5. Close, save, and compile the table. 

6. Run the table. 

7. Finish entering the Amount now and press Enter. 

 What happened? 

 What is displayed in the field if you enter the Amount 234.1 and 
press Enter? 

 

 What is displayed in the field if you enter the Amount 234 and press 
Enter? 

 

 What is displayed in the field if you enter the Amount 234.110 and 
press Enter? 
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 Types of Tables and Their Characteristics 
There are numerous standard types of tables in Microsoft Navision. Below is a 
table with the most common types of tables and some examples of each. A more 
detailed description of each type appears in the following subsections. 
 
Understanding these standards regarding the tables within Microsoft Navision 
gives you the ability to understand areas of the application with just a superficial 
look at the objects. 
 
Type Brief Description Examples 
Master Contains information about the 

primary focus subject of its functional 
area. 

Customer, Vendor, 
Item 

Supplemental Stores information about a 
supplemental subject used in one or 
more functional areas. 

Department, 
Language, Currency 

Setup Stores one record that holds general 
information about its functional area. 

G/L Setup, Sales 
&Receivables Setup 

Register A "table of contents" for its 
corresponding Ledger table or tables. 

G/L Register, Item 
Register 

Subsidiary Contains information which is 
subsidiary to either a Master table or a 
Supplemental table or both. 

Item Vendor, FA 
Depreciation Book 

Ledger Contains the transactional information 
that is the primary focus of its 
functional area. 

Cust. Ledger Entry, 
Item Ledger Entry 

Journal The primary transaction entry table 
for a functional area. 

Purchase Journal, 
Item Journal 

Document Secondary transactional tables that 
allow entries in a functional area or 
into multiple functional areas at once. 
This is actually implemented as a pair 
table. 

Sales Header / Sales 
Line, Finance Charge 
Memo Header / 
Finance Charge 
Memo Line, 
Reminder Header / 
Reminder Line 

Document 
History 

Contains the transaction history for 
documents that have been posted. 

Sales Invoice Header 
/ Sales Invoice Line, 
Issued Fin. Charge 
Memo Header / 
Issued Fin. Charge 
Memo Line, Issued 
Reminder Header / 
Issued Reminder Line
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Master Table Characteristics 
A Master Table contains information about the primary focus subject of its 
functional area. For example, the Customer table, which is the primary focus of 
the Sales & Receivables functional area, is a Master table.  
 
Generally, many other tables are related to a Master table and the Master table 
itself is related to many other (usually Supplemental) tables.  
 
There is usually a Ledger table that is related to a Master table. Master tables also 
contain many FlowFilters and FlowFields, most of which relate to its 
corresponding Ledger table.  
 
Most functional areas have only one Master table, though occasionally, there are 
two Master tables for a functional area. 

Naming Master Tables 
The name of this table is the name of one of the records in the table. For 
example, the name of the Customer table is named "Customer" because each 
record within it contains information about one customer. 

Primary Key and Other Standard Fields 
The Primary Key of a Master table is a Code field of length 20, named "No." or 
occasionally "Code".  
 
The Description field of this table is a Text field of length 30 named "Name" or 
"Description".  
 
These two fields are included in the DataCaptionFields property of the table so 
that these display in the title bar of this table's forms. 

Associated Forms 
There are three or more forms that are used with a Master table.  
 

• Card Form 
• List Form 
• Statistics Form 

 

The Associated Card Form 
The first form is a Card Form that is used to edit the records in the Master table. 
The name of this form is the name of the table followed by the word "Card". 
Thus the Card form for the Customer table is named "Customer Card".  
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It has at least one additional menu button (besides the usual OK, Cancel, and 
Help), which is labeled the same as the name of the table. The menu button 
provides links to other forms giving related or subsidiary information. One of 
these choices is a link to the List form that can be triggered by pressing F5 on the 
keyboard. Another of these choices is a link to the form showing the related 
Ledger table that can be triggered by pressing CTRL + F5 on the keyboard. 
Another of these choices is a link to the related Statistics form that can be 
triggered by pressing F9 on the keyboard. 

The Associated List Form 
The second form used with a Master table is a List Form, which is used to view 
the records in the master table. Unlike the Card Form, this cannot be used to edit 
the master table. 
 
The name of this form is the name of the table followed by the word "List". Thus 
the List form for the Customer table is named "Customer List".  
 
It has at least one additional menu button (besides the usual OK, Cancel, and 
Help), which is labeled the same as the name of the table. It provides links to 
other forms giving related or subsidiary information. One of these choices is a 
link to the Card form that can be triggered by pressing SHIFT + F5 on the 
keyboard. Another of these choices is a link to the form showing the related 
Ledger table that can be triggered by pressing CTRL + F5 on the keyboard. 
Another of these choices is a link to the related Statistics form that can be 
triggered by pressing F9 on the keyboard.  
 
This form is set as the LookupFormID property and the DrillDownFormID 
property of the table, since it is used not only for viewing but also for Lookups 
and Drill downs into this table. 

The Associated Statistics Form 
The third form used with a Master table is a Statistics Form, which is used to 
view calculated information about the record in the Master table. This 
information is put on a separate form from the Card form for performance 
reasons since this information is calculated.  
 
The name of this form is the name of the table followed by the word "Statistics". 
Thus the Statistics form for the Customer table is named "Customer Statistics". 

Supplemental Table Characteristics 
A Supplemental Table is a table in which information is stored about a 
supplemental subject used in one or more functional areas.  
 
An example of this would be the Department table, which contains information 
about company departments. This is not the primary focus of any functional area 
but it is important to practically all of them. Generally, Supplemental tables are 
not related to other tables although many other tables of all types are related to 
Supplemental tables. 
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Naming Supplemental Tables 
The name of this table is the name of one of the records within the table. For 
example, the Department table is named "Department" because each record 
within it contains information about one department. 

Primary Key and Other Standard Fields 
The Primary Key of a Supplemental table is a Code field of length 10, named 
"Code."  
 
The description field of this table is a Text field of length 30 or 50, named 
"Description." Some Supplemental tables do not contain a description field and 
some contain a description field whose name is "Name." 

Associated Forms 
The form used for a Supplemental table is a Tabular Form as described before. 
The name of this form is the plural of the name of the Supplemental table. Thus, 
the form that is used to edit the Department table is named "Departments."  
 
This form generally has no buttons except for the standard OK, Cancel and 
Help. This form is set as the LookupFormID property of the table since it is used 
not only for edit but also for Lookups into this table. 

Subsidiary Table Characteristics 
A Subsidiary Table contains information which is subsidiary to either a Master 
table or a Supplemental table or both.  
 
For example, the Item Vendor table is a table which contains subsidiary 
information (vendor numbers) for the Item table in the Inventory functional area.  

Primary Key and Other Standard Fields 
The Primary Key for the Subsidiary table contains a field for each table to which 
it is subsidiary, each of which is related to that table.  
 
For example, the Primary Key fields for the Item Vendor table include an Item 
No. field (related to the Master table "Item") and a Vendor No. field (related to 
the Master table "Vendor").  
 
The Primary Key can also contain an Integer as the last field (named "Line No.") 
to differentiate multiple records with the exact same subsidiary relationship. For 
example, the Employee Qualification table has an Integer field in the Primary 
Key to differentiate two records for the same Employee. 
 
Subsidiary tables are generally not related to other tables except for the Primary 
Key fields mentioned before. Other tables are generally not related to a 
Subsidiary table due to the fact that each Subsidiary table has multiple fields in 
the Primary Key.  
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Subsidiary tables usually do not contain description fields. 

Naming Subsidiary Tables 
The name of this table is generally made up of the names of the table or tables to 
which it is subsidiary or something close to that.  
 
For example, the table that is subsidiary to both the Vendor table and the Item 
table is named "Item Vendor." Whatever it is, it is a singular name that describes 
one record contained within the table. 

Associated Forms 
A Subsidiary table uses one form for editing and viewing purposes and this form 
is usually called from a button on the Master or Supplemental form to which it is 
subsidiary.  
 
The name of this form is usually the plural of the name of the table.  
 
If the Primary Key for the Subsidiary table contains an Integer, the form is a 
Worksheet form and it does not contain any of the Primary Key fields. Instead, 
the Primary Key fields other than the Integer are filtered so that they are viewed 
and set automatically.  
 
If the Primary Key for the Subsidiary table does not contain an Integer, the form 
is a Tabular form and it does not contain the Primary Key field of the master 
table. Instead, this field is filtered so that it is viewed and set automatically.  
 
In both cases, the form is linked back to the form that called it up so that if the 
record there is changed, the filters on this form are also changed. This ensures 
that the correct related records are always in view. 

Ledger Table Characteristics 
A Ledger Table contains the transactional information that is the primary focus 
of its functional area. For example, the Customer Ledger Entry table which 
contains all Sales and Receivables transaction information and which is the 
primary focus of the Sales and Receivables functional area, is a Ledger table.  
 
This table is very much like a Subsidiary table, in that, it is related to the 
corresponding Master table, but it has different characteristics, as shown. It is 
also related to many other tables, mostly Supplemental tables. Register tables are 
related to Ledger tables but, rarely is another table related to a Ledger table.  
There is normally one Ledger table per functional area, although occasionally 
there are two. 

Naming Ledger Tables 
The name of the Ledger Table is usually the name of the Master table to which it 
is related, plus the words "Ledger Entry" describing one of the records in it (an 
entry). Since this is sometimes lengthy, the name is sometimes abbreviated.  
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For example, the Customer Ledger Entry table is actually named "Cust. Ledger 
Entry."  
 
Sometimes, when there is more than one Master table, the name is the functional 
area followed by the words "Ledger Entry." Thus, the Ledger table for the 
Payroll functional area is named "Payroll Ledger Entry." 
 
Ledger tables cannot be modified by users except for some highly controlled 
exceptions.  
 
These exceptions never include the ability to add or delete a record.  

Primary Key and Other Standard Fields 
The Primary Key of a Ledger table is an Integer named "Entry No." This Primary 
Key is always generated automatically by the posting routine that controls this 
Ledger table.  
 
There is always a field in the Ledger table that has a table relation to the Master 
table associated with this ledger table. 
 
The description field of this table is a Text field of length 50 named 
"Description." 
 
In addition to the Primary Key, Ledger tables generally have numerous 
Secondary Keys, many of which have SumIndex fields attached to them. These 
are used in conjunction with the FlowFields on the Master table to calculate 
information for the user. Because of this, at least one, and usually more than one 
of the Secondary Keys have the field that is related to the Master table as the first 
field in the key. 

Associated Forms 
A Ledger table uses a List Form to display information to the user. This form is 
named with the plural of the Ledger table. For example, the name of the form 
that displays records from the Customer Ledger Entry table is "Customer Ledger 
Entries."  
 
This form is set as the LookupFormID property and the DrillDownFormID 
property of the table since it is used not only for viewing but also for Lookups 
and Drill downs into this table.  
 
This form can be displayed from the Master table forms by pressing the CTRL + 
F5 keys on the keyboard. 

Register Table Characteristics 
A Register Table is a "table of contents" for its corresponding Ledger table or 
tables.  
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There is one record per posting process and the Register table corresponds more 
closely to the posting routine rather than the functional area.  
 
For example, the table that contains the list of entries made to the Customer 
Ledger Entry table is the G/L Register table. This is because the Customer 
Ledger Entries are posted from the General Journal table using the General 
Journal posting procedures. The Register Table is related to its corresponding 
Ledger table or Tables. 

Naming Register Tables 
Register Tables are named according to the posting function followed by the 
word "Register." Thus the Register updated by the General Ledger posting 
function is named "G/L Register." 
 
The user can never modify the Register table. 

Primary Key and Other Standard Fields 
The Primary Key of a Register table is an Integer field named "No." The Primary 
Key is always generated automatically by the posting routine that controls this 
Register.  
 
Other standard fields for the Register table include two fields, both Integer fields 
related to the corresponding Ledger table, called "From Entry No." and "To Entry 
No." 
 
Register tables usually do not contain description fields. 

Associated Forms 
A Register table uses a List form to display its information to the user. This form 
generally has the same name as the Register table.  
 
It contains a menu button named "Register" which contains links to other List 
forms displaying the corresponding Ledger table or tables. 

Journal Table Characteristics 
A Journal Table is the primary transaction entry table for a functional area.  
 
All transactions, whether entered by the user directly or generated from another 
posting routine, pass through this table to eventually be posted to a Ledger table.  
 
Journal tables are related to many other tables including the Master table, 
Supplemental tables, Subsidiary tables and even the corresponding Ledger table 
(for application purposes). Other tables are not related to the Journal table.  
 
Because of their use for transaction entries, Journal tables have more trigger code 
than most other table types. 
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Naming Journal Tables 
The name of this table is the name of the type of transaction being posted, 
followed by the words "Journal Line."  
 
For example, the name of the table in which the user enters transactions to the 
Resource functional area is "Resource Journal Line." Each record in the journal 
table contains one line from the journal. 
 
The Journal table is usually related to two corresponding Supplemental tables, 
the Journal Template table and the Journal Batch table. These tables let users 
split up data entry in various ways and let them set optional information that 
applies to the entire Journal.  
 
The names of these two tables are the same as the name of the Journal table, 
except followed by Journal Batch or Journal Template rather than Journal Line. 
Thus, the two corresponding tables for the Resource Journal Line are named 
"Resource Journal Template" and "Resource Journal Batch." 

Primary Key and Other Standard Fields 
The Primary Key for the Journal table is made up of three fields, the field which 
is related to the Journal Template table, the field which is related to the Journal 
Batch table and an Integer field named "Line No."  
 
The description field of this table is a Text field of length 50 named 
"Description." 

Associated Forms 
The form that is used for a Journal table is a Worksheet Form, which is used to 
make entries to this table.  
 
This form is named the same as the table, except without the "Line." Thus the 
Worksheet form for the Resource Journal Line table is named "Resource 
Journal." Sometimes, the form is named for the type of data being input. For 
example, one of the (many) Worksheet forms used with the Gen. Journal Line 
table is called "Sales Journal." 
 
None of the Primary Key fields are included on this form.  
 
When it is called, it is filtered by the Template and Batch fields, and the 
AutoSplitKey property of the Worksheet automatically sets the Line No. field.  
 
The Worksheet form always includes a menu button that has the same name as 
the related Master table. It includes a way to call up the Card form for the Master 
table that can be triggered by pressing SHIFT + F5 on the keyboard. It also has a 
way to call up the Ledger for that current Master record which can be triggered 
by pressing CTRL + F5 on the Keyboard.  
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The Worksheet form also always includes a menu button that is named Posting, 
which lets the user print the test report, post, or post and print a register and 
sometimes includes a choice to reconcile. The Worksheet form also usually 
includes other buttons that lets the user perform various processing functions. 

Document Table Characteristics 
Document Tables are secondary transactional tables that allow entries in a 
functional area or into multiple functional areas at once. They are secondary only 
in that its information is posted to ledgers through journal tables, and not directly.  
 
For most users, it is the primary means of entering data as it is the one most often 
used. Because they are used for transaction entries, Document tables have more 
trigger code than most other table types. 
 
There are actually two types of Document Tables:  
 

• Document Header table 
• Document Line table 

 

Document Header Table 
The Document Header table holds the main transaction information. For 
example, in the case of a sales transaction, the Sales Header table contains 
information pertaining to the order or invoice as a whole.  

Document Line Table 
The Document Line table holds the detailed information for the transaction. For 
example, in the case of a sales transaction, the Sales Line table contains 
information about each individual line of the order or invoice. The Document 
Line table is a Subsidiary table to the Document Header table. 
 
Like Journal tables, Document tables are related to numerous other tables, 
including Master, Supplemental, and Subsidiary tables, but rarely is another table 
related to a Document table. 

Naming Document Tables 
The name of the Document Header table is the name of the transaction or 
document, plus the word "Header." For example, the Document Header table that 
contains Sales transactions is named "Sales Header." Each record contains one 
sale (order or invoice).  
 
Another example, the Document Header table that contains Finance Charge 
Memo transactions is named "Finance Charge Memo Header." Each record 
contains one Finance Charge Memo. 
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The name of the Document Line table is the name of the transaction or 
document, plus the word "Line." For example, the Document Line table that 
contains Sales transactions is named "Sales Line." Each record contains one line 
from a sale (order or invoice).  
 
Another example, the Document Line table that contains Finance Charge Memo 
transactions is named "Finance Charge Memo Line." Each record contains one 
line from a Finance Charge Memo. 

Primary Key and Other Standard Fields 
For most Document Header tables, the Primary Key is a Code field of length 20 
containing the document number and named "No." 
 
Some Document Header tables contain multiple types of documents each 
referring to the same transaction. For example, the Sales Header table contains 
Invoice documents, Credit Memo documents, Sales Order documents and so on. 
In these cases, the Primary Key has two fields − an Option field named 
Document Type and a Code field of length 20 named "No." 
 
For most Document Line tables, the Primary Key has two fields − a Code field of 
length 20 containing the document number and an Integer field named "Line 
No." The Code field is table related to the Document Header table, and so is 
named according to that table's name (without "Header") followed by that table's 
Primary Key field. For example, the Code field in the Primary Key of the 
Finance Charge Memo Line table is named "Finance Charge Memo No."  
 
In the case where the Document Header has a document type, the Primary Key of 
the Document Line table has 3 fields − an Option field named "Document Type", 
a Code field of length 20 named "Document No.", and an Integer field named 
"Line No." Again, the Code field is table related to the Document Header table. 

Associated Forms 
A Document Header table uses a special kind of Card form to display one header 
record at a time for the user to view and edit information.   
 
The name of this form is the name of the document that it displays. This is true 
even if the table can contain multiple types of documents since, in this case, the 
form is set up to only view information from one type. It contains tabs to split the 
fields into logical groups to make it easier for the user to edit the information.  
 
The Document Header form always includes a menu button which is named 
Posting, which lets the user print the test reports, post, post and print the 
Document, or post a batch of these documents.  
 
The form also includes other buttons that let the user perform various processing 
functions.  
 
The thing that makes a Document Header form different from a Card form is that 
it contains a sub-form control, which in turn contains a Document Lines form. 
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A Document Line table uses a special kind of Worksheet form to display 
multiple line records at a time for the user to view, and letting the user edit one at 
a time.  
 
The name of the form is the name of the document followed by either "Lines" or 
"Sub-Form." Since this name never shows, it is not that critical.  
 
What is critical is that the size of this form is exactly the same as the size of the 
sub-form control in which it is displayed.  
 
None of the Primary Key fields should be included on this form as the form is 
filtered (using a link) for all of the Primary Key fields except the Integer field, 
which is handled automatically by the AutoSplitKey property of the Worksheet. 
 
The Document Header table also uses a List form to let the user view multiple 
documents at the same time.  
 
The name of this form is, like most List forms, the name of the table (without the 
word "Header") followed by the word "List". This List form can be invoked from 
the Header form by pressing the F5 key on the keyboard. 

Document History Table Characteristics 
Document History tables are to Document tables what Ledger tables are to 
Journal tables.  
 
When a Document is posted, part of that posting process is copying the 
Document Tables to their corresponding Document History tables.  
 
To aid with that copying process, the Document History table generally has the 
same fields with the same field numbers, names and properties as the original 
Document tables.  
 
Since the Document History tables record posted transactions, they are generally 
not editable by the user, although they can be deleted if the user has that 
permission.  
 
Other than the above, the Document History tables and forms are the same as the 
corresponding Document tables.  
 
Naturally, the sub-form is a List form rather than a Worksheet form since 
modifications are not allowed.  
 
And the names include either the word "Posted" or "Issued" to indicate that it is a 
history table rather than a transaction entry table. 



 

 

Microsoft Navision Development I − C/SIDE Introduction 

Page 78 

Setup Table Characteristics 
A Setup Table is a table that is designed to hold only one record. This record 
contains various fields that are used to select options for Microsoft Navision or to 
hold data that is applicable to the company as a whole.   
 
Generally, no tables are related to a Setup Table, although Setup Tables can be 
related to other tables, usually Supplemental Tables. 

Naming Setup Tables 
The name of this table is usually the name of the functional area it is meant to set 
up, followed by the word, "Setup." For example, the table that contains the setup 
information for the General Ledger functional area is named "General Ledger 
Setup." One exception to this rule is the Company Information table. 

Primary Key and Other Standard Fields 
The Primary Key for this table is a Code field of length 10, named "Primary 
Key." It is always left blank as only one record per table is allowed. There is no 
description field for this table type. 

Associated Setup Form 
There is only one form set up for this table, and it is a Setup Form as described in 
the next section. The form has the same name as the table. The primary key field 
is not included on this form. 
 

NOTE: There are some tables containing the word "Setup" in their name which have 
more than one record. These tables generally follow the rules of the Subsidiary Tables 
described previously, not the rules outlined here. 
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Test Your Knowledge 
This section reviews the concepts of the chapter by asking you questions.  
 

1. What two major items can you define within a table description? 

 

 

2. What table property defines the default lookup form for the table? 

 

 

3. What field property is used to force the user to enter a value into a 
primary key field? 

 

 

4. What number range can you use for new fields that you add to the 
customer table? 

 

 

5. If you want to view customers in order by the city that they live in, 
what would you have to change in the table description? 

 

 

6. How could you change the Salesperson Code field in the Customer 
table so that the user would only be able to look up Salespeople that 
have a Commission % larger than zero? 

 

 

7. What type of table is the Customer table? 

 

 

8. What type of table is the Item Vendor table? 
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9. What type of table is the Department table? 

 

 

10. What type of table is the Item Ledger Entry table? 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 2: BASIC FORMS 
Training Objectives 

In this chapter, you learn about: 
 

• Forms 
• Starting With a Blank Form 
• Other Useful Controls 
• Using the Form Wizard 
• Creating Buttons 
• Creating Subforms 
• Form Types and Characteristics 
• Standard Navigation 
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Forms 
After you have created tables, the next step in developing a C/SIDE application is 
to design forms. Forms are used for entering information into database tables and 
for retrieving and displaying information from database tables. It is through 
forms that users generate the events that determine the flow of the application. 
 
Forms can be used to access one table at a time, or they can combine information 
from a number of different tables. A form can display information that is 
calculated as the form is displayed, and it can contain information (such as a 
label) that is not related to any table, or purely decorative elements (such as 
bitmap pictures). 
 
The figure below shows the components of a form and how they are related. This 
and the following chapters explore each component in depth. 
 

 
 
Forms are created and edited in the Form Designer. 

Controls 
All information on a form is presented in controls. Controls are objects that can 
display data from a database table field, the value of a C/AL expression, bitmap 
pictures or static information such as a descriptive text. 
 
Some controls are called container controls. An example is a frame. The frame 
itself does not display data or information, but it can contain a number of other 
controls that you want to group. A powerful container control is the tab control.  
 
A tab control is a number of frames or pages that are placed on top of each other. 
The user can switch between the pages by clicking the tabs that have captions. 
Tab controls make it possible to group information on a form so that each page is 
not cluttered with information, and it is very fast and easy to switch between 
pages. 
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Another concept is control branches, which consist of a parent control and 
subordinate or child controls. The best example is a text box and a label. The 
child control inherits some properties from the parent, and the entire branch can 
be moved together on the form. 

Bound and Unbound Forms and Controls 
Typically, a form is related to a database table and is used to enter information 
into the table and display information from the table. The form is said to be 
bound to the table. 
 
An unbound form is not related to a table. An example of an unbound form is a 
form that is used as a menu, from which the user can choose other forms or 
reports to run.  
 

NOTE: Menu forms are no longer part of the base product but can still be developed 
in Microsoft Navision. 

 
The controls on a form that is bound to a table are usually bound to fields in the 
same table. There need not be a control for every field in the table, nor do all 
controls on the form need to be bound to table fields − controls that aren't bound 
to fields are called unbound controls. An example is a command button that 
causes the information on the form to be printed; another is a control that 
contains a descriptive text. An important category of unbound controls includes 
controls displaying information − based on the underlying table or user-entered 
values − that is calculated as the form is displayed. 

Form and Control Properties 
Properties describe how a control is placed on the form, what field it is related to 
and what happens when information is entered into the field, among other things. 
Different types of controls have different sets of properties. For example, a text 
box, the control type that is typically used to display the contents of a database 
field, has more properties than a picture box, a control used to display bitmap 
pictures. 
 
The form itself also has properties. For example, you can specify whether the 
form is to be used only for displaying information or whether it is possible to 
insert new records or update existing ones. 
 
Properties are defined on the Property Sheet that can be edited when the form is 
opened in the Form Designer. 
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Triggers 
Certain predefined events that happen to a form or a control cause the system to 
execute a user-definable C/AL function − the event triggers the function. The 
event and the function are together called a trigger. Form triggers include 
OnOpenForm, containing statements that are executed when the form is opened, 
and OnModifyRecord, containing statements that are executed before the system 
accepts changes the user makes to a record. Triggers are edited in the C/AL 
editor, which can be opened from the Form Designer. 

Starting with a Blank Form 
In this section, we discuss how to create a blank form. This is not the best way to 
create a form, but it gives you an appreciation for the Form Wizard and the Field 
Menu (these are discussed in a later section). 

Creating a Blank Form 
Start by creating a blank form. There is a Wizard that helps you create forms, but 
you will use it later. The steps to create a blank form are: 
 

1. From the Tool menu, choose Object Designer. 

2. In the Object Designer, click the Form button. 

3. Click New. C/SIDE displays the Form Wizard window. 

4. Click OK to create a blank form. C/SIDE displays the Form 
Designer window. When you create a blank form, the size is rather 
small. You can enlarge this if you need to in later exercises. 

5. Close, save, and compile the new form. Use the name 'Blank Form' 
and the ID 123456754. You use this form in the following exercises. 
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6. Run the form. 

 

 
 

 What is the value in the title bar of the form (this is usually the blue 
area at the top of a form that has the Min, Max, and Close buttons 
on it)? 

 

 What happens when you click the Next button on the toolbar? 

 

 Is the form reading information from a table? 
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Test Your Skills − Attaching a Source Table 
A blank form is unbound when it is created. This means that it is not associated 
with any table. In this exercise, you associate the blank form you created with a 
table and see what happens. 
 

1. Design form 123456750 (Blank Form). 

2. Open the Properties window for the form. 

3. Click on the SourceTable property. 

4. Enter the number 18 into this property. The number 18 is the ID of 
the Customer table. Your form is now bound to the Customer table. 

 

 
 

5. Close, save and compile the form. 

 Now let's take a look at what has changed. 

 Run form 123456750 (Blank Form) and answer the following 
questions.  

 What is the value in the title bar of the form (this is usually the blue 
area at the top of a form that has the Min, Max, and Close buttons 
on it)? 

 

 What happens when you click the Next button on the toolbar? 

 

 Is the form reading information from the source table? 
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Test Your Skills − Adding Simple Controls 
In this exercise, add a text box, label and a check box to your blank form. These 
are the most common controls that you see on a form. 

Adding a Text Box 
 

1. Design form 123456750 (Blank Form). 

2. Click the Toolbox button on the toolbar (or VIEW→TOOLBOX). The 
Toolbox window appears. 

 

 
 

3. Hold your mouse over each button on the Toolbox window for a few 
seconds. This shows you the Tool Tip for that button. The Tool Tip 
displays the name of the control that the button represents. 

4. Click the Text Box button on the Toolbox window. This selects this 
control type (the button stays down). To unselect this control type, 
you can click the Arrow button at the top left of the Toolbox 
window. 

5. With the Text Box button selected, move the cursor (mouse pointer) 
over the blank form. Your cursor should change to the cross hairs 
and a box. 

6. Click somewhere in the middle of the form. Notice that where you 
click is where the upper left corner of the Text Box is located. If you 
drag the mouse with the mouse button still down, you change the 
size of the Text Box as you are creating it. This is usually not useful. 
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 Answer the following questions as you go through this text.  

 

 
 

 You now have a Text Box on your form. What information does it 
display? 

 

 Try running the form by clicking FILE→RUN. What happens? 
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Binding the Text Box 
The Text Box control must be bound to a field or other data element (this could 
be anything that returns a valid value: variable, function, or other expression). 
 
To bind the Text Box control, you must set a property: 
 

1. Click on the Text Box control to select it. 

2. Open the Properties window. 

3. Change the SourceExpr property to "No." (including the double 
quotes). 

4. Close, save and compile the form. 

Run the form and test your new Text Box by moving to the next, previous, first 
or last record. 

Adding a Label 
There is only one problem that someone using your very simple form might have. 
The user may not know what is being displayed. To help your user, add a label 
that describes the field on the form. 
 

1. On the Toolbox window, click the Label button (remember to use 
the Tool Tips to help you find the right button).  

2. Move the cursor over the form and click somewhere to the left of the 
Text Box control that you added. 

3. Open the Properties window for the label. 

4. Change the Caption property to 'No.' (without the quotes). 

5. Close, save and compile the form. 
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Run the form and test your new Text Box by moving to the next, previous, first 
or last record. The label lets you know what field you are looking at. 
 

 
 

Adding a Check Box 
 

1. On the Toolbox window, click the Check box button. 

2. With the Check box button selected, move the cursor (mouse 
pointer) over the blank form. 

3. Click somewhere in the middle of the form below the other controls. 
Notice that where you click is where the upper left corner of the 
Check box is located. 

4. Like the Text Box, the Check box control must be bound to a field or 
other expression. For a Check box to work correctly, however, the 
expression or field that it is bound to must return a boolean value 
(true or false). A check in the box represents true, and an empty box 
represents false. 

5. Open the Properties window. 

6. Change the SourceExpr property to "Print Statements" (with the 
double quotes). 

7. A Check box has a built in label. So, change the Caption property 
also to "Print Statements" (with the quotes).  

8. You have to change the ShowCaption property to Yes and perhaps 
expand the size of the check box to see the caption. Notice that the 
built in label for a Check box appears on the right side of the check 
box. This can be changed with another property (you can experiment 
to find out which one). 
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9. Close, save, and compile the form. 

 

 
 
Run the form and test your new Check box by moving to the next, previous, first 
or last record. You may also want to check and uncheck the box. 
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Test Your Skills − Using Add Label and Lock 
There are two very useful options on the bottom of the Toolbox window that can 
help you quickly design your forms. The first is the Add Label option. It allows 
you to attach a label automatically when you put another type of control onto the 
form like a Text Box. The second is the Lock option. It allows you to quickly add 
more than one control at a time. 
 
Answer the questions as you go through these exercises.  

Using Add Label  
 

1. Design form 123456750 (Blank Form). 

2. Click the Toolbox button on the toolbar (or VIEW→TOOLBOX). The 
Toolbox window appears. 

3. Click the Add Label button (bottom right). Notice that this button 
stays down. To unselect it (bring it back up) you can click it again. It 
stays down until you unselect it or leave the Form Designer. 

4. Click on the Text Box button. Notice that the Add Label button is 
still selected. 

 

 
 

5. Move the cursor over to the form (under the other controls) and click 
to put the Text Box on the form. 
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 What else was put on the form? 

 

 What happens when you move the Text Box? 

 

 What happens when you move the Label? 

 

 How can you move just the Text Box (Hint: look for the hand 
cursor)? 

 

 What happens if you click on the Check box button and then click 
on the form? 

 
6. Delete the controls that you added for this exercise. 

7. Close, save and compile the form. 

Using Lock 
 

1. Design form 123456750 (Blank Form). 

2. Click the Toolbox button on the toolbar (or VIEW→TOOLBOX). The 
Toolbox window appears. 

3. Click the Lock button (bottom left). Notice that this button stays 
down. To unselect it (bring it back up), click it again. It stays down 
until you unselect it or leave the Form Designer. 

4. Click the Text Box button. Notice that the Lock button is still 
selected. 

5. Move the cursor over to the form (under the other controls) and click 
to put the Text Box on the form. 

6. Move the cursor down and click again. 

7. Move the cursor down and click again. 
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8. Move the cursor down and click again. 

 

 
 

 How many Text Box controls did you add? 

 

 Can you move any of the controls with the Lock button selected? 

 
9. Delete the controls that you added for this exercise by selecting them 

one at a time and pressing the DELETE key or by using a Marquee 
selection to select them all and then pressing the DELETE key. For 
more information about selecting controls, see the Application 
Designer's Guide. 

10. Close, save and compile the form. 

Using Add Label and Lock 
Design the form one more time and use both the Add Label button and the Lock 
button to add Text Boxes. Experiment with both of these until you are 
comfortable.  
 
Remember to remove any unbound controls before trying to save the form. 
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Other Useful Controls 
In this section, you create and use various types of controls. You start again with 
a blank form.  
 
For some of these exercises, you need to create a new item record. The following 
steps guide you to creating that record. 
 

1. Open the Item Card window from the Inventory menu. 

2. Press F3 to insert a new record. 

3. Enter '1111' (without the quotes) in the No. field. 

4. Enter 'My Test Item' (without the quotes) in the Description field. 

 

 
 

5. Close the Item Card. 

When instructed to find item 1111, you should find the item you just created. 

Adding Container Controls 
In this exercise, you add container controls to your blank form and get to use the 
Tab, Frame, and Table Box controls. Answer the questions as you go along. 
  

1. Create a blank form as in the earlier exercise, with the name 'Blank 
Form 2' and the ID 123456751. 

2. Set the SourceTable to Item (the customer table is not useful for 
some of the exercises). 

3. Design form 123456751. 

4. Click the Toolbox button on the toolbar (or VIEW→TOOLBOX). The 
Toolbox window appears. 
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Using a Tab Control 
 

1. Click the Tab Control button. 

2. Move the cursor over the top left area of the form. 

3. Click to create the Tab control. Notice that it has only one tab. The 
name of the first tab is General. This name is a standard for forms 
that have Tab controls. 

 

 
 

 To add more tabs to a Tab Control follow these steps: 

4. Click the first tab on the Tab Control (any tab will do). This may 
select the Tab control or it may simply change to that tab. 

5. To assure that the Tab control is selected, click the first tab again. 

6. With the Tab control selected, open the Properties window. 

7. Click on the PageNames property. Notice that the current value is 
<General> (the name of the first and only tab). The PageNames 
property is a comma-separated list of tab names. To add a tab, you 
simply add to the list. (You can press the F2 function key twice to get 
to the end of a selected field.) 
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8. Change the PageNames Property to read General,Test,Frame,Table 
Box. There are no spaces after the commas. 

 

 
 
What happened to the Tab control? 

Adding Controls to a Tab 
 

1. Click on the Tab that you want to add the control to. In this case, 
click on the Test tab. 

2. Select the control on the Toolbox window. Select a Label control. 

3. Click on the Tab where you want the control to be. You can move 
the control if you need to. 
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What happens if you click the General tab and back to the Test tab? 
 
Edit the PageNames property of the Tab control so that it looks like 
General,Frame,Table Box. Where is the label control now? 
 
Move the label control to the bottom of the form (off of the Tab control). What 
happens when you change to the General tab and back now? 
 
Click the General tab and move the label from the bottom of the form to the 
middle of the page for the General tab. What happens when you change to the 
Frame tab and back? 

Adding a Frame Control 
A Frame control is similar to the page of a Tab control. It holds other controls 
and when you move the frame, the controls stay with it. 
 

1. Click the Frame tab of the Tab control. 

2. On the Toolbox window, select the Frame button. 

3. Click in the middle of the page for the Frame tab. A frame should be 
created. Re-size the frame so that it fits inside the Tab control. 

4. Change the Caption property of the Frame control to 'Test Frame'. 

5. Add several label controls to the Frame. Remember to drop the 
controls inside the frame. 

 

 
 

 What happens if you move the frame? 

 

 What happens if you delete the frame? 
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Adding a TableBox Control 
A TableBox is a container control that contains bound controls. It allows the 
form to display more than one record at a time. 
 

1. Click the Table Box tab of the Tab control. 

2. On the Toolbox window, select the TableBox control. 

3. Click in the middle of the tab to create the TableBox. You may want 
to move it to the upper left corner and also resize it to fit the Tab 
control. Notice that the TableBox is empty. Remember that it is a 
container control. We still need to add other controls to it. The most 
common control that you see in a TableBox is a Text Box. 

 

 
 

4. On the Toolbox window, select the Text Box control. 

5. Click TableBox. The Text Box control becomes a column and a 
Label control is added to the top for a column heading. 
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6. Change the SourceExpr property of the Text Box control (column) to 
"No." (including the double quotes). 

 

 
 

7. Close, save and compile the form. 

 Run the form. What is displayed in the TableBox? 

 

 What happens to the title bar of the form if you click on another row 
in the TableBox? 

 

 What happens if you maximize the form or simply make it bigger? 

Autosizing Controls 
It would be better if the tab control grew with the form. The TableBox should 
also grow with the form. We adjust the "glue" properties of the controls to allow 
this. 
 

1. Design form 123456751. 

2. Select the Tab Control by clicking the General tab twice. 

3. Open the Properties window. 

4. Change the HorzGlue property to Both. 

5. Change the VertGlue property to Both. 

6. Select the TableBox control by clicking the TableBox tab and then 
clicking the upper left gray box in the TableBox control. 

7. Open the Properties window. 
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8. Change the HorzGlue property to Both. 

9. Change the VertGlue property to Both. 

10. Close, save and compile the form. 

 Run the form. What happens now when you resize the form by 
making it bigger? 
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 Test Your Skills − Displaying Options 
Option fields can be displayed to the user in two different ways. You can use a 
Text Box control (which can display almost anything) or you can use option 
buttons (also known as radio buttons). In this exercise, you explore both.  

Using a Text Box 
 

1. Design form 123456751. 

2. Add a Text Box with an attached label to the General tab. 

3. Change the SourceExpr property of the Text Box to "Costing 
Method". The Costing Method field is an option field in the Item 
table. 

 

 
 

4. Close, save, and compile the form. 

5. Run the form. 

 What type of button is in the Text Box? 

 

 What happens when you click the button? 

Using Option Buttons 
 

1. Design form 123456751. 

2. On the Toolbox window, click the Lock button to select it. 

3. On the Toolbox window, click the Option button. 
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4. On the General tab, click to create an Option button. 

5. Move down and click again to create another Option button. 

6. Move down and click again to create the last Option button. There 
are five option values for the Costing Method field. You only allow 
the user to access three of the values. That is why you need three 
Option buttons. Each Option button represents one value of the 
Costing Method field. 

7. On the Toolbox window, click the Lock button to clear it. 

8. For each Option button, change the SourceExpr property to "Costing 
Method". 

9. For the first Option button, change the OptionValue property to 0. 

10. For the first Option button, change the Caption property to FIFO. 

11. For the second Option button, change the OptionValue property to 
1. 

12. For the second Option button, change the Caption property to LIFO. 

13. For the third Option button, change the OptionValue property to 2. 

14. For the third Option button, change the Caption property to 
Standard. 

 

 
 

15. Close, save, and compile the form. 

16. Run the form and find item 1111. 

 How many of the Option buttons are selected? 
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 What happens if you try to select another one? 

 

 What happens if you change the Text Box that is bound to the 
Costing Method field to Standard? 

 

 What happens if you change the Text Box that is bound to the 
Costing Method field to Average? 
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Test Your Skills − Displaying Progress Indicators 
For this exercise, create a way for the user to easily see the percentage of profit 
that they make on each item. Use a vertical progress bar that goes from 0 to 100.  
 

1. Design form 123456751. 

2. On the Toolbox window, click the Indicator button. 

3. Click the General tab to create an indicator control. By default, the 
indicator starts on the left and increase to the right. Yours starts at 
the bottom with zero and increase up to the top (100). 

 

 
 

4. Change the Orientation property of the Indicator control to Bottom. 

5. Change the MinValue property to 0. 

6. Change the MaxValue property to 100. 

7. Change the SourceExpr property to "Profit %". 

8. Increase the height of the Indicator control by dragging the top edge. 

9. Close, save, and compile the form. 
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10. Run the form. 

 

 
 

 Use the Next button to look at many different records. What range of 
values did you notice? 

 

 What happens if you change the MaxValue property to 1000 and run 
the form again? 
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Displaying BLOB Fields (Pictures) 
BLOB fields are used primarily to store pictures. Some items in the Item table 
have pictures. Add a control to your form to display the picture to the user.  
 

1. Design form 123456751. 

2. Select the Tab Control by clicking the General tab twice. 

3. Add a tab to the Tab control called Picture. Make sure this is the last 
tab on the control. 

4. Click the Picture tab. 

5. On the Toolbox window, click the PictureBox button. 

6. Click in the middle of the tab to create the PictureBox control. Do 
not worry about the size. The default size works fine for this 
example. Move the PictureBox to fit inside the Tab control. 

7. Change the SourceExpr property of the PictureBox control to 
Picture. 

 

 
 

8. Close, save and compile the form. 

9. Run the form. 

Use the next button to look at many different records. List some of the items that 
have pictures. 
 

HINT: Begin looking around item 1896-S. 
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Using the Form Wizard 
In this section, we discuss easier ways of creating and modifying forms. Always 
keep in mind what you learned in the previous sections to understand what is 
really being done. 
 
The form wizard can create two different types of forms − Card forms and 
Tabular forms. 

Card Forms 
A card form is a form that displays one record at a time to the user. It usually has 
a tab control, and the first tab is normally called General. In this exercise, you 
create a card form using the wizard. 

Starting the Wizard 
 

1. From the Tool menu, choose Object Designer. 

2. In the Object Designer, click the Form button. 

3. Click New. C/SIDE displays the New Form window. 

 

 
 

4. Enter 18 in the Table field. You are creating a new Customer Card 
form. 

5. Click Create a form using wizard. 

6. Click Card-Type Form in the list. 

7. Click OK to start the Card-Type Wizard. 
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The Card-Type Wizard 
Anytime during the creation of the form in the Wizard, you can press Preview on 
the bottom of the Wizard to view what you are creating. 
 

 
 

1. Should the Form contain tabs?  

a. Leave Yes selected. Notice that the first tab is called General by 
default. 

b. Click in the empty line under General and type 'Second Tab'. 
c. Click Next. 

2. Which fields from the Customer table do you want on the tabs? 

a. Click the Second Tab tab. Notice that the form has both of the 
tabs that you requested. 

b. Click the General Tab. 
c. Double-click the following fields: No., Name, Address and 

City. These fields are moved onto the General tab. 
d. Click the Second Tab tab. Notice the Field Order list is empty 

for this tab. 
e. Double-click the following fields: Global Dimension 1 Code, 

Territory Code, and Global Dimension 2 Code. 
3. Click Finish to end the wizard and open the newly created form in 

the Form Designer. The form has not been saved yet. 

4. Close, save and compile the form with the ID 123456752 and the 
Name 'My Customer Card'. 
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5. Run the form and test your tabs and fields. 

 

 
 

Tabular Forms 
A tabular form is a form that displays many records at a time to the user. It 
usually has a Tablebox control. In this exercise, you create a tabular form using 
the wizard. 

Starting the Wizard 
 

1. From the Tool menu, choose Object Designer. 

2. In the Object Designer, click the Form button. 

3. Click New. C/SIDE displays the New Form window. 

4. Enter 18 in the Table field. You are creating a new Customer List 
form. 

5. Click Create a form using wizard. 

6. Click Tabular-Type Form in the list. 

7. Click OK to start the Tabular-Type Wizard. 
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The Tabular-Type Wizard 
Anytime during the creation of the form in the Wizard, you can press Preview on 
the bottom of the Wizard to view what you are creating. Notice that there is only 
one screen in this wizard. When you are done on this screen, you are done with 
the wizard. 
 

 
 

1. Which fields from the Customer table do you want on your form? 

a. Double-click the following fields: No., Name, Address and 
City. 

2. Click Finish to end the wizard and open the newly created form in 
the Form Designer. The form has not been saved yet. 

3. Close, save and compile the form with the ID 123456753 and the 
Name 'My Customer List'. 

4. Run the form and test your fields. 

 

 
 

 Unlike the real Customer List form, this form allows the user to 
change the values. This is not desirable because a list form is used 
for searching and selecting records. You need to change the form so 
that it is not editable. You could change every control, but that would 
still allow deletions and inserts. 

5. Design form 123456753. 
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6. Open the Properties window for the form. 

7. Change the Editable property of the form to No. 

8. Close, save and compile the form. 

9. Run the form. 

10. Click the Name field and begin typing your name. Answer the 
following: 

 What happens? 

 

 Why is this desirable to a user? 
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Test Your Skills − Using the Field Menu 
In this exercise, add fields to your card form and your list form. 
 

NOTE: The Field Menu can be used to add fields to any bound form, whether you 
used the wizard to create the form or not. 

 

Adding Fields to a Card Form 
 

1. Design form 123456752. 

2. On the toolbar, click the Field Menu button to open the Field Menu 
dialog. 

 

 
 

3. Find the Balance field in the Field Menu dialog. 

4. Click the gray box beside the Balance field to select the field (it 
should be highlighted in blue). 

5. Move the mouse over the form where you want the field to be. 

6. Click to create a Text Box for the field. The SourceExpr property is 
already set for you. 

7. Close, save, and compile the form. 
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8. Run the form. 

 Does the field work properly? 

 

 What else got placed on the form with the Text Box? 

Adding Fields to a Tabular Form 
 

1. Design form 123456753. 

2. On the toolbar, click the Field Menu button to open the Field Menu 
dialog. 

3. Find the Balance field in the Field Menu dialog. 

4. Click the gray box beside the Balance field to select the field (it 
should be highlighted in blue). 

5. Move the mouse over the Tablebox where you want the new column 
to be. 

6. Click to create a new column for the field. The SourceExpr property 
is already set for you. 

 

 
 

7. Close, save and compile the form. 

8. Run the form. 

 Does the field work properly? 

 

 What was the column heading? 

 

 Do you think that most users need to see the Balance field on this 
form? 
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Test Your Skills − Making Columns Invisible on a Tabular 
Form 

Because most users do not need to see the customer's balance, the column should 
be made invisible on the List form by default. However, every user should be 
able to add it. 
 
In this exercise, you change the List form to accommodate the requirements 
mentioned above. 
 

1. Design form 123456753. 

2. Open the Properties window for the Balance field column. 

3. Change the Visible property of the Text Box to No. 

4. Close, save and compile the form. 

5. Run the form. 

 Can you see the column? 

 

 Click VIEW→SHOW COLUMN. Is the Balance field listed? Is the Net 
Change field listed?  

 

 Why is the Balance field listed while the Net Change field is not? 

 

 Check the box next to the Balance field and Click OK. Is the 
Balance field shown now? 

 

 What happens if you close the form and run it again? 
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Creating Buttons 
In this section, you learn about the most important control that you have to add to 
almost all forms (the wizard does not do this for you). This control is the button. 
 
Explore the main two types of buttons − Command Buttons and Menu Buttons. 
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Test Your Skills − Creating Command Buttons 
In this exercise, you create a command button that closes the form. Answer the 
questions in the exercise.  
 

1. Design form 123456752. 

2. Open the Toolbox window. 

3. Click the Command Button button. 

4. Move the mouse over the bottom right of the form (to the left of the 
Help button).  

5. Click to create the Command Button. On standard forms, buttons go 
in the bottom right corner. 

6. Open the Properties window for the button. 

7. Change the PushAction property of the button to OK (not 
LookupOK). This tells the button to be an OK button. OK buttons 
close the form when clicked. PushAction must be set on any button 
that you want to work without code. 

8. Close, save and compile the form. 

9. Run the form. 

 

 
 

 What caption does the button have? 

 

 What happens when you click the button? 
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 Run the form again. Resize the form slowly. What happens to your 
new button? 

 

 What happened to the Help button? 

 

 What caused them to act differently? 

 

 Change the HorzGlue and VertGlue properties of your button to 
match those of the Help button. 

 

 Test the form again by resizing it. What happens to your new button? 
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Test Your Skills − The RunObject PushAction 
In this exercise, create a push button that runs another form.  
 

1. Design form 123456753. 

2. Add a Command Button (see previous exercise) next to the OK 
button. 

3. Change the caption of the button to 'Card'. Do not forget to change 
the glue properties as well. 

4. Change the RunObject property to 'form 123456752' (without the 
quotes). You can use the lookup button to find form 123456752 as 
well. Typing the values, however, is usually faster. 

 

 
 

5. Close, save and compile the form. 

6. Run the form. 

 Where is the button? Where are the OK and Cancel buttons? 

 

 What happens when you click the button? 

 

 What did you neglect to set? 
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 Change the PushAction property of the button to RunObject. Now, 
the button performs the action. A PushAction of <0> causes the 
button to do nothing (except fire its OnPush trigger). You may also 
want to move your Card button next to the Help button. 

 

 
 

 Run the form again. What happens this time when you click the 
Card button? 

 

 Close the card form. Select customer 50000 on the list form. Click 
the Card button. Which customer is displayed on the card form? 
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Test Your Skills − Linking Forms 
In this exercise, change the Card button so that it opens the card form with the 
record that is selected on the list form. This is called linking. 
 

1. Design form 123456753. 

2. Open the Properties window for the Card button. Just below the 
RunObject property are the RunForm properties. These properties 
allow you to control the form that the button runs. 

3. Change the RunFormLink property to 'No.=FIELD(No.)' (without 
quotes). You can also use the assist-edit button to bring up the Table 
Filter dialog to assist you. 

4. Close, save and compile the form. 

5. Run the form. 

What happens when you click the Card button with customer 50000 selected? 
 
What happens if you close the card form, select another customer and click the 
Card button again? 
 
Notice that while the card form is open, you can click back on the list form and 
choose another record. What happens to the card form when you change the list 
form in this way? 
 
Design the form and change the RunFormLinkType property of the Card button 
to OnUpdate.  
 

 
 
Save your changes and run the form. Now, what happens when you change the 
list form while the card form is still open? 
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Creating Menu Buttons 
Menu buttons are containers for menu items. A menu item is almost identical to a 
command button (they share many properties). 
 
In this exercise, you create a menu button. 
 

1. Design form 123456753. 

2. Move the OK and Cancel buttons to the left. 

3. On the Toolbox window, click the Menu button. 

4. Click on the form next to the Card button. 

5. Change the caption of the menu button to 'Customer'. Most card and 
list forms contain a menu button with the name of the table. 

6. Make sure to change the glue properties on the button as you did 
with the other buttons. 

 

 
 

7. Close, save and compile the form. 

8. Run the form. 

 What happens when you click the new menu button? 

 (Answer: Nothing) 
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Test Your Skills − Creating Menu Items 
In this exercise, add menu items to your menu button.  
 

1. Design form 123456753. 

2. Click on the Customer menu button to select it. 

3. On the main menu, click VIEW→MENU ITEMS to open the Menu 
Designer. 

 

 
 

4. Click on the first empty line.  

5. Enter the word 'Card' (without quotes) into the Caption field. 

6. Instead of entering the rest of the values on the line, open the 
Properties window for the menu item. 

7. Change the PushAction property to RunObject. 

8. Change the RunObject property to 'Form 123456752' (without 
quotes). 

9. Change the RunFormLink property to 'No.=FIELD(No.)' (without 
quotes). You can also use the assist-edit button to open the Filter 
dialog and set the values there. 

10. Change the RunFormLinkType property to OnUpdate. 

11. Change the ShortCutKey property to SHIFT + F5. 

12. Close the Menu Designer. 

13. Close, save and compile the form. 

14. Run the form. 

 What happens when you click the menu button now? 

 What happens when you click the Card menu item? 

 What happens when you press SHIFT + F5? 
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Test Your Skills − The LookupTable PushAction 
In this exercise, you explore a very special PushAction called LookupTable. 
Again, the questions are answered at the end of the manual. 
 

1. Design form 123456752. 

2. Add a menu button to the form with a caption of Customer as in one 
of the previous exercises. 

3. Add a menu item to the menu button that has a caption of List. 

4. Change the ShortCutKey of the menu item to F5 and the PushAction 
to LookupTable. This action brings up the default lookup form for 
the form's source table. 

 

 
 

5. Close, save and compile the form. 

6. Run the form. 

 What form comes up when you press the F5 function key? 

 

 Why does that form come up and not your customer list form? 

 

 Design table 18 and change the LookupFormID property of the table 
to 123456753. Run your card form again. Now what form comes up 
when you press the F5 function key? 
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Creating Subforms 
In this section, we discuss how to display information from another table on a 
form (not the source table of the form). One way to accomplish this is to display 
another form within the first form. This is called a subform. Here you explore the 
subform control. 
 
You build two forms that come together to show the customer records and the 
customer comments on one form. 
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Test Your Skills − Creating the Main Form 
In this exercise, you create the main form. It displays customer information and 
includes a subform control that displays comments for the customer.  
 

1. From the Tool menu, choose Object Designer. 

2. In the Object Designer, click the Form button. 

3. Click New. C/SIDE displays the New Form window. 

4. Create a card form using the wizard that contains the customer 
number, name, address, and city on one tab named General.  

5. Once the form wizard is done, save and compile the form with the ID 
123456754 and the name 'Customer Comment'. 

6. Make room for the Subform control by making the form larger (not 
wider) and moving the Help button down to the bottom right corner. 
There should be almost as much room on the form for the Subform 
control as there is for the Tab control. 

7. Create a Subform control on the form from the Toolbox window. 
The control should be positioned just below the tab control and 
should be exactly the same width. Adjust the height of the subform 
control to take up the available space. 

8. Open the properties window for the Subform control and write down 
the Height and Width properties. 

 Height ____________________ 

 Width _____________________ 
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9. Close, save and compile the form. 

10. Run the form. 

 What appears where the subform control is? 
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Test Your Skills − Creating the Subform 
In this exercise, you create the form that displays the comment lines for the 
customer. It is a worksheet form that fits into the subform control on the 
Customer Comment form.  
 

1. In the Object Designer, click the Form button. 

2. Click New. C/SIDE displays the New Form window. 

3. Create a tabular form using the wizard that contains the Table 
Name, No., Line No., Date and Comment fields from the Comment 
Line table (the Code field is not needed). 

4. To make this into a sub form, you must delete all buttons (OK, 
Cancel, and Help). You must also move the table box into the upper 
left corner and make the form the same size as the table box control. 

 

 
 

5. Close, save and compile the form with the ID 123456755 and the 
Name 'Customer Comment Subform'. 

6. Run the form. 

7. Enter the following records: 

 
Table 
Name 

No. Line 
No. 

Date Comment 

Customer 10000 10000 8/10/01 Cust. 10000 Comment 1 
Customer 10000 20000 8/11/01 Cust. 10000 Comment 2 
Customer 20000 10000 10/9/01 Cust. 20000 Comment 1 
Customer 30000 10000 10/10/01 Cust. 30000 Comment 1 
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 What property of the form could you use to automatically fill in the 
Line No. field for you? 

 

 What purpose does the Table Name field serve? 
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Test Your Skills − Adding the Subform Onto the Main Form 
In this exercise, add the subform to the main form by setting up the subform 
control.  
 

1. Design the main form, 123456754. 

2. Click on the Subform control to select it. 

3. Open the Properties window. 

4. Change the SubFormID property to 123456755. 

5. Close, save and compile the form. 

6. Run the form. 

 

 
 

 What appears in the spot where the subform control is? 

 

 Does the Customer Comment Subform fit into the subform control 
perfectly (is it lined up with the tab control)? 

 

 Why is there a box around the subform? 
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 What happens when you resize the form by making it wider? 

 

 What happens when you resize the form by making it taller? 

 

 What records show up in the subform when you change to a new 
customer on the main form? 

 
Here is a list of the things you need to do to finish this combination of two forms: 
 

1. Correct the sizing problems.  

a. Change the VertGlue property of the Tab control to Top. 
b. Change the VertGlue property and the HorzGlue property of the 

subform control to Both. 
2. Correct the appearance of the subform in the subform control. 

a. Change the Border property of the subform control to None. 
b. Change the Width and Height properties of the Tablebox control 

(on the subform) to the values that you wrote down earlier. 
3. Display the records in the subform that match the customer record in 

the main form. 

a. Change the SubFormLink property of the subform control to 
'Table Name=CONST(Customer),No.=FIELD(No.)' (without 
quotes). You must set the Table Name to Customer, so that only 
customer comments appear on the form. 

4. Remove unneeded fields from the subform. It is dangerous to show 
the user the Table Name, No. and Line No. fields. The form is 
automatically filling in these values, and the user must not be 
allowed to change them. 

a. Change the AutoSplitKey property of the subform to Yes. 
b Delete the Table Name, No. and Line No. fields from the 

subform. 
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5. Save, compile and test these two forms again. 

 

 
 

 Are there any other problems with your forms? 

 

 Can you insert a new customer? 

 

 Can you add comments to that new customer? 

 

 What happens when you change to another customer? 
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Form Types and Characteristics 
This section describes the types of windows that the user sees in C/SIDE. It then 
describes the types of forms that you create in your applications and gives 
examples and characteristics of each. 

Types of Forms in C/SIDE 
There are five basic kinds of forms in C/SIDE, the programming environment for 
Microsoft® Business Systems − Navision®.  

Dialogs  
These are simple windows that display information and whose only responses 
consist of pressing a button, whether it is OK, Cancel, Yes, No and so on. These 
are generated by C/AL functions such as ERROR, MESSAGE, TESTFIELD, 
CONFIRM and so on, or are created by the programmer using a variable of type 
Dialog. They are not associated with Form Objects. 

Request Panels  
These are found only within Report Objects and are not associated with Form 
Objects. 

Unbound Forms  
These are Form Objects that are not associated with a table. They, like Request 
Panels, are used when a few questions need to be asked of a user in order to 
continue processing.  

One-Record Forms  
These are Form Objects that are associated with a table. They let the user see and 
possibly edit only one record from one table at a time. An example of this would 
be a Card Form. 

Multi-Record Forms  
These are Form Objects that are associated with a table. They let the user see 
multiple records from one table at once and possibly edit them. Examples of 
these include Tabular Forms, TrendScape Forms and Matrix Forms. 

Our Focus 
The forms that make up the Building Blocks of Microsoft Navision are those 
Form Objects that are associated with tables (the last two listed above). While 
important, the other forms and windows are not covered in this section. 

Why is This Important? 
Note that while C/SIDE lets you create forms of many kinds with many different 
looks and methods of operation, the Microsoft Navision application only uses a 
few of the possibilities. This is to provide a consistent look and feel to the 
application.  
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It is strongly recommended that for ease of use and for consistency, you also 
follow this policy for all modifications to Microsoft Navision and for any 
application that interfaces with it. All of the following descriptions assume full 
use of the Microsoft Navision standards. 

Types of Forms and Examples 
There are several types of standard forms in Microsoft Navision. Below is a table 
with the most common types of forms and some examples of each. A more 
detailed description of each type appears in the following sections. 
 
Understanding these standards regarding the forms within Microsoft Navision 
gives you the ability to understand areas of the application with just a superficial 
look at the objects. 
 
Type One Record/Multi-

Record 
Examples 

Card Form One Record Customer Card, Vendor Card, Item 
Card 

Statistics 
Form 

One Record Customer Statistics, Vendor Statistics, 
Employee Statistics 

Tabular 
Form 

Multi-Record Departments, Currencies, Payment 
Terms 

List Form Multi-Record Customer List, Item List, Item Ledger 
Entries 

Worksheet 
Form 

Multi-Record General Journal, Cash Receipts Journal, 
Item Transfer Journal 

Header/Line 
Form 

Both (actually two 
forms) 

Sales Invoice, Posted Purchase Credit 
Memo, Finance Charge Memo 

Setup Form One Record General Ledger Setup, Company 
Information, Sales & Receivables Setup 

 

Card Form Characteristics 
A Card form allows the user to view and edit one record at a time in a table. It is 
used when there are too many fields to view them all conveniently on only one 
line. Card forms always have tabs (like index tabs) across the top edge with 
which the user can select different groups of fields to display.  
 
Even if there are few fields, there is at least one General tab, which is always 
first.  
 
The table's Primary Key field is always the first field in the General tab. In tables 
that use Card forms, there is only one field in the Primary Key. 
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Naming Card Forms 
Card forms are named with the name of the table they are associated with, 
followed by the word "Card".  
 
For example, the card form associated with the Customer table is named 
"Customer Card". Card Forms also have at least one Menu Button at the bottom 
named with the name of the table that provides ways of getting to related 
information. 

Statistics Form Characteristics 
A Statistics form is a one-record form that let the user view, but not edit 
information. It usually contains FlowFields, which lets the user drill down to get 
to more information. Usually, it also contains calculated or derived information 
contained in variables, which cannot be drilled down.  
 
Statistics Forms can also contain tabs in order to help organize the information. 
The table's Primary Key is displayed only in the form's title bar. 

Naming Statistics Forms 
Statistics forms are named with the name of the table with which they are 
associated, followed by the word "Statistics." 
 
For example, the statistics form associated with the Customer table is named 
"Customer Statistics".  
 
Entry Statistics forms are a special version of the statistics form. They are named 
with the name of the table they are associated with, followed by the words "Entry 
Statistics". An example would be the "Customer Entry Statistics" form. 

Tabular Form Characteristics 
A Tabular form is a multi-record form that lets the user view multiple records 
from a table and edit them. Each record is displayed as a single row in the tabular 
form and each field is displayed as a column forming a spreadsheet-like table 
within the form itself.  
 
The Primary Key of the associated table is displayed in the left-most column. If 
there are multiple fields in the Primary Key, they display in order of their 
significance in the columns, starting from the left. 

Naming Tabular Forms 
Tabular forms are named with the plural of the name of the table with which they 
are associated.  
 
For example, the Tabular Form associated with the Department table is named 
"Departments".  
 
In the case of associated tables that have multiple fields in the Primary Key, the 
name can be different. For example, the Tabular Form associated with the 
General Posting Setup table is named "General Posting Setup". 
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List Form Characteristics 
A List form is a multi-record form that lets the user view multiple records from a 
table at once, but does not let the user edit them. It uses the same rows-and-
columns look as the Tabular Form.  
 
The Primary Key field(s) of the associated table is (are) displayed in the left-most 
column. 

Naming List Forms 
List Forms are named with the name of the table with which they are associated, 
followed by the word "List". For example, the list form associated with the 
Customer table is named "Customer List". 

The "Specialized" Ledger Form 
A more specialized version of the List Form is the Ledger Form. These are used 
only for Ledger Entry tables. They differ from ordinary List Forms, in that even 
though users cannot insert or delete records, they can sometimes edit a small 
number of the fields.  
 
Also, the Primary Key, always an integer named "Entry No.", is displayed in the 
right-most column rather than the left-most column.  
 
Finally, the Ledger Form is named with the plural of the name of the associated 
table. For example, the Ledger Form associated with the Customer Ledger Entry 
table is named "Customer Ledger Entries". 

Worksheet Form Characteristics 
A Worksheet form is a specialized version of the Tabular Form, a multi-record 
form that lets the user view multiple records from a table and edit them. The 
difference is that when the user inserts a new record, the record does not jump to 
another position within the form, but instead stays in the same order as the user 
inserted it.  
 
This is done using the AutoSplitKey property of the form, combined with an 
integer as the last field in the table's Primary Key.  
 
The Primary Key fields of the associated table do not display on the Worksheet 
Form. 

Naming Worksheet Forms 
Worksheet forms are named in accordance with the purpose of the associated 
table, as covered later in this section. One example is a Journal Table. In this 
case, the name of the worksheet form ends with the word "Journal".  

Header/Line Form Characteristics 
Many forms within Microsoft Navision have characteristics of both a card form 
and a tabular form. An example would be the Sales Invoice form.  
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The fields that are common to the entire invoice are located on a card-like form 
with tabs, showing one invoice at a time. However, the invoice lines display in a 
table-like section of the form, where multiple invoice lines (from the same 
invoice) can be viewed at the same time and edited. These are called 
"Header/Line" forms. 
 
Header/Line forms are, in fact, two separate forms associated with two different 
tables. The main form is a Card Form associated with a table. The main form has 
a sub-form control. A Worksheet Form is displayed within the sub-form control 
that is associated with a different table, a table which is "subsidiary" to the first 
(you learn more later). The sub-form control handles the linkage between the two 
forms. 

Naming Header/Line Forms 
In many cases, a Header/Line form represents a Document.  
 
In the example above, the Sales Invoice form, the name of the form is the name 
of the Document that it represents. In other cases, the name of the form is 
whatever the name of the main form would have been without the sub-form. 
These situations are described in more detail when we discuss the Table building 
blocks. 

Setup Form Characteristics 
A Setup form is a one-record form that allows the user to view and edit that 
single record in a setup table. The user is not allowed to insert or delete this 
record using this form. Since there are many fields, these forms contain tabs (like 
index tabs) across the top edge to organize the information.  
 
Since there is only one record, the Primary Key does not display anywhere on 
this form. 

Naming Setup Forms 
Setup forms are named with the name of the table they are associated with. For 
example, the setup form associated with the General Ledger Setup table is named 
"General Ledger Setup." 

Menu Form Characteristics 
With the release of Microsoft Navision 4.0 and the introduction of the Navigation 
Pane, Menu forms no longer exist. However, you may from time to time develop 
on earlier versions that require a working knowledge of these objects. 
 
A Menu form is a non-bound form (not related to any table) that lets the user 
access many of the other form types for a functional area from the main menu.  
 
The form usually consists of command buttons or menu buttons. However, the 
appearance of the buttons is usually not what you would expect. The buttons 
properties change so that they look basically like labels with small circles or 
triangles in front of the caption. The buttons still have the same behavior as 
normal buttons. The only difference is their appearance. 
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Naming Menu Forms 
Menu forms are named with the name of the functional area they are associated 
with plus the word "Menu". For example, the menu form associated with the 
General Ledger functional area is named "General Ledger Menu." 

Other Multi-Record Forms 
There are other forms that let users view and/or edit multiple records at the same 
time. These include TrendScape forms and Matrix forms. These forms allow 
great functionality within Microsoft Navision, but like a patio on a house, they do 
not impact the main architecture of the system. 

Standard Navigation 
This section describes the usual ways a user can go to one form from another. We 
described the mechanics of this in the previous section − Extending the 
Functionality of Your Forms. 
 
Here we simply mention the standard navigation that must be provided for 
consistency throughout the application. 

Card and List Forms 
Most master tables have both a card and a list form. Since both of these forms 
access the same table, there are many standards concerning what each form must 
do.  
 

• The user must be able to view and edit one record at a time on the 
card form.  

• The user must be able to view (not edit) all records on the list form. 
By making this form non-editable, the user can begin a search by 
typing in a particular column. 

• The user must be able to bring up the list form from the card form in 
the following ways − F5, List menu item (on the menu button that 
has the same name as the table) and the Lookup button on the tool 
bar. In this case, the user should be able to select a new master 
record and press the OK button to exit the list form and change the 
original card form to the selected master record. 

• The user must be able to open a new card from the list form (by 
pressing SHIFT + F5 or clicking the Card menu item on the menu 
button that has the same name as the table) that displays the master 
record selected on the list form. 

 

Master Statistics Forms 
As mentioned above, most master tables have a card and a list form. Many 
master tables also have a statistics form. The user should be able to get to this 
form from either the card or the list forms in exactly the same way. 
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The standard way of getting to the statistics form is with the shortcut key F9 or 
the Statistics menu item (on the menu button that has the same name as the 
table). 

Master and Ledger Forms 
Every master table has at least (usually only) one ledger table. From the master 
forms (card, list and statistics), the user must be able to get to the ledger form. 
The user can get there in the three different ways − as a result of a drilldown 
button on a FlowField, using CTRL + F5, or the Ledger Entries menu item (on the 
menu button that has the same name as the table). 
 
If a drilldown button was pushed, only the records used to create the calculated 
value are displayed (this is a function of the built in drilldown functionality). If 
the shortcut key or the menu item is used, all ledger records for this particular 
master are shown. This requires a RunFormLink on the menu item that links the 
two tables. You also want to keep the two forms synchronized whenever the 
master form is updated. For this, you should also change the RunFormLinkType 
property to OnUpdate. 
 

NOTE: For performance reasons, you should always set the RunFormView property if 
the RunFormLink property is also set. In fact, the sort chosen in the RunFormView 
property must contain the fields listed in the RunFormLink property or performance 
will be decreased. 

 

Journal Forms 
Every journal form has similar buttons at the bottom of the form. These buttons 
allow the user to either navigate to another form or perform a task. 
 
The normal buttons on a journal form are: 
 

• A menu button named after the master table for the functional area. 
This menu button must contain menu items that let the user go 
directly to the card form for the master table or go directly to the 
ledger form for the ledger entries. In both cases, the form brought up 
should be linked to the master table record that the journal line is 
associated with. 

• A menu button named "Posting". This menu button should contain 
the following menu items related to posting the journal lines − Post, 
Post and Print, Test Report. 
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Test Your Knowledge 
In this section, you are asked questions about the material covered in this chapter.  
 

1. True or False. All forms are bound. 

 

2. True or False. The form wizard is not useful. 

 

3. Which property must you set on Command button for the 
RunObject property to work? 

 

4. Which control allows a form to display more than one record at a 
time? 

 

5. Which control allows a form to display another form? 

 

6. Which property of a Text box binds it to a field in a table? 

 

7. What form property binds a form to a table? 

 

8. How do you turn a menu item into a submenu on a menu button? 

 

9. How do you attach a label to another control so that the label follows 
the other control if you move it? 

 

10. What are the steps to create a List form for a table? 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 3: INTRODUCTION TO C/AL 
PROGRAMMING 
Training Objectives 

In this chapter, you learn about: 
 

• The C/AL Programming Unit 
• C/AL 
• Accessing C/AL 
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C/AL Programming 
This section discusses Microsoft® Business Solutions−Navision® programming 
language and our development environment. You become familiar with creating 
variables using the Pascal-based language and Microsoft Navision's built in 
functions to run simple code. This provides a good base in preparation for 
attending the Solution Developer class. The following topics are presented in this 
section: 
 

• Chapter 4: Intrinsic Data Types Training  
• Chapter 5: Identifiers and Variables  
• Chapter 6: Assignment Statement  
• Chapter 7: Simple Expressions, Terms, and Operators  
• Chapter 8: Numeric Expressions  
• Chapter 9: Logical and Relational Expressions  
• Chapter 10: The IF and EXIT Statements  
• Chapter 11: Compound Statements and Comments  
• Chapter 12: Arrays  
• Chapter 13: Repetitive Statements 
• Chapter 14: Other Statements 
• Chapter 15: Functions 
• Chapter 16: Using Intrinsic C/AL Functions 
• Chapter 17: Creating Your Own Functions 

 

C/AL 
Definition 
C/AL (Client Application Language) is the programming language used in the 
Client / Server Integrated Development Environment (C/SIDE) included with 
Microsoft Navision. 

What is it used for? 
There are many purposes for which you can use a computer programming 
language. However, many of these uses are already handled for you by using the 
standard C/SIDE objects. For example:  
 

• Data presentation is handled through the form objects and report 
objects. 
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• Data acquisition is mainly handled through form and dataport 
objects.  

• Data storage and organization is handled by the table objects in 
conjunction with the built-in Database Management System 
(DBMS). 

 
In C/SIDE, the main purpose of the programming language is data manipulation. 
Through C/AL, you can create business rules to insure that the data stored in the 
tables are meaningful and consistent with the way your customer does business. 
You can add new data or transfer data from one table to another (for example, a 
journal to a ledger). If data from multiple tables need to be combined onto one 
report or displayed on one form, you probably need to program this. 
 
Another purpose of C/AL is to control the execution of the various C/SIDE 
objects. With C/AL you are able to coordinate them in a way that meets the 
business needs of your customer. 

Where is it Used? 
C/AL programming can be found in any Microsoft Navision application object. 
In fact the codeunit application object is used only for programming. If you go 
into the Object Designer, press the Codeunit button, select a codeunit and press 
the Design button, you immediately see the C/AL editor and programming 
language statements (also known as "C/AL statements", or just "code"). 
 
Other objects can have C/AL statements as well, although they do not always 
have them. This code is found in "triggers" within the object. Please start 
Microsoft Navision and follow along as we explore. 
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Accessing C/AL 
Start the Object Designer 
To start the Object Designer, select the Tools option from the Menu Bar and then 
select Object Designer from the list that drops down.  
 

 
 

View Codeunit Objects 
To view codeunit Objects, press the Codeunit Option button on the Object 
Designer form. 
 

 

Codeunit 
Option Button 

 
 

Scroll 
Bar 

Design Command Button 

Select an Object 
Using the picture above as a guide, scroll through the codeunits to find codeunit 
number 358, "DateFilter-Calc", then click on it. Or, if you prefer, use the up and 
down arrows on your keyboard to move to codeunit 358.  
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Look at the C/AL Code 
Using the below picture as a guide, press Design once codeunit 358 − 
"DateFilter-Calc" has been selected. The C/AL Editor window appeared, looking 
something like this: 
 

 
 
Each shaded bar is called a "trigger." The C/AL code that you may see listed 
below the shaded bar is the "trigger code" for that trigger. If there is no C/AL 
code between one trigger and the next trigger, then that trigger is said to be 
empty. For example, there is no trigger code between the "OnRun" trigger and 
the "CreateFiscalYearFilter" trigger, therefore the "OnRun" trigger is empty. 
 
There are three kinds of triggers. The first is the "Documentation Trigger". This 
is not really a trigger and no code in this trigger is run. Instead, you can use the 
Documentation trigger to write any sort of documentation you want for this 
object. Many people use this space to document their modifications to standard 
objects. Every object has a Documentation trigger. 
 
The second kind of trigger is an "Event Trigger". The name of these triggers 
always starts with "On." The C/AL code in an event trigger is executed when the 
named event occurs. For example, the code in the "OnRun" event trigger is 
executed whenever this codeunit object is run. In this case, since there is no 
trigger code, nothing would happen. Each object has its own set of predefined 
event triggers that can be programmed. 
 
The third kind of trigger shown here is a "Function Trigger". These triggers are 
created whenever you create a "function" in an object. The C/AL code in this 
function trigger is executed whenever the function is "called." You learn more 
about creating and calling functions in another section. You learn more about 
event triggers in your Solution Developer II class. 

Page 149 



 

 

Microsoft Navision Development I − C/SIDE Introduction 

Closing an Object 
After looking at the "CreateFiscalYearFilter" codeunit, close the C/AL Editor 
window by clicking the Close Box or by pressing the ESC key. If you have not 
changed anything, the object is closed and you can continue. If you have changed 
something, the following box pops up: 
 

 
 
For now, press the No button (or press the ALT +N key) to discard any changes 
you may have made in order to exit the C/AL Editor and close the object. 

Look at C/AL Code in a Table Object 
Press the Table button in the Object Designer window. Scroll through the Object 
Designer window and select Table 18 (the Item table). Press the Design button to 
open the Table Designer window. Note that this is not the C/AL Editor. Instead, 
it is a list of the fields that make up the table definition. You learn more about 
these later. 
 
To get to the C/AL Code, you must open the C/AL Editor. To do this, review the 
Tool Bar: 
 

 
 C/AL Code Editor 
 
Press the C/AL button. As an alternative, you can press the F9 key. Once you are 
in the C/AL Editor, note that there are numerous triggers in this Table Object. 
Most of them are empty, but several of them contain C/AL code.  
 
Most of these are in triggers labeled with a field name followed by "OnValidate." 
These are event triggers and the code is triggered by the "event" of the user 
completing the entry of that field. You learn more about this and the other 
triggers discussed here in your Solution Developer class. For now, just take a 
look around and then close the C/AL Editor window. Once it is closed, close the 
Table Designer, again without saving any changes you may have accidentally 
made. 
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Test Your Skills 
Terminology 
 

1. What is the programming language of C/SIDE called? 

 

2. List three or more uses of programming code. 

 

3. Where can programming language statements be found? 

 

4. What do you use to modify code in an object? 

 

5. List the three basic types of triggers. 

 

6. What is the key you press to view or modify code in an object (other 
than a codeunit object)? 

Practical 
Use the Object Designer to look at the code in Form Object 39. 
 
Use the Object Designer to look at the code in Report Object 324. Note that the 
code is different depending upon which line (also called a "DataItem") is selected 
in the Report Designer. See what happens when you select the line following the 
last line in the Report Designer before starting the code window. 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 4: INTRINSIC DATA TYPES 
Training Objectives 

In this chapter, you learn about: 
 

• Simple Data Types 
• Numeric Data Types 
• String Data Types 
• Boolean 
• Date, Time and DateTime 
• Complex Data Types 
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Simple Data Types 
Definitions 
Data 
Data are known facts, known pieces of information. For our purposes, we always 
use "data" to mean information that is available for us to manipulate in 
Microsoft® Business Solutions−Navision® using C/SIDE. 

Data Types 
Data Types are the different kinds of information that may appear in C/SIDE. 
Different Data Types have different values, different meanings for those values 
and are manipulated differently. For example, if we have two different data 
values − "25" and "37" − and we add them, we get different results depending on 
what type of data they are. If they are numbers, the result would be "62". If, on 
the other hand, they are text, the result could be "2537".  

Constants 
Constants are data values that are written directly into our programming 
statements. They are called Constants because their values never change while 
the user is running the application. Constants can only be changed by changing 
the C/AL code. 

Simple Data Types 
Simple Data Types are those types of data which have only one value and which 
cannot be broken up into other values of different types. 

Byte 
A byte is a unit of data storage space used in computers. One character stored in 
the computer takes up one byte of storage. Related terms are a kilobyte (KB), 
which is 1024 bytes, a megabyte (MB), which is 1024 Kb or 1,048,576 bytes and 
a gigabyte (GB), which is 1024 Mb, or 1,073,741,824 bytes. 

Numeric Data Types 
Numeric data types are all forms of numbers or amounts. As such, there are many 
automatic methods used by C/SIDE to convert one type of number to another 
behind the scenes and in many cases they can be used interchangeably. However, 
in some cases, their differences can be quite important, sometimes causing errors 
and sometimes causing more subtle problems. 
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Integer 
An integer is a whole number that can range in value from  
-2,147,483,647 to +2,147,483,647. It takes up 4 bytes of storage. By default, an 
integer is equal to zero. Typical constants of type Integer in C/AL are: 
 

• 12 
• 1000 (note that there are no commas as they are invalid in numeric 

constants) 
• -100 
• 0 

 

BigInteger 
Use this data type to store very large whole numbers. This data type is a 64 bit 
integer. 
 
You must add an L to the constant definition to inform C/AL that the integer 
must be interpreted and treated as a BIGINTEGER. 
 

• BI := 1L 
• BI := 455500000000L  

 

Decimal 
A decimal is a whole or fractional number that can range in value from -1x1063 (a 
1 followed by 63 zeroes) to +1x1063, with values as small as 1x10-63 (a zero 
followed by a decimal point followed by 62 zeroes followed by a 1). It is kept 
with up to 18 digits of precision in Binary Coded Decimal (BCD) format and 
takes up 12 bytes of storage. Also, the default value of a decimal is zero. Typical 
constants of type Decimal in C/AL are: 
 

• 12.50 
• 52000000000 (again, note that there are no commas) 
• -2.0 
• 0.008 
• -127.9533 

 

Option 
An option is a special kind of Integer that allows the programmer to define words 
for each value. For example, if we created a variable called Spectrum, we could 
assign it as an option with the following OptionString:  
 

• Red,Orange,Yellow,Green,Blue,Indigo,Violet 
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The default value of an option is zero, since it is an integer and this represents the 
1st element, which is "Red". Therefore, "Green" is represented by the integer 3. 
Note that there are not any spaces between the elements, as a space would 
become part of the element's name. 

Char 
A char is a single character. It takes up 1 byte of storage. For syntax purposes, it 
is considered a numerical type and can have integer values from 0 to 255. It can 
be used along with other numerical types in expressions. Typical constants of 
type Char in C/AL are: 
 

• 'b'  (note the single quotes surrounding the character) 
• 'C' 
• '3' 
• '?' 

String Data Types 
String data is data that is made up of strings of characters. The data that is placed 
in word processors is string data. In spreadsheets, where most of the data is 
considered numeric, string data is sometimes entered using a special prefix to 
distinguish it. In C/AL constants, the symbol used to distinguish string data is the 
single quote, also known as an apostrophe ('). All string constants are surrounded 
by single quotes. 

Text 
A text is a string of 0 to 1024 characters (earlier versions may be limited to 250 
characters). The length of a text is the number of characters in it. To find the 
amount of storage a text takes up, add one to the length and round up to the 
nearest four. Thus an 8-character text takes up 12 bytes (1 + 8 rounded up to the 
nearest 4). Typical constants of type Text in C/AL are: 
 

• 'Hello' 
• '127.50' (even though this looks like a number, since it is surrounded 

by quotes, it is a text) 
• '' (Note that this is an empty, 0 length text) 
• ' spaces before ... and after ' 
• 'Here''s how to use an apostrophe' (note that to put a single 

apostrophe in a text constant, insert two apostrophes) 
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Code 
A code is a special kind of text. All letters are forced to upper case and all 
leading and trailing spaces are removed. In addition, when displayed to the user, 
a code is automatically right justified if all characters in it are numbers. To find 
the amount of storage a code takes up, add two to the length and round up to the 
nearest 4. Thus an 11-character code takes up 16 bytes (2 + 11 rounded up to the 
nearest 4). The same text constants above, converted to code, look like this: 
 

• 'HELLO' 
• '127.50' 
• '' 
• 'SPACES BEFORE ... AND AFTER' 
• 'HERE''S HOW TO USE AN APOSTROPHE' 

 
When comparisons are done on two code values, or when they are sorted, the 
special right justification feature mentioned above is taken into account. Thus, 
for codes, '10' is greater than '9', but '10A' is less than '9A'. For texts, '10' is less 
than '9' as well. 

Boolean 
Boolean 
Boolean data, also known as logical data, is actually the simplest form of data. It 
takes up only 1 byte in memory, though when it is stored in the database it uses 4 
bytes. The constants of type Boolean in C/AL are only  
 

• TRUE  
• FALSE 

 
Note that if these values are compared, the False value is less than the True value 
because it is stored as a zero and True is stored as one. However, the integer 
value is not interchangeable with the constant of TRUE or FALSE. In code, the 
Boolean variable must be set to "TRUE" or "FALSE", not zero or one. 
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Date, Time, and DateTime 
Date 
A date is just what it says, a calendar date, which can range in value from 
1/1/0000 through 12/31/9999. It takes up 4 bytes of storage. In addition, the value 
of a date can either be a Normal Date or a Closing Date. The Closing Date 
represents the last millisecond of the last minute of the last hour of the day, so it 
is greater than the Normal Date with the same calendar value. Typical constants 
of type Date in C/AL are: 
 

• 123197D (December 31, 1997) 
• 030595D 
• 08171953D (August 17, 1953) 
• 0D (The undefined date, less than all other dates) 
• 063012D (June 30, 2012)  

 
All these Date constants are Normal Dates. There are no Closing Date constants 
in C/AL. 
 
The general syntax is mmddyyD or mmddyyyyD. Two digits may be used for the 
year, which is translated differently depending upon which version of Microsoft 
Navision you are using. For versions 2.6 and greater, if the year is from 30 to 99, 
it is considered to be in the 1900's and if it is from 00 to 29, it is considered to be 
in the 2000's. For version 2.01 through 2.5, the year 19 is considered 2019, but 
year 20 is 1920.  
 
Note that the date is defined with a 'D' at the end. If there is no 'D', then C/AL 
assumes that it is an integer and an error occurs as one cannot assign an integer to 
a date. Also, in code, do not use slashes to separate the month, day and year. That 
implies division and you get an error since it cannot assign an integer or decimal 
to the date variable.  

Time 
A time data type represents the time of day (not a time interval) which can range 
in value from 00:00:00 through 23:59:59.999. It takes up 4 bytes. Typical 
constants of type Time in C/AL are: 
 

• 103000T (10:30am) 
• 154530T (3:45:30pm) 
• 0T (The undefined time, less than all other times) 
• 030005.100T (3:00:05.1am) 
• 225930.135T (10:59:30.135pm) 
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The general syntax is hhmmss[.xxx]T, where the fractions of seconds (.xxx) are 
optional. Similarly to the date type, the time type must have a 'T' at the end of it 
to distinguish it from an integer. 

DateTime 
A DateTime variable denotes a date and the time of day. The datetime is stored in 
the database as Coordinated Universal Time (UTC). UTC is the international 
time standard (formerly Greenwich Mean Time, or GMT). Zero hours UTC is 
midnight at 0 degrees longitude. The datetime is always displayed as localtime in 
Microsoft Navision. Local time is determined by the time zone regional settings 
used by your computer. 
 
You must always enter datetimes as local time. When you enter a datetime as 
local time, it is converted to UTC using the current settings for the time zone and 
daylight saving time. 
 
There is only one constant available when you use this data type: undefined 
datetime. 
 

• 0DT (The undefined DateTime) 
• December 31, 2004, 14:20:59.999. 

 

Complex Data Types 
Complex Data Types 
C/AL also contains a number of complex data types. Complex data types are 
used when you need to work with, for example, records in tables, pictures 
(bitmaps) or disk files. As C/AL is object oriented, each complex data type can 
include both member variables and member functions. 

BLOB 
This is a Binary Large Object. Variables of this data type differ from normal 
numeric and string data type variables in that they have a variable length. BLOBs 
are used to store memos (text), bitmaps (pictures) or user-defined types. The 
maximum size of a BLOB is normally determined by your system's disk storage 
capacity, as the upper limit is 2GB. 

Record  
This is a complex data type, consisting of a number of simpler elements called 
fields. A record corresponds to a row in a table. Each field in the record is used to 
store values of a certain data type. The fields are accessed using the variable 
name of the record (often the same as the name of the corresponding table), a dot 
(a period) and the field name. A record is typically used to hold information 
about a fixed number of properties. 
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Form  
Variables of this data type are used to store forms. This is a complex data type 
and can contain a number of simpler elements called controls. Controls are used 
to display information to the user or to receive user input. 

Codeunit 
Variables of this data type are used to store codeunits. This is a complex data 
type which can contain a number of user-defined functions. 

File 
Variables of this data type give you access to operating system files. 

Dialog 
Variables of this type are used to store dialog windows. A number of functions 
are available for manipulating dialogs. 

Report 
Variables of this data type are used to store reports. This is a complex data type 
that can contain a number of simpler elements called controls. Controls are used 
to display information to the user. 

DateFormula 
Use this data type to contain a date formula that has the same capabilities as an 
ordinary input string for the CALCDATE function. The DateFormula data type is 
used to provide multilanguage capabilities to the CALCDATE function. 

GUID 
Use this data type to give a unique identifying number to any database object. 
The Globally Unique Identifier (GUID) data type is a 16 byte binary data type. 
This data type is used for the global identification of objects, programs, records 
and so on. 
 
The most important property of a GUID is that each value is globally unique. The 
value is generated by an algorithm, developed by Microsoft, which assures this 
uniqueness. 
 
The GUID is a 16 byte binary data type and can be logically grouped into the 
following subgroups: 4byte-2byte-2byte-2byte-6byte. The standard textual 
representation is {12345678-1234-1234-1234-1234567890AB}. 

TableFilter 
Use this data type to apply a filter to another table. At the moment, this data type 
can only be used when you are setting security filters from the Permission table. 

RecordRef  
This complex data type identifies a row in a table. Each record consists of fields 
(which form the columns of the table). A record is typically used to hold 
information about a fixed number of properties. 
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The RecordRef object can refer to any table in the database. Use the 
RecordRef.OPEN function to select the table you want to access. When you use 
the RecordRef.OPEN function a new object is created. This object contains 
references to the open table, filters and the record itself and all the fields it 
contains. 
 
If one RecordRef variable is assigned to another RecordRef variable, they both 
refer to the same table instance. 

RecordID  
This complex data type contains the table number and the primary key of a table. 
You can store a RecordID in the database but you cannot set filters on a 
RecordID. 
 
FieldRef This complex data type identifies a field in a table and gives you access 
to this field. The fieldref object can refer to any field in any table in the database. 

KeyRef 
This complex data type identifies a key in a table and the fields in this key. This 
gives you access to the key and the fields it contains. The keyref object can refer 
to any key in any table in the database 

InStream and OutStream 
Variables of these data types enable you to read from or write to files and 
BLOBs. In addition, you can use InStream and OutStream to read from and write 
to objects of the Automation and OCX data types. 

Variant 
This data type can contain the following C/AL data types: record, file, action, 
codeunit, Automation, boolean, option, integer, decimal, char, text, code, date, 
time, binary, DateFormula, TransactionType, InStream and OutStream. 

BigText 
This complex data type is used to contain large text documents. Data of the 
BigText data type cannot be displayed, in for example, the debugger or in a 
message window. However, you can use the BigText functions to extract part of 
a big text and place it in a normal text string that can be displayed. 
 
The maximum length of a BigText variable is 2147483647 characters. This is the 
equivalent of 2 GB. 
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Test Your Skills 
 

1. What data type should be used to store an employee's birthday? 

 

2. What data type should be used for an employee's name? 

 

3. What data type should be used for an employee's weekly salary (you 
need to record it to the penny)? 

 

4. What data type should be used to record whether or not an employee 
is income tax exempt? 

 

5. Write down the data type of this constant: 'You must enter a positive 
value.' 

 

6. Write down the data type of this constant: 123197 

 

7. Write down the data type of this constant: 327.01 

 

8. Write down the data type of this constant: 3,498 

 

9. Which complex data type is used to store bitmaps (pictures)? 

 

10. Which complex data type corresponds to a row in a table? 

 

11. What two data types would you use to read from and write to objects 
of the Automation and OCX data types? 

 

12. Which complex data type can hold up to two gigabytes of text data? 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 5: IDENTIFIERS AND VARIABLES 
Training Objectives 

In this chapter, you learn about: 
 

• Identifiers and Variables 
• The Syntax of Identifiers 
• Variable scope and initialization 
• Create a New Codeunit 
• Displaying Variables 
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Identifiers and Variables  
Definitions 
Identifier 
An identifier is a name for something, a way to identify it. Objects, variables, 
fields and functions all have identifiers. These Identifiers must be used when 
referring to these entities. Not all items found in a program have Identifiers. 
Among those that do not are constants, operators and certain reserved words. 
Instead, these items are referred to directly. One way to understand the difference 
is that those programming elements that refer to something stored elsewhere in 
memory require an identifier to access them, while those that exist in the 
programming code itself and do not refer to anything outside, do not need an 
Identifier. 

Variable 
A variable is the reference to a data value that can vary while the user is running 
the application. A variable refers to an actual location in memory in which data is 
stored. A variable has a name, also called the identifier, which the programmer 
uses in the program rather than an actual memory address. A variable also has a 
data type, which describes the kind of data that can be stored in that memory 
address. Finally, a variable has a value, which is the actual data currently stored 
in that memory address. 

Syntax 
Syntax is the set of grammatical rules that define the programming language. 
Programming lines that follow these rules are said to follow the proper syntax. 
The computer does not understand programming lines that do not follow the 
proper syntax; they cannot be compiled or executed. We have already defined the 
proper syntax for constants. More syntactical rules are covered in this unit. 

The Syntax of Identifiers 
There are two ways that valid identifiers can be constructed in the program. The 
first is to follow the proper Pascal syntax. This means that the first character in 
the identifier must be either an underscore (_) or a letter (either upper or lower 
case). Following this first character, you can have up to 29 additional characters, 
each of which must either be a letter (upper or lower case), an underscore, or a 
digit (a number from 0 through 9). 
 
The second method is used if you do not want to follow the normal Pascal 
syntax. In this case, the identifier must be surrounded by quotation marks (") 
when used within C/AL. Then, you can use any characters except "control" 
characters (characters whose underlying ASCII code is from 0 - 31 or 255) and 
the quote character itself ("). You can even use spaces. 
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Note that if you use the second method, the number of characters in an identifier 
can still include 30 characters and that these 30 do not include the quotation 
marks. Secondly, C/SIDE does not distinguish between upper and lower case 
letters in identifiers. Thus if there were two identifiers, the first being "Account 
Number" and the second being "Account number", these two would be seen as 
identical by C/SIDE. 
 
This brings up another point. Within one object, all identifiers must be unique. 
An identifier cannot be the same as one of the reserved words (like BEGIN or 
END) or an operator (like DIV or MOD). If this happens, a syntax error occurs. 
In addition, two identifiers should not have the same name in an object. If a 
reference is "ambiguous" (that is, if C/SIDE cannot tell what exact programming 
element you are referring to), it results in an error. 

Variable Scope and Initialization 
Global and Local Variables 
All variables have a defined "scope", that is, a defined set of places where it can 
be accessed. A variable is said to have "global" scope if it can be accessed 
anywhere in an object. A variable is said to have "local" scope if it can only be 
accessed in a single trigger in an object. No variables can be accessed outside of 
the object in which they are defined. 

System Defined Variables 
Certain variables are automatically defined and maintained by the system. An 
example of this is the variable called "Rec" in table objects. Each object has its 
own set of system-defined variables. The programmer can use these variables 
whenever they need to without doing anything special to either create them or to 
initialize their values. 

Variable Initialization 
Before any C/AL code is executed, all programmer-defined variables are 
initialized with certain values.  
 

• For all variables with a numeric type, this value is 0.  
• For string variables, the value is the empty string (").  
• For Boolean variables, the initial value is FALSE.  
• For Date and Time type variables, this initial value is 0D (the 

undefined date) and 0T (the undefined time) respectively. The 
DateTime variable is initially set to 0DT. 

 

Page 167 



 

 

Microsoft Navision Development I − C/SIDE Introduction 

Create a New Codeunit 
Exercise 
Open the Object Designer by selecting TOOLS→OBJECT DESIGNER from the Menu 
Bar. Press the Codeunit button to view all codeunits. Now press the New button 
located at the bottom of the Object Designer. The C/AL Editor window appears, 
completely blank. Now close the C/AL Editor window. A question window 
appears asking "Do you want to save the changes to the codeunit"? Click Yes. 
The Save As window is now displayed. Fill it in as follows: 
 

 
 
Click OK. Now, scroll down to the bottom of the Object Designer window and 
find your new codeunit. Select it and press the Design button. 

Define a Variable 
To define global variables in an object, select View, C/AL Globals on the Menu 
Bar once you are designing that object. A window like the following appears: 
 

 
 
Please fill it in as shown above. If you press the F6 key while you are in the 
DataType column, a list of data types appears that you can select. Note that these 
simple data types make up only a portion of the types that can be created. 
 
Once you have entered all of these, select the Variable named Color. Note that in 
the picture above, Color is already selected, as shown by the black triangle in the 
left margin.  
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Now click the Properties button on the Tool Bar: 
 

 
 
A window like the following should appear. Fill in the OptionString property 
exactly as shown in this window: 
 

 
 
Note that commas separate the words, but that there are no spaces between the 
commas and the words. Now close the Properties window and then the C/AL 
Globals window. Finally, close the Object Designer window. When it asks if you 
want to save, click Yes. 

Displaying Variables 
Click Design and go back into our Workbook Exercises codeunit. Click on the 
first line underneath the OnRun Trigger. Now type in the following line of C/AL 
code: 
 
MESSAGE('The value of %1 is %2','LoopNo',LoopNo); 

 
The MESSAGE function allows you to display a simple window with a single 
message in it, plus an OK button for users to press when they have finished 
reading the message.  
 
Note that following the function identifier MESSAGE, what appears is an open 
parenthesis, a text constant, a comma, another text constant, another comma, the 
LoopNo variable, a close parenthesis and a semicolon. When a function like this 
is Called, it is followed by its Parameters enclosed in parentheses. Here there are 
three parameters, each one separated from the others by a comma. 
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The first parameter is text and contains the actual message to be displayed. This 
text has special substitution strings in it. A substitution string is allowed in 
certain functions, including this one, and consists of a percent sign followed by a 
single digit from 1 to 9. When this function is actually executed at run time, the 
first substitution string (%1) is replaced by the first parameter following it, and 
the second substitution string (%2) is replaced by the second parameter following 
it. If the parameters are not text parameters (for example, the LoopNo parameter 
above), it is automatically converted or formatted into text first before 
substitution is done. 
 
Close and save the codeunit and then click Run.  
 
The following window appears: 
 

 
 
Note that the first substitution string was replaced by the second parameter (the 
first parameter following the message), the text constant 'LoopNo'. The second 
substitution string was replaced by the third parameter (the second parameter 
following the message), which was the value of the variable LoopNo.  
 
Note that the value of the integer variable was automatically initialized to zero 
and that this is the value that was substituted into the message. Click OK to clear 
the message window. 
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Test Your Skills 
 

1. Modify the code line in the Workbook Exercises codeunit to display 
the name of your second variable (YesOrNo) and its value. Run the 
codeunit and write down the resulting message here. 

2. Do the same for Amount. 

3. Do the same for When Was It. Do not forget to enclose the variable 
name in quotes when you use it in the third parameter. 

4. Do the same for What Time. 

5. Do the same for Description. 

6. Do the same for Code Number. 

7. Do the same for Ch. 

8. Do the same for Color. 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 6: ASSIGNMENT STATEMENT 
Training Objectives 

In this chapter, you learn about: 
 

• Assignment Statements 
• Assiging a value to a Variable 
• Automatic Type Conversions 
• The Statement Separator 
• Using Assignment Statements and the Symbol Menu 
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Assignment Statements 
Most developers are familiar with the assignment and statements terms, but, 
again, for clarification, we define them here. 

Assignment  
Assignment means setting a variable to a value. Once a variable has a value, it 
keeps that value until it is set to another value or until the current set of code ends 
and then the computer no longer keeps track of the variable. C/AL has several 
assignment methods, one of which is the simple assignment statement. 

Statement 
A programming statement is a single complete programming instruction written 
into code. You can think of it as a code line, since normally we write one 
statement per line. In reality, however, one statement could take up many actual 
lines in the C/AL Editor and, similarly, many statements could be on one line in 
the C/AL Editor.  

Assignment Statement  
The assignment statement is a particular type of statement. This statement 
specifically assigns a value to a variable. 

Assigning a Value to a Variable 
Being able to assign variables to different values is a cornerstone for 
programming. Different programming languages may have different syntax for 
doing this. The below section describes C/AL's method. 

Assignment Syntax 
We have already seen that certain function calls, like the MESSAGE function, 
can be a statement all by themselves. We call these "Function Call Statements". 
The syntax for a Function Call Statement is very simple: 
 
<function call> 

 
The result of calling a function varies depending upon which function is called. 
Likewise, the syntax of the function call itself varies with the function being 
called.  
 
The syntax of an assignment statement is almost as simple as the function call 
statement: 
 
<variable> := <expression> 
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The "colon equals" (:=) is called the assignment operator. The assignment 
statement evaluates the expression and the variable is set to this resulting value. 
We cover expressions more fully in future lessons, but for now, we use either a 
constant or another variable on the right side of the assignment operator. A 
constant or a variable can be used as a very simple expression. 

Automatic Type Conversions 
In order for a variable to be assigned a value, the type of the value must match 
the type of the variable. However, certain types, within limits, can be converted 
automatically during the assignment operation.  

String Data Types 
Both the string data types, code and text, can be automatically converted from 
one to the other. For example, if Description was a variable of type text and 
"Code Number" was a variable of type code, the following statement would be 
valid: 
 
"Code Number" := Description 

 
The text value in Description would be converted into code before being assigned 
to the "Code Number" variable. This means that all the lower case letters would 
be converted to upper case and all leading and trailing spaces would be deleted. 
Thus, the value assigned to the code variable would be of type code. Note that 
this conversion process does not affect the value stored in Description. Variables 
on the right side of the assignment operator are not modified by the assignment 
operation, only the one variable on the left side of the assignment operator is 
modified. 
 
NOTE: There are limits to what can be done with the automatic conversion. For 
example, suppose that the value of the Description text variable had more characters 
than could fit in the "Code Number" code variable. In this case, an error would result 
when this statement was executed while the program was running, also known as a 
Run-Time Error 

 

Numeric Data Types 
All of the numeric types (integer, decimal, option and char) can be converted 
automatically from one to another, as well. There are also restrictions here: 
 

• A decimal value must be a whole number (no decimal places) in 
order to be converted to any of the other numeric types.  

• Among the other types, if the value falls outside of the range of the 
variable type, the conversion does not take place. For example, a 
decimal cannot be converted to an integer or an option unless the 
value is between negative 2,147,483,647 and positive 2,147,483,647, 
which is the valid range for integers.  
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• A decimal, integer or option cannot be converted to a char unless the 
value is between 0 and 255, since that is the valid range for chars. If 
any of these conversions are attempted, a run-time error results. 

 

Other Data Types 
Although string types can be automatically converted from one to the other and 
the same with numeric types, no other variable types can be converted 
automatically from one to another using assignment. 

The Statement Separator 
As stated previously, a single programming statement might cover several code 
lines and that one code line might have multiple statements. If so, how does the 
C/AL compiler tell when one statement ends and another statement begins? It 
recognizes a statement separator as the indicator of a statement ending. The 
statement separator is the semicolon (;). When the compiler reaches a semicolon 
(or the end of a trigger) it knows that it has reached the end of a statement. Here 
is the syntax of a trigger: 
 
[ <statement> { ; <statement> } ] 

 
The brackets are used to indicate that whatever is enclosed in them is optional; it 
can either be there or not. Whatever is enclosed in the braces is deemed optional 
and can be repeated zero or more times. In other words, it is optional for any 
statements to appear in a trigger and as many statements as desired can appear in 
the trigger, as long as each one is separated from the others by a semicolon. 
 
Note that whenever a semicolon is used, a statement must follow. But what about 
at the end of a trigger, where you often end the last statement with a semicolon? 
In this situation, a Null Statement is automatically inserted after the last 
semicolon and before the end of the trigger. As its name implies a Null Statement 
is nothing and does nothing. Although this seems like a moot point now, it is 
important to note that the semicolon does not signal the end of a statement (it is 
not a "statement terminator"), but instead signals the arrival of a new statement 
(it is a "statement separator"). This distinction is critical in understanding the 
syntax of certain other statement types. 

Using Assignment Statements and the Symbol Menu  
The following exercise gives you practice using assignment statements and 
introduce you to the very useful symbol menu tool. 
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Simple Assignment Statement 
Go into the Object Designer, select Codeunit 123456750 and click the Design 
button. In the OnRun trigger, enter the following two statements, removing any 
code that was there previously. 
 
LoopNo := 25; 

MESSAGE('The value of %1 is %2','LoopNo',LoopNo); 

 
Now exit, save and Run the codeunit. 

Multiple Messages 
Go back and edit codeunit 123456750 again. After the code you entered above, 
add the following lines: 
 
LoopNo := -30; 

MESSAGE('The value of %1 is %2','LoopNo',LoopNo); 

Amount := 27.50; 

MESSAGE('The value of %1 is %2','Amount',Amount); 

"When Was It" := 093097D; 

MESSAGE('The value of %1 is %2','When Was It',"When Was 
It"); 

"Code Number" := ' abc 123 x'; 

MESSAGE('The value of %1 is %2','Code Number',"Code 
Number"); 

 
Exit, save and Run the codeunit.  
 
Note that the messages appear sequentially, one after the other. As you click OK 
for each message, the next message displays. Also, when you look at the last 
message (the one displaying the Code Number), note that automatic type 
conversion took place. The leading and trailing spaces were stripped and the 
letters turned to upper case when the value was converted from type text to type 
code. 
 
One thing that is not apparent, however, is that messages do not display until 
after the processing has ceased. In other words, as the MESSAGE functions are 
called, messages are added to a queue. A queue is like a line at a ticket counter: 
people get into the line at one end and leave the line at the other end in the same 
order they entered it. After the codeunit has completed its execution, the 
messages are read off the queue and displayed on the screen in the order that they 
were put into the queue. Because messages do not display immediately, they do 
not interrupt the processing.  
 
However, this also means that they cannot be used to give the user feedback on 
processing in progress. They can only be used to give the user results of 
processing. 
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Use of the Symbol Menu 
We are now going to add a few more lines to codeunit 123456750, using a 
slightly different method. Go to the end of the existing code, just as if you were 
about to type in another line. Instead, select View, C/AL Symbol Menu from the 
Menu Bar, press the F5 key, or press the Symbol button on the Tool Bar. 
 

 
 
The following window should appear: 
 

 
 
In the left panel, notice that there is a list all of the identifiers defined by the 
programmer, among other things. Click on the line which says "YesOrNo", then 
click OK. The Symbol Menu disappears and the word YesOrNo appears in your 
code.  
 
After YesOrNo, type in: 
 
:= TRUE; 

 
Then that the line now says: 
 
YesOrNo := TRUE; 

 
Then press ENTER and continue on the next line: 
 
MESSAGE('The value of %1 is %2',' 
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With the cursor still sitting just after the single quote you last typed, press the F5 
key again, select YesOrNo again in the Symbol Menu (it should still be selected 
from last time) and click OK. Continue with a single quote and a comma. Again, 
press F5 and this time press the ENTER key (which also presses the OK button on 
the Symbol Menu). Finish off by typing a close parenthesis and a semicolon. The 
result should be: 
 
YesOrNo := TRUE; 

MESSAGE('The value of %1 is %2','YesOrNo',YesOrNo); 

 
Try using this method again for Description, but set the value (after the 
Assignment Operator) to 'Now is the time.' The result should be: 
 
Description := 'Now is the time. '; 

MESSAGE('The value of %1 is %2', 
'Description',Description); 

 
Again, use the Symbol Menu to enter another two lines setting and displaying 
"What Time". Set its value to 153000T. The result should look like this: 
 
"What Time" := 153000T; 

MESSAGE('The value of %1 is %2','"What Time"',"What Time"); 

 
Note that by using the Symbol Menu, the double quotes are automatically 
inserted when needed. In this case, however, the double quotes inside the single 
quotes are not needed, so you should go back and remove them. The results are: 
 
"What Time" := 153000T; 

MESSAGE('The value of %1 is %2','What Time',"What Time"); 

 
Now, exit and save the codeunit and run it again.  
 
Note that the Time and Date displays are dependent on the settings you made in 
your system Control Panel (Regional Settings). On most US systems, for 
example, the time would be displayed as 3:30:00 PM. However, a simple change 
on your Control Panel changes this display to 15:30:00. Note that this does not 
require a code change, or even a recompile, under C/SIDE. The Control Panel 
change itself is sufficient. 

Char Constants 
Because of automatic type conversion, a Char variable can be set using either a 
number or a one character text. Enter the following lines in your codeunit: 
 
Ch := 65; 

MESSAGE('The value of %1 is %2','Ch',Ch); 

Ch := 'A'; 

MESSAGE('The value of %1 is %2','Ch',Ch); 
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Note that both 65 and 'A' result in the same value displayed in the message. This 
is because 65 is the ASCII code for the upper case A. You may want to 
experiment with a few other numbers to see what the results are. These codes are 
used for characters in C/SIDE, as well as in most other programs and computer 
systems. 

Option Constants 
We previously covered using a number as an option constant. In C/SIDE, other 
syntax can be used to write option constants into your code. Enter the following 
lines into your codeunit: 
 
Color := 2; 

MESSAGE('The value of %1 is %2','Color',Color); 

Color := Color::Yellow; 

MESSAGE('The value of %1 is %2','Color',Color); 

 
Once you have saved and executed this new code, notice that the results are the 
same for both messages. The first option is always numbered 0, so the third 
option, in this case Yellow, is numbered 2.  
 
Note that the syntax used for option constants is the Variable Identifier, followed 
by two colons, followed by the Option Identifier. 

Run-Time Errors 
As we mentioned before, not every value can be converted automatically to a 
value of another type.  
 
Try entering these lines, one at a time, into your codeunit, compile and run it. See 
what kinds of error messages you get: 
 
Description := 'Now is the time. Here is the place.'; 

LoopNo := 27.5; 

YesOrNo := 1; 

Amount := 27.5; LoopNo := Amount; 

 
Note that only the first one and the last one actually compile, as the compiler is 
smart enough to figure out that some things would never work. In the first case, 
however, since both the constant and the variable were of type text, it wasn't until 
you executed the codeunit that it discovered the overflow (Description was 
defined as 30 characters long, but the constant is 36). In the last case, the fact that 
Amount contained a value that could not be converted to integer could also not 
be found until the program was executed. These kinds of errors are called Run-
Time Errors. Note that when a run-time error is discovered, it stops all further 
processing and produces an error message. 
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Test Your Skills 
Feel free to use your practice codeunit to help you answer these questions. All 
variables refer to those you defined in that codeunit. 
 

1. What would be displayed if you displayed Amount after setting its 
value to 15.00? 

 

2. What if you then assigned Amount to LoopNo and then displayed 
LoopNo? 

 

3. What would be displayed if you set Color to the value of 4 and then 
displayed Color? 

 

4. What if you set Color to 8 and then displayed it? 

 

5. What would be displayed if you set Description to 'the time.', then 
assigned Description to Code Number and then displayed Code 
Number? 

 

6. What would be displayed if you set Description to 'Now is the time.', 
then assigned it to Code Number and then displayed Code Number? 

 

7. What would be displayed if you set Color to Green, assigned Color 
to LoopNo and then displayed LoopNo? 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 7: SIMPLE EXPRESSIONS, TERMS, AND 
OPERATORS 
Training Objectives 

In this chapter, you learn about: 
 

• Expressions, Terms and Operators 
• The Syntax of an Expression 
• The String Operator 
• Function Calls in Expressions 
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Expressions, Terms, and Operators 
We start with a review of the definitions of these terms, and in later sections, we 
observe them in use. 

Expression 
An Expression is like an equation put into a program, a formula telling the 
computer exactly how to generate the desired value. Like a variable and a 
constant, an expression has a type and a value. However, unlike either one, an 
expression must be evaluated at run-time in order to determine its value. 
Although a constant's value is known at all times, a variable's value is determined 
at run-time, the system must look it up in memory. The following are examples 
of expressions: 
 

• FunctionX + 7 
• Quantity * UnitCost  

 

Evaluation 
To Evaluate an expression means to actually follow the instructions set out in the 
formula and determine the expression's type and value at that time. Depending on 
the values of the variables included in the expression, the value may be different 
each time the expression is evaluated, although its type does not change. 

Term 
A Term is the part of an expression that evaluates to a value. It can be a variable, 
a constant or a function call, as long as the function returns a value. A term can 
also be another expression surrounded by parentheses. This last type of term is 
also known as a sub-expression. The above expressions have the following terms: 
 

• FunctionX 
• 7 
• Quantity 
• UnitCost 
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Operator 
An Operator is the part of an expression that acts upon either the term directly 
following it (i.e. a unary operator), or the terms on either side of it (i.e. a binary 
operator). Operators are represented by symbols (e.g. +, >, /, =) or reserved 
words (e.g. DIV, MOD). They are defined by the C/AL language and cannot be 
redefined or added to by the programmer. During expression evaluation, when 
the operator operates on its term(s), it results in another value, which may be the 
value of the expression, or may be a term used by another Operator. Some 
examples of operators and their uses: 
 

• 5 + (-8)   The '+' is a binary arithmetic operator, the '-' is a 
unary arithmetic operator.  

• TotalCost/Quantity The '/' is a binary operator. 
• 'cat' + ' and dog' The '+' is now used as a binary string operator. 
• (Quantity > 5) OR (Cost <= 200) The 'OR' is a binary logical 

operator. The '>' and '<=' are binary relational operators. 
 

The Syntax of an Expression 
Describing an expression's syntax requires a few more syntax statements than we 
have seen previously, since it is so complex.  
 
The ::= symbol used below means that the element on the left side of that symbol 
has a syntax defined by what is on the right side of that symbol. Note that the 
vertical bar (|) means "OR". Any one of the elements separated by vertical bars 
works as valid syntax. 
 

• <unary operator>     ::=   + | - | NOT 
• <string operator>    ::=   + 
• <arithmetic operator> ::=   + | - | * | / | DIV | MOD 
• <relational operator>  ::=  < | > | = | <= | >= | <> | IN 
• <logical operator>   ::=  NOT | OR | AND | XOR 
• <operator>        ::=  <string operator> | <arithmetic 

operator> |                                          <relational operator> | <logical 
operator> 

• <simple term>  ::=  <constant> | <variable> | <function call> 
| (<expression>) 

• <term>       ::=  <simple term> | <unary 
operator><simple term> 

• <expression>   ::=  <term> { <operator><term> } 
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Remember that the braces surrounding an element mean zero or more repetitions 
of that element. We cover the various operator types as we cover different 
expression types in this and future lessons. 

The String Operator 
There is only one string operator and that is the plus sign (+), which indicates 
concatenation. Concatenation is the operation that "glues" two or more strings 
together to make one string. The concatenation operator is a binary operator, 
which means that it operates on the term preceding it and the term following it. 
Both of these terms must be strings, that is, either of type Code or Text. If both 
terms are of type Code, then the resulting concatenation will be of type Code. 
Otherwise, the result will be of type Text. 

Expression Example 
Here is an example of an expression and how it is evaluated. First a couple of 
assignments, then the expression: 
 
CodeA := 'HELLO THERE'; 

TextA := 'How Are You? '; 

CodeB := CodeA + '. ' + TextA; 

 
The expression is evaluated as follows:  
 
First, the value of CodeA is obtained.  
 
Then, the constant value is concatenated to the end. Since CodeA is a Code while 
the constant is a Text (note the trailing spaces), the result is a Text and the value 
is 'HELLO THERE.'. This value becomes the first term for the next 
concatenation operator.  
 
The value of TextA is obtained. Then, this value is concatenated to the end of the 
previously generated text. Since both values are Text, the type of the result is 
Text and the value is 'HELLO THERE. How Are You?' . Since this is the end of 
the expression, this result becomes the result of the expression, both the type and 
the value. 
 
Once the expression is evaluated, the new value is assigned to the CodeB 
variable using the assignment operator. Since the type of the expression is Text 
and the type of the CodeB is Code, the result of the expression must be converted 
to Code using automatic type conversion. The result of this conversion is that 
'HELLO THERE. HOW ARE YOU?' is assigned to CodeB. 
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String Operator Exercise 
Go into the Object Designer, select codeunit 123456750 and click Design. Add 
the following global variables to the current variable list, by selecting View, 
C/AL Globals on the Menu Bar: 
 
CodeA Code 30 

CodeB Code 50 

TextA Text 50 

TextB Text 80 

 
In the OnRun trigger, enter the following four statements, after removing any 
code that was in that trigger from previous lessons. 
 
CodeA := 'HELLO THERE'; 

TextA := 'How Are You? '; 

CodeB := CodeA + '. ' + TextA; 

MESSAGE('The value of %1 is %2','CodeB',CodeB); 

 
Now exit, save and Run the codeunit. You should get the same result as was 
described above. 

Function Calls in Expressions 
Remember that if you try to assign too many characters to a string variable, you 
receive a run-time error. How can this be prevented, since the error does not 
occur until the program is running? One way is to design your program such that 
this error could never happen. This is how it is handled in most of Microsoft® 
Business Solutions−Navision®. In some cases, though, this is impossible. 
Fortunately, there is another method. 

MAXSTRLEN Function 
There is a function available that tells you (at run-time) the maximum length of a 
string that can fit in a variable. This function is called MAXSTRLEN. It has one 
parameter, which is the variable in question. The return value is of type integer.  
 
Enter the following two code lines into codeunit 123456750, after the lines 
entered above: 
 
LoopNo := MAXSTRLEN(Description); 

MESSAGE('The value of %1 is %2','LoopNo',LoopNo); 

 
The result is that LoopNo is set to 30, which is the length that you used when you 
created this variable.  
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Now that we know how long a string we can put into this variable, how do we 
put only that many characters into it? First let's look at the result if we do not do 
this. Type in the following lines after the ones above: 
 
Description := 'The message is: ' + CodeB; 

MESSAGE('The value of %1 is %2','Description',Description); 

 
Once you save and run this, you get the expected run-time error. The problem is 
that the assignment statement transfers the entire value of the expression on its 
right to the variable on its left and there is not enough space in this case. What we 
need is something that only gets part of a text.  
 
That something is a function called COPYSTR.  
 
This function has three parameters. 
 

• The first is the string that is being copied from.  
• The second is the position of the first character to copy. If we wanted 

to start copying from the fifth character, this second parameter would 
be 5. If we want to start from the first character, the second 
parameter would be 1.  

• The third parameter is the number of characters to copy. This third 
parameter is optional and if it is not there, then all the characters of 
the string are copied from whatever the second parameter says to the 
last character. If you try to copy more characters than are in the 
string, there is no harm done. The maximum number of characters 
that are copied is the number in the original string. The value of the 
COPYSTR function, once it has been evaluated, is a copy of the first 
parameter, but only including those characters designated by the 
second and third parameters. If the first parameter is a Text, the type 
of the COPYSTR function is Text. If the first parameter is a Code, 
the type of the COPYSTR function is Code. 

 
Now, in your codeunit, find the line you typed that looks like this: 
 
Description := 'The message is: ' + CodeB; 

 
Change it to look like this: 
 
Description := COPYSTR('The message is: ' + 
CodeB,1,MAXSTRLEN(Description)); 

 
When you save and run this, you no longer get a run-time error. Instead, the 
value of Description only includes the characters that would fit. 
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How Did it Work? 
Let us evaluate the expression "by hand" and see how it worked.  
 
The expression is what is to the right of the assignment statement. Here is the 
original expression: 
 
COPYSTR('The message is: ' + 
CodeB,1,MAXSTRLEN(Description)) 

 
First, to evaluate a function like COPYSTR, we must evaluate each of its 
parameters. The first step, to evaluate the first parameter, is to get the value of 
CodeB and concatenate it (note the plus sign) with the string constant. The result 
is this: 
 
COPYSTR('The message is: HELLO THERE. HOW ARE 
YOU?',1,MAXSTRLEN(Description)) 

 
The next step is to evaluate the second parameter. Since this is a constant, it is 
easy. Next, we must evaluate the third parameter. This parameter is a function 
that returns the defined length of its parameter (which must be a variable, not an 
expression). The result is: 
 
COPYSTR('The message is: HELLO THERE. HOW ARE YOU?',1,30) 

 
Finally, the COPYSTR function itself can be evaluated. In this case, it copies 
characters from the text in the first parameter, starting with the first character (the 
second parameter) and copying up to 30 characters (the third parameter). The 
result is: 
 
'The message is: HELLO THERE. H' 

 
Now that the expression has been evaluated, the assignment can be performed: 
 
Description := 'The message is: HELLO THERE. H'; 

 
Description now has its new value. 
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Test Your Skills 
 

1. Underline the expression in this assignment statement: 
 TextA := TextB; 

2. In mathematics, the things that operators operate on are called 
"operands". What are these things called in programming 
expressions? 

 

3. What does the plus operator (+) do to text variables or constants? 

 

4. Underline the expression in this assignment statement: 
TextA := 'The ' + TextB; 

5. Underline the operator(s) in the expression: 
TextA := 'The ' + TextB; 

6. Underline the term(s) in the expression: 
TextA := 'The ' + TextB; 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 8: NUMERIC EXPRESSIONS 
Training Objectives 

In this chapter, you learn about: 
 

• Numeric Expressions and Operator Precedence 
• Types of Arithmetic Operators 
• Operator Precedence Effects 
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Numeric Expressions and Operator Precedence 
The terms "Numeric Expressions" and "Operator Precedence" are used frequently 
in this chapter. The definitions follow. 

Arithmetic Operators 
Arithmetic operators are those operators that are used in numeric expressions to 
operate on numeric or non-numeric terms. Addition, subtraction, multiplication, 
and division symbols are arithmetic operators. 

Numeric Expression 
This type of expression, which uses at least one arithmetic operator, results in a 
numeric data type. So, when evaluating a numeric expression, the result is of type 
decimal, integer, option or char. Although the individual terms of a numeric 
expression might not be numeric, the result will be. 

Operator Precedence 
This is the order that operators are evaluated within the expression. Operators 
with a higher precedence are evaluated before operators with a lower precedence. 
For example, since the multiplication operator (*) has a higher precedence than 
the addition operator (+), the expression 5 + 2 * 3 evaluates to 11, rather than 21, 
which is what it would evaluate to under the normal left to right rule. 

Types of Arithmetic Operators 
There are six different arithmetic operators in C/AL.  

The Plus (+) Operator 
The plus operator is used for several purposes. As shown earlier, if the terms on 
either side of it are both string types, the result is a string, so this would not be an 
example of it being used as an arithmetic operator. However, it can be used as 
either a unary or binary arithmetic operator. 
 
When used as a unary operator, its function is to not change the sign of the term 
following it. It literally does nothing and is rarely used. If it is used, its purpose is 
to explicitly show that a value is positive. Here is an example of an expression 
using the plus unary operator and the same expression without it: 
 

• IntVariable * +11 
• IntVariable * 11 
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When normally used as a binary operator, its function is to add the term 
following it to the term preceding it. Both terms can be numeric, or one term can 
be a Date or a Time and the other an integer. If either term is a decimal value, 
then the result is decimal. If both terms are char values and the sum is less than 
256, the result is char; otherwise, the result is integer. If both terms are option or 
integer values and the sum is in the allowable values for integers, the result is 
integer; otherwise, the result is decimal. 
 
If one term is a date and the other an integer, the result is the date that is the 
integer number of days away from the date term. Thus, the value of 03202001D 
+ 7 is 03272001D. If the resulting value results in an invalid date, a run-time 
error will occur. 
 
Similarly, if one term is a time and the other an integer, the result is the time that 
is the integer number of milliseconds away from the time term. Thus, the value of 
115815T + 350000 is 120405T. If the resulting value results in an invalid time, a 
run-time error will occur. 
 
Technically the plus operator used with a date or a time term is not an example of 
an arithmetic operator, since the result is not numeric. However, we have covered 
it here for convenience. The chart below reviews this information.  
 
Note that the left column indicates the type of the term preceding the plus 
operator, while the top row indicates the type of the term following the plus 
operator. 
 
Plus (+) Char Option Integer Decimal Date Time 
Char Char Integer Integer Decimal N/A N/A 
Option Integer Integer Integer Decimal N/A N/A 
Integer Integer Integer Integer Decimal N/A N/A 
Decimal Decimal Decimal Decimal Decimal N/A N/A 
Date Date Date Date N/A N/A N/A 
Time Time Time Time N/A N/A N/A 

 
Remember that if a result would normally be a char but the value is not a valid 
char value, the result type changes to integer. If a result would normally be an 
integer but the value is not a valid integer value, the result type changes to 
decimal. 

The Minus Operator (-) 
Like the plus operator, the minus operator can be used as either a binary operator 
or a unary operator. When used as a unary operator, its function is to change the 
sign of the term following it. 
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When used as a binary operator, its function is to subtract the term following it 
from the term preceding it. Both terms can be numeric, both can be a date or a 
time, or the preceding term can be a Date or a Time, while the following term is 
an integer.  
 
If the first term is a date and the second is an integer, the result is the date that is 
the integer number of days before the date term. Thus, the value of 02252001D - 
7 is 02182001D. If the resulting value results in an invalid date, a run-time error 
will occur. 
 
If the first term is a time and the second is an integer, the result is the time that is 
the integer number of milliseconds before the time term. Thus, the value of 
115815T - 350000 is 115225T. If the resulting value results in an invalid time, a 
run-time error will occur. 
 
If one date is subtracted from another, the result is the integer number of days 
between the two dates. If one time is subtracted from another, the result is the 
integer number of milliseconds between the two times. 
 
The following chart summarizes the result types when the minus operator is used 
on various term types. Note that the left column indicates the type of the term 
preceding the minus operator, while the top row indicates the type of the term 
following the minus operator: 
 
Minus (-) Char Option Integer Decimal Date Time 
Char Char Integer Integer Decimal N/A N/A 
Option Integer Integer Integer Decimal N/A N/A 
Integer Integer Integer Integer Decimal N/A N/A 

Decimal Decimal Decimal Decimal Decimal N/A N/A 
Date Date Date Date N/A Intege

r 
N/A 

Time Time Time Time N/A N/A Intege
r 

 
Remember that if a result would normally be a char but the value is not a valid 
char value, the result type changes to integer. If a result would normally be an 
integer but the value is not a valid integer value, the result type changes to 
decimal. 
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The Times Operator (*) 
The times operator (or the multiplication operator) is only used as a binary 
operator. Its function is to multiply the numeric term preceding it by the numeric 
term following it. The following chart summarizes the result types when the 
times operator is used on various term types: 
 
Times (*) Char Option Integer Decimal 
Char Char Integer Integer Decimal 
Option Integer Integer Integer Decimal 
Integer Integer Integer Integer Decimal 
Decimal Decimal Decimal Decimal Decimal 

 
The normal automatic conversion rules, from char to integer to decimal, apply. 

The Divide Operator (/) 
The divide operator is only used as a binary operator. Its function is to divide the 
numeric term preceding it by the numeric term following it. The result type of 
this division is always decimal. If the second term is zero (0), the result is a run-
time error.  

The Integer Divide Operator (DIV) 
The integer divide operator is also only used as a binary operator. Its function is 
to divide the numeric term preceding it by the numeric term following it. The 
result type of this division is always integer. If the second term is zero (0), the 
result is a run-time error. Any decimals that would have resulted from an 
ordinary division are dropped, not rounded. Thus, the result of 17 DIV 8 is 2, 
while the result of 17 DIV 9 is 1.  

The Modulus Operator (MOD) 
The modulus operator requires two numbers. The first number is the one that is 
converted using the modulus function and the second number. The second 
number represents the number system being used. By definition, the number 
system will start at zero and end at the second number minus 1. For example, if 
the second number were 10, then the number system used would be from 0 to 9. 
So, the modulus represents what the first number would convert to if your 
numbering system only had the number of values indicated by the second 
number, and then was forced to restart at zero. 
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Here are some examples: 
 

• 15 modulus 10 is 5 (since 9 is the last number available, 10 is 
represented by going back to the start, or zero, 11 is 1, 12 is 2, etc.) 

•  6 Modulus 10 is 6 
•  10 Modulus 10 is 0  
• 127 Modulus 10 is 7 

 
HINT: Think "Remainder" 

 
Notice that you would get the same result if you divided the first number by the 
second using integers only and returned the remainder as the value. 
 
The modulus operator (or the remainder operator) is only used as a binary 
operator. Its function is to divide the numeric term preceding it by the numeric 
term following it using the integer division method outlined above and then 
return the remainder of that division. The result type of this operation is always 
an integer. If the second term is zero (0), the result is a run-time error.  
 

• 17 MOD 8 = 1 
• 17 MOD 9 = 8. 

 

Arithmetic Operator Exercise  
Go into the Object Designer, select codeunit 123456750 and click Design.  
 
Add the following global variables to the current variable list, by selecting View, 
C/AL Globals on the Menu Bar: 
 
Int1 Integer 

Int2 Integer 

Amt1 Decimal 

Amt2 Decimal 
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In the OnRun trigger, enter the following statements, after removing any code 
that was in that trigger from previous lessons. 
 
Int1 := 25 DIV 3; 

Int2 := 25 MOD 3; 

LoopNo := Int1 * 3 + Int2; 

MESSAGE('The value of %1 is %2','LoopNo',LoopNo); 

Amt1 := 25 / 3; 

Amt2 := 0.00000000000000001; 

Amount := (Amt1 - Int1) * 3 + Amt2; 

MESSAGE('The value of %1 is %2','Amount',Amount); 

 
Now exit, save and Run the codeunit. The results you should get are that the 
LoopNo is 25 and Amount is 1.  

Operator Precedence Effects 
It is important to know the precedence that operators take, since unexpected 
results could occur if they are ignored. 

Operator Precedence Levels 
There are three levels of operator precedence used for arithmetic operators.  
 

• The highest level is the unary operator level, which includes both 
positive (+) and negative (-).  

• The second is the multiplicative operator level, which includes 
multiplication (*), both kinds of divides (/, DIV) and modulus 
(MOD). 

• The lowest precedence level is the additive operator level, which 
includes both addition (+) and subtraction (-) binary operators. 

 
Normal evaluations of expressions proceed from left to right. However, if one 
operator has a higher precedence level than another, it is evaluated first. To 
override either of these methods, the programmer can create sub-expressions by 
surrounding parts of an expression with parentheses. Sub-expressions are always 
evaluated first. 
 
The purpose of this exercise is to illustrate the various division functions, 
including normal division, integer division and modulus. Examine the code and 
the results thoroughly so that you understand how it works. If you need to, insert 
other messages to view the intermediate results. 
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Operator Precedence Exercise  
Return to codeunit 123456750 and add the following code lines after the lines 
you entered above: 
 
Int1 := 5 + 3 * 6 - 2 DIV -2; 

MESSAGE('The value of %1 is %2','Int1',Int1); 

 
Save it and run and you will find that the result is 24.  
 
Using the precedence rules it was evaluated as follows: 
 

1. The times operator (*) is evaluated, multiplying its preceding term 
(3) by its following term (6) and resulting in a new term of 18, 
leaving the following: 

 
Int1 := 5 + 18 - 2 DIV −2 
 

2. The integer divide operator (DIV) is evaluated, dividing its preceding 
term (2) by its following term (-2) and resulting in a new term of −1: 

 
Int1 := 5 + 18 − (-1) 
 

3. The plus operator (+) is evaluated, adding its following term (18) to 
its preceding term (5) and resulting in a new term of 23: 

 
Int1 := 23 − (-1) 

 
4. Finally, the binary minus operator (-) is evaluated, subtracting its 

following term (-1) from its preceding term (23) and resulting in the 
value of the complete expression, which is 24 (23 minus a negative 1 
is 24). 

 Now, create sub-expressions by adding parentheses as follows: 

 
Int1 := (5 + 3) * (6 - 2) DIV -2; 

 
 Save and run it again. You will find that the result is negative 16. 

Knowing that sub-expressions are evaluated first, it was evaluated as 
follows: 
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5. The first sub-expression is evaluated. The plus operator (+) adds its 
following term (3) to its preceding term (5) and results in the sub-
expression value of 8. This value now becomes a term of the 
complete expression. 

 
Int1 := 8 * (6 - 2) DIV -2; 

 
6. The next sub-expression is evaluated. The binary minus operator (-) 

subtracts its following term (2) from its preceding term (6), resulting 
in the value of 4 for the sub-expression. Again, this value is now a 
term of the complete expression. 

 
Int1 := 8 * 4 DIV -2; 

 
7. The unary minus operator (-) and its following term (2) is evaluated, 

resulting in a value of negative 2 (-2). 

 
Int1 := 8 * 4 DIV -2; 

 
8. The times operator (*) is evaluated, multiplying its preceding term 

(8) by its following term (4) and resulting in a new term of 32. 

 
Int1 := 32 DIV -2; 

 
9. Finally, the integer divide operator (DIV) is evaluated, dividing its 

preceding term (32) by its following term (-2) and resulting in the 
value of the complete expression, which is negative 16 (-16). 

 
Int1 := -16; 
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Test Your Skills 
Write down the result type and value of each of these expressions: 
 

1. 57 * 10 

2. 57 / 10 

3. 57 DIV 10 

4. 57 MOD 10 

5. 2000000 * 3000 

6. 9 / 4 - 9 DIV 4  

7. (3 - 10) * - 5 - 10 + 2.5 * 4 

8. 02201996D + 14 

9. 02101996D − 14 

10. 01201996D − 02101996D 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 9: LOGICAL AND RELATIONAL 
EXPRESSIONS 
Training Objectives 

In this chapter, you learn about: 
 

• Logical and Relational Operators and Expressions 
• Relational Expressions for Comparison 
• Relational Expressions for Set Inclusion 
• Using Logical Expressions 
• Adding Logical and Relational Expressions to a Form 
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Logical and Relational Operators and Expressions 
Logical and relational expressions are different from arithmetic expressions in 
that they always result in a Boolean value (either true or false). These expressions 
use logical or relational operators to determine their value. However, there are 
some differences between them, so it is important to fully understand these 
concepts. 

Relational Operator 
This operator is used in a relational expression to test a relationship between the 
term preceding it and the term following it, resulting in a Boolean value. The 
relational operators are:  
 

• = (equal to) 
• < (less than) 
• > (greater than) 
• <= (less than or equal to) 
• >= (greater than or equal to) 
• <> (not equal to) 
• IN (included in set) 

 

Relational Expression 
A relational expression is an expression that, by using a relational operator, 
compares values and results in a Boolean value (True or False). The terms of this 
expression are usually not Boolean themselves, but they must be compatible with 
each other. Thus an integer can be compared with a decimal, since they are both 
numeric, but an integer cannot be compared to a text, since one is numeric and 
the other is string. Below are some examples: 
 

• 5 <= IntVar 
• DecVar <> IntVar 

 

Logical Operator 
This operator uses one or two Boolean terms in a logical expression. The logical 
binary operators are AND, OR and XOR (exclusive or). The one logical unary 
operator is NOT. 
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Logical Expression 
This expression uses at least one logical operator, which results in a Boolean 
value. It is similar to a relational expression in that it can have terms of any type, 
but relational expressions must have two terms and one operator. A logical 
expression can have multiple terms, but the terms must all be of type Boolean. 
The following are examples of logical expressions: 
 

• TRUE AND FALSE  (results in a value of False) 
• FALSE OR  NOT FALSE  (results in a value of True) 
• (Quantity> 5 ) OR (Quantity <= 10) OR ( Price < 100)   (This has 

three terms) 
 

Relational Expressions for Comparison 
All of the relational operators, except for IN, compare two values. These two 
values must be of the same type, or of compatible types. All of the various 
numeric types (e.g. integer and decimal) are compatible. Both of the string types 
(text and code) are compatible.  

Numeric Comparisons 
If a comparison is done between two numbers, the normal numeric rules apply. 
Note the following examples: 
 

• 57 = 57 is TRUE 
• 57 = 58 is FALSE 
• 57 < 58 is TRUE 
• 57 <= 58 is TRUE 
• 57 > 58 is FALSE 
• 57 >= 57 is TRUE 
• 57 <> 58 is TRUE 

 

String Comparisons 
String comparisons use a modified alphabetical order, not the ASCII order that 
many other programming languages use. One major difference you should note is 
that special characters used in other languages (like the é in Danish or the ñ in 
Spanish) are placed in their proper alphabetical order, not relegated to the end as 
they would in ASCII order. Another major difference is that the digits appear 
after the letters in alphabetical order, while in ASCII order, they come before the 
letters. Finally, in alphabetical order, the lower case letters come before the upper 
case letters, while in ASCII order, the lower case letters come after the upper 
case letters. Here are some examples: 
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• 'X' = 'X' is TRUE 
• 'X' = 'x' is FALSE 
• 'ark' > 'arc' is TRUE 
• 'arC' > 'arc' is TRUE 
• '10' > '2' is FALSE 
• '00' <= 'OO' is FALSE 
• 'é' > 'f' is FALSE 
• 'abc' < 'ab' is FALSE 
• ' a' <> 'a'  is TRUE 

 
Also, remember that when a code variable is used in a comparison, there are 
some special rules. All trailing and leading spaces are removed and all letters are 
converted to upper case. In addition, code values that consist only of digits are 
right justified before comparison. Thus, the fifth example above ('10' > '2') would 
evaluate to TRUE if those values were loaded into variables of type code before 
comparison. 

Date and Time Comparisons 
Date and Time values are compared as you would expect; dates (or times) farther 
in the future are greater than dates (or times) in the past. A Closing Date (which 
represents the last second of the last minute of that date) is greater than the 
Normal Date for the same day and less then the Normal Date for the next day.  

Boolean Comparisons 
Boolean values are normally not compared using relational operators, but they 
can be. When they are, True is considered greater than False. 

Relational Operator Precedence 
These have the lowest precedence of any operator. The comparison is performed 
after the expressions on either side of the relational operator are evaluated.  
 
Thus, the following example evaluates to True: 
 
5 * 7 < 6 * 6 
 
The left side expression (5 * 7) is first evaluated to 35. Then the right side 
expression (6 * 6) is evaluated to 36. Then the value 35 is compared to 36.  

Relational Expressions for Set Inclusion 
The relational operator IN is used to determine inclusion. It determines if the first 
term is in a specific set. Therefore, it requires a list of values, a set, to compare 
the term to. This list is part of the expression and is called a set constant. 
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Set Constant 
There are no variables of type set, but there are constants of type set. A set 
constant consists of an open square bracket ([) followed by a list of allowed 
values separated by commas, followed by a close square bracket (]). For 
example, a set of all the even numbers from one to ten would look like this: 
 
[2,4,6,8,10] 

 
Besides individual values, a member of a set can also be a range of values. A set 
of all the numbers from one to twenty not evenly divisible by ten would look like 
this: 
 
[1..9,11..19] 

 
In addition, an individual value or a value used as part of a range can actually be 
an expression. A list of numbers from 10 to 20, but not including the variable n 
(as long as n was from 10 to 20), would look like this: 
 
[10..n-1,n+1..20] 

 

The IN Operator 
Once you have constructed a set constant, the IN operator's operation is quite 
simple. It checks to see if the value of the term preceding it is included in that set. 
For example: 
 

• 5 IN [2,4,6,8,10] is FALSE 
• 5 IN [2,4..6,8,10] is TRUE 
• 10 IN [1..9,11..19] is FALSE 
• 'M' IN ['A'..'Z'] is  TRUE 

 

Using Logical Expressions 
As stated before, a logical operator operates on Boolean terms and results in a 
Boolean value. Often, these Boolean terms are the result of a relational 
expression.  
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Logical Operator Results 
The following reviews the logical operator results: 
 

• The unary Boolean operator, NOT, logically negates the term 
following it, changing True to False and False to True.  

• The AND operator results in True if both of the terms on either side 
of it are True and otherwise results in False.  

• The OR operator results in False if both of the terms on either side of 
it are False and otherwise results in True.  

• The XOR operator results in True if either (but not both) of the terms 
on either side of it are True, but if both are True or both are False, it 
results in False.  

 
The following "truth tables" summarize these facts: 
 
NOT True False  OR True False 
Results in: False True  True True True 
    False True False 

 
AND True False  XOR True False 
True True False  True False True 
False False False  False True False 

 

Logical Operator Precedence 
The NOT operator has the same precedence as the other unary operators, positive 
(+) and negative (-), which is the highest precedence. This means that it is 
evaluated before any other operator in the same expression. The AND operator 
has the same precedence as the multiplicative operators, while XOR and OR 
have the same precedence as the additive operators. As stated before, the 
relational operators have the lowest precedence of all.  
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The following table summarizes the operator precedence of all of the operators 
covered so far: 
 
Type of 
Operator 

Operator Comments 

Sub-expression 
or Terms 

( ) [ ] . :: Sub-expression in parentheses is evaluated 
first. 
Other operators are used in a Term. 

Unary + - NOT Highest Precedence within Expression 
Multiplicative * / DIV 

MOD AND 
 

Additive + - OR XOR  
Relational < <= = >= > 

<> IN 
Lowest Precedence within Expression 

Range .. Used in Set Constants 
 
When dealing with logical expressions, it is especially important to note that the 
relational operators are lower in precedence than the logical operators. Thus, if 
you want to see if a variable N is between 10 and 20 exclusive, you cannot use 
the following expression: 
 
N >= 10 AND N <= 20 

 
If you used the above, the first operator to be evaluated would be AND and the 
terms preceding (10) and following (N) are integer, not Boolean, terms. This 
causes an error. Instead, you need to use parentheses to force the relational 
operators to be evaluated first: 
 
(N >= 10) AND (N <= 20) 

 
Now, the two relational expressions are evaluated first, resulting in two Boolean 
terms. Then the logical operator AND can be legally evaluated. 

Adding Logical and Relational Expressions to a Form 
In the past, we have worked with a simple codeunit to evaluate expressions and 
used the MESSAGE function to view the results. Now, in order to allow more 
data to be tested without as many recompiles, we create a form object to work 
with.  
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Creating a New Form 
Open the Object Designer by selecting TOOLS→OBJECT DESIGNER from the Menu 
Bar. Click the Form Button to view all forms. Now click the New Button located 
at the bottom of the Object Designer. The New Form window appears, as shown 
below: 
 

 
 
Click OK. A blank form window appears.   
 
We now save it so that it appears as a form object in the object designer window. 
Close the form window. A question window appears asking "Do you want to 
save the changes to the Form"? Click Yes. The Save As window is displayed. Fill 
it in as follows, and then click OK. 
 
Scroll down to the bottom of the Object Designer window and find your new 
form.  
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Select it and press the Design Command Button. The following blank form 
window appears: 
 

 
 

Adding Variables to a Form 
Select View, C/AL Globals from the Menu Bar, and create two variables of type 
Integer called Value1 and Value2. Also, create a variable of type Boolean called 
Result. Close the C/AL Globals window. 
 

1. Display the Toolbox window, by clicking the Toolbox button on the 
Tool Bar: 

 

 
 

2. The Toolbox appears.  

3. Move it next to the blank form as shown below. 

4. Select the Add Label tool in the lower right corner. 

5. Select the Text Box tool in the right-hand column. 
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6. Move the mouse cursor until it is over the blank form, as shown in 
the following picture. The cursor should change into a special 
positioning cursor. The one you see does not look exactly like this 
picture, but it should be close. Position the cursor so that the cross is 
near the center top of the blank form and click. 

 

 
 

7. A text box "Control" appears (the white box) and to the left of it is 
the associated label "Control" (the gray box). Click the Text Box 
tool again, move the positioning cursor to a spot just below the 
existing text box control, and click again. Finally, click the Text Box 
tool again, move the positioning cursor little below the other two text 
boxes, and click.  

8. You should end up with the form looking something like this: 
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 If the controls did not line up neatly, you can move them by dragging 
the text box control into place. Note that when you drag the text box 
control, the associated label control (the gray box) moves with it. 

9. Now, click on the first text box control and then press the Properties 
button on the Tool Bar.  

 The Properties button is the button just to the right of the Toolbox 
button. The Properties window appears, as you have seen it before, 
but this time there are more properties than you have seen before.  

 For now, we are only interested in two of them. Find the Caption 
property and change the value to "First Value". Find the SourceExpr 
property and change the value to "Value1". Then close the Properties 
window. 

10. Click on the second text box control, and then click the Properties 
button. Change this control's Caption property to "Second Value", 
and change the SourceExpr property to "Value2". Finally, click on 
the last text box control, display the Properties window, change the 
Caption property to "Result", and change the SourceExpr property to 
"Result". 

11. Close the form, save it and run it.  

Note that you can set any of the three values when running the form. The first 
two can be any integer value, while the third is limited to either Yes or No, since 
it is a Boolean. When a Boolean value is displayed as text, True displays "Yes", 
while False displays "No". 

Adding a Command Button and C/AL Code 
Open the form again by clicking the Design button. The form and the Toolbox 
should display. Click the Add Label tool so that it is no longer selected. Now, 
click the Command Button tool. Move the positioning cursor to the middle 
bottom of the form and click. Display the Properties window and change the 
Caption Property to Execute. After closing the Properties window, the screen 
should look like this: 
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Click the Command button and press the C/AL Code button on the Tool Bar, or 
press the F9 key. Find the Trigger that says OnPush. This code is executed 
whenever you push the Command button. As an example of what you can do, 
type the following code into the OnPush trigger code section: 
 
Result := Value1 > Value2; 

 
Close the form, save and run it. Try entering a value into the First Value box, 
another one in the Second Value box and then press the Execute button. The 
Result box is automatically updated with the result of the expression you placed 
in the assignment statement in the OnPush trigger code. Try several values in 
each box, including some negative values.  
 
Once you are comfortable that you can predict the results when you press the 
Execute button, try putting this code into the OnPush trigger in place of the code 
above: 
 
Result := (Value1 >= Value2) AND (Value1 <= 2 * Value2); 

 
Try other formulas as well. See what you can learn about how expressions are 
evaluated. 
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Test Your Skills − Logical and Relational Expressions Part 1 
On all of the questions below, feel free to use the test form you created to find the 
answers. Remember that each control's SourceExpr property determines which 
variable is being displayed and updated through that control. For each question, 
write down the value of the result of evaluating the logical or relational 
expression: 
 

1. 5 * 7 > 35 

2. 5 * -7 > -36 

3. (3 > 5 - 1) OR (7 < 5 * 2) 

4. (27 MOD 5 = 2) AND (27 DIV 5 = 5) 

5. (5 > 3) XOR (7 = 7) AND (9 >= 10) 

6. (10 > 2) AND ('10' > '2') 

7. NOT (11 + 7 < 15) OR ('Great' > 'Greater') AND ('Less' < 'Lesser') 

8. TRUE OR FALSE = TRUE 

9. Given that X is a Boolean Variable: 

 NOT (X AND TRUE OR FALSE) = (NOT X OR FALSE) AND 
TRUE 
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Test Your Skills − Logical and Relational Expressions Part 2 
 

1. FALSE: 5 * 7 > 35 

2. TRUE: 5 * -7 > -36 

3. TRUE: (3 > 5 - 1) OR (7 < 5 * 2) 

4. TRUE: (27 MOD 5 = 2) AND (27 DIV 5 = 5) 

5. TRUE: (5 > 3) XOR (7 = 7) AND (9 >= 10) 

6. FALSE: (10 > 2) AND ('10' > '2') 

7. TRUE:    NOT (11 + 7 < 15) OR ('Great' > 'Greater') AND ('Less' 
< 'Lesser') 

8. TRUE: TRUE OR FALSE = TRUE 

9. TRUE: NOT (X AND TRUE OR FALSE) = (NOT X OR 
FALSE) AND TRUE 

 
Explanation: Given that X is Boolean, let's look at each possibility:   

Suppose that X is TRUE:   

NOT (TRUE AND TRUE OR FALSE) = (NOT TRUE OR FALSE) 
AND TRUE 

NOT (TRUE OR FALSE) = (FALSE OR FALSE) AND TRUE 

NOT TRUE = FALSE AND TRUE 

FALSE = FALSE Yes, this is TRUE  

Suppose that X is FALSE:   

NOT (FALSE AND TRUE OR FALSE) = (NOT FALSE OR FALSE) 
AND TRUE 

NOT (FALSE OR FALSE) = (TRUE OR FALSE) AND TRUE 

NOT FALSE = TRUE AND TRUE 

TRUE = TRUE Yes, this is also TRUE  
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 10: THE IF AND EXIT STATEMENTS 
Training Objectives 

In this chapter, you learn about: 
 

• Conditional Statements and Boolean Expressions 
• The IF Statement 
• The EXIT Statement 
• Performing Calculations Using These Statements 
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Conditional Statements and Boolean Expressions 
Once again, to ensure that the terminology is defined the same way for all 
students, we offer these definitions. 

Conditional Statement 
This statement tests a condition and executes one or more other statements based 
on this condition. The IF Statement is the most commonly used conditional 
statement when there are only two possible values for the condition: either True 
or False. 

Boolean Expression 
This expression results in a Boolean value: either True or False. It can be a 
Boolean variable or constant, a relational expression, or a logical expression. 
Note that the terms, "Boolean expression" and "logical expression" can be used 
interchangeably for most purposes. However, we use Boolean expression when 
we want to emphasize that either a relational expression or a more general logical 
expression can be used. 

The IF Statement 
The IF Statement is used when you want only a specific statement to be executed 
if a condition is True. It can then be used to execute another statement if the 
condition is False. There are two ways of writing an IF statement, depending 
upon the situation.  

IF − THEN Syntax 
The following syntax is used to execute a statement only if a condition is True: 
 
IF <Boolean expression> THEN <statement> 
 
A True or False condition is stated using a Boolean expression. If the Boolean 
expression evaluates to True, the statement following the reserved word, THEN, 
is executed. If the Boolean expression evaluates to False, the statement following 
THEN is not executed.  
 
For example, if you wanted to test an integer value to see if it was negative and if 
so, to make it positive, you could use the following IF statement: 
 
IF Amount < 0 THEN 

 Amount := -Amount; 
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The relational expression, Amount < 0, is evaluated. If it is True, then the 
assignment statement is executed and the Amount becomes positive. If it is False, 
then the assignment statement is not executed and the Amount remains positive. 
 
Note how the above IF statement was written. The statement that is to be 
executed if the relational expression is True is placed below the IF − THEN line 
and indented by two characters. Your program works with or without this indent 
and it would work even if this statement appeared on the first line, right after the 
THEN. By convention, we write it using two lines and indenting the second line. 
Using this technique makes your code much easier to read. 

IF−THEN−ELSE Syntax 
Remember, there were two ways of writing an IF statement. The following 
syntax is used to execute one statement if a condition is True and to execute a 
different statement if that condition is False: 
 
IF <Boolean expression> THEN <statement 1> ELSE <statement 2> 
 
A True or False condition is stated using a Boolean expression. If the Boolean 
expression evaluates to True, the statement following the reserved word, THEN, 
is executed. If the Boolean expression evaluates to False, the statement following 
the reserved word, ELSE, is executed. In this type of IF statement, either of the 
two statements are executed, but not both.  
 
For example, if you wanted to find the unit price of an item, you might divide the 
total price by the quantity. However, if the quantity was zero and you did the 
division, it would result in an error in your code. To prevent this, you would want 
to test the quantity first. However, even if the quantity is zero, you still want to 
give the unit price a valid value. Thus, you might write: 
 
IF Quantity <> 0 THEN 

 UnitPrice := TotalPrice / Quantity 

ELSE 

 UnitPrice := 0; 

 
The relational expression, Quantity <> 0, is evaluated. If it is True (quantity is 
not equal to zero), the total price is divided by the quantity and the value assigned 
to the unit price. If it is False (quantity is equal to zero), the unit price is set to 
zero. 
 
Again, note the way that the IF statement was written above. The two statements 
that are optionally executed are indented by two spaces. However, the ELSE 
reserved word is aligned with the IF reserved word. Even though the program 
works the same regardless of any spaces or new lines, this is a helpful, visual cue 
as to which ELSE goes with which IF and even helps you to determine which 
condition triggers the ELSE (just look straight up to the preceding IF). 
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Another thing to notice is that the first assignment statement does not have a 
semicolon following it. This is because we are still in the middle of the IF 
statement. If we were to put the semicolon (statement separator) after the first 
assignment statement, the system would think that a new statement was coming 
up. However, the next word after that assignment statement is ELSE, and there is 
no such thing as an ELSE statement; it is part of the IF statement. A syntax error 
would result when compiling. 

The EXIT Statement 
Normally, code in a trigger executes from the top to the bottom and then control 
returns to the object that called this trigger, if there is one, or back to the user. If 
for some reason you do not want to execute the rest of the trigger code, you can 
use the EXIT statement. When the EXIT statement is executed, the rest of the 
trigger code is skipped. 
 
The EXIT statement is often used with the IF statement to stop executing trigger 
code under certain conditions. Suppose that in the above situation, you decided to 
skip the rest of the trigger code if the Quantity was equal to zero. In this case, 
you might write: 
 
IF Quantity = 0 THEN 

 EXIT; 

 

UnitPrice := TotalPrice / Quantity; 

 
The relational expression, Quantity = 0, is evaluated. If it is True, then the EXIT 
statement is executed, which skips the rest of the trigger code. If it is False, the 
EXIT statement is not executed and therefore the next statement executed is the 
assignment statement following the EXIT. Note that this assignment statement is 
not indented, because it is not part of the IF statement. 

Performing Calculations in Microsoft Navision Using These 
Statements  

We are going to expand on the form created in the last lesson to make it do more 
things. Refer to the previous lesson if you have any questions on how to create 
controls, move them, or set their properties. 
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Adding Additional Variables 
For this example, we need to add some variables. 
 
Go into the Object Designer, select Form 123456756 and click Design. Add the 
following global variables to the current variable list by selecting View, C/AL 
Globals on the Menu Bar: 
 
Quantity  Integer 

UnitPrice  Decimal 

TotalSales  Decimal 

TotalCredits Decimal 

GrandTotal  Decimal 

Result  Decimal (Changed from Boolean) 

 

Modifying Existing Controls 
The existing controls need some modification so that they show us the values of 
two of the new variables. 
 
Close the Globals window and click on the first Text Box, the one whose label 
says "First Value". Display the Properties window by pressing the Properties 
button on the Tool Bar. Change the following properties as indicated: 
 
1st Text Box: 

Caption Quantity 

SourceExpr Quantity 

 
Click on or "select" the second Text Box (the one whose label says "Second 
Value"). Change the following properties as indicated: 
 
2nd Text Box: 

Caption Unit Price 

MinValue 0 

SourceExpr UnitPrice 

 

Adding New Controls 
You need three new Text Boxes to access the values of the remaining variables 
and two command buttons to perform the calculations. 
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Display the Toolbox window, by pressing the Toolbox button on the Tool Bar. 
Make sure the Add Label tool is selected and add three more Text Boxes with 
labels to the form. Then, set the properties on each of the three new Text Boxes 
as follows: 
 
First Text Box: 

Editable  No 

Focusable  No 

Caption  Total Sales 

SourceExpr  TotalSales 

 

Second Text Box: 

Editable  No 

Focusable  No 

Caption  Total Credits 

SourceExpr  TotalCredits 

 

Third Text Box: 

Editable No 

Focusable No 

Caption Grand Total 

SourceExpr GrandTotal 

 
Then, deselect the Add Label tool, select the Command button tool and add one 
more Command button to the form. Set its Caption property to "Clear".  
 

 
 
Now, using the techniques discussed in the previous lesson, drag the Text Box 
and the Command button controls so that the form looks something like this. 
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Adding New Trigger Code to the Command Buttons 
The Command buttons require coding to perform our task. 
 
Select the Execute Command button and press the C/AL Code button on the 
Tool Bar. Remove the existing code in the OnPush trigger and replace it with the 
following code. Feel free to use the F5 key to display the Symbol Menu in order 
to select the variable names, rather than typing them in: 
 
IF Quantity = 0 THEN 

 EXIT; 

 

Result := Quantity * UnitPrice; 

 

IF Result < 0 THEN 

 TotalCredits := TotalCredits + Result 

ELSE 

 TotalSales := TotalSales + Result; 

 

GrandTotal := GrandTotal + Result; 

 
The three totals (TotalSales, TotalCredits and GrandTotal) are updated using a 
standard programming technique called "incrementing". The new value of the 
total is set to the current value of the total plus the new amount, called the 
"increment". In the above code, the new GrandTotal is set to the current 
GrandTotal plus the value of Result. 
 
When executed, this trigger code does the following: It first checks the Quantity. 
If Quantity is equal to zero, the rest of the trigger code is skipped; otherwise, 
Result is set to the product of UnitPrice and Quantity. The value of Result is now 
tested. If it is less than zero, then TotalCredits is incremented. If it is greater than 
or equal to zero, TotalSales is incremented. GrandTotal is incremented regardless 
of the value of Result. 
 
Select the Clear Command button and display the C/AL Editor again. Add the 
following code to the OnPush trigger: 
 
Quantity := 0; 

UnitPrice := 0; 

Result := 0; 

TotalSales := 0; 

TotalCredits := 0; 

GrandTotal := 0; 

 
When this code is executed, all of the variables are set back to zero.  
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Setting Data 
You now need to test this code. 
 
Exit the Form Designer, save and run the new form. Fill in the Unit Price and 
Quantity boxes and press the Execute button. Then set the Quantity to another 
value and press the Execute button again. What happens?  
 
Try entering a negative value in the Quantity (for example, -4) and pressing the 
Execute button. What happens this time?  
 
What happens if you enter a negative value in the Unit Price? Why does this 
happen? 
 
What happens when you press the Clear button? 

Hand Execution of the Trigger Code 
If you do not understand what is happening when you press the Execute button, 
try hand-executing your code. To do this, write down the starting values of the 
variables on a slip of paper and for each line of code, check off when it is 
executed and write the resulting values of the variables down.  
 
Here is an example of how to hand-execute this code. Note that, for this example, 
the Execute button's code has already been run several times as TotalSales, 
TotalCredits and GrandTotal have values other than zero assigned to them. 
 
IF Quantity = 0 THEN 

 EXIT; 

Result := Quantity * UnitPrice; 

IF Result < 0 THEN 

 TotalCredits := TotalCredits + Result 

ELSE 

 TotalSales := TotalSales + Result; 

GrandTotal := GrandTotal + Result; 

 

Step 1: ExistingValues Before Execution 
 
Quantity UnitPrice Result TotalSales TotalCredits GrandTotal 
-5 2.50 120.50 357.50 -7.00 350.50 
 

Step 2: Test Quantity 
 
IF Quantity = 0 THEN 
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Quantity UnitPrice Result TotalSales TotalCredits GrandTotal 
-5 2.50 120.50 357.50 -7.00 350.50 
 
Note that no variables are changed here, only tested. The result is that the EXIT 
statement is not executed. 

Step 3: Calculate Result 
 
Result := Quantity * UnitPrice; 

 
Quantity UnitPrice Result TotalSales TotalCredits GrandTotal
-5 2.50 -62.50 357.50 -7.00 350.50 
 
The new value of Result is negative 62.50. 

Step 4: Test Result 
 
IF Result < 0 THEN 

 
Quantity UnitPrice Result TotalSales TotalCredits GrandTotal
-5 2.50 -62.50 357.50 -7.00 350.50 
 
Again, no variables are changed at this time. The value of Result is being tested 
and the next statement run is being determined. Since Result is < 0, TotalCredits 
are incremented, while the statement that increments TotalSales is skipped. 

Step 5: Increment TotalCredits 
 
TotalCredits := TotalCredits + Result 

 
Quantity UnitPrice Result TotalSales TotalCredits GrandTotal
-5 2.50 -62.50 357.50 -69.50 350.50 
 
The new value of TotalCredits is its current value plus Result. 

Step 6: Increment GrandTotal  
 
GrandTotal := GrandTotal + Result; 

 
Quantity UnitPrice Result TotalSales TotalCredits GrandTotal
-5 2.50 -62.50 357.50 -69.50 288.00 
 
The new value of GrandTotal is its current value plus Result. 
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The check marks below show which lines were run in this example. 
 
 IF Quantity = 0 THEN 

   EXIT; 

  Result := Quantity * UnitPrice; 

  IF Result < 0 THEN 

  TotalCredits := TotalCredits + Result 

 ELSE 

   TotalSales := TotalSales + Result; 

GrandTotal := GrandTotal + Result; 
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Test Your Skills 
Perform this Self Test on your own. The solution is provided in an appendix at 
the end of this document. 
 

1. Using the Workbook Test Form (123456756) that you have been 
developing, add the ability to accumulate the total quantity sold, the 
total quantity credited and the grand total quantity. 

2. Using the same form, add two counters that can be incremented by 1 
every time you press the Execute button and are set to zero 
whenever you press the Clear button. One counter should be used to 
count the number of sales (Quantity > 0) and the other should count 
the number of credits (Quantity < 0). Also, when the Execute button 
is pressed, use these counters to calculate the average quantity sold 
and the average quantity credited. 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 11: COMPOUND STATEMENTS AND 
COMMENTS 
Training Objects 

In this chapter, you learn about: 
 

• Compound Statements and Comments 
• Compound Statements Syntax with BEGIN and END 
• Compound Statements using Nested IF Statements 
• Adding Comments to Code 
• Coding with Compound Statements and Comments 
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Compound Statements and Comments 
Below are the definitions of the two terms that we use in this chapter. 

Compound Statement 
This statement enhances the capabilities of the conditional statement. Remember 
that a conditional statement can only run one additional statement if the condition 
is found True. If there is an ELSE built in to the statement then it runs one 
statement if the condition is False. However, many times we need to run more 
than one statement for either or both conditions. This is where the compound 
statement comes in. 
 
The compound statement actually consists of multiple statements. For example, 
in an IF statement, if you wanted to perform two or more assignments when a 
condition tested to True, you would place a compound statement after the THEN. 
Normally after a THEN, you are allowed to place only one statement, however, if 
that one statement is a compound statement, you can perform multiple 
assignment statements in it. 

Comment 
A comment is a description that you place in your code, possibly to explain the 
code, or to document who did a modification or why it was done. However, since 
it is a description and not an instruction, we do not want the compiler to read it. 
Using a special syntax, we inform the compiler to ignore what is written in the 
comments and therefore, it does not attempt to translate them. 

Compound Statement Syntax with BEGIN and END 
In order to use Compound Statements, you need to understand their syntax. 

Compound Statement Syntax  
The syntax of a compound statement is as follows: 
 
BEGIN <statement> {; <statement>} END 

 
The braces ( { } ) indicate that whatever is included inside can be repeated zero 
or more times. In other words, there may not be a second statement at all, or there 
may be two or five, however many are needed. The curly bracket is also known 
as a "brace." 
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IF−THEN Compound Statement 
A compound statement can be used wherever, syntactically, a single statement 
can be used. For example, if you wanted to first calculate a unit price from an 
extended price, then add the extended price to the total price, but only if the 
quantity was not zero, you could write the following IF statement: 
 
IF Quantity <> 0 THEN BEGIN 

 UnitPrice := ExtendedPrice / Quantity; 

 TotalPrice := TotalPrice + ExtendedPrice; 

END; 

 
Note the indentation that is used with the compound statement. The statements in 
a compound statement are always indented two spaces from the BEGIN and the 
END, which are aligned with each other. If this rule were strictly followed, along 
with the normal indentation rules for IF statements, the result would have been: 
 
IF Quantity <> 0 THEN  

 BEGIN 

  UnitPrice := ExtendedPrice / Quantity; 

  TotalPrice := TotalPrice + ExtendedPrice; 

 END; 

 
However, to prevent this double indentation, while still making the code easy to 
follow, there is a special indentation rule for IF statements. In an IF statement, 
the BEGIN is placed on the same line as the THEN and the END is aligned with 
the beginning of the line that contains the BEGIN. 

IF−THEN−ELSE Compound Statement 
Let's include the ELSE clause. Suppose that if the Quantity was zero, you not 
only wanted to set the unit price to zero, but you also wanted to skip the rest of 
the trigger. Using the "normal" indentation rules, you would expect to see: 
 
IF Quantity <> 0 THEN  

 BEGIN 

  UnitPrice := ExtendedPrice / Quantity; 

  TotalPrice := TotalPrice + ExtendedPrice; 

 END 

ELSE 

 BEGIN 

  UnitPrice := 0; 

  EXIT; 

 END; 
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However, we also have special indentation rules for use with ELSE clauses. To 
reduce the number of lines of code (keeping more on the screen at once) and still 
make the code easy to read, we allow two changes. First, the ELSE appears on 
the same line as the END from its corresponding IF. Secondly, the BEGIN is on 
the same line as the ELSE. Thus the Microsoft Navision standard indentation for 
the above IF statement would be: 
 
IF Quantity <> 0 THEN BEGIN 

 UnitPrice := ExtendedPrice / Quantity; 

 TotalPrice := TotalPrice + ExtendedPrice; 

END ELSE BEGIN 

 UnitPrice := 0; 

 EXIT; 

END; 

 

Compound Statements Using Nested IF Statements  
The statement in the THEN or the ELSE clause of an IF statement could be 
another IF statement instead of an assignment. When this occurs, the second IF 
statement is called a "nested" IF statement. These can be complicated to 
understand, especially when trying to figure out which IF statement goes with an 
ELSE.  

Nested IF Statement Confusion 
The rule is that the ELSE goes with the closest IF above it that does not already 
have an ELSE. Here, indentation rules can really help when trying to understand 
code. For example, look at the following code that is not indented: 
 
IF Amount <> 0 THEN 

IF Amount > 0 THEN  

Sales := Sales + Amount 

ELSE  

IF Reason = Reason::Return THEN 

IF ReasonForReturn = ReasonForReturn::Defective THEN 

Refund := Refund + Amount 

ELSE 

Credits := Credits + Amount 

ELSE 

Sales := Sales - Amount; 
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It is hard to tell what circumstances would cause Sales to be reduced by Amount 
without diagnosing this code. Even worse, suppose it was indented incorrectly. 
This could be downright misleading: 
 
IF Amount <> 0 THEN 

 IF Amount > 0 THEN  

  Sales := Sales + Amount 

 ELSE  

  IF Reason = Reason::Return THEN 

   IF ReasonForReturn = ReasonForReturn::Defective THEN 

    Refund := Refund + Amount 

  ELSE 

   Credits := Credits + Amount 

ELSE 

 Sales := Sales - Amount; 

 

Proper Nested IF Statement Indentation 
However, using the rule that the ELSE goes with the closest IF without an ELSE 
and the standard indentation rules that were covered in the above sections, you 
could rewrite it like this: 
 
IF Amount <> 0 THEN 

 IF Amount > 0 THEN  

  Sales := Sales + Amount 

 ELSE  

  IF Reason = Reason::Return THEN 

   IF ReasonForReturn = ReasonForReturn::Defective THEN 

    Refund := Refund + Amount 

   ELSE 

    Credits := Credits + Amount 

  ELSE 

   Sales := Sales - Amount; 

 
Note that in all of these examples, the code would execute the same, since the 
compiler ignores all spaces and new lines. However, in the last example, it is 
much easier for the programmer to tell what is going on.  
 
Also, note the importance of having meaningful names for your variables. 
Suppose the same code was indented correctly, but the variables' names were not 
meaningful, like this: 
 
IF Amt1 <> 0 THEN 

 IF Amt1 > 0 THEN  

  Amt2 := Amt2 + Amt1 

 ELSE  

  IF OptA = 1 THEN 

   IF OptB = 3 THEN 
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    Amt3 := Amt3 + Amt1 

   ELSE 

    Amt4 := Amt4 + Amt1 

  ELSE 

   Amt2 := Amt2 - Amt1; 

 
The difference between poor programming and good programming is often how 
well your code documents itself. Through proper indenting, use of meaningful 
variable names, using Booleans to designate yes or no choices and using the 
Option type and option constants rather than integers to designate selections with 
more than two choices, your code can be mostly self-documenting. Just reading 
this type of code tells you what it means. Sometimes, however, it is useful to add 
additional documentation to your code. This brings us to the next topic. 

Adding Comments to Code 
There are two different syntaxes for Comments. Either one may be used 
anyplace. However, there are some advantages of one over the other, depending 
upon the situation.  

Single Line Comment 
The first syntax is a single line comment;  that is, it comments out a single line in 
the code. To "comment out" means that the entire section of code becomes a 
comment, which is ignored by the compiler. It is created by placing two slashes 
next to each other (//) on a line. Everything on that line after those two slashes is 
considered a comment and is ignored by the compiler. Here are some examples: 
 
// Calculate the Unit Price 

IF Quantity <> 0 THEN // Do not allow division by zero 

 UnitPrice := TotalPrice / Quantity 

ELSE // that is, if Quantity = 0 

 UnitPrice := 0; 

 
The first comment is an example of a program line being used entirely for a 
comment. The other two show that you can have some code on a line and then 
follow it with a Comment. In each case, the compiler ignores anything following 
the two slashes on that line. 

Block of Comments 
The second syntax is a block of comments. If a brace ( { ) is inserted in the code, 
the compiler ignores it and everything following it until the matching brace ( } ) 
is found. The compiler ignores even new lines in this case. Here is an example of 
a block of Comments: 
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{The following code is used to calculate the Unit Price. 
Note that we compare the Quantity to zero in order to 
prevent division by zero. In this case, we set the Unit 
Price to zero.} 

 

IF Quantity <> 0 THEN 

 UnitPrice := TotalPrice / Quantity 

ELSE 

 UnitPrice := 0; 

 

Nested Comments 
One of the common uses of a block of comments is when you are tracking down 
problems. A brace is inserted at the beginning of a section of code and a 
matching brace is inserted at the end of the section of code. This causes the entire 
section of code to comment out. When you comment out a section of code, it 
allows you to concentrate your efforts on the remaining parts of the code, or 
eliminate a part of the code as the cause of a problem. 
 
But what if there is already a set of braces in the code, indicating a comment? 
This is not a problem.  
 
Comment blocks can be nested. When the compiler reaches a brace, it treats 
everything as a comment until it reaches the matching brace. Thus, in your 
trigger code, a closing brace must match every opening brace. Here is an 
example of a nested comment: 
 
{The following code temporarily removed on 8/15/01... 

 

{The following code is used to calculate the Unit Price. 
Note that we compare the Quantity to zero to prevent 
division by zero. In this case, we set the Unit Price to 
zero.} 

 

IF Quantity <> 0 THEN 

 UnitPrice := TotalPrice / Quantity 

ELSE 

} 

 UnitPrice := 0; 

 
Note that when this section of code is run, only the line that sets the unit price to 
zero is actually executed. The rest are skipped. 
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Coding with Compound Statements and Comments 
After the exercises in Chapter 11, along with the Self-Test in the same lesson, the 
OnPush trigger of the Execute button has quite a bit of code in it. However, a lot 
of it can be consolidated, now that we can use compound statements.  
 
Go into the Object Designer and Design Form 123456756. Modify the code on 
the Execute button to take full advantage of compound statements. The result 
might look something like this: 
 

 
 
Because this code is short and easy to understand, the programmer may not 
normally add comments. However, just for the exercise, try adding some 
comments, both a comment block and several single line comments. Try 
compiling to make sure everything is still correct. 
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Test Your Skills 
1. In the following set of statements, draw a line from each ELSE to its 

matching IF statement: 

 
IF (X1 > X2) OR B3 THEN BEGIN IF X7 < X2 THEN  

A1 := (X1 + X7) / 2 ELSE IF X6 < X2 THEN  

A1 := (X1 + X6) / 2; 

X7 := X6 + 1; END ELSE IF (X1 < X2) AND B5 THEN  

IF X6 > X7 THEN BEGIN 

IF B2 THEN A2 := X1 / 2 + X7 / 2 ELSE 

A2 := X1 * 2 + X7 * 2; END ELSE A1 := X1 ELSE  

A2 := X2; 

IF B1 THEN EXIT; 

 
2. After executing the following set of statements, what value does 

variable A5 have? 

 
{Initialize Variables} 

A5 := 7; // Initialize answer 

B1 := {TRUE;} FALSE; B2 := TRUE; // FALSE; 

A1 := { 5 // be sure to set this one correctly 

A2 := 3 * A5; 

A3 := 10 } 11; // either one is OK 

A2 := 2 * A5;  

// IF B2 THEN A5 := A5 + 1 

IF (A1 < A5) OR {B2 AND} B1 THEN  

A5 := 3 * A5 // ELSE A5 := A2 / A5; 

ELSE A5 := A1 + A5; 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 12: ARRAYS 
Training Objectives 

In this chapter, you learn about: 
 

• Array Definitions 
• Array Syntax 
• The Power of Arrays 
• Strings as Arrays of Characters 
• Using Arrays 
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Array Definitions 
Arrays are special variables that have more functionality than the variables that 
we have discussed to this point. 

Review of Simple Data Types and Variables 
Simple data types were defined as types of data that only have a single value. A 
simple variable is a variable defined as a simple data type.  

Complex Data Types and Variables 
A complex data type is a type of data with multiple values. A complex variable is 
a variable with a complex data type, that is, a variable that has multiple values. 

Array 
An array is a complex variable that actually holds a group of variables. This 
group is defined all at once with a single identifier and a single data type. For 
example, we could create an array variable with the following identifier and data 
type: 
 

• Identifier: QuantityArray 
• Data Type: Integer 

 

Element 
This term is a single variable in an array. An array is made up of one or more 
elements. Although it is possible to create an array with one element, this is 
rarely done, as it would be no more useful than a simple variable. All elements in 
an array have the same data type, whatever the array was defined to be. The 
above array needs to have the number of elements defined. 
 

• Elements: 5 
 

Index 
An index is used to refer to a single element in an array. In order to access a 
single element in an array, you need to use both the array variable name and a 
number, the index, to indicate the desired array element. To access the fourth 
element in the above example, you would specify: 
 

• QuantityArray[4] 
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Dimension 
An array can have one or more dimensions. The easiest array is a one-
dimensional array, which is what we have defined, by default, above. This array 
has only elements in one dimension. This can be compared to having only 
elements on the x-axis of a graph. 
 
In the above example, there are a grand total of five elements (one line, or 
dimension, of five defined elements.) 
 
If we define the array as two dimensions, it then has a grand total of 25 elements 
(five elements in one dimension times five elements in the second dimension.) 
Think of this as having a two dimensional graph, using the x-axis and y-axis. 
Each line has five elements (1 through 5), but provides a combination of 25 
different points (using only integers). 
 
The mathematical formula for giving the grand total of elements in an array is the 
defined element number raised to the dimension number. Arrays can have up to 
10 Dimensions in C/AL. 
 
In order to use a particular element in a multi dimensional array, you specify an 
index value for each dimension. Therefore, there is the same number of index 
values as the defined dimensions. Remember that these values must be integers. 

Array Syntax 
Remember that an array is still a variable. The only difference between calling a 
simple variable and a complex one is adding the element index. 

Variable Syntax 
When you want to refer to any variable or an array as a whole, you use its 
identifier. For example, there is a built-in function called CLEAR, which has the 
following syntax: 
 
CLEAR(<variable>) 

 
The CLEAR function clears the variable you use as the parameter. If the variable 
is a numeric type, the CLEAR function sets it to zero. If the variable is a string 
type, it is set to the empty string. If the variable is an array, then each element in 
the array is set to its own cleared value. Thus, if you had a one dimensional array 
named SaleAmount whose data type was set to decimal, the following function 
call would set all elements in SaleAmount to zero. 
 
CLEAR(SaleAmount); 

Page 245 



 

 

Microsoft Navision Development I − C/SIDE Introduction 

Array Element Syntax 
When you want to refer to a single element of an array, you must refer to it with 
its identifier and its index, according to the following syntax: 
 
<identifier>[<index expression>{,<index expression>}] 

 
The brackets ( [ ] ) above are literal brackets, while the braces ( { } ) indicate that 
whatever is included in them can be repeated zero or more times. A one -
dimensional array requires a single index expression, while a two dimensional 
array requires two index expressions, separated by a comma. Each index 
expression must result in an integer value when evaluated. Using the same 
SaleAmount array described above, if you wanted to set the fifth element to zero, 
you would use the following assignment statement: 
 
SaleAmount[5] := 0; 

 

How to Think About Arrays 
An easy way to think about a one-dimensional array, is to think of a row of 
boxes, like this: 
 
5 27 8 17 25 3 7 12
Box[1] Box[2] Box[3] Box[4] Box[5] Box[6] Box[7] Box[8]

 
Here, is a one-dimensional array, whose identifier is Box and which has eight 
elements. Each element of the array is a single box. The fourth element of the 
array contains the value of 17. If you want to refer to the fourth element of the 
array, you refer to Box[4]. 
 
It is also easy to think about a two-dimensional array, if you think of it like a 
checkerboard or a multiplication table. 
 
Box[1,c] 1 2 3 4 5 6
Box[2,c] 2 4 6 8 10 12
Box[3,c] 3 6 9 12 15 18
Box[4,c] 4 8 12 16 20 24
Box[5,c] 5 10 15 20 25 30
 Box[r,1] Box[r,2] Box[r,3] Box[r,4] Box[r,5] Box[r,6] 

 
Here, is a two-dimensional array, whose identifier is Box and has a total of 30 
elements, broken up into five rows of six elements. The first dimension can be 
thought of as the row number, while the second dimension is thought of as a 
column number. In order to identify a specific element, you must identify both 
the row and the column. For example, if you want the value of the element in the 
4 row, 6th column, you refer to Box[4,6] and the value picked up would be 24. 
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Once you get to three or more dimensions, it starts getting harder to visualize. 
You have to start thinking in terms of the index being a list of criteria to match. 
Fortunately, there are few reasons to have a more than one-dimensional array in 
Microsoft® Business Solutions−Navision®, although up to 10 are allowed. For the 
rest of this chapter, we limit ourselves to one-dimensional arrays. 

The Power of Arrays 
If all you could do with an array is access a particular element, like this… 
 
SaleAmount[5] 

 
…it would not be very useful. At this point, creating an array with 10 elements 
only saves the developer from creating 10 different variables. Of course, there is 
much more that the developer can do with an array. 

Using Expressions as an Index Value 
The true power of an array is in the fact the index value can be an expression. 
 
SaleAmount[Counter] 

 
This allows the element you are addressing to be determined at run-time. In the 
above example, the element is determined by whatever value Counter has. This 
can be very useful as is explored in the exercise below, as well as in the 
following chapter, where we discuss repetitive statements. 
 
However, this does bring up a possible problem. How do you know, at run-time, 
whether the value of the index expression is a valid element number? If an array 
has been defined to have eight elements and you refer to element number 12, it 
results in a run-time error. 
 
To stop this use an IF statement to test the value of the variable before using it to 
index an array. For example: 
 
IF Counter <= 8 THEN 

 SaleAmount[Counter] := Answer; 

ARRAYLEN Function 
However, the problem with this method is that the array might actually be 
defined to have seven elements and you could never tell that this line was not 
correct until a run-time error occurred. To address this problem C/AL has a built-
in function called ARRAYLEN, with the following syntax: 
 
Result := ARRAYLEN(<array variable>) 
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The "Result :=" above indicates that the ARRAYLEN function results in a value, 
in this case of type Integer. Using the above syntax, the result is the number of 
elements in the array variable used as the parameter. For example, if a one-
dimensional array has been defined to have eight elements, the function below 
has the integer value of 8: 
 
ARRAYLEN(SaleAmount) 

 
NOTE: ARRAYLEN can also be used for more than one-dimensional arrays. If you 
are interested, look at the Help for this function in C/SIDE. 

 
The advantage of using ARRAYLEN is that if you later go back and change the 
defined length of an array, you do not have to back through your code to update 
references to the defined length. Thus, in the first example above, you could test 
to see if you have a valid index value like this: 
 
IF Counter <= ARRAYLEN(SaleAmount) THEN 

 SaleAmount[Counter] := Answer; 

 
Since the number eight is never used, nothing here says the array must have 
exactly eight elements. If it turns out the array is actually defined to have seven 
elements, this code still works perfectly. 

Strings as Arrays of Characters 
A string variable (variable of type text or code) can be thought of as an array of 
characters. Because of this, C/AL allows access to each character as an element 
in an array. 

Characters as Elements 
Each element is considered a variable of type char. For example, if you ran the 
following code… 
 
Str := 'Walk in the park'; 

Str[13] := 'd'; 

MESSAGE(Str); 

 
…the resulting message would be "Walk in the dark." 
 
Note that since char is a numeric type, you can use the ASCII codes for 
characters when using strings this way.  
 
For example, if you imported a text line, you could check for a tab character like 
this: 
 
IF Str[idx] = 9 THEN 

 MESSAGE('There is a TAB character at position %1 in the 
text.',idx); 
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Note that the length of a string cannot be accessed in this manner. No matter 
which characters you read or set, the length of the string remains the same. The 
elements beyond the string's length are considered undefined.  
 
In the first example, if you had set the 25th element (rather than the 13th) to 'd', 
the message displayed would have said, "Walk in the park." There would have 
been no change, since the 25th character was beyond the length of the string.  
 
Similarly, in the second example, if idx had been greater than the length of Str, it 
still might find a tab character there, but it would just be garbage, not actually 
part of Str. 
 
If you want to know the number of elements in a string being used as an array of 
characters, you must use the MAXSTRLEN function. The ARRAYLEN function 
does not work for this purpose. 

Using Arrays 
The following helps you understand how to create and use arrays in C/SIDE. 

Creating an Array Variable 
Go into the Object Designer, select Form 123456756 and click Design. Add the 
following global variables to the current variable list, by selecting View, C/AL 
Globals on the Menu Bar: 
 
Counter  Integer 

Amount  Decimal 

 
With the cursor on the same line as the Amount variable, display the Properties 
window by pressing the Properties button on the Tool Bar. Change the 
Dimensions property to a value of ten. This means that Amount is a one-
dimensional (since only one number was entered) array variable, of type decimal, 
with a maximum value of the first (and only) dimension being ten, which means 
that there are ten elements. 
 
NOTE: We are not going to do this now, but if you wanted to create a two-
dimensional array, you would put two numbers in the Dimensions property, separated 
by a semicolon (;). For example, to create the Box array from the above lesson, you 
would put 5;7 in the Dimensions property. This would create a two dimensional array, 
with the maximum value of the first dimension being 5 and the maximum value of the 
second dimension being seven, which means that there are 35 elements. 
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Adding Controls to View the Array 
Close the Globals window. By now, your form should look something like this: 
 

 
 
Display the Toolbox window by pressing the Toolbox button on the Tool Bar.  
 
Make sure the Add Label tool is not selected and add a Text Box (with no label) 
to the form, just to the right of Result. Then, set the properties on this new Text 
Box as follows: 
 
Editable No 

Focusable No 

BlankZero Yes 

SourceExpr Amount[1] 

 
Now, making sure that the new control is still selected (if not, click on it), press 
the Copy button on the Tool Bar: 
 
Press the Paste button on the same Tool Bar nine times. Each of the new controls 
should appear below the previous control, so you end up with a list of 10 
controls.  
 

 

Copy Button 

Paste Button 
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Select each control in turn. Go to its properties and change the SourceExpr so 
that each control references the corresponding element in the Amount array. For 
example, the second control ought to be changed to Amount[2], the third control 
to Amount[3] and so on, until the tenth control is changed to Amount[10]. 
 
By now, your form should look something like this: 
 

 
 

Add Code to the Clear Button 
Select the Clear button and access its OnPush trigger code. Set all of the 
variables to zero.  
 
Rather than setting each element individually to zero, set the entire array to zero 
using the CLEAR function. Not only does this save a lot of code (consider if the 
Amount had 1000 elements), but it also does not force you to know how many 
elements there are. Add the following two lines to set both of the new variables 
to 0: 
 
Counter := 0; 

CLEAR(Amount); 
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Add Code to the Execute Button 
Select the Execute button and access its OnPush trigger code. At the end, add the 
following lines of code (with a comment): 
 
// Display results in Amount column on form 

Counter := Counter + 1; 

Amount[Counter] := Result; 

 
Note what we are doing here: 
 

• The first time you press the Execute button, Counter is incremented 
to 1 and the element Amount[1] is set to the result. Amount[1] is 
displayed in the first of the new controls that we added.  

• The second time you press the Execute button, Counter is 
incremented to 2 and the element Amount[2] is set to the result. 
Amount[2] is displayed in the second of the new controls that we 
added. 

 
Save and run the form. Add some Unit Prices and some Quantities, pressing the 
Execute button after each. Watch what happens. Now press the Clear button. 
What does it do?  
 
Enter more Unit Prices and Quantities and continue to press the Execute button 
until you have filled the Amount column. Then press Execute one more time. 
What is the result? Why? 
 
Let's go back and fix this last problem. Go into the Execute button's OnPush 
trigger and modify those last lines we just added so that they now look like this: 
 
// Display results in Amount column on form 

Counter := Counter + 1; 

IF Counter <= ARRAYLEN(Amount) THEN 

 Amount[Counter] := Result; 

 
Save and run this form again. What happens when you press the Execute button 
more than 10 times now? We have now solved this problem. We need to keep 
this problem in mind anytime an array is used. 
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Test Your Skills 
In each of these examples, explain if this is an allowable application for arrays.  
 

1. We have a list of students, numbered from 1 to 99. Each student 
takes a test. We want to put the numeric score (from 0 to 100) for 
each student into an array, with student 1's score going in element 1, 
student 2's score in element 2, etc. 

 

 

 

2. We have a list of students, numbered from 1 to 99. Each student 
takes a test. We want to create a two dimensional array with two 
rows of 99 columns. In the first row, we would put the corresponding 
student's name, with student 1's name in element 1,1, student 2's 
name in element 1,2, etc. In the second row, we would put the 
corresponding student's numeric test score (from 0 to 100), with 
student 1's score going in element 2,1, student 2's score going in 
element 2,2, etc. 

 

 

 

3. We create an array containing the number of households in each ZIP 
code. There is one array element for each five-digit ZIP code and 
each element contains the number of households in that ZIP code. 
The number of households that have a ZIP code of 30071 goes into 
element 30071, etc. 

 

 

 

4. We create an array containing the number of households in each 
state. There is one array element for each two-character postal state 
code and each element contains the number of households in that 
state. The number of households in Georgia goes into element 'GA', 
etc. 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 13: REPETITIVE STATEMENTS 

Training Objectives 
This chapter helps you understand the repetitive statements, such as FOR, 
WHILE…DO and REPEAT…UNTIL. 
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Repetitive Statements 
A repetitive statement is a statement that allows you to execute one or more other 
statements multiple times. There are several kinds of repetitive statements and 
they differ on how they determine the number of times their included 
statement(s) is (are) executed. A repetitive statement is often called a "loop", 
because when the execution reaches the end of the repetitive statement, it loops 
back to the beginning of the repetitive statement. 
 
This chapter reviews three different types of repetitive statements, their 
similarities and their differences. 

The FOR Statement 
The FOR statement is used when a statement is to be executed a predetermined 
number of times. There are two FOR statements.  

FOR…TO Statement 
The most common, FOR…TO, has this syntax: 
FOR <control variable> := <start value> TO <end value> DO <statement> 
 
The control variable must be a variable of type Boolean, Date, Time or any 
numeric type. The start value and the end value must be either expressions that 
evaluate to the same data type as the control variable or be variables of that same 
data type. For example: 
 
FOR idx := 4 TO 8 DO 

Total := Total + 2.5; 

 
In this case, the control variable (idx), the start value (4) and the end value (8) are 
all of type integer. The chart below describes what happens: 
 

1. The start value expression is evaluated and the 
control variable is set to the result. idx := 4 

2. The end value expression (after the TO) is 
evaluated. End value is 8 

3. 
The control variable is compared to the end 
value. If it is greater than the end value, the 
FOR statement is terminated. 

IF idx > 8,  THEN 
The FOR statement 
ends. 

4. The statement (after the DO) is executed. Total := Total + 2.5 

5. The control variable is incremented by one. idx := idx + 1 (5) 

6. Go to step 3 and test the control variable again.  
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The net result, for this example, is that the Total variable is increased by 2.5 a 
total of 5 times, therefore increasing it by 12.5. Note that both the start value and 
the end value are evaluated only one time, at the beginning of the FOR statement. 
Note that the control variable's value should not be changed in the FOR loop, as 
the results of that would not be predictable. Also, the value of the control variable 
outside of the FOR loop (after it ends) is not defined. 

Using BEGIN and END 
What if several statements need to be run inside the loop? We then need to use a 
compound statement by adding BEGIN and END. Here's an example: 
 
FOR idx := 4 TO 8 DO BEGIN 

 Total := Total + 2.5; 

 GrandTotal := GrandTotal + Total;  

END; 

 

FOR…DOWNTO Statement 
The second FOR statement, the FOR DOWNTO statement, has this syntax: 
 
FOR <control variable> := <start value> DOWNTO <end value> 
DO <statement> 

 
The rules for the control variable, start value and end value are the same as for 
the other FOR statement. The only difference between the two is that in the FOR 
TO statement, the control variable increases in value until it is greater than the 
end value, where in the FOR DOWNTO statement, the control variable decreases 
in value until it is less than the end value. Here is an example and the explanation 
using an array and a compound statement: 
 
FOR idx := 9 DOWNTO 1 DO BEGIN 

TotalSales := TotalSales + Sales[idx]; 

NumberSales := NumberSales + 1; 

END; 
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1. The start value expression is evaluated and the 

control variable is set to the result. 
Idx := 9 

2. The end value expression (after the TO) is 
evaluated. 

End value is 1 

3. The control variable is compared to the end 
value. If it is less than the end value, the FOR 
statement is terminated. 

IF idx < 1, THEN 
 The FOR statement 
ends. 

4. The statement (after the DO) is executed. 
 
 

TotalSales := 
TotalSales + 
Sales[9]; 
NumberSales := 
NumberSales + 1; 

5. The control variable decrements by one. Idx := idx - 1 (8) 

6. Go to step 3 and test the control variable 
again. 

 

 
Through each execution of the first statement in the compound statement, a 
different element of the Sales array is accessed − first 9 and then 8, and so on. 

The WHILE…DO Statement 
The WHILE loop is used when a statement is to be executed as long as some 
condition holds true. Here is the syntax of a WHILE statement: 
 
WHILE <Boolean expression> DO <statement> 

 
This is simpler than the FOR statement. As long as the Boolean expression 
evaluates to True, the statement, or statements if using BEGIN and END, is 
executed repeatedly. Once the Boolean expression evaluates to False, the 
statement is skipped and execution continues with the statement following it. 
 
Here is an example, showing the use of a compound statement: 
 
WHILE Sales[idx + 1] <> 0 DO BEGIN 

 idx := idx + 1; 

 TotalSales := TotalSales + Sales[idx]; 

END; 
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Here is the explanation: 
 

1. The Boolean expression is evaluated. If 
it is true, continue with step 2. If not, 
the WHILE statement is terminated. 

Is Sales[idx + 1] <> 0? 

2. The statement (after the DO) is 
executed. 

idx := idx + 1; 
TotalSales := TotalSales + 
Sales[idx]; 

3. Go to step 1 and test the Boolean 
expression again. 

 

 
Note that the Boolean expression is tested before the statement is even executed 
one time. If it evaluates to False from the beginning, the statement is never 
executed.  
 
Also, note that the Sales[idx] that is added to Total Sales in the WHILE loop is 
the same value that was tested in the Sales[idx + 1] at the beginning of the 
WHILE loop. The intervening idx := idx + 1 statement is what causes this. Also, 
once the WHILE loop has ended, idx still refers to the last non-zero element in 
the Sales array. 

The REPEAT…UNTIL Statement 
The REPEAT statement is used when one or more statements are to be executed 
until some condition becomes true. Here is the syntax of the REPEAT statement: 
 
REPEAT <statement> { ; <statement> } UNTIL <Boolean 
expression> 

 
There are several differences between the REPEAT and WHILE statements: 
 

• First, there can be more than one statement between the REPEAT 
and the UNTIL, even if no BEGIN and END is used.  

• Secondly, the Boolean expression is not evaluated until the end, after 
the statements have already been executed once.  

• And third, when the Boolean expression is evaluated, it loops back to 
the beginning if the expression evaluates to False and terminates the 
loop if the expression evaluates to True. 

 
Here is an example, which is almost identical to the example used for the 
WHILE statement: 
 
REPEAT 

 idx := idx + 1; 

 TotalSales := TotalSales + Sales[idx]; 

UNTIL Sales[idx] = 0; 
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Here is the explanation: 
 
1. The statements (between the REPEAT 

and the UNTIL) are executed. 
idx := idx + 1; 
TotalSales := TotalSales + 
Sales[idx]; 

2. The Boolean expression is evaluated. If 
it is true, the REPEAT statement is 
terminated. If not, go back to step 1. 

Is Sales[idx] = 0? 

 
Note that since the Boolean expression is not evaluated until the end, the 
statements incrementing the index and adding the TotalSales are executed even 
though the value of those Sales might be zero. Therefore, at the end of this loop, 
idx refers to the first Sales which equals zero, rather than the last non-zero Sales 
as in the WHILE loop. 
 
Also note that the Boolean expression had to be rewritten, since we are now 
testing for a False condition to continue the loop, rather than a True expression as 
in the WHILE loop. 

Coding with Repetitive Statements 
Recall from the last chapter, the test form was left so that the first 10 items you 
added to the list were listed, but from then on nothing showed in the list. We now 
change this so that the last ten items you added to the list always show. 

Adding a FOR Loop 
Go into the Object Designer, select Form 123456756 and click Design.  
 
Add the following global variable to the current variable list by selecting 
VIEW→C/AL GLOBALS on the Menu Bar: 
 
idx  Integer 

 
Select the Execute button and access its OnPush trigger code. Find the code 
following the comment that says "Display results in Amount column on form." 
Modify it so that it looks like this: 
 
// Display results in Amount column on form 
 
Counter := Counter + 1; 

IF Counter > ARRAYLEN(Amount) THEN BEGIN 

 Counter := ARRAYLEN(Amount); 

 FOR idx := 2 TO Counter DO 

  Amount[idx-1] := Amount[idx]; 

END; 

Amount[Counter] := Result; 
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Note that once Counter becomes greater than the length of the Amount array, you 
set it back to be equal to that length. Then, move each of the elements in the 
Amount array up by one index, using a FOR statement. Element 2 is moved to 
element 1, then element 3 is moved to element 2, etc. Finally, element 10 is 
moved to element 9 and then the FOR loop ends. The new result is then moved 
into the last element in the array. 
 
Now save and run this form.  
 
Enter some values, press the Execute button, and watch what happens. Until the 
list is filled, nothing changes, but watch what happens when you have pressed the 
Execute button more than 10 times. 

Sorting − Phase I 
Go back into the design of the form and add a new Command Button with its 
Caption property set to Sort. If you need help doing this, refer back to the 
exercise "Adding a Command Button and C/AL Code" in Chapter 10.  
 
Highlight the button and press the F9 key to find the OnPush trigger and add the 
following code: 
 
FOR idx := ARRAYLEN(Amount) DOWNTO 2 DO 

 IF Amount[idx] < Amount[idx-1] THEN BEGIN 

  TempAmount := Amount[idx]; 

  Amount[idx] := Amount[idx-1]; 

  Amount[idx-1] := TempAmount; 

 END; 

 
For this to compile, you also need to add a variable called TempAmount of type 
Decimal. Now exit, compile, save and run this form.  
 
Fill in some values and press the Execute button, entering differing quantities 
each time until the column is full. Now press the Sort button. What happens?  
 
Press the Sort button again. What happened this time?  
 
Continue pressing the Sort button until nothing further happens. Note that at this 
point all entries are sorted. Now, examine the above code and answer the 
following questions. Hand execute the code if necessary.  
 

1. Why in the FOR statement do we only go down to 2 rather than all 
the way to 1?  

2. Why do we not need a BEGIN after the DO in the FOR statement?  

3. What is taking place in the 3 lines of the compound statement 
(between BEGIN and END)?  

4. Why is TempAmount used for this?  
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5. If the entries in the column had been made exactly in the wrong 
order (highest to lowest), how many times would the Sort button 
have to be pressed to sort the list? 

Sorting − Phase II 
Obviously, it would be better if the user could just press the Sort button once and 
have the list completely sorted. Note, however, that sometimes one press of the 
button would work, while other times a lot more are needed. A FOR loop would 
be inappropriate for this, because we do not know in advance how many times it 
takes.  
 
For this situation, a REPEAT loop would work best. Add a new variable called 
IsSorted of type Boolean.  
 
Then modify the Sort button's OnPush code as follows: 
 
REPEAT 

 IsSorted := TRUE; 

 FOR idx := ARRAYLEN(Amount) DOWNTO 2 DO 

  IF Amount[idx] < Amount[idx-1] THEN BEGIN 

   TempAmount := Amount[idx]; 

   Amount[idx] := Amount[idx-1]; 

   Amount[idx-1] := TempAmount; 

   IsSorted := FALSE; 

  END; 

UNTIL IsSorted; 

 
Note that the IsSorted variable is used as a signal to tell whether we are finished 
sorting. We set it to TRUE at the beginning of each REPEAT loop and if you 
ever have to swap two elements because the list is not in order, set it to FALSE.  
 
At the end of the REPEAT loop, we check to see if it is TRUE. If it is, you know 
that all of the elements are in order, since none needed to be swapped and 
therefore you can exit the loop. If not, the loop is repeated again. When using a 
Boolean variable as a signal in this way, programmers sometimes call it a "flag".  
 
Also, note that we cannot tell whether the list is sorted unless we actually run 
through it at least one time. That is why REPEAT is used here, rather than a 
WHILE loop. 
 
Save and run this form. Perform the same experiment as before, filling in the 
table with values and then pressing the Sort button. Note that the list is 
completely sorted with one press. 
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• Look at the IF statement again. We used the less than (<) operator to 
compare the elements. What would happen if you changed this to the 
greater than (>) operator?  

• Test the case where two elements happen to have the same value. 
Once you find out, change it back to the less than operator for the 
next exercise. 

 

Sorting − Phase III 
We now have a perfectly good sorting routine. It works quite well for small 
arrays. But notice that we wrote it so that it could take arrays of any size. What if 
there were 100 elements, 1,000 elements, or 10,000 elements? We created 
"nested" loops when we put one loop (the FOR loop) inside another loop (the 
REPEAT loop). Whenever there are nested loops, there is always a potential for 
inefficiency, especially as the number of elements increase. The question 
becomes, how many times the innermost loop is to be executed?  
 
For example, in this case, whenever the FOR loop is executed once, the IF 
statement is executed 9 times, because the length of the array is 10, but we are 
not going all the way down to 1. If the REPEAT loop has to be executed 9 times, 
the FOR loop will be executed 9 times and the IF statement will be executed 9 * 
9 = 81 times. However, if the array length goes up to 100, the IF statement would 
be executed 99 times per FOR statement and the FOR statement could be 
executed by the REPEAT loop up to 99 times. In this situation, the IF statement 
might be executed up to 99 * 99 = 9,801 times! 
 
We can reduce this substantially, by remembering what happened when we first 
wrote the FOR loop by itself. Every time we ran it, the lowest element would rise 
to the top. If you think about it, that means that the first element would never 
need to be tested again, once the first FOR loop was run. Once the second FOR 
loop was run, you would never need to test the first two elements again. Each 
loop needs fewer and fewer tests to do its job. And this is the worst case. 
Sometimes, when we pressed the Sort button, the first 3 elements became sorted 
and we would really never need to test any of the first 3 again! 
 
Here is how we can take advantage of this. First, create an integer variable called 
LowestSwitch.  
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Rewrite the sorting routine so it looks like this: 
 
LowestSwitch := 2; 

REPEAT 

 IsSorted := TRUE; 

 FOR idx := ARRAYLEN(Amount) DOWNTO LowestSwitch DO 

  IF Amount[idx] < Amount[idx-1] THEN BEGIN 

   TempAmount := Amount[idx]; 

   Amount[idx] := Amount[idx-1]; 

   Amount[idx-1] := TempAmount; 

   IsSorted := FALSE; 

   LowestSwitch := idx + 1; 

  END; 

UNTIL IsSorted; 

 
Instead of sorting down to 2 (comparing with 1) every time, now the FOR loops 
says to sort down to LowestSwitch (comparing with LowestSwitch - 1). 
LowestSwtich starts out as 2, but each time two values are switched (in the 
THEN clause of the IF statement), it is reset to one more than the element 
currently being switched. Since the FOR loop works down, at the end, 
LowestSwitch is the lowest element to test next times around. Even in the worst 
case, it is one higher than the previous value and it might be several higher. Each 
one higher is one less thing to test and the savings are compounded as you go 
through the sort.  
 
For example, if the array has 10 elements, then in the worst case, we would 
execute the innermost IF statement 9 * 9 = 81 times. In the worst case, we would 
execute the innermost IF statement 9 + 8 + 7 + 6 + 5 + 4 + 3 + 2 + 1 times = 45 
times. If the array has 100 elements, the worst case goes from 9,801 executions 
down to 4,950.  
 
In other words, this simple modification makes the sort go twice as fast (takes 
half as long to execute). 
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Test Your Skills 
 

1. Which Repetitive Statement would you use if you could determine, 
before you started, how many times your statement(s) would have to 
be executed? 

 

2. Which Repetitive Statement does not require a BEGIN and END to 
execute more than one statement repetitively? 

 

3. Which Repetitive Statement(s) test the condition at the beginning of 
each loop? 

 

4. Rewrite the following WHILE statement as a REPEAT statement. 
Describe the difference(s) in how it is executed. 

 

WHILE X > 0 DO BEGIN 

 Y := A * X * X + B * X + C; 

 X := X - 1; 

END; 
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Test Your Knowledge Answers 
 

1. Which Repetitive Statement would you use if you could determine, 
before you started, how many times your statement(s) would have to 
be executed?  

 The FOR statement 

2. Which Repetitive Statement does not require a BEGIN and END to 
execute more than one statement repetitively?  

 The REPEAT statement 

3. Which Repetitive Statement(s) test the condition at the beginning of 
each loop?  

 The FOR statement and the WHILE statement 

4. Rewrite the following WHILE statement as a REPEAT statement. 
Describe the difference(s) in how it is executed. 

WHILE X > 0 DO BEGIN 

Y := A * X * X + B * X + C; 

X := X - 1; 

END; 

 

REPEAT 

 Y := A * X * X + B * X + C; 

 X := X - 1; 

UNTIL X <= 0; 

 
The difference is that if X starts out less than or equal to zero, no statements in 
the loop is executed in the case of the WHILE statement, while in the case of the 
REPEAT statement, the two statements in the loop are executed once.  
In the case that X starts out greater than zero, there is no difference in the way 
these are executed. 

Page 266 



 

 

Chapter 13: Repetitive Statements 

Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 14: OTHER STATEMENTS 

Training Objectives 
In this chapter, you learn about: 
 

• The WITH Statement 
• CASE Statement 

Page 269 



 

 

Microsoft Navision Development I − C/SIDE Introduction 

The WITH Statement 
The WITH statement is used to make coding with record variables easier. So 
before discussing the WITH statement, you need to understand what a record 
variable is. 

Record Variables 
A record variable is a complex data type (see Chapter 13 on Arrays). Like an 
array variable, a record variable contains multiple values. In an array, all of the 
values have the same name and type and are distinguished by an element number, 
or index. 
 
In a record, the various values, also called fields, each have their own name and 
type. To distinguish the values, a period (.) is used to separate the name of the 
record variable from the name of the field. Thus, if a record called Customer had 
a field called Name, then to access the name of the customer, you would enter 
Customer.Name in your code 
 
Records represent one row, or record, in a database table. The fields that make up 
a record are defined using a Table Object. How this is done is covered in the 
Solution Developer class.  

The WITH Statement Syntax 
Suppose you had some data in an array that was to be loaded into a record 
variable. The code to do this might look like this: 
 
Customer.Name := Txt[1]; 

Customer.Address := Txt[2]; 

Customer.City := Txt[3]; 

Customer.Contact := Txt[4]; 

Customer."Phone No." := Txt[5]; 

 
The WITH statement is used to make this sort of coding easier to do and under 
many circumstances easier to read. The syntax of the WITH statement is: 
 
WITH <record variable> DO <statement> 
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Within the statement (which can be a compound statement), the record name is 
no longer needed. Instead, the fields of that record can be used as though they 
were variables themselves. Thus, the above example could be rewritten like this: 
 
WITH Customer DO BEGIN 

 Name := Txt[1]; 

 Address := Txt[2]; 

 City := Txt[3]; 

 Contact := Txt[4]; 

 "Phone No." := Txt[5]; 

END; 

 
Note that the record name is no longer needed. The field name compiles and the 
computer knows that these fields go with the Customer record. However, if there 
is a variable name that has the same name as a field, how does C/SIDE know 
which you are referring to? It uses the field from the record, rather than the 
variable, but this sort of ambiguous reference should be avoided. 

Implied WITH Statements 
In many important places that use the WITH statement, you do not even see a 
WITH statement. These are the implied WITH statements found in the various 
objects.  
 
For example, in a Table Object, there is an implied WITH statement covering the 
entire object. Every reference to a field defined in that table has the implied 
record variable (called "Rec") and a period automatically and invisibly placed in 
front of it. 
 
In your Solution Developer II class, you learn about other places where there are 
implied WITH statements. 

CASE Statement 
Like the IF statement, a CASE statement is a conditional statement. The IF 
statement is used when the condition has only two values: either True or False. If 
the condition is True, the statement following THEN is executed. If the condition 
is False, the statement following ELSE is executed.  
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Case Statement Syntax 
The CASE statement is used when there are more than two possible values for 
the condition. The syntax of the CASE statement is as follows: 
 
CASE <expression> OF 

 <value set 1> : <statement 1>; 

 <value set 2> : <statement 2>; 

     

 <value set n> : <statement n>; 

 [ELSE <statement n+1>] 

END 

 
A value set is like the constant set used with the IN operator, except without the 
brackets. Thus, it can contain a single value, multiple values separated by 
commas, ranges, multiple ranges separated by commas, etc. All of the values in 
the value sets must have a type compatible with the type of the CASE expression. 
 
Note that the ELSE clause is optional for the CASE statement, thus the brackets. 
 
When the CASE statement is executed, the expression is evaluated first. This 
expression is sometimes called the selector. Then, in turn, each of the values in 
each value set is evaluated.  
 
If one of the values in the first value set matches the value of the expression, then 
the first statement is executed. If one of the values in the second value set 
matches the value of the expression, then the second statement is executed. This 
continues until one of the statements is executed.  
 
If the last value set has been reached and no statement has been executed, then 
the ELSE clause is checked. If not, the second value set is checked. If there is an 
ELSE clause, then its statement is executed. If there is no ELSE clause, then no 
statement is executed for this CASE statement.  
 
Note that only one of the statements is executed. If there is more than one value 
set that contains the same value, only the first one of them is executed. 

Page 272 



 

 

Chapter 14: Other Statements 

Simple Use of the CASE Statement 
Go into the Object Designer, select codeunit 123456750 and click Design.  
 
In the OnRun trigger, enter the following statements, removing any code that was 
there previously. 
 
Int2 := 3; 

 

FOR Int1 := 0 TO 8 DO BEGIN 

 Color := Int1; 

 

 CASE Color OF 

  Color::Orange: 

   Int2 := Int1 + Int2; 

  Color::Red,Color::Green: 

   Int2 := Int2 * 2; 

  Color::Yellow: 

   BEGIN 

    Amt1 := Int1 * 5; 

    Int2 := Amt1 DIV 2; 

   END; 

  Color::Blue,Color::Violet: 

   BEGIN 

    Amt1 := Int1 * 2 + Amt1; 

    Int2 := Amt1 DIV 3; 

   END; 

  ELSE  

   BEGIN 

    MESSAGE('Invalid Color'); 

    Int2 := Int2 + 3; 

   END; 

 END; 

 

 MESSAGE('The value for %1 is %2',Color,Int2); 

END; 

 
Before saving this code, try executing this by hand and try to predict what the 
various messages state.  
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If you forget what the various colors were, use View, C/AL Globals to display 
the variable list, select the Color option variable and then press F5 to display the 
Properties. Make a note of the predicted messages here or on a separate piece of 
paper.  
 
Now exit, save and Run the codeunit.  
 
Did you predict the messages correctly? If not, please review the code and your 
hand execution to determine what went wrong. 

Complex Use of CASE Statement 
Now go into the Object Designer, select Form 123456756 and click Design.  
 
Select the Execute button and access its OnPush trigger code. Modify the code at 
the beginning (before the comment) so that it looks like this: 
 
Result := Quantity * UnitPrice; 

 

CASE TRUE OF 

 Quantity = 0: 

  EXIT; 

 Quantity < 0: 

  BEGIN 

   TotalCredits := TotalCredits + Result; 

   TotalQtyCredited := TotalQtyCredited + Quantity; 

   CreditCounter := CreditCounter + 1; 

  AvgQtyCredited := TotalQtyCredited DIV  

    CreditCounter; 

  END; 

 Quantity > 0: 

  BEGIN 

   TotalSales := TotalSales + Result; 

   TotalQtySold := TotalQtySold + Quantity; 

   SalesCounter := SalesCounter + 1; 

   AvgQtySold := TotalQtySold DIV SalesCounter; 

  END; 

END; 

 

GrandTotal := GrandTotal + Result; 

GrandTotalQty := GrandTotalQty + Quantity; 

 
Note that we have replaced the various IF statements with one CASE statement.  
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Look carefully at the way we constructed this CASE statement. Normally in a 
CASE statement, a variable expression is used for the selector and each value set 
is a list of one or more constants. In this case, we have used a constant for the 
selector and each value set is a variable expression. However, the rules for 
execution are still the same. The selector expression is evaluated and then each of 
the values in each value set is evaluated. The first value set where both values 
match is the one that is executed. 
 
Exit, save and Run the Form.  
 
Verify that the Execute button works as before.  
 
Note that there is one difference. What is it?  
 
How could you have changed the code so that it executes identically to the 
previous code? 

Page 275 



 

 

Microsoft Navision Development I − C/SIDE Introduction 

Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 15: FUNCTIONS 

Training Objectives 
In this chapter, you learn about: 
 

• Functions and Parameters 
• Using Built-in Functions 
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Functions and Parameters 
To fully understanding functions and parameters and how they are used is very 
important. So we first review these terms and others that are closely related. 

Functions 
A function is a named portion of a program (sometimes called a “sub-program” 
or a “subroutine”).  
 
When the function’s name, also called an identifier, is used, the current program 
is suspended while the trigger code for the specified function is executed. Using 
the Identifier in this way “calls” the function. When the trigger code in the called 
function is completed, the function “returns” to where it was called. Depending 
upon how the function is called determines what happens when it returns. 
 
A function can be used as an expression. For example, here is a function named 
CalculatePrice used in the following expression: 
 
TotalCost := Quantity * CalculatePrice; 

 
The CalculatePrice function needs to return a value, which is used in evaluating 
the expression. This return value is then multiplied by the variable Quantity and 
that result is assigned to the variable TotalCost. 
 
A function can also be called using a function call statement. This statement 
simply calls the function and does not receive a return value. Here's an example 
of calling a function named "RunFunction" in this manner: 
 
IF Quantity > 5 THEN 

 RunFunction; 

 
The RunFunction function does not return any data back to the calling function. 

Built-in Functions 
A built-in function is a function provided within C/SIDE without you having to 
write it. You are not able to see its trigger code, since that too is built into 
C/SIDE. 

Parameter 
A parameter is one or more variables or expressions that are sent to the function 
through the function call. The parameter provides the function information and, if 
needed, the function can modify that information. Most functions have 
parameters and if so, the function identifier has a set of parenthesis that follows 
the function identifier. Within these parentheses are one or more parameters. If 
there is more than one parameter, the parameters are separated by commas. 
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Pass By Value 
Sometimes a parameter is passed to a function strictly to give the function 
information. In that case, the parameter is said to be passed (or called) by value. 
In this case, the parameter knows just the value of the variable or expression that 
was used for the parameter. Since it is just a value, any change that the function 
does to this parameter does not affect any variables in the calling trigger. 

Pass By Reference 
Other times, a parameter is passed to the function and the function modifies that 
parameter. In this case, the parameter is said to be passed (or called) by reference 
or by name. The parameter actually knows the variable's location in the computer 
memory that it represents. The parameter passes the computer memory location 
to the new function. Any changes that the function does to this type of parameter 
are permanent and do affect variables in the calling trigger. 
 
These concepts are covered more thoroughly in the next chapter. However, there 
is one important thing to note at this point. If a parameter is passed by value, then 
you can use any expression for that parameter. However, if a parameter is passed 
by reference, you must use a variable for that parameter, so that its value can be 
changed. A variable has a location in memory, whereas an expression or a 
constant does not. 

Using Built-in Functions 
You have already covered several built-in functions in previous chapters. Take a 
couple of minutes to review these: 
 
MESSAGE (displays a message on the screen) see Chapter 6 

MAXSTRLEN (returns defined length of text variable) see 
Chapter 8 

COPYSTR (returns part of a string)   see 
Chapter 8 

CLEAR (clears the passed in variable)  see Chapter 13 

ARRAYLEN (returns number of elements in an array) see 
Chapter 13 

 
Note that some of them, like MESSAGE and CLEAR, have no return value, so 
they can only be called using a function call statement. Others, like COPYSTR 
and MAXSTRLEN, return a value, so they can be used in an expression. Also, 
note that CLEAR changes the passed in parameter, so it is an example of pass by 
reference, while the others are examples of pass by value. 

Page 279 



 

 

Microsoft Navision Development I − C/SIDE Introduction 

The C/AL Symbol Menu 
Open the Object Designer and design codeunit 123456750 again.  
 
Now select View, C/AL Symbol Menu from the Menu Bar, or press the F5 key. 
You can also press the Symbol button on the Tool Bar. The following window 
should appear: 
 

 
 
If this does not immediately appear, scroll the left-hand panel until the function 
groupings appear in it, as shown above.  
 
Highlight the DIALOG choice to see some of the built-in functions that display 
on the screen. In the right-hand panel, highlight the MESSAGE function. Note 
that at the bottom of the frame (above the command buttons), a line appears that 
looks like this: 
 
MESSAGE(String [, Value1] …) 

 
This is to tell you the syntax of the function. Note that there is no return value, 
there is one required parameter (String), and there are multiple optional 
parameters. The square brackets indicate an optional parameter and the ellipsis 
indicates multiples.  
 
Now, highlight the ERROR function (just above MESSAGE). As you can see, its 
syntax looks like this: 
 
ERROR(String [, Value1] …) 
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The syntax of the ERROR function is identical to that of the MESSAGE function 
(except for the function identifier and the functionality.) When an ERROR 
function is called in a function call statement, the processing stops with an error 
condition and the message is displayed in a similar manner as the MESSAGE 
function. 
 
Now, in the left panel, highlight SYSTEM. Note that in the middle panel, there is 
now a list of various function groupings, like string functions, numeric 
(mathematical) functions, and so on. As you highlight each of these choices in 
the middle panel, the functions listed in the right-hand panel change. As an 
example, highlight “Date” in the middle panel and then, in the right-hand panel, 
highlight DATE2DMY. The syntax of this function now appears at the bottom of 
the window: 
 
Number := DATE2DMY(Date, What) 

 
The “Number :=” listed before the function identifier indicates that this function 
has a return value and that this return value is a number. The first parameter, 
“Date” is an expression of type date. But what could “What” (the second 
parameter) be? To find out, now that you have highlighted the DATE2DMY 
function, press the F1 key.  
 
The help screen displays for this function and you can read a complete 
description of what it does and what it returns. There, you find out that “What” is 
an integer expression that should resolve to one of three values. If it is a 1, then 
this function returns the day of the month. If it is a 2, then this function returns 
the month (from 1 to 12). If it is a 3, then this function returns the year (the full 4 
digits). 
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Using the DATE2DMY Function 
Here is an example of this function, which extracts the month from a date type 
variable and displays it as human readable text. You can try it in your Workbook 
Exercises codeunit to see how it works. 
 
"When Was It" := TODAY; 

CASE DATE2DMY("When Was It",2) OF 

 1:Description := 'January'; 

 2:Description := 'February'; 

 3:Description := 'March'; 

 4:Description := 'April'; 

 5:Description := 'May'; 

 6:Description := 'June'; 

 7:Description := 'July'; 

 8:Description := 'August'; 

 9:Description := 'September'; 

 10:Description := 'October'; 

 11:Description := 'November'; 

 12:Description := 'December'; 

END; 

MESSAGE('%1 is in %2',"When Was It",Description); 

 
Note that the first line in that code uses another function, called TODAY. This 
function has no parameters. It always returns the current date from your 
computer’s operating system, also known as the “system date. 
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Test Your Skills − Functions 
The questions on this self-test relate to the following code. Hand execute this 
code in order to determine each of the answers. Use the Symbol Menu and the 
Help system to determine what the various functions do. Note that all of these 
functions can be found in the String subsection of the SYSTEM section. Do not 
actually run this code in your test codeunit until you reach question 8. 
 
// UserInput is a Text variable of length 100. The other 
variables are Integers. 

 

UserInput := 'The colors are red, orange, yellow, green, 
blue and violet.'; 

Count := 0; 

 

REPEAT 

 Comma := STRPOS(UserInput,','); //Q1 

 IF Comma > 0 THEN BEGIN //Q2 

  Count := Count + 1; 

  UserInput := DELSTR(UserInput,Comma,1); //Q3 

  UserInput := COPYSTR(INSSTR(UserInput, 

 ' and',Comma),1,MAXSTRLEN(UserInput)); 

 END; 

UNTIL Comma <= 0; 

 

// Display Results 

MESSAGE('The sentence is "%1". Number of commas is 
%2.',UserInput,Count); 

 
1. What is the value of Comma after the statement labeled Q1 is 

executed the first time? 

 

2. Is the value of Comma ever less than 0 in this code (see statement 
labeled Q2)? 

 

3. What is the value of UserInput after the statement labeled Q3 is 
executed the first time? 

 

4. What is the value of Count when the comment line is reached the 
first time? 
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5. Suppose that UserInput was redefined so that it was a Text of length 
60. Now, what is its value when the MESSAGE function after the 
comment line is reached? 

 

6. Note that the end of the sentence can be lost under the above 
circumstances. Let's suppose that you modify the UNTIL clause of 
the REPEAT statement so that it looked like this: 

 

UNTIL (Comma <= 0) OR (STRLEN(UserInput) + 3 > 
MAXSTRLEN(UserInput)); 

 

7. Although better, this was not the desired result. Why didn’t it work? 

 Go ahead and run the above code in your test codeunit. Do not forget 
that you have to define some new variables. Now, make as simple 
change as you can to address the problem you uncovered in question 
7. Write your change here: 
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 Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 16: USING INTRINSIC C/AL FUNCTIONS 

Training Objectives 
In this chapter, you learn about: 
 

• The Essential C/AL Functions 
• User Communication Functions 
• String Functions 
• System Functions 
• Date Functions 
• Number Functions 
• Array Functions 
• Other Important Functions 
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The Essential C/AL Functions 
Although there are more than 100 functions in C/AL, you find that you use a 
limited set of these functions repeatedly, while the rest of the functions are used 
only occasionally. During basic application development you use perhaps no 
more than 20 different functions.  
 
This does not mean that the rest of functions are obsolete or that you never use 
them – but it does mean that if you are comfortable with this set of essential 
functions, you are able to go a long way in C/AL programming. As you need to 
add more specialized functionality to your applications – or you want to round 
them off by adding “bells and whistles” – you can familiarize yourself with the 
full set of functions. 
 
Below are some examples of how to use this set of essential functions. You 
should, however, always refer to the online C/SIDE Reference Guide and the 
Application Designers Guide for full and updated information on any C/AL 
function. 

Searching For Records 
The three functions described in this section are used to search for records. When 
you are going to search for records, it is important to remember the difference 
between GET and FIND – and how you can use FIND and NEXT in conjunction. 

GET 
GET retrieves one record, based on the value of the primary key. That is, if the 
No. field is the primary key of the Customer table, GET can be used like this: 
GET(Customer,’4711’); 
 
The result is that the record of customer 4711 is retrieved. GET is one of those 
functions that produce a runtime error if it fails and the return value is not 
inspected by the code, and otherwise not. This means that your actual code would 
probably look more like this: 
 
IF GET(Customer,'4711') THEN 

.... // do some processing 

ELSE 

.... // do some error processing 

 
GET searches for records, regardless of current filters, and it does not change any 
filters. In other words: GET always searches among all records in a table.  
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FIND 
An important difference between GET and FIND is that FIND respects (and is 
limited by) the current setting of filters. Further differences are that FIND can be 
instructed to look for records where the key value is equal to, larger than or 
smaller than the search string, and finally, FIND can find the first or the last 
record (given the sorting order defined by the current key). 
 
You can use these features in various ways. When developing applications under 
a relational database management system, you often have one-to-many 
relationships between tables.  
 
An example could be the relations between an Item table, which registers items, 
and a Sales Line table, which registers the detail lines from sales orders. 
Obviously, one record in the Sales Line table can only be related to one item, but 
each item can be related to any number of sales line records. You would not want 
an Item record deleted while there are still open sales order records that include 
the item. You can use FIND to check this.  
 
To do this, insert the following code in the OnDelete trigger of the Item table: 
 
SalesOrderLine.SETCURRENTKEY("Documentype",Type,"No."); 

SalesOrderLine.SETRANGE( 

 "Document Type",SalesOrderLine."Document Type"::Order); 

SalesOrderLine.SETRANGE(Type,SalesOrderLine.Type::Item); 

SalesOrderLine.SETRANGE("No.","No."); 

IF SalesOrderLine.FIND('-') THEN 

ERROR('You cannot delete because there are one or more 
outstanding sales orders that include this item.'); 

 

NEXT 
NEXT is often used with FIND to step through records of a table, as in this 
fragment: 
 
FIND('-'); 

REPEAT 

// process record 

UNTIL NEXT = 0; 

 
Here, FIND is used to go to the first record of the table. Afterwards, NEXT is 
used to step through every record, until there are no more (then, NEXT returns 0 
[zero]). 
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Sorting and Filtering Records 
These functions are used to filter records in a table, that is to set limits on the 
value of one or more specified fields, so that only a subset of the records are 
displayed, modified, deleted, and so forth. You also find a description of how to 
change the sorting of the records in a table. 

SETCURRENTKEY 
This function is used to select a key for a record, thereby setting the sorting order 
that used for the associated table. SETCURRENTKEY has this syntax: 
 
[Ok :=] Record.SETCURRENTKEY(Field1, [Field2],...) 

 
You should have these points in mind when you use SETCURRENTKEY: 
 

1. Fields that are not active are ignored 

2. When searching for a key, C/SIDE selects the first occurrence of the 
specified field(s). 

For example, even if you specify only one field as a parameter when calling 
SETCURRENTKEY, the key that is actually selected may consist of more fields; 
if several keys have as their first component the field that you specified, you may 
not get the key that you think you will. 
 
If no keys can be found that include the specified field(s), a runtime error occurs 
unless you test the boolean return value of SETCURRENTKEY in your code. If 
you do test the return value, you have to decide what to have the program do if 
the function returns FALSE, because without a runtime error, the program 
continues to run even though no key has been found. 

SETRANGE 
This function is used to set a delimitation on a field – that is, a simple filter. The 
syntax is: 
 
Record.SETRANGE(Field [,From-Value] [,To-Value]); 

 
As in this example: 
 
Customer.SETRANGE("No.",'10000','90000'); 

 
This would limit the Customer table by selecting only those records where the 
No. field has a value between 10000 and 90000. 
 
SETRANGE removes previous filters. If used without the From-Value/To-Value 
parameters, the function can be used to remove any filters that might already be 
set. 
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And, finally, if only From-Value is used, To-Value is set to the same value as 
From-Value. 

SETFILTER 
SETFILTER sets a filter in a more general way than SETRANGE. SETFILTER 
has this syntax: 
 
Record.SETFILTER(Field, String [, Value], ...]; 

 
Where Field is the name of the field to set a delimitation on. String is a filter 
expression that may contain %1, %2 and so on to indicate locations where the 
system inserts values (but not operators) given as the Value parameter(s) in a 
filter expression. 
 
Here are two examples of using SETFILTER: 
 
Customer.SETFILTER("No.", '>10000 & <> 20000'); 

 
This statement would select records where the No. is larger than 10000 and not 
equal to 20000. 
 
Customer.SETFILTER(“No.”,’>%1&<>%2’,Value1, Value2); 
If the variables V1 and V2 have been assigned “10000” and “20000”, 
respectively, this statement has the same effect as the first one. 

GETRANGEMIN 
This function retrieves the minimum value of the delimitation currently in effect 
for a field. GETRANGEMIN has this syntax: 
 
Record.GETRANGEMIN(Field); 

 
GETRANGEMIN causes a runtime error if the filter currently in effect is not a 
range. 
 
That is, if a filter has been set like this: 
 
Customer.SETFILTER("No.",'10000|20000|30000'); 

 
then 
 
BottomValue := Customer.GETRANGEMIN("No."); 

 
fails, since the filter is not a range. 

GETRANGEMAX 
GETRANGEMAX works like GETRANGEMIN, except that it retrieves the 
maximum value of the delimitation currently in effect. 
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Inserting, Modifying, and Deleting Records 
These functions are used to maintain the database by adding, modifying and 
removing records. Generally, these functions return a boolean value that indicates 
whether they succeed. If you do not handle the return value in your code, a 
runtime error occurs when a function returns FALSE. If you handle the return 
value – by testing its value in an IF statement – no error will occur, and you must 
take corrective action yourself (knowing that the function did not succeed, of 
course). 

INSERT 
This function inserts a record in a table, as in this example: 
 
Customer.INIT; 

Customer."No." := '4711'; 

Customer.Name := 'John Doe'; 

Customer.INSERT; 

 
These statements insert a new record, with No. and Name having the assigned 
values, while other fields have their default values. Supposing that No. is the 
primary key of the Customer table, the record is inserted in the Customer table 
unless there already is a record in the table with the same primary key. In that 
case, as the return value is not tested, an error message would be displayed. 

MODIFY 
This function is used to modify an already-existing record. Like INSERT, it 
returns a boolean – TRUE, if the record to be modified exists, FALSE otherwise. 
 
MODIFY is used like this: 
 
Customer.GET('4711'); 

Customer.Name := 'Richard Roe'; 

Customer.MODIFY; 

 
The statements above would change the name of customer 4711 to Richard Roe. 

MODIFYALL 
This function is used to do a bulk update of records. MODIFYALL respects the 
current filters, meaning that you can perform the update on a specified set of 
records within a table.  
 
MODIFYALL does not return any value, nor does it cause an error if the set of 
records to be changed is empty. 
 
You could use MODIFYALL like this: 
 
Customer.SETRANGE("Salesperson Code",'PS','PS'); 

Customer.MODIFYALL("Salesperson Code",'JR'); 
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The SETRANGE statement selects the records where Salesperson Code is PS, 
and MODIFYALL changes these records to have Salesperson Code set to JR. 

DELETE 
This function is used to delete a record from the database. The record to delete 
must be specified (using the value(s) in the primary key fields) before calling the 
function. This means that DELETE does take filters into consideration. Here is 
an example in which DELETE is used to delete the record with customer number 
4711: 
 
Customer."No." := '4711'; 

Customer.DELETE; 

 
DELETE returns a boolean value: TRUE if the record could be found, FALSE 
otherwise. Unless you test this value yourself, a runtime error occurs when 
DELETE fails (returns FALSE). 
 
When developing your application, you should consider this scenario: 
 

1. You retrieve a record from the database. 

2. You perform various checks to determine whether the record should 
be deleted. 

3. You delete the record, if step 2 indicated that you should. 

Now, this can cause problems if, in a multi-user environment, another user 
modifies or deletes the record between steps 2 and 3. If the record is modified, 
then perhaps the new contents of the record would have changed your decision to 
delete it. If it has been deleted by the other user, you can get a seemingly 
inexplicable runtime error if you have just verified that the record existed (in step 
1). If the design of your application indicates that you can encounter this 
problem, you should consider using the LOCKTABLE function (described 
below) – but LOCKTABLE should be used as sparingly as possible, since this 
function effectively short-circuits the concept of optimistic concurrency, thereby 
degrading performance. 

DELETEALL 
This function is used to delete all records that are selected by the filter settings – 
if no filters are set, all records in the table are deleted. 
 
The following statements would delete all records where Salesperson Code is 
PS from the Customer table: 
 
Customer.SETRANGE("Salesperson Code", 'PS', 'PS'); 

Customer.DELETEALL; 
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Transactions 
Normally, you do not need to be concerned with transactions and table locking 
when developing applications in C/SIDE. 
 
There are, however, some situations where you have to lock a table explicitly. 
For example, if you, in the beginning of a function, inspect data in a table, then 
use this data to perform various checks and calculations and finally want to write 
back a record, based upon the result of this processing, you want the values that 
you retrieved at the beginning to be consistent with the data in the table now. In 
short, you cannot allow other users to update the table while your function is 
busy doing its calculations. 

LOCKTABLE 
The solution is to lock the table yourself, at the beginning of your function, by 
using the LOCKTABLE function. 

Working with Fields 
These functions perform various actions on fields. 

CALCFIELDS 
The CALCFIELDS function is used to update FlowFields. As described in Form 
and Control Properties on page 116, FlowFields are automatically updated when 
they are direct source expressions of controls, but they must be explicitly 
calculated when they are not (that is, are part of a more complicated expression).  
 
When you use FlowFields in C/AL functions, you have to update them yourself, 
and this is what you use the CALCFIELDS function for. In the statements below, 
the SETRANGE function sets a filter, and then CALCFIELDS is called.  
 
CALCFIELDS calculate the Balance and Balance Due fields by taking account 
of the filter setting and performing the calculations that are defined as the 
CalcFormula properties of the FlowFields. 
 
SETRANGE("Date Filter",0D,TODAY); 

CALCFIELDS(Balance,"Balance Due"); 

 

CALCSUMS 
The CALCSUMS function is used to calculate the sum of one or more fields that 
are SumIndexFields in the record. For CALCSUMS to work, a key that contains 
the SumIndexFields must be selected as the current key. Like CALCFIELDS, 
CALCSUMS takes the current filter settings into account when performing the 
calculation. 
 

Page 294 



 

 

Chapter 16: Using Intrinsic C/AL Functions 

In the statements below, an appropriate key is selected. Then filters are set, and 
finally the summation is performed. 
 
SETCURRENTKEY("Customer No.") 

SETRANGE("Customer No.",'10000','50000'); 

SETRANGE(Date,0D,TODAY); 

CALCSUMS(Amount); 

 

FIELDERROR 
The FIELDERROR function triggers a runtime error after having displayed a 
field-related error message. The function is very similar to the ERROR function, 
but it has some benefits. For one thing, it is easier to use. The more important 
reason, however, is that if the name of a field is changed (for example translated 
to another language) in the Table Designer, the message from the FIELDERROR 
function reflects the current name of the field. 
 
FIELDERROR can be called simply as: 
 
Item.GET('70000'); 

IF Class <> 'HARDWARE' THEN 

 FIELDERROR(Class); 

 
This causes an appropriate message to be displayed, depending on whether Class 
currently is empty or has a value. 
 
An error message appears when a field has a “wrong” value. 
 
Finally, you can add your own text if the default texts do not suit your 
application. Then, you call FIELDERROR like this: 
 
IF Class < '4711' THEN 

FIELDERROR(Class,'must be greater than 4711'); 

 
and the FieldError message appears. 

FIELDNAME 
The FIELDNAME function returns the name of a field. Again, you could simply 
use the name, as you probably know it when you are writing the code, but by 
using FIELDNAME, you can create messages that are still meaningful if the field 
name is later changed. FIELDNAME could be used together with 
FIELDERROR, in a construction like this: 
 
FIELDERROR(Quantity,'must not be less than ' +  
FIELDNAME("Quantity Shipped")); 
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INIT 
The INIT function initializes a record. If a default value for a field has been 
defined (by the InitValue property), this value is used for the initialization – 
otherwise, there is a default value for each data type set. 
 
Note that INIT does not initialize the fields of the primary key. 

TESTFIELD 
This function is used to test a field against a value. If the test fails, that is if the 
values are not the same, an error message is displayed, and a runtime error is 
triggered, meaning that any changes made to the record is discarded. If the value 
to test against is the empty string, the field has to have a value other than blank or 
0 (zero). 
 
The following statements: 
 
Code := 'DK' 

TESTFIELD(Code,'ZX'); 

 
would give an error message. 

VALIDATE 
The VALIDATE function is used to call the OnValidate trigger of a field, as in 
this example, where it calls the OnValidate trigger of the Total Amount field: 
VALIDATE(“Total Amount”); 
 
The function is useful for centralizing processing – thus making your application 
easier to maintain. Suppose that the OnValidate trigger of the Total Amount 
field performs a calculation with values from three other fields as operands. 
 
If the contents of any of these fields changes, the calculation must be performed. 
You should avoid entering the calculation formula in the OnValidate triggers of 
each field – there are all sorts of possibilities for errors if the calculation formula 
later has to be changed.  
 
Instead, you should perform the calculation in the OnValidate trigger in only one 
of the fields and call this trigger code from the OnValidate triggers of the other 
fields. 

User Communication Functions 
The following functions give the user feedback and/or an opportunity for them to 
input information into the program –  

MESSAGE 
MESSAGE (String [, Value1, ...]) 
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The message function is run non-modally, meaning the remaining code in the 
process is run before the message. It displays a message to the user, but only after 
the process is complete. The window remains open until the user selects the OK 
button (or presses the Enter key) 
 
This function is often used for debugging purposes such as displaying values of 
variables. However, if an error is occurring and since it is run non-modally, the 
process stops and the message is not displayed. 
 
When working with strings, the plus character (“+”) is used to concatenate text 
and the backslash character (“\”) starts a new line. The “%” and “#” symbols may 
be used as variable placeholders. The percent is used for free format and the 
pound symbol is for fixed formats. 
 
Example: 
 
Value1 := 12345.678; 

Value2 := 987.65 

MESSAGE( 'The Free Format of Value1 is %1 \' + ' The Fixed 
Format of Value2 is #2#########', Value1, Value2); 

 
The message window shows: 
 
The Free Format of Value1 is 12,345.678 

The Fixed Format of Value2 is 987.65 

 

CONFIRM 
CONFIRM (String [, Default] [, Value1, ...]) 

 
This function is similar to the MESSAGE function, but allows the user to answer 
a question by selecting a Yes or No button. Then, the function returns a Boolean 
value (True or False), corresponding to the user’s selection. Since this is run 
modally, the system waits for the user’s response.  
 
CONFIRM is often used to confirm that the user wants to continue with a given 
process. Microsoft® Business Solutions–Navision® uses the CONFIRM functions 
prior to posting records. The user is given an opportunity to stop the posting 
process or to continue. 
 
The Default value is False, as are normal Boolean data types, therefore, the No 
button is the default button and is active. This means if the user just presses 
ENTER, the function returns a False. Normally, if the user selects the Yes button, 
then by setting the Default parameter to “TRUE” sets the Yes button to the 
default. 
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Example: 
 
IF NOT CONFIRM(‘Do you want to post the Journal Lines?’) 
THEN           

 EXIT() 

// Otherwise run the posting routine. 

 
The Confirm function is limited as to the options (Yes, No) that it allows. If other 
options are needed, there is another function that may be more useful, the 
STRMENU dialog function. 

STRMENU 
STRMENU (OptionString [, DefaultNumber]) 

 
This is used to create and display a form with an option group, returning the 
value (integer) of the user’s selection. If no default is provided, the default is the 
first element in the option string, with a value of 1. A zero value is returned if 
ESC is pressed, indicating no choice by the user. 
 
Example: 
 
MESSAGE(‘Your selection returns the value of %1’, 
STRMENU(‘Yes, No, N/A’)); 

ERROR 

ERROR(String [, Value1, ...]) 

 
This raises an error condition and leaves the current process, canceling the entire 
process (not just the function). So, if the code is in a transaction, the transaction 
is stopped and all uncommitted data is rolled back. 
 
It returns an Error message (String) to the user, which should inform them why 
further processing was not allowed. 
 
Example: 
 
IF Number <= 0 THEN BEGIN 

 ERROR(‘Number must be positive. Current value: %1.’, 
Number); 

 MESSAGE(‘This Message is never displayed’); 

END; 

 

String Functions 
These functions allow the programmer to manipulate strings. For more help, use 
the Microsoft Navision online documentation. 
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STRPOS 
Position := STRPOS(String, SubString) 

 
The STRPOS function is used to search for the first occurrence of a sub-string 
within a string. The returning value is the position of the first character of the 
sub-string within the string. If SubString is not found within String, the function 
returns a zero. As with all string functions, STRPOS is case sensitive. 
 

COPYSTR 
NewString := COPYSTR(String, Position [, Length]) 

 
The COPYSTR function is used to copy a sub-string of any length from a 
specific position in a string to a new string. If no length is provided, the result 
includes all characters from Position to the end of the string. 
 

PADSTR 
NewString := PADSTR(String, Length [, FillCharacter]) 

 
This is used to change the length of a string to a length you define. If the 
parameter ‘Length’ is smaller than the actual length of the string, the string is 
truncated. Otherwise it adds filler characters to the end of the string. If the 
parameter FillCharacter is not provided, then blanks are added. 
 
There are also two other functions that are similar to PADSTR. One is DELSTR, 
which is used to delete a sub-string from inside a string. There is also INSSTR, 
which inserts a sub-string into a string at a specified position. The Syntax for 
these functions is as follows: 
 
NewString := DELSTR(String, Position [, Length]) 

NewString := INSSTR(String, SubString, Position) 

 

STRLEN 
Length := STRLEN(String) 

 
This function returns an integer, which is the length of the string in the 
parameter. 
 

MAXSTRLEN 
MaxLength := MAXSTLEN(String) 

 
Similar to STRLEN, it also returns an integer, but that integer represents the 
maximum (defined) length for that string variable. 
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LOWERCASE and UPPERCASE 
NewString := LOWERCASE(String),   

NewString := UPPERCASE(String) 

 
Use these functions to convert a string to all lower-case or upper-case, 
respectively. 
 

CONVERTSTR 
NewString := CONVERTSTR(String, FromCharacters, 
ToCharacters) 

 
This function converts the characters in a string based on the characters in the 
strings FromCharacter and ToCharacters, which serve as conversion tables. 
 

DELCHR 
NewString := DELCHR(String [, Where] [, Which]) 

 
This is used to delete one or more characters in a string. It can delete characters 
from either end of the string or all instances throughout the string. Note that this 
can be used to trim strings of blanks: 
 
DELCHR(StringVar, '<>', ' ') 

 

INCSTR 
NewString := INCRSTR(String) 

 
Use this function to increase a positive number or decrease a negative number 
inside a string by one (1). If there is more than one number in a string, it changes 
the first number. 
 

SELECTSTR 
NewString := SELECTSTR(Number, CommaString) 

 
This function retrieves a substring from a comma-separated string. The 
substrings are numbered starting with 1. 
 

STRCHECKSUM 
CheckNumber := STRCHECKSUM(String [,WeightString] [, 
Modulus]) 

 
This is used for a variety of different applications such as barcodes. It calculates 
a checksum for a string containing a number. 
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System Functions 
These functions do not require any parameters since they return information that 
is stored in the system. 
 

USERID 
Name := USERID 

 
This function returns the ID of the current user. 
 

COMPANYNAME 
Name := COMPANYNAME 

 
This function returns the current company that the program is using. 
 

TODAY and TIME 
DateVar := TODAY, TimeVar := TIME 

 
These functions return the operating system’s date and time. 
 

WORKDATE 
[WorkDate] := WORKDATE([NewDate]) 

 
This function returns the current workdate or may be used to reset the workdate. 
Although the developer can change the workdate, note that in standard Microsoft 
Navision applications, ONLY the USER should change the Workdate, it should 
not be changed in code. 

Date Functions 
These functions provide specific information about a given date.  
 

DATE2DMY 
IntegerVar := DATE2DMY(Date, Integer) 

 
This function returns information about the parameter ‘Date’. Set ‘Integer’ to ‘1’ 
to return the day of the month (1-31), set Integer to ‘2’ to return the month (1-
12), or to ‘3’ to return the year (0000-9999). 
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DATE2DWY 
IntegerVar := DATE2DWY(Date, Integer) 

 
This function also returns information about the parameter ‘Date’. Set ‘Integer’ 
to ‘1’ to return the day of the week (1-7, remember that day 1 is Monday), set 
Integer to ‘2’ to return the Week number (1-53), or to ‘3’ to return the year 
(0000-9999). 
 

CALCDATE 
CALCDATE(DateExpression [, Date]) 

 
CALCDATE is a very powerful function. It can calculate a new date based on a 
date expression and a reference date. Calculating dates based on document dates, 
posting dates, invoicing dates, and so on, is common throughout Microsoft 
Navision. 
 
Here are some examples of a DateExpression: 
 
‘CQ + 1M – 10D’: Last Day of Current Quarter + 1 Month – 10 
Days 

‘-WD2’:  Last 2nd Day of the Week, (last Tuesday) 

‘CM + 30D’:  Last Day of Current Month + 30 Days 

 

Calcdate(‘CM +15D’, 030502D) returns 04/15/02.  

 
Calcdate starts with the March 5, 2002 reference date and goes to the last day of 
that current month (CM). This brings us to 03/31/02. Then it adds 15 days, which 
is April 15, 2002. 
 
The date expression can be any length; it must have at least one SubExpression. 
The system interprets the string from left to right, one SubExpression at a time. 
The SubExpression is either a positive or negative Term value. 
 
The Term value may be a Number-Unit combination, a Unit-Number 
combination or a Prefix-Unit combination. The Number is a positive integer. The 
Unit may be one of the following: 
 
D (Date) 

WD (WeekDay) 

W (Week) 

M (Month) 

Q (Quarter) 

P (Period) 

Y (Year) 
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There is one Prefix: C, which stands for the Closing date of that period. The 
closing date for a quarter would represent 12:59 PM of the last day of the last 
month in the quarter.  
 
Every date, from 01/01/0000 to 12/31/9999 has a corresponding normal date and 
closing date, used for closing journal entries. To the system, a closing date 
represents 12:59 PM of that date. Closing dates are sorted immediately after the 
corresponding normal date, but before the next normal date. The letter “D” 
indicates a normal date, and “C” indicates a closing date. These functions 
determine which type of date is being used: 
 

NORMALDATE 
ReturnDate := NORMALDATE(Date) 

 
A very common place to see this function is in the posting routines. For example 
posting dates or invoice dates must be Normal dates. The following code ensures 
that only Normal dates are posted.  
 
Example:  
 
IF "Posting Date" <> NORMALDATE("Posting Date") THEN 

 ERROR(‘Posting Date cannot be a closing date'); 

 

CLOSINGDATE 
ReturnDate := CLOSINGDATE(Date) 

 
This function is the opposite of the above function and can be used to return the 
corresponding Closing date. 

Number Functions 
Most of these are rarely used, with the exception of the Round function. That 
function is used quite often when dealing with currency and tax. 
 

ABS 
NewNumber := ABS(Number) 

 
This function returns the absolute value of the number. 

POWER 
NewNumber := POWER(Number, Power) 
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This function raises the Number parameter to the Power parameter. This can also 
calculate roots. For example, to calculate the square root of 16… POWER(16, .5) 
returns 4.  

ROUND 
NewNumber := ROUND(Number [,Precision] [, Direction]) 

 
This function returns a rounded number. The Precision parameter determines the 
precision used when rounding off. The default value is .01 for the US version, 
however settings in the G/L setups can affect this. The Direction parameter 
details how to round: 
 
=  Rounds to the nearest value (default) 

>  Rounds up 

<  Rounds Down. 

 

RANDOMIZE 
RANDOMIZE ([Seed]) 

 
This function generates a set of random numbers. Seed is an optional integer 
value that is used to create a unique set of numbers. Using the same seed number 
results in the same set. If the parameter is omitted, the current system time (total 
number of milliseconds since midnight) is used. 

RANDOM 
Number := RANDOM(MaxNumber) 

 
Using the random number set from the RANDOMIZE function, this returns a 
pseudo-random number between 1 and MaxNumber. Until RANDOMIZE is 
called again, RANDOM chooses a number from the same set of numbers. 

Array Functions 
Arrays are not frequently used in Microsoft Navision, however they are often 
used in reports for address and label information. 
 

ARRAYLEN 
Length := ARRAYLEN(Array [, Dimension]) 

 
Returns the total number of elements in an array or the number of elements in a 
specific dimension. A 3-Dimensional array would have valid dimensions of 1, 2, 
and 3. If, in this case no dimension were given, then the return value would 
represent the number of elements in the whole array, not just a dimension. 
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COMPRESSARRAY 
[Count :=] COMPRESSARRAY(StringArray) 

 
This function is only useful for text or code arrays. It moves all the non-empty 
strings of the array to the beginning of the array. The array contains the same 
number of elements, however, the empty entries and those that contain only 
blanks appear at the end of the array. 
 
If a return value is captured, it represents the number of non-empty strings the 
system compressed. 
 
A good example of using this function would be when printing names and 
addresses. This function would be useful to remove blank lines in account 
statements or from multi-line addresses. 

COPYARRAY 
COPYARRAY(NewArray, Array, Position [, Length]) 

 
This copies one or more elements in an array to a new array. Position is the 
position of the first array element to copy, while the optional Length is the 
number of array elements to copy. If Length is not included, then all array 
elements from Position to the last element are copied. This is only used for 1 
dimensional arrays. Repeat this function to copy more dimensions. 

Other Important Functions 
These are important functions that are used throughout Microsoft Navision. 

EXIT  
EXIT (Value) 

 
This command leaves the current function or trigger immediately. If there is a 
parent function that called this current function or trigger, then the value is 
returned to the calling function. This does NOT cause an error condition or 
rollback any data. 
 
Example: 
 
Function AddTen (Number : Integer) : Integer 

BEGIN 

 Exit(Number + 10); 

 Message (‘This line is never read.’) 

END; 
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CLEAR 
CLEAR(Variable) 

 
This clears the value of a single variable (or all elements of an array) to the 
following: 
 
Variable Type  Clearing Result 

Number  0 (zero) 

String  empty string 

Date  0D (undefined date) 

Time  0T (undefined time) 

Boolean  FALSE 

 

CLEARALL 
This parameters-less function clears all internal variables in the current object 
and in any called objects such as reports, units of code and so on that contain 
C/AL code. It works by calling CLEAR repeatedly for each variable. 
 
When an object is called repeatedly within the same process, the system retains 
all values for variables and filters in memory between calls. Using CLEARALL 
clears all of this. 

EVALUATE 
[Ok := ] EVALUATE (Variable, String) 

 
Use this function to convert a string expression into another appropriate data 
type. The result is assigned to the Variable parameter. This function can convert 
string expressions into Decimal, Integer, Date, Time, Boolean, Option, Text and 
Code data types.  

FORMAT 
String := FORMAT(Value [, Length] [, FormatNumber | 
FormatString]) 

 
This is a very powerful function that takes some time to fully master. At the very 
basic level, it can convert any type of variable to a string variable. The following 
changes a decimal variable to a string: 
 
TextVar := Format(DecimalVar); 

 
The parameter Length (integer) can ensure that if the value is larger than the 
maximum length that the String allows, then a run-time error does not occur. 
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If length = 0, then the system returns the entire value (default). 
 
If length > 0, then String is exactly Length characters. If Value is less than 
Length characters, the system inserts either leading or trailing spaces, depending 
on the format you select. If Value exceeds Length characters, the system 
truncates String accordingly. 
 
If length < 0, then String has the maximum length of Length characters. If Value 
is less than Length characters, the length of String equals the length of Value. If 
Value exceeds Length characters, the system truncates String accordingly. 
 
Only one of the next two parameters is used at any time. FormatNumber 
determines the format the system uses. The basic options are: 
 
0 Standard Display Format (the default for all data types)
  

1 Standard Display Format 2 (edit)  

2  C/AL Code Constant Format  

 
Other options are available depending upon the datatype. See the online help for 
more information. 
 
FormatString is more powerful; it is a literal string that defines a format as in the 
Format property. This property describes the various predefined formats in detail, 
and also how to create customized formats. 
 
Examples: 
 
MESSAGE('The formatted value: %1', FORMAT(-123456.78, 15, 
0)); 

The message window shows – The formatted value: 123,456.78 
 
MESSAGE('The formatted value: %1', FORMAT(-123456.78, 5, 
3));  // Changed length to 5 

The message window shows – The formatted value: 123,4 
 
MESSAGE('Today is %1', FORMAT(TODAY,0,'<Month Text> 
<Day>.'); 

 
The message window shows – Today is April 15. 
 
A common request is to show negative numbers as strings with parenthesis 
instead of minus signs. If this is part of a vertical list of numbers, one also might 
want to add a trailing space at the end of the positive numbers (so that negative 
amounts, with their added parenthesis, align with the positive amounts). Here is a 
way to do it using the FORMAT function: 
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IF DecimalVar < 0 THEN 
 
  StringVar := FORMAT(DecimalVar, 0, '(<Integer 
Thousand><decimals>)') 

 

ELSE 
  StringVar := FORMAT (DecimalVar, 0, '<Integer 
Thousand><decimals> ')   

 
Note, the ‘<’ and ‘>’ signs are part of the FormatString parameter. For the 
negative values, note the parenthesis inside the single quotes and for the positive 
values, note the space before the last single quote for alignment. 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 17: CREATING YOUR OWN FUNCTIONS 

Training Objectives 
In this chapter, you learn about: 
 

• Why You Create Functions 
• Formal and Actual Parameters 
• Local Functions and Variables 
• The EXIT Statement 
• Creating Functions 
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Why Create Functions? 
We have been able to create programs that are quite useful without using 
functions. Why should we create them now? It is true that you can program 
without creating functions. Also, for almost anything you might need to do in 
C/SIDE, you do not have to create functions in order to create the functionality 
required. However, there are some very good reasons why programmers create 
functions. Here are a few: 
 

• To organize your program. A function is to your code what the 
headings are to a well-organized written document. They make your 
program easier to follow, not only for yourself, but also to other 
programmers who may need to modify your code later.  

• To simplify your tasks. When you are designing your program, you 
can break a complex problem into multiple smaller tasks. Each of 
these tasks can become a function in your program and the whole 
program can be put together from these smaller tasks. Should a 
function turn out to be too complex, you can do the same thing 
again: break it apart into smaller tasks and create a new function for 
each task. 

• To reduce your work by re-using code. If you find that you are doing 
the exact same thing, or very similar things, in two separate parts of 
your program, consider creating a function to do that task. Then, 
rather than writing the same or similar code in two or three places, 
you can write it in one place and call it from other places. 

• To reduce the chance of errors. A function can be tested thoroughly 
by itself, using special test programs to test all possibilities. Thus, 
when it is used in another place, it is a known quantity; when you are 
searching for errors, you can reduce your search. Similarly, should 
an error be found in a function, it can be fixed in one place and it is 
automatically fixed in all the places that called that function. If you 
had to fix it in each place, then you might forget one, or you might 
even add another bug. 

• To make modifications easier. If you do need to modify the way your 
program works and you have similar code in many places, you have 
to make your modifications to each of those places. If you have put 
that common code in a function, you can make your modification to 
one place and every place that uses that function is updated as well. 
This reduces your work and reduces the chance of introducing more 
errors. 

• To localize data. When a function performs a task, it can have its 
own local data that cannot be tampered with by other functions in the 
same object. By using its own local data, it does not tamper with data 
owned by those other functions. If you have global variables used by 
many tasks throughout your program, there is a good chance that this 
data may become corrupted. 
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• To reduce the size of your objects. Although a minor consideration, 
it can be worthwhile, especially when you are trying to locate 
something in your code. 

 
There are many good reasons to create functions. In fact, when you are designing 
code for an object, the first thing you should do is figure out your major tasks and 
create (define) a function for each one. Then, as you discover yourself doing 
similar things in different places, always consider adding another function to 
handle that task. 
 
Another reason to create functions, which is specific to C/SIDE, is that functions 
are one of the main ways to communicate between objects. Remember that 
variables cannot be shared across objects, but functions can be. This is discussed 
in more detail in your Solution Developer class. 

Formal and Actual Parameters 

Formal Parameter 
This is a parameter as defined in the function definition. In the previous chapter's 
exercise, we used the DELSTR function. When you look up the DELSTR 
function in the Symbol Menu, it listed the syntax as: 
 
NewString := DELSTR(String, Position [, Length]) 

 
The words that appear in parentheses are the formal parameters. If you were able 
to see the trigger code for a built-in function, these formal parameters could be 
used as variables in that trigger code. 

Actual Parameter 
The actual parameter is what you use when you call the function. When we 
called the DELSTR function in the above-mentioned exercise, we used the 
following line: 
 
UserInput := DELSTR(UserInput,Comma,1); 

 
The constant and variables that appear in the parentheses are the actual 
parameters.  
 
Note that there is a one-to-one correspondence between the actual parameters and 
the formal parameters. The actual parameter "UserInput" becomes the formal 
parameter "String", the actual parameter "Comma" becomes the formal 
parameter "Position' and the actual parameter "1" becomes the formal parameter 
"Length". 
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Since we are using pass by value for all three parameters, what we are actually 
passing to the function are the values of the three actual parameters. Thus, the 
actual parameters are not changed when the formal parameters are changed 
inside the function.  
 
If we had used pass by reference, we would be passing the variable references 
(memory addresses) to the function. Then the actual parameters would be 
changed if the corresponding formal parameters were changed inside the 
function. Naturally, since constants cannot be changed, we would not have been 
able to use "1" as an actual parameter if Length were being passed by reference; 
it would have generated a syntax error. 

Local Functions and Variables 

Local Function 
A local function is a function that can only be called in the object in which it is 
defined. Any function that has not been defined as a local function can be called 
from other objects as well as the object in which it is defined. 

Local Variable 
A local variable is a variable whose scope is limited to a single function. This 
means that in this function's trigger code, a local variable can be used like any 
other variable. However, throughout the rest of the object, this variable cannot be 
accessed at all. If the name of a local variable is referred to outside of the 
function in which it is defined, a syntax error results. The formal parameters of a 
function are also treated as local variables in that function. 

The EXIT Statement 
Recall that the EXIT statement is used to stop the execution of a trigger. It can be 
used in this manner for function Triggers as well. However, in functions, the 
EXIT statement has an additional use.  
 
When a function call is used in an expression, the function is required to return a 
value. When you write your own function that has a return value, you signal to 
the system to return this value by using the EXIT statement. Below is the syntax: 
 
EXIT(<expression>); 

 
For example, let's create a function named "Square" which is used to square a 
value. The following expression: 
 
Answer := 4 + Square(5); 
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would result in Answer being assigned the value 29. The Square function's 
trigger code could be written like this if the formal parameter is called "Param". 
 
EXIT(Param * Param); 

 
The EXIT statement's parameter was the expression that squared the parameter 
and that is what the function returns to its caller. 

Creating Functions 
Go into the Object Designer, select Form 123456756 and click Design. Move the 
Sort Command Button control by dragging it to the upper right-hand corner of 
the form.  
 
Select the Execute Command Button control. Press the Copy button on the Tool 
Bar (or press CTRL+C on the keyboard). Click any place on the form that does 
not have a control on it. Now, press the Paste button on the Tool Bar (or press 
CTRL+V on the keyboard). A copy of the Execute button is placed in the upper 
left corner of the form. Now drag this copy next to the original Execute button. 
 
Go into the Properties for the left-hand button and change the Caption property to 
"Sale". Now, select the original Execute button and change the Caption property 
to "Credit". At this point, your form should look like this: 
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Defining a Function 
Now, go into the Globals list by selecting View, C/AL Globals on the Menu Bar. 
Note that there are three tabs on this form and, up until now, you have always 
used the first tab. This time, click the 3rd tab, Functions. This is where you go to 
define a Function. The cursor should now be in the Name column. Enter the 
name of the first function, which is: 

Accumulate 
While on the line that now says Accumulate, display the Properties form. Note 
that one of the Properties is called Local. Since you do not want this function to 
be called from any object outside of this form, set this property to Yes. This 
makes the new function a Local Function.  
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Close the Properties window 
Back on the Globals form, press the Locals button. Another form comes up, 
called Locals. This form is used to complete the definition of your new 
Accumulate function, so it should say Accumulate in its title bar, as shown here: 
 

 
 
By the four tabs at the top of this form, it is apparent that you can set up the 
formal Parameters for the function, the Return Value, Local Variables and Text 
Constants you may need. On this function, we just need a single parameter. 
Add the following Local Parameter to the current variable list: 
 
 Qty  Integer 

 
The column labeled Var is used if you want this parameter to be passed by 
reference. A parameter passed by reference must be a variable (not an 
expression) and that is why this column is labeled Var, which is short for 
Variable. In this case, you do not check this column. 
 
Close this form so you can return to the Globals form, still on the Functions tab. 
We have completed the definition of the Accumulate function. 

Defining Additional Functions 
Now, add another line to the Function List, this time named: 
 
 Extend 

 
Set its Local property to Yes, as we did above for the Accumulate function. Now 
press the Locals button and create two parameters.  
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Parameters: 
 
 Qty  Integer 

 Unit  Decimal 

 
Now, select the second tab on the Locals form, "Returnvalue". Click on the 
down-arrow button in the Return Type field to bring down the list of possible 
return types. Select Decimal as the Return Type of this function.  
 

 
 
Close the Locals form. This completes the definition of the Extend function. 
 
Add a third line to the Function List, this time named  
 
AddToArray 

 
Set its Local property to Yes and then press the Locals button. Add an Integer 
parameter called CurLen. This time, click in the Var column, so that a check 
mark appears to the left of CurLen. This sets CurLen to a Var parameter, which 
means it is passed by reference rather than by value.  
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Add a second parameter, called NumToAdd, with a type of Decimal. This one is 
not a Var parameter, so do not check the Var column. It is a passed by value. 
 

 
 
This time, select the tab on the Locals form named Variables. Add an Integer 
variable named idx. Then, close the Locals Form and close the Globals form. 
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Adding Code to Your Functions 
Click the Sale Command Button and then the Code button (or press the F9 key). 
Scroll down and you see your three new functions, looking like this: 
 

 
 
If these three Function Trigger lines do not look like the example, go back to 
VIEW→GLOBALS and correct the function definitions you entered above. 
 
Now, fill in the trigger code for each of these three functions, as shown below. 
Note that all of this code is very similar to the code that is in the OnPush trigger 
of the Sale button. If you feel comfortable with it, you can copy the code from 
there and paste it into these functions. Then modify the code to match the 
following: 
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Calling Your Functions 
Now, scroll up to the OnPush code of the Sale Command button and modify it 
so it looks like this: 
 

 
 
Close the code form and then click on the Credit Command button. Display the 
code form again and modify the OnPush trigger code of the Credit Command 
button so it looks like this: 
 

 
 
Note that both routines are small and they are very similar. The only difference is 
that the Credit button turns the Quantity negative before calling the functions. 
This means that the user does not enter negative quantities any more. Instead, 
they just enter quantities and then press either the Sale or the Credit button, 
depending on what kind of transaction it is.  
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Finally, Select the "Quantity" text box and look at its properties. Modify the 
MinQty Property to be 0 (zero). 
 

 
 
Close and save this Form Object, then run it and try it out. 
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Test Your Skills − Creating Your Own Functions 
Go into the Object Designer and find codeunit 1 (named 
"ApplicationManagement"). Open it and answer the following questions by 
looking at this object. Remember: If a question is about the Function Definition, 
it would be best to look at the Globals form (the Functions tab) and the Locals 
form. If a question is about the code, it would be best to look at the trigger code. 
 

1. How many Parameters does the LoginStart function have? 

 

2. What type of value (if any) is returned by the ReadRounding 
function? 

 

3. In the ReadSymbol function, is the first parameter (Token) passed by 
value or passed by reference? 

 

4. In the ReadSymbol function, is the second parameter (Text) passed 
by value or passed by reference? 

 

5. In the AutoFormatTranslate function, how many local variables are 
defined? 

 

6. Look at the code for the AutoFormatTranslate function. How many 
lines in that trigger code could return the value of this function? 

 

7. Look at the code and the definition of the ApplicationLanguage 
function. Is there anything in this function that affects any data 
outside this function (not counting the return value)? If so, what? 

 

8. Look at the code and the definition of the ReadCharacter function. Is 
there anything in this function that affects any data outside this 
function (not counting the return value)? If so, what? 

 

Page 323 



 

 

Microsoft Navision Development I − C/SIDE Introduction 

 Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 18: REPORTS  
Reports are used to print information from a database. A report can be used to 
structure and summarize information, and reports can be used to print documents 
such as invoices. Reports can also be used to process data without printing 
anything. 

Training Objectives 
In this chapter, you learn about: 
 

• Reports 
• Types of Printed Reports 
• The Report Designers 
• Learning How Sections Work 
• Some Useful Properties 
• Grouping Within a Report 
• Totaling Within a Report 
• Adding Some Advanced Features 
• Creating a Basic Report for Yourself 
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Reports 
Reports in C/SIDE have several purposes: 
 

• Reports are used to print information from a database in a structured 
way. For example, in a sales order application, you can create a 
report that contains a list of all customers and for each customer, lists 
all orders placed by that customer. An example of this would be 
Report 301 − "Vendor − List". 

• All documents pertaining to an application must be created as 
reports. For example, in order to print an invoice, you create a report 
that is automatically filled out with the relevant information. See 
Report 206 − "Sales − Invoice" as an example. 

• Reports can be non-printing. While this may sound like a 
contradiction in terms, it is not. A report can be used to automate 
many recurring tasks such as updating all prices in an item list. This 
could be performed entirely from C/AL code in a codeunit, but using 
a report makes it a lot easier because you can use the powerful data 
modeling available for report design. An example of this would be 
Report 5168 − "Export To-dos to Outlook". 

 
The following diagram shows the components of a report and their relationship. 
This and the following chapters explore all components in depth. 
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The Report Components 
The diagram outlines how a report is composed from a number of different 
components. Below you find a short description of each component. 

Report Description  
This is the total description of the report − how data is collected and how data is 
presented on paper when the report is run. The report description is stored in the 
database. 

Data Item  
A data item corresponds to a table. In order to retrieve information from the 
tables in the database, you define data items. When a report uses more than one 
table, you set relations between the data items in order to retrieve and organize 
data in the way that you want. 

Section  
In a printing report, each data item could have one or more sections. A section 
can be thought of as a block of information to print on the paper. The complete 
report is composed of a number of sections, some that are printed only once like 
a grand total, some that are printed once per page, for example a header and some 
that are printed for each record that is retrieved from the database. 

Control  
The information that is printed in the sections is composed of controls. The 
available controls are text boxes, for printing the result of the evaluation of any 
valid C/AL expression such as the contents of a table field (but also complex 
calculations), labels for printing static text such as a caption for a column of data, 
and shapes, images and picture boxes, for printing graphical elements (lines, 
circles) and bitmap pictures in a report. 

Request Form  
A request form is a form that is run before the actual report begins execution. It is 
used to gather requests and options from the user of the report−for example, sort 
order or level of detail. 

Property  
A property is an attribute of an object − report, data item, section and so forth − 
that characterizes the object in some way − color, size, whether it is displayed, 
and much else. Properties are set on the Property Sheet of an object. 

Trigger  
Certain predefined events that happen to a report cause the system to execute a 
user-definable C/AL function − the event triggers the function. As you can see in 
the diagram, the report itself, the data items, the sections, the request form and 
the controls on the request form all have triggers. Triggers are edited in the C/AL 
editor. 
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Logical and Visual Design 
There are two sides to designing a report: defining the logical structure, the data 
model and designing the visual layout. 
 
Defining the data model means defining how the data for the report is collected. 
This includes: 
 

• Defining the tables the report uses by creating data items. 
• Defining relationships between data items if the report uses more 

than one table. 
• Defining the key, sort order and filters to use with the involved data 

items. 
• Defining which elements the user is able to change at run time. 
• Defining how data is to be grouped. 
• Defining how subtotals and totals are to be calculated. 
• Possibly writing C/AL code in data item triggers to obtain advanced 

functionality. 
 

Data Items  
The data model of a report is built from data items. A data item corresponds to a 
table. When the report is run, each data item is iterated for all records in the 
underlying table. When a report is based on more than one table, you establish a 
hierarchy of data items to control how the information is gathered by indenting 
data items. 

Example 
In order to make a report that prints out a list of customers and for each customer 
lists sales orders placed by that customer, you define two data items − one that 
corresponds to the Customer table and one that corresponds to the Sales Order 
table. The second data item is indented − as the report works its way through the 
records in the Customer table, for each customer all sales orders that are related 
to this customer must be found by going through the records in the Sales Order 
table. 

Sections  
The visual layout of a report includes the sections. In a printing report (remember 
that reports do not have to print anything), one or more sections can be attached 
to each data item. There are several types of sections, each having a specific 
function. Normally, the bulk of the data is printed out in the body section of a 
data item, while the header section of the data item is used to print information 
before any record of the data item is printed (for example, column captions), but 
there are reports − like some of the examples in the lab manual − where the body 
section is not used at all, and all information is printed in other sections. 
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The following shows a finished report. 
 

 
 
The report prints sales statistics information and retrieves all its data from one 
table. It demonstrates a range of the features that are available for designing 
reports. 
 

• Before any record from the table is printed, there is a header − 
containing a title and information about the filter that was used on 
the customer numbers. 

• Each body section prints information about a customer on several 
lines. The "Profit %" lines are calculated as the report is run. 

• After all records (all records that were selected by the filter that is) 
have been printed, a footer section is printed that contains totals for 
the selected customers. 

• In the body section and in the footer section, a filter has been applied 
to create columns where data are collected and totaled for different 
periods. 
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Types of Printed Reports 
In this section, you learn about the types of reports that are found in a normal 
functional area. The types of reports are not nearly so formal as the types of 
forms or tables. This is just a brief outline that helps you in further discussions 
about the system architecture. 

List Reports 
A List report contains a single DataItem that is the table that is being listed. The 
table is either a Master table or a Supplemental table.  
 
Each column contains a field from the table, and the data is printed from that 
table, not brought in from other tables or calculated from other tables.  
 
The name is usually the name of the table followed by the word "List", or 
sometimes followed by the word "Listing". 
 
Examples: 
 

• Customer Listing 
• Item List 
• Department List 

 

Test Reports 
A Test report is a report printed from a Journal Table. Its purpose is to test each 
of the Journal Lines according to the same criteria that are used for Posting, so 
that all of the errors can be found and fixed before posting.  
 
Once an error is found during posting, processing stops and the error must be 
fixed before Posting can be attempted again. Thus, in a journal with multiple 
errors, a Test report is a good way of finding these errors.  
 
The name is usually the name of the corresponding Journal form followed by the 
word "Test". 
 
Examples: 
 

• General Journal − Test 
• Resource Journal − Test 
• Payroll Journal Test Report 
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Posting Reports 
A Posting report can be printed as part of the "post and print" option on a Journal. 
It is actually a report that is printed from the Register, and has the same name as 
that Register. It lists all of the transactions (that is, Ledger Entries) that have been 
posted into that Register. 
 
Examples: 
 

• G/L Register 
• Item Register 
• Payroll Register 

 

Transaction Reports 
A Transaction report has two DataItems. The first is the Master table, and the 
second is the corresponding Ledger table.  
 
Normally, a Transaction Report lists all of the ledger entries for each record in 
the Ledger table.  
 
Normally, there is a subtotal for each Master table record, and a grand total for 
all tables printed.  
 
This report is used to view all transactions for a particular Master record.  
 
There is no standard name for this kind of report. 
 
Examples: 
 

• Trial Balance Detail/Summary 
• Vendor Account Detail 
• Employee Transaction Detail 

 

Other "Normal" Reports 
Reports are more loosely defined than other application objects because they are 
so often customized for a particular client. However, most reports consist of a 
tabular listing with records listed horizontally and each field displaying in its own 
column. Many times, there is some sort of group heading or total to split the lines 
among various categories and subtotal the lines by the categories. 
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Examples: 
 

• Item Status by Salesperson 
• Vendor 1099 Information 
• Item Sales by Customer 

 

Document Reports 
Document reports are different from most other reports, in that, many of the 
fields are not displayed in columns.  
 
An example of this kind of report is an Invoice, where the header information is 
printed as though filling out an invoice document, and where this header 
information is repeated at the top of each page and where no page has 
information from more than one header.  
 
The lines for the invoice print out more like a normal report in rows and columns. 
The lines correspond to the header on the same page, and lines from other 
invoices do not display on the same page. 
 
Examples: 
 

• Sales Invoice 
• Customer Statement 
• Purchase Order 

 

The Report Designers 
The Report Designer contains two additional designers − the Section Designer, 
used for designing the layout of reports, and the Request Options Form Designer, 
used for designing request options forms. 

The Report Designer 
When you select a report in the Object Designer and press the Design button, you 
are taken into the Report Designer.  
 
In the Report Designer window, you define the Data Model by adding Data 
items. 
 

Page 332 



 

 

Chapter 18: Reports 

In the Report Designer window, you can specify the tables that the report reads. 
It is important to note that any table mentioned here is read in its entirety during 
the report. In order to limit the number of records read, you should link and filter 
Data items. You could actually read the same table more than once in the same 
report by listing it more than once in the Report Designer. For example, you may 
want to read customers that are not blocked first and then customers that are 
blocked. 
 
The tables you list become Data items in the report. Data items are record 
variables (just like you would use in code) that allow the report to access the data 
of a table.  
 
The right column in the Report Designer is the Name that the Data item goes by 
throughout the report. Like all variable names, these names should be unique 
within the report.  
 
You can use the Report Designer to specify how the report engine should read 
the underlying tables: 

Ordering the Data items 
The order in which the Data items are listed is the order that the report reads the 
data from the tables. At the bottom of the Report Designer window there are four 
arrow buttons. You can use the up and down arrow buttons to reorder the Data 
items.  

Indenting a Data item 
You can use the right and left buttons to indent or unindent a Data item. 
Indenting a Data item under another Data item effects the report in this way − 
For every record read from the top Data item, all records are read from the 
indented Data item (this takes into account any filters or links). (This is similar to 
a nested FOR loop.) 

Linking a Data item 
Each Data item has a property called DataItemLinkReference and a property 
called DataItemLink. Usually, these are used to define a Master/Detail 
relationship between the two tables. In the LinkReference property, you can 
choose which other Data item you would like to link to (this must be a Data item 
that this Data item is indented under). In the DataItemLink property, you can 
specify a filter for this Data item by matching fields in this Data item with fields 
from the LinkReference Data item. 
 
NOTE: A proper key should be selected for the indented data item. It should contain 
the fields that are being used to link the data item. 
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Creating a Data Model 
This exercise helps you understand some of the basic design principles of 
creating a Microsoft Navision Report. In this half of the exercise, you create the 
data model in the Report Designer. 
 
This report sorts the Customer table by Salesperson Code. Before getting started 
with the report, we must first add a key to the Customer table. By now you 
should be familiar with adding keys to a table, but if not: 
 

1. Open the Object Designer 

2. Click Table 

3. Select Table 18 − Customer 

4. Click the Design button 

5. Select VIEW→KEYS and add the key of "Salesperson Code" as shown 
in the following diagram: 

 

 
 

6. Close the designer for Table 18. 

 Now we are ready to start the report. 

7. Open the Object Designer 

8. Click Report. 
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9. Click New. The New Report window appears. You are not using the 
Report Wizard because it limits you to one table. 

 

 
 

10. Click OK. The Report Designer appears. 

 

 
 

11. Click on the first empty line in the Report Designer and enter the 
number or name of the Salesperson/Purchaser table (13). 

12. Click on the next empty line in the Report Designer and enter the 
number or name of the Customer table (18).  

 Because you want the report to look at customers by salesperson, 
you must set it up so that it first reads the salesperson table. Then, for 
each salesperson record, it reads all the customers for that 
salesperson. This is done by indenting the customer data item under 
the salesperson data item and linking the two. See the following 
steps for detailed instructions. 
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13. Indent the Customer data item by clicking the right arrow button at 
the bottom of the form. 

 

 
 

14. With the customer data item still selected, bring up the properties for 
that data item. 

15. Click on the DataItemLinkReference property. Verify that it is set to 
Salesperson/Purchaser.  

16. Click on the DataItemLink property. You need to match the fields 
that link the two tables.  

17. Click the Assist-Edit button. 

18. In the Field column, choose the Salesperson Code field from the 
Customer table. 

19. In the Reference column, choose the Code field from the 
Salesperson/Purchaser table. 
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20. Click OK to save the link. 

21. Whenever you link two dataitems, you should always sort the 
indented data item accordingly. In this case, you should change the 
DataItemTableView property of the Customer data item to 
'SORTING(Salesperson Code)' (without quotes). 

22. Close, save and compile the report with the ID 123456750 and the 
name 'Customers by Salesperson' (without the quotes). 

 The data model is now complete. The next step is to design the page. 
Before you do that, you need to know about the Section Designer. 

The Section Designer 
As you recall, each Data item can have one or more sections defined in the 
report. The Section Designer lets you design the visual layout of the report 
section by section. While you are in the Report Designer, select the View menu 
and then Sections.  
 
NOTE: If the report has its Processing Only property set to Yes you cannot create 
any sections. This property is discussed later with the other properties. 

 
Each Data item can have any number of sections (remember that every section is 
a sub-object of one of the Data items). Therefore, when you create a section (F3), 
you must select the Data item that the section is associated with and specify what 
type of section you need. You can delete a section by clicking on the gray bar 
and then pressing F4. 
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The following table provides a brief description of the types of sections in a 
report: 
 

 
 
Each section works like a small form with the SourceTable property set to the 
Data item's table. Controls on sections do not have any triggers but do have the 
same properties as on a form. 
 
NOTE: While you can see colors that you set for controls in the design of a section, 
these colors do NOT print when you actually run the report. The only way to print 
colors is to use Image or PictureBox controls. 

 

Designing the Page Layout 
In this exercise, you finish the report that you started earlier by defining the 
sections. 
 

1. Design report 123456750. 
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2. On the main menu, click VIEW→SECTIONS. You should see two 
sections already created for you by the report − 
Salesperson/Purchaser body(1) and Customer body(1). 

 

 
 

3. Click F3 to insert another section. The Insert Section dialog appears. 

 

 
 

4. Select the Salesperson/Purchaser data item and a section type of 
Header. This inserts a Salesperson Header into the sections (the 
header section for a data item always comes before the body 
section). 

5. Click OK to insert the desired section. Notice that a new gray bar 
appears with the name Salesperson/Purchaser Header(1). 
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6. Repeat steps 4 and 5 to insert a Customer header section. You should 
now have four sections in your report. But they do not have any 
controls on them. If you were to run the report, nothing would print 
on the pages. 

7. Click on the Salesperson/Purchaser body section.  

8. Click VIEW→FIELD MENU. The Field Menu dialog appears.  

9. Hold down the CTRL key and select the Code and Name fields. 

 

 
 

10. Move your mouse over the Salesperson/Purchaser body section. 

11. Click once to activate the Sections Designer. 

12. Click again to create the fields on the section. Notice that the labels 
and text boxes are created differently on a report section than on a 
form. The labels are placed above the text boxes in columns. Most 
likely, your labels are on top of the text boxes because the section 
was too small to put them above the text boxes. You can move the 
controls around just like you did with forms. 

13. Drag the labels one at a time from the body section to the header 
section and line them up with the corresponding text boxes. 
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14. Repeat steps 7 - 14 for the Customer body section. Add the No., 
Name, City, and Phone No. fields from the Customer table. Do not 
forget to move the labels to the header section. 

 

 
 

15. Close, save and compile the report. You do not have to save a report 
before you run it, but it is a very good idea. You never know when 
your computer may lock up. Save often when designing reports! 

16. Run the report. The request form appears. This form allows the user 
to enter filters for the data items or change the sort of the data items. 
They can also choose to Print the report or Preview the report. 

 

 
 

17. Click Preview.  

 
NOTE: If you do not have a printer driver loaded for Microsoft® Windows® you 
may not be able to print or preview any reports. 

 
Answer these questions about your new report. The answers are provided at the 
end of this section. 
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Does the report look like you expected it to? Where do the header sections print 
for each data item? 
 
Did the header sections ever repeat? 

The Request Options Form Designer 
While you are in the Report Designer, you can select the View menu and then 
Request Form.  
 

 
 
Use the Request Options Form Designer to design the Options tab of the Request 
Form. The request form is the form that is displayed to the user when they run 
the report.  
 
You cannot design the Data item tabs or the buttons at the bottom of the Request 
Form from here. This is just like any other form you create, just keep in mind that 
the Options tab is the last tab of the Request Form. 
 
When you add controls to this form, the Options tab begins to be displayed. 
Until there are controls on it, the Options tab is not visible to the user. 
 
To utilize the Options tab of the request form usually requires coding in some of 
the triggers. Because this course is on basic reports, you are not adding controls 
to the request form. 
 
The other tabs of the request form can be changed via properties, as shown in the 
rest of this chapter. 

Learning How Sections Work 
In this section, you learn how certain types of sections can be used and when they 
print. 
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Headers, Bodies, and Footers 
In this exercise you experiment with header, body and footer sections. First you 
work without indentation or linking. Next, you work with indentation, and finally 
with linking. Answer the questions along the way. The answers are provided at 
the end of the section. 

No Indentation or Linking 
 

1. Open the Object Designer 

2. Click Report. 

3. Click New. The New Report window appears. You are not using the 
Report Wizard, because it limits you to one table. 

4. Click OK. The Report Designer appears. 

5. Click on the first empty line in the Report Designer and enter the 
number or name of the Salesperson/Purchaser table (13). 

6. Click on the next empty line in the Report Designer and enter the 
number or name of the Customer table (18). Do not indent or link the 
two data items. 

7. Click on the Customer data item. 

8. Open the Properties window. 

9. Change the MaxIteration property to 5. 

10. Click VIEW→SECTIONS. 

11. Insert a header for each data item. You should now have four 
sections. Insert a footer for each data item as well. 

12. On the Salesperson Body put the Code and Name fields and drag the 
labels to the header. 

13. On the Customer Body put the No., Name, and Phone No. fields and 
move the labels to the header. 
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14. On the Footer for each data item, put a label from the toolbox and 
change the caption to "SP-footer" and "Cust-Footer" respectively. 

 

 
 

15. Close, save and compile the report with the ID 123456751 and the 
name 'Basic Sections Test'. 

16. Run the report. 

– How did the report loop through the tables? 
– Where does each data item's Header section print? 
– Where does each data item's Footer section print? 

With Indentation 
 

1. Design the report. 

2. Indent the Customer data item (do not link it yet).  

3. Close, save, and compile the report. 

4. Run the report. 

– How did the report loop through the tables? 
– Where does each data item's Header section print? 
– Where does each data item's Footer section print? 

With Linking 
 

1. Design the report. 

2. Click on the Customer data item.  
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3. Change the DataitemLink property to 'Salesperson 
Code=FIELD(Code)' (without the quotes). 

4. Remember that you also need to set the Sorting for the report. 
Change the DataItemTableView property to 'SORTING(Salesperson 
Code)' (without quotes). 

5. Close, save and compile the report. 

6. Run the report. 

– How did the report loop through the tables? 
– Where does each data item's Header section print? 
– Where does each data item's Footer section print? 

TransHeaders and TransFooters 
In this exercise, add a TransHeader and a TransFooter to the previous report.  
 
Answers to the exercise questions are provided at the end of the manual. 
 

1. Design report 123456751.  

2. Click on the Customer data item. 

3. Open the Properties window. 

4. Delete the value in the MaxIteration property. 

5. Close, save and compile the report. 

6. Run the report. Notice that the Customers for some of the 
salespeople extend to more than one page. However, on the second 
page, the report does not print any headings, that tell us, what 
salesperson we are looking at. It would be nice if we could get our 
headings printed on every page. 

7. Close the report after running. 

8. Design report 123456751.  

9. Click on VIEW→SECTIONS. 

10. Select each of the Header sections on the report and change the 
PrintOnEveryPage property to Yes. 

11. Close, save and compile the report. 

12. Run the report. Now, the Salesperson header and the Customer 
header appear at the top of every page. This still doesn't tell us which 
salesperson those customers go with. What we need here, is a section 
that prints at the top of just those pages that are continuations of the 
previous page and show the salesperson that we are currently on. 
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13. Close the report after running. 

 This is what a TransHeader does. First, you need to determine what 
data item the TransHeader section goes with. You should ask 
yourself "which data item is the report in the middle of printing when 
it goes to the next page (where I want the TransHeader)?" The 
answer in your case is the customer data item.  

14. Click on the Customer body section.  

15. Insert a TransHeader section for the customer data item. Note that it 
comes between the header and the body sections. In the Customer 
TransHeader section, you need to display the current salesperson.  

16. Click on the Salesperson Body section and select both the Code and 
Name fields. 

17. Click EDIT→COPY to copy these controls to the clipboard.  

18. Click on the new TransHeader section.  

19. Click EDIT→PASTE to copy the two controls to this section. Line them 
up with the ones that you copied. This almost works. Because we are 
in a section of the customer data item now, we can not display fields 
from another data item without specifying the data item first.  

20. Click on the Code text box control and open the properties.  

21. Change the SourceExpr property to "Salesperson/Purchaser".Code. 
You have now specified the other data item that is part of the Code.  

22. Repeat the two previous steps for the Name text box. The value for 
the SourceExpr property should be "Salesperson/Purchaser".Name. 
You also want to add a label to this section that has the word 
"Continued" in the caption. 
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23. Close, save and compile the report. 

24. Run the report. 

– Where did the TransHeader print (it is not on every page)? 
25. Close the report after running. 

Transfooter 
A TransFooter works basically the same as the TransHeader but it prints at the 
bottom on the page that had to be continued.  
 

1. Design report 123456751.  

2. Click on VIEW→SECTIONS. 

3. Click on the Customer Body section. 

4. Insert a TransFooter section for the Customer data item. 

5. Add to it a label that has "Continued on next page" in the Caption 
property. 

 

 
 

6. Close, save, and compile the report. 

7. Run the report. 

Some Useful Properties 
In this section, you participate in exercises that help in understanding many 
useful properties and slowly improving the report you created in previous 
exercises. 
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NewPagePerRecord Property 
Your user would like the Customer by Salesperson report start a new page every 
time it finds a new salesperson. There is a property designed just for this − 
NewPagePerRecord. 
 

1. Design report 123456751.  

2. Click on the Salesperson/Purchaser data item. 

3. Change the NewPagePerRecord property to Yes. 

4. Close, save and compile the report. 

5. Run the report. 

– When does a new page get created now (there are two times)? 
 

 

Answer: 
– When the report continues to the next page and when the 

Salesperson data item moves to the next record. 
 

PrintOnlyIfDetail Property 
Now notice that the report does not show any customers for salesperson Annette 
Hill. She is not really a Salesperson. She is a Purchaser. You need to change the 
report to only include those Salespeople that actually have Customers. 
Remember that in this report customer is the detail data item. 
 

1. Design report 123456751.  

2. Click on the Salesperson/Purchaser data item. This is the master data 
item. The customer data item is the detail data item. The report 
should only print master records that have details. 

3. Change the PrintOnlyIfDetail property to Yes. 

4. Close, save and compile the report. 

5. Run the report. 

– Which salespeople are printed on the report? 
 

Answer: 
– JR and PS 

 

6. Close the report after running. 
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ReqFilterFields and ReqFilterHeading 
Your user would like the report to allow filtering on the Code and Name fields 
of the Salesperson/Purchaser table on the request form. The property 
ReqFilterFields allows you to specify which fields the user can see on the request 
form. Answers to the questions in this section are provided at the end of the 
exercise. 
 

1. Design report 123456751.  

2. Click on the Salesperson/Purchaser data item. 

3. Change the ReqFilterFields property to 'Code,Name' (without 
quotes). 

4. Close, save and compile the report. 

5. Run the report. 

– What fields appeared on the Salesperson/Purchaser tab of the 
request form? 

– Can you filter on any other fields? 
– What else does the tab allow you to do to the data item? 

You may also want to change the name of the tab (or the Heading) from 
"Salesperson/Purchaser" to just "Salesperson" on the request form. The property 
ReqFilterHeading allows you to change the name of the tab on the request form. 
 

1. Design report 123456751.  

2. Click on the Salesperson/Purchaser data item. 

3. Change the ReqFilterHeading property to Salesperson. 

4. Close, save and compile the report. 

5. Run the report. 

– What name appeared on the tab? 
 
NOTE: Sorting a data item that does not have ReqFilterFields causes its tab on the 
Request Form to disappear. 
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Grouping Within a Report 
In this section, you learn how to group data within a report. 

What is Grouping? 
Typically in a report, there is a need to print subtotals or to separate groups of 
records based on fields within the records themselves. In Microsoft Navision, 
you must tell the report which fields you want to monitor for these events. The 
report monitors the fields and when they change to a new value, it triggers 
special sections to print on the report. These special sections do not print unless 
the report is grouping on fields. 
 
Grouping is not a necessity if you can use indentation to link and filter your data 
items the way that you want. Grouping must be used in cases where the field that 
you want to group on is not related to another table. 
 
The most common use for grouping is to subtotal a report by Date. Date fields 
are not related to a table but do signify important groups within the table. For 
example, you may want to look at Customer Ledger Entries by Customer and for 
each Customer by date. You only need to Group on one field − Date. You can 
"Group" (this is in quotations because while the term is correct, here we are not 
actually talking about Grouping the report) the entries by Customer using 
indentation. 
 
NOTE: In most cases, it is easier to use indentation rather than grouping. Grouping 
on more than one field is somewhat tricky and requires you to write some code. 
Indentation is a more natural way to use the Report Designer (if you can). 

 

The GroupTotalFields Property 
This property is the key to printing the special sections. You must specify the 
fields that you want the report to monitor (or break on) in this property to group 
the report. This property has nothing to do with Totals or with indentation. The 
name of the property is somewhat misleading. 
 
To properly use this field, you must do two things.  
 

• First, the fields you specify in this property (and there can be more 
than one) must also be in the key that you specify in the 
DataItemTableView property. If you do not choose an appropriate 
key, the GroupTotalFields that you specify are ignored by the report.  

• Second, you must create those special sections. The only thing that 
Grouping does for you is cause those sections to print at the correct 
time (nothing else).  

 

Page 350 



 

 

Chapter 18: Reports 

The GroupHeader and GroupFooter Sections 
Grouping a report allows you to print GroupHeader and GroupFooter sections. 
As their names imply, they are printed before a group starts and after a group has 
finished. The GroupHeader section prints after any Header sections and before 
any body sections for this group (or right after the previous group's 
GroupFooter). The GroupFooter section prints after the last body section for this 
group and before the GroupHeader of the next group (or before the footer 
section). 

How Grouping Works 
In this exercise, you create a report with one data item and use grouping to form 
breaks in the report. Answers to the exercise questions are provided at the end of 
the section. 
 

1. Open the Object Designer. 

2. Click Report. 

3. Click New. The New Report window appears. You are not using the 
Report Wizard, although it could be used to create this report. 

4. Click OK. The Report Designer appears. 

5. Click on the first empty line in the Report Designer and enter the 
number or name of the Cust. Ledger Entry table (21). 

6. Change the GroupTotalFields property to Posting Date. 

7. Click VIEW→SECTIONS. 

8. Insert a Header section. 

9. Insert a Group Header section.  

10. In the body section, add the Posting Date, Customer No., 
Document Type, Document No., Description and Amount fields.  

11. Move the labels up to the Header section.  

12. Click on the Posting Date text box. 

13. Drag it from the body section to the Group Header section.  
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14. Change the FontBold property to Yes. 

 

 
 

15. Close, save and compile the report with an ID of 123456752 and a 
Name of 'Customer Detail'. 

16. Run the report. 

– Where did the Group Header Section print? 
– Why didn't it print? 

Creating a Needed Key 
You must sort the data item using the field(s) that you want to group on. 
Unfortunately, there is no key in the Cust. Ledger Entry table that starts with the 
Posting Date field. So, as you may have to do with many reports that you create, 
you create a new key in the underlying table. 
 

1. Design table 21. 

2. Click on VIEW→KEYS. 

3. Click on an empty line at the bottom of the Key Designer window. 

4. Enter Posting Date into the Key column. 

5. Close the Key Designer window. 

6. Close, save and compile the table. 

Finishing Up 
Now, you can finish your report. 
 

1. Design report 123456752.  

2. Click on the data item. 

3. Open the Properties window. 
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4. Change the DataItemTableView property to SORTING(Posting 
Date). You can use the Assist-Edit button to open the Table View 
dialog and choose the new key you created. 

5. Close, save and compile the report. 

6. Run the report. 

– Where did the Group Header Section print? 

Creating a Needed Key 

How Grouping and Indentation Can Work Together 
In this exercise, you learn how grouping and indentation can work together to 
group data at many different levels. As before, the answers to the exercise 
questions can be found at the end of the section. 
 

1. Design report 123456752.  

2. Click FILE→SAVE AS. 

3. Enter the ID 123456753 and the name 'Customer Detail 2'. 

4. Click OK to save the report with the new ID and name. 

 You change this report so that it groups the Customer Ledger Entries 
first by Customer and then by posting date. Instead of trying to add 
Customer No. to the GroupTotalFields property, you use indentation 
to group by Customer. 

5. Insert (F3) a line above the Cust. Ledger Entry data item. 

6. Select the Customer table for this new data item. 

7. Indent the Cust. Ledger Entry data item once under the Customer 
data item. 

8. Change the DataItemLink property for the Cust. Ledger Entry data 
item to "Customer No." = FIELD("No."). You can use the Assist-
Edit button to help you set this property. 

 Remember that you should always use an appropriate key for 
indented data items. For this situation, you want the ledger entries to 
be sorted by Customer No. and then by Posting Date. There is a key 
with those fields first. 

9. Change the DataItemTableView property to sort by a key that 
contains Customer No. and then Posting Date. 

10. Now is a good time to save the report. Click FILE→SAVE. 
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11. Click VIEW→SECTIONS. 

12. Insert a Header section for the Customer data item.  

13. On the Customer body section add the No., Name, City, and Phone 
No. fields.  

14. Move the labels up to the Header section. 

 You may want to move the controls on the Cust. Ledger Entry 
sections over to the right to show the indentation that we are using. 
You may Note the ">" symbol in the gray bar of the Ledger sections. 
This signifies that this data item is indented. To do this, simply select 
all the controls on a section and move them to the right as you would 
on a form. 

 

 
 

15. Close, save and compile the report. 

16. Run the report. The request form appears. 

17. Click Preview. 

– Where did the Group Header Section print? 
– Where did the Header sections print for each data item? 

Totaling in a Report 
In this section, you learn how to add totals to the footer sections in a report. This 
is actually very easy, as shown in the exercises. 
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Totaling 
Almost always in a financials package, a report is designed to give the user some 
summary information about what is in the database. This usually requires 
summing one or more fields that are being displayed or read by the report and 
then displaying the Sum. We call this process "Totaling" the report.  
 
Microsoft Navision uses Subtotals and Grandtotals. Subtotals come after some 
logical grouping of records and sum the group. Grandtotals come at the very end 
of the report and sum the entire report (all subtotals). 

The TotalFields Property 
Before the report calculates a total for you, you must tell the report which fields it 
should total (sum). The TotalFields property of a data item allows you to specify 
the fields that you want to sum. By naming a field in this property, you are telling 
the report to keep up with totals for that field throughout the report. This does 
not, however, tell the report to display the totals. 

How to Display the Totals 
To display the total amounts for the Fields you have specified in the TotalFields 
property, you need to do two things: 
 

• First, create a section to display the Totals. The report only displays 
total amounts on some type of Footer section (Footer, GroupFooter, 
TransFooter or TransHeader). 

• Second, bring up the field menu for that section and drop the fields 
that you are summing into that section. You may want to delete the 
labels and line up the controls with the correct columns. That is it. 
Because you are displaying these fields on a Footer type of section, 
instead of showing the current value of the fields, the report shows 
the total amounts. 

Creating Subtotals and Grand Totals 
In this exercise, you add subtotals and grand totals to one of the reports you 
created earlier. Answers to the exercise questions are found at the end of this 
section. 
 

1. Design report 123456752. 

2. Click on the Cust. Ledger Entry data item. 

3. Open the Properties window. 

4. Change the TotalFields property to Amount. This tells the report to 
calculate totals for the Amount field as this data item is processed. 

5. Click VIEW→SECTIONS. 

6. Insert a GroupFooter section and a Footer section. 

Page 355 



 

 

Microsoft Navision Development I − C/SIDE Introduction 

7. Open the Field Menu dialog. 

8. Select the Amount field. 

9. Add this field to the Group Footer section. 

10. Delete the label.  

11. Line up the Amount field with the amount column. You may want to 
change the font or make it bold as well. 

12. Repeat steps 7 - 11 for the Footer section. 

 

 
 

13. Close, save and compile the report. 

14. Run the report. The request form appears. 

15 Click Preview. 

– Do the totals seem correct? 
– How did you tell the system that the Amount field on the Group 

Footer section should show the total for just that group? 
 

16. Close the report after running. 

Adding Subtotals and Grand Totals to Indented Data 
Items 
In this exercise add subtotals to your report that has indentation and grouping. 
Answers to the exercise questions are provided at the end of this section. 
 

1. Design report 123456753. 

2. Click on the Cust. Ledger Entry data item. 
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3. Open the Properties window. 

4. Change the TotalFields property to Amount. This tells the report to 
calculate totals for the Amount field as this data item is processed 
(the report only calculates totals for one data item at a time). 

5. Click VIEW→SECTIONS. 

6. Insert a Group Footer and a Footer section for the Cust. Ledger Entry 
data item. 

7. Open the Field Menu dialog. 

8. Select the Amount field. 

9. Add this field to the Group Footer section. 

10. Delete the label.  

11. Line up the Amount field with the amount column. You may want to 
change the font or make it bold as well. 

12. Repeat steps 7 - 11 for the Footer section. 

 

 
 

13. Close, save and compile the report. 

14. Run the report. The request form appears. 

15. Click Preview. 

– Do the totals seem correct? 
– What total prints on the Group Footer section? 
– What total prints on the Footer section? 
– Is it possible to add a Grand Total to this report without writing 

code? 
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Adding Some Advanced Features 
In this section, you discover some of the interesting things that are possible with 
reports. Some of these features require a line of code or two, but you are 
instructed exactly where to place the code. 
 
You learn how to use FlowFilters in reports, modify the request form, skip 
sections, and perform grand totals with more than one data item. 

Using FlowFilters in a Report 
In this exercise, you add the ability to filter the report with the Date Filter field 
in the Customer table. This exercise depends on the exercises performed earlier 
in this chapter. You must complete those exercises before attempting these. As 
before, the answers to the exercise questions follow this section. 
 

1. Design report 123456753. 

2. Click on the Customer data item. 

3. Open the Properties Window. 

4. Change the ReqFilterFields to include the Date Filter field. 

5. Close, save and compile the report. 

6. Run the report. The request form appears. 

7. In the Filter column for the Date Filter field, enter the range 
01/01/01..12/31/01. 

8. Click Preview. 

– Are there any records on the report that are outside of that range? 
– Why do you think the report did not change? 

 

9. Design report 123456753. 

10. Click on the Cust. Ledger Entry data item. 

11. Open the Properties Window. 

12. Change the DataItemLink property to 'Customer 
No.=FIELD(No.),Posting Date=FIELD(Date Filter)' (without 
quotes). You may want to use the Assist-Edit button to help you 
change this property. 

13. Close, save and compile the report. 

14. Run the report. The request form appears. 
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15. In the Filter column for the Date Filter field, enter the range 
01/01/01..12/31/01. 

16. Click Preview. 

– Are there any records on the report that are outside of that range? 
– What happens to the report if you leave the Date Filter empty on 

the request form? 

Adding and Taking Away from the Request Form 
In this exercise, add a check box to the Options tab of the request form and take 
away other tabs on the request form. Answers to the exercise questions are 
provided at the end of the exercise. 

Appearing and Disappearing Tabs 
You may have noticed that not every data item seems to have a tab (on the 
request form) on the reports that you have created. Actually, every data item does 
have a tab but, depending on certain properties that tab may or may not appear on 
the request form. 
 

1.  Run report 123456753. The request form appears. 

– What tabs appear on the request form? 
 

2. Design report 123456753. 

3. Click on the Cust. Ledger Entry data item. 

4. Open the Properties Window. 

5. Erase the DataItemTableView property to set it back to the default 
value. 

6. Close, save and compile the report. 

7. Run the report. The request form appears. 

– What tabs are on the request form now? 
– What can the user do on each tab (notice the button)? 

 

8. Design report 123456753. 

9. Click on the Cust. Ledger Entry data item. 

10. Open the Properties Window. 
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11. Change the DataItemTableView property to 'SORTING(Customer 
No.,Posting Date,Currency Code)' (without quotes). 

12. Close, save and compile the report. 

13. Run the report. The request form appears. 

– What tabs are on the request form now? 
 

14. Design report 123456753. 

15. Click on the Cust. Ledger Entry data item. 

16. Open the Properties Window. 

17. Change the ReqFilterFields to 'Posting Date' (without quotes). 

18. Close, save and compile the report. 

19. Run the report. The request form appears. 

– What tabs are on the request form now? 
– What can the user do on the Cust. Ledger Entry tab? 
– Which two properties determine whether the user sees the tab for 

a data item on the request form? 

Adding a Check box to the Options Tab 
To add a data control to the Options tab of the request form, you first need to 
create a global variable for the control to be bound to. The user changes the value 
of the variable through the control. You use the value of the variable in the next 
exercise. 
 

1. Design report 123456753. 

2. Click VIEW→C/AL GLOBALS. The C/AL Globals window appears. 
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3. Add a variable named ShowDetails with a data type of Boolean. 

 

 
 

4. Close the C/AL Globals window. 

5. Click VIEW→REQUEST FORM. The Request Form Options Designer 
appears. 

6. Add a check box and label (use the Add Label button) to the form. 

7. Change the caption property of the check box to 'Show Details' 
(without quotes). This changes the caption of the attached label. 

8. Change the SourceExpr property of the check box to ShowDetails. 

9. Close the Request Form Options Designer. 

10. Close, save and compile the report. 

11. Run the report. The request form appears. 

– What tabs are on the request form now? 
– Can you change the value of the check box you added? 
– What value does the variable have when the box is checked? 
– What value does the variable have when the box is not checked? 
– Check the box and preview the report. Close the preview 

window and rerun the report. Is the box still checked? 
 
Every time the report is run, the variable is set to its default value of False. To get 
the value to be remembered, you must tell the request form to save its variable 
values in the ZUP file. 
 

1. Design report 123456753. 
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2. Click VIEW→REQUEST FORM. The Request Form Options Designer 
appears. 

3. Open the Properties window for the form. 

4. Change the SaveValues property to Yes. 

5. Close the Request Form Options Designer. 

6. Close, save, and compile the report. 

7. Run the report. The request form appears. 

– Check the box and preview the report. Close the preview 
window and rerun the report. Is the box still checked? 

Skipping Sections in a Report 
In this exercise, use the value of the variable that you added in the previous 
exercise to display or not display a section on the printed report. The section that 
you conditionally show is the Cust. Ledger Entry Body section. Answer the 
exercise questions as you go along. An answer section is provided at the end of 
the exercise. 
 

1. Design report 123456753. 

2. Click VIEW→SECTIONS. The Sections Designer appears. 

3. Click on the Cust. Ledger Entry Body section's gray bar. This selects 
that section. 

4. Click VIEW→C/AL CODE (F9). The C/AL Editor appears. 

5. In the OnPreSection Trigger put the following code: 

 
   CurrReport.SHOWOUTPUT(ShowDetails); 

 
6. Close the C/AL Editor and the Sections Designer. 

7. Close, save, and compile the report. 

8. Run the report. The request form appears. 

9. Make sure that the checkbox is checked on the Options tab. 

10. Click Preview. 

– Does the report look the same as the last time you ran the report? 
– Close the preview window. Rerun the report and make sure the 

check box is not checked on the Options tab. 
– What has changed on the report? 
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Adding a Grand Total with More Than One Data Item 
In this exercise, you add a grand total to the Customer Detail 2 report. This is not 
possible without some amount of code. In this case, you add just one line of code 
to the report and, of course, a new section. Answers to the exercise questions are 
provided at the end of the section. 
 

1. Design report 123456753. 

2. Click on the Customer data item to select it. 

3. Click VIEW→C/AL CODE (F9). The C/AL Editor appears. 

4. In the OnPreDataitem Trigger put the following code: 

 
   CurrReport.CREATETOTALS("Cust. Ledger Entry".Amount); 

 
5. Close the C/AL Editor. 

6. Click VIEW→SECTIONS. 

7. Insert a Footer section for the Customer data item. 

8. On that footer section, manually add a Textbox. 

9. Change the SourceExpr property of the Textbox to "Cust. Ledger 
Entry".Amount. You may also want to increase the font size or make 
the textbox bold. 

10. Close the Sections Designer. 

11. Close, save and compile the report. 

12. Run the report. The request form appears. 

13. Make sure that the checkbox is checked on the Options tab. 

14. Click Preview. 

– Does the total at the end of the report seem correct? 
– How else might you have done this? 

Creating a Basic Report for Yourself 
In this exercise, you test your abilities to create a simple report. There are no step 
by step instructions in this section. Once you have tried this for yourself, you 
may want to look at the step by step instructions that follow this section. 
 
Here are the requirements for your report. Use the ID 123456754 and the Name 
'Vendor Detail' for this report. 
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1. Create a report that has the following requirements: 

– Prints Vendor Ledger Entries by Vendor (two data items, use 
indentation). 

– Displays No., Name, and Phone No. from the Vendor table. 
– Displays Posting Date, Document Type, Document No., 

Description, and Amount from the Vendor Ledger Entry table. 
– Displays a subtotal on the Amount field for the Vendor. 

2. Change that report to include another subtotal. This time, a subtotal 
for each unique posting date within a certain vendor. This requires 
grouping on the Posting Date field. Do not forget to choose an 
appropriate key. 

3. Change the report so that it doesn't print vendors that do not have any 
detail records. 

4. Change the report so that it doesn't print any Ledger records whose 
Document type is Credit Memo. This requires filtering on that data 
item. Remember that the word View means Sorting and Filtering. 

Creating A Basic Report − Step-by-Step 
Here are the step-by-step instructions on how to do this report. 

Step 1 
 

1. Open the Object Designer. 

2. Click Report. 

3. Click New. The New Report window appears. 

4. Click OK. The Report Designer appears. 

5. Click on the first empty line in the Report Designer and enter the 
number or name of the Vendor table (23). 

6. Click on the next empty line in the Report Designer and enter the 
number or name of the Vendor Ledger Entry table (25).  

7. Indent the Vendor Ledger Entry data item by clicking the right arrow 
button at the bottom of the form. 

8. With the Vendor Ledger Entry data item still selected, bring up the 
properties for that data item. 

9. Click on the DataItemLinkReference property. Verify that it is set to 
Vendor.  

10. Change the DataItemLink property to 'Vendor No.=FIELD(No.)' 
(without the quotes).  

11. On the main menu, click VIEW→SECTIONS. 
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12. Insert a Vendor Header section. 

13. Change the PrintOnEveryPage property to Yes. 

14. Insert a Vendor Ledger Entry Header section. 

15. Change the PrintOnEveryPage property to Yes. 

16. Click on the Vendor body section.  

17. From the Field Menu, add the No., Name, and Phone No. fields. 

18. Move the labels to the header. 

19. Click on the Vendor Ledger Entry body section.  

20. From the Field Menu, add the Posting Date, Document Type, 
Document No., Description, and Amount fields. 

21. Move the labels to the header. 

22. Insert a Vendor Ledger Entry footer section. 

23. Add the Amount field to the Vendor Ledger Entry footer section. 
Delete the label. 

24. Line up the Amount field on the footer section with the Amount 
field on the body. 

25. Change the FontBold property of the Amount field on the footer 
section to Yes. 

26. Save the report with ID of 123456754 and the Name 'Vendor Detail'. 

Step 2 
 

1. Design report 123456754. 

2. Click on the Vendor Ledger Entry data item. 

3. Change the GroupTotalFields property to Posting Date. 

4. Change the DataitemTableView property to SORTING(Vendor 
No.,Posting Date,Currency Code). 

5. Click VIEW→SECTIONS. 

6. Insert a Vendor Ledger Entry group footer section. 

7. Add the Amount field to the Vendor Ledger Entry group footer 
section. Delete the label. 

8. Line up the Amount field on the footer section with the Amount 
field on the body. 

9. Close, save and compile the report. 
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Step 3 
 

1. Design report 123456754. 

2. Click on the Vendor data item. 

3. Change the PrintOnlyIfDetail property to Yes. 

4. Close, save, and compile the report. 

Step 4 
 

1. Design report 123456754. 

2. Click on the Vendor Ledger Entry data item. 

3. Change the DataitemTableView property to SORTING(Vendor 
No.,Posting Date,Currency Code) WHERE(Document 
Type=FILTER(<>Credit Memo)). 

4. Close, save and compile the report. 

The report should now be complete. 
 

Page 366 



 

 

Chapter 18: Reports 

Test Your Skills − Reports 
 

1. True or False. All reports must print at least one page. 

 

2. List the names of the three Designers used with reports and describe 
their function. 

 

3. How many times does a Header section print on a report for an 
indented data item (assume PrintOnEvery page is turned off and 
there is data in the table)? What if the data item is not indented? 

 

4. What data item property can be used to remove the Data Items tab 
on the request form (assume there are no request filter fields set)? 

 

5. What two properties of a data item must be set in order to print a sub 
total of a field on a group footer section? 

 

6. When does a Transheader section print for a data item? 

 

7. What property can be set to start a new page every time a record is 
read? 

 

8. What two properties can be used to print a footer at the bottom of 
every page? 

 

9. Given a report that has two data items and the second is indented. 
What C/AL code could you write that would most closely resemble 
this situation? 

 

10. What property can be used to filter an indented data item based on 
fields in the unindented data item above it? 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 19: DATAPORTS 
Dataports are used to export data to external text files, and to import data from 
external text files within Microsoft® Business Solutions−Navision®. 

Training Objectives 
In this chapter, you learn about: 
 

• Dataport Fundamentals 
• Designing Dataports 
• Sample Dataports 
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Dataport Fundamentals 
Dataports are objects used for importing data from and exporting data to external 
text files. During importing and exporting, there is a wide range of options for 
defining the format of the external file. 
 
When importing, you can control what happens if a record in the import file has 
the same value in the key as an existing record in the database table. In addition, 
at dataport field level, you can control whether or not to run the OnValidate 
trigger for each field. 
 
Dataports can be dynamic, that is, on execution the dataport determines whether 
the process is an import or an export and the name of the file to read from or to 
be written to. This is achieved either with options that the user sets in the request 
form or by programming. 
 
The following diagram shows the components of the dataport object: 
 

 
 
The diagram shows how a dataport is composed of a number of different 
components. The following is a short description of each component. 
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Dataport Description  
This is the complete description of the dataport − how data is collected, how data 
is formatted when written to the output file and so on. The dataport description is 
stored in the database. 

Data Item  
A data item corresponds to a table. In order to retrieve information from the 
tables in the database, you define data items. 

Dataport Field  
A dataport field refers to a field in a file from which data is to be imported. 
Dataport fields in the external file are defined either as having a fixed length, or 
as delimited by certain characters that you define. 

Request Form  
A request form is a form that is run before the actual dataport begins execution. It 
is used to gather requests and options from the user of the dataport, for example, 
the name of the external file. 

Property  
A property is an attribute of an object − dataport, data item, dataport field, and so 
forth − that characterizes the object in some way, for example length and position 
of a dataport field in a line (when importing). Properties are set on the Property 
Sheet of an object. 

Trigger  
Certain predefined events that happen to a dataport cause the system to execute a 
user-definable C/AL function − the event triggers the function. As you can see in 
the diagram, the dataport itself, the data items, the dataport fields, the request 
form and the controls on the request form all have triggers. Triggers are edited in 
the C/AL editor. 

Logical Design 
Designing a dataport involves two distinct tasks: designing the data model and 
defining the layout of the external file. 

Data model  
You build the data model by designing data items. A data item corresponds to a 
table. When exporting data, each data item is iterated for all records in the 
underlying table, and you can set up sorting order, keys and table views to use. 
For each record, you can decide whether or not it should be written to the 
external file. 
 
When importing data, records read from the external file can be inserted in the 
table that corresponds to the data item. You can examine the records before 
inserting them, and you can specify whether records should be inserted 
automatically and whether records already in the database should be overwritten 
or updated when a record with the same primary key is read from the external file 
(or, of course, whether this record should be inserted at all). 
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External file  
The layout of the external file is defined by means of a set of dataport properties. 
During importing, these properties describe how the input stream should be 
broken up into records and dataport fields; during exporting, these properties 
describe how the dataport fields and records should be written to the file. 

How a Dataport Is Run 
The following is a simplified version of the steps used in dataport processing. A 
full set of dataport flowcharts can be found in Appendix G, Dataport Flow 
Charts, in the Application Designer's Guide. 
 

1. When the user initiates the dataport run, the OnInitDataport trigger is 
run. This trigger can be used to initialize variables, but should not be 
used for general processing purposes. 

2. When the OnInitDataport trigger has been executed, the request form 
for the dataport is run if it is defined. Here, the user can choose to 
cancel the dataport run. 

3. If the user chooses to continue, the dataport enters a transaction (a 
BWT − Begin Write Transaction − is issued) and then the 
OnPreDataport trigger is called. At this point, no data has yet been 
processed. 

4. The OnPreDataport trigger can be used to process the user input 
from the request form. 

5. When the OnPreDataport trigger has been executed, the external file 
is opened, and the processing of the first data item begins. 

6. When the first data item has been processed, the next (if any) data 
item is processed in the same way. 

7. When there are no more data items, the OnPostDataport trigger is 
called. You can use this trigger to do any post processing that is 
necessary. 

8. When the OnPostDataport has been processed, the external file is 
closed. 

9. The transaction that was entered in step 3 ends with an EWT (End 
Write Transaction) being issued. 

The processing of each data item (steps 5 and 6) is different for importing and 
exporting. What is important to note in the overall chart is that the entire 
processing of a dataport takes place within a transaction. This means that if the 
processing is interrupted at any time before the final EWT, there is no trace left 
of the interrupted run afterwards in the database (an external file, however, often 
has been corrupted.) 
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NOTE: There are no Right and Left buttons on the Dataport Designer window (as 
there are on the Report Designer window). This means that you cannot indent data 
items in a dataport. You must process one data item (table) at a time. 

 

Saving, Compiling and Running a Dataport 
After you have designed a dataport, you must save and compile it before it can be 
run from other objects or from the Object Designer. Normally, do this when you 
have finished designing the dataport. However, you may want to save a dataport 
that is not yet finished and thus cannot be compiled. You can also compile and 
run a dataport without closing or saving it. 

Saving and Closing a Dataport 
A dataport is closed when the Dataport Designer window is closed. You can 
close this window in the same ways that you can close any other window. 
 
To save a dataport: 
 

1. When you close a dataport, C/SIDE asks whether the dataport should 
be saved. If it is a new dataport (a dataport that has not been saved 
before) you have to assign it an ID and a name. The ID must be 
unique and follow the rules for numbering objects − your C/SIDE 
dealer provides you with this information. 

 
NOTE: If you enter ID and Name as dataport properties, these values are used, and 
you are not prompted for ID and Name when you close the dataport. 

 
2. The option field Compiled is by default set to TRUE (displayed as a 

check mark). If your dataport is not yet ready to be compiled, 
remove the check mark by clicking the field. 

 

 
 

3. Click OK to save the dataport. 

You can save a dataport without closing it by choosing Save or Save As from the 
File menu. By using Save As, you can rename an existing dataport (note that you 
can copy a dataport by opening it and saving it with a new name). 
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Compiling a Dataport 
Dataports, like other objects in C/SIDE, must be compiled before they can be 
run. As described above, you can choose to compile a dataport whenever you 
save it. 
 
While you are designing a dataport, you may want to test-compile it to find 
possible errors. You can test-compile a dataport during design by choosing the 
Compile option on the Tools menu. 

Running a Dataport 
In a finished application, your dataports are incorporated into menus, or they are 
called, for example, from a command button on a form. However, while you are 
designing dataports, you may often want to run them before they have been 
integrated into an application. 

Test-running dataports 
While designing a dataport, you can test-run it by choosing Run from the File 
menu. This way the dataport is compiled and run in its current stage of 
development. It is not saved, which means that you can use this function to verify 
that the changes you are making work as intended before you save them. 
 
NOTE: If the dataport is an Import, no records are actually saved in the database 
table during a test-run. 

 

Running dataports from the Object Designer 
You can run a dataport from the list of dataports in the Object Designer by 
selecting it and clicking the Run button. 

Designing Dataports 
This section provides an overview of the elements of designing dataports. The 
tables of properties summarizes what each property is used for. Full (and most 
up-to-date) explanations are found in the online C/SIDE Reference Guide. 
 
Designing a dataport consists primarily of setting various properties. The 
following sections explain which properties to use, and how to use them. 

Dataport Properties 
This set of properties describes the dataport in general, and this is also where you 
specify the format of the external file. 
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Note that Import and FileName can be set and reset dynamically. For example, 
you can create a dataport where the user can select whether to import or export, 
or select the name of the external file to read from or write to (or you can 
generate a filename automatically once the dataport is run) 
 

 
 

FileFormat  
The FileFormat property determines the format of the external file. This property 
defines how a record is read from or written to the file. The RecordSeparator 
property defines how the file is broken up into records, and the FileFormat 
property then defines how to break each record up into dataport fields. Finally, 
the DataItemSeparator property defines how data items should be separated if the 
dataport has more than one data item. Note that data items cannot be nested − 
although a dataport can have several data items that are processed sequentially. 
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FileFormat: Fixed  
When the format of the external file is Fixed, the dataport fields in a record have 
a fixed width. You can define the starting position and the width of each dataport 
field in the record (if the RecordSeparator is a new line character, you can think 
of a record as a line of text). The positions and widths of the dataport fields are 
properties of the dataport fields (described in a following subsection). 

FileFormat: Variable  
When the format of the external file is Variable, the dataport fields in a record are 
delimited by characters that you define, and the dataport fields can have varying 
widths. The dataport fields are separated by the string defined as the 
FieldSeparator property. 
 
The FieldStartDelimiter and the FieldEndDelimiter properties are used to "quote" 
the dataport field contents in situations where the data of a dataport field contains 
the character that is defined as a separator (FieldSeparator, RecordSeparator or 
DataItemSeparator). These delimiters are not obligatory. This means that if only 
one dataport field of a record needs to be quoted, only this dataport field has to 
be enclosed by the FieldStartDelimiter and FieldEndDelimiter characters. The 
other dataport fields can have the delimiters optionally − it makes no difference 
during importing. During exporting, all dataport fields are written to the external 
file with all delimiters and separators. 

Data Item Properties 
This set of properties describes the data items of the dataport, which is the 
database table part of the dataport. 
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Most of these properties are the same and have the same function as the 
corresponding properties of a data item in a report (see the Chapter Designing 
Reports. Three properties are special for a dataport: AutoSave, AutoUpdate and 
AutoReplace. 
 

 
 
The three Auto* properties determine how records that are read from the external 
file are handled. They are also used to resolve the conflict that arises when a 
record that has been read from the external file during importing has the same 
primary key as a record that already exists in the database table. 
 
AutoSave and AutoReplace are used to define how records are saved in the 
database table. Note that if AutoSave is No, the settings of AutoReplace and 
AutoUpdate have no effect − in this case you have to handle any conflicts from 
your C/AL code. The following table outlines the effects of various combinations 
of settings of these properties: 
 

 
 
--- means that the setting doesn't matter. 
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* If AutoSave is No, it is possible to insert and modify records by using insert or 
modify from C/AL 
 
AutoUpdate is useful in some particular situations. Its functionality is best 
explained by a brief example: 
 
Suppose you have a table that is an item list. You update the prices by exporting 
a list with item numbers (the primary key) and prices to an external file and then 
you do some calculations on the prices on a spreadsheet. Now, when the prices 
are calculated and you are ready to import the file with the new prices, it is 
obvious that the records read from the external file has the same primary key as 
records that are already in the database. Using AutoSave and AutoReplace does 
not solve the problem. If you are replacing every record with the corresponding 
record from the import file, all the information except the item numbers and the 
prices are lost (it is assumed that the table contains information other than the 
item numbers and the prices, for example names of the items, stock level, and so 
forth). 
 
AutoUpdate solves this dilemma. When a record is imported, it actually replaces 
the existing record − but fields that are not present in the imported record are 
initialized with the data from the already existing record instead of being left 
empty. The existing record is updated with the information that was revised. 

Dataport Field Properties 
This set of properties describes the dataport fields of a record. If FileFormat is 
Fixed, you use the StartPos and Width properties of each dataport field to define 
how a record that is read from the external file is to be broken into dataport 
fields. During exporting, these properties determine how data from the database 
is written to the external file. 
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When fields are exported, the data is converted to text before the export. If the 
format is Fixed and the Width is smaller than the actual width of the data after 
conversion, the contents are truncated from the right until it has the defined 
Width. That is, a number is not rounded or truncated as a number, but as text − 
from the right. 
 
You get a warning at design-time if you have defined dataport fields with starting 
positions and widths that could cause these dataport fields to overlap. The error 
makes it impossible to compile (and thus to execute) the dataport. 
 
You can, however, have gaps in the dataport fields (the starting position of the 
second dataport field does not have to be exactly where the first dataport field 
stopped). These gaps may skip unneeded information or create blank columns in 
the file. 
 
During importing, a value that is too large for the data type or defined width of 
the database table field where it is to be inserted causes an error and execution 
stops. As the whole dataport is inside a transaction, no traces are left of the 
aborted run in the database. 

Sample Dataports 
This section tells you how to create dataports by going through the steps 
necessary to create the four fundamental types of dataports: importing and 
exporting, each with a fixed and a variable format of the external file.  

Exporting − Fixed Format 
This sample dataport exports records to a file in fixed format. The records in the 
file are separated by new lines and within each record (line, in effect) a dataport 
field has the same width in all records, no matter how wide the actual data of the 
dataport field is. 
 
The database table that is used as an example is the G/L Account table (the Chart 
of Accounts). There are several FlowFields among the dataport fields that are 
exported, which have to be calculated when exporting. 

Simple Version 
The first version is very basic. It is extended to a more refined object in the next 
subsection. 
 

1. On the Tools menu, click the Object Designer. 

2. In the Object Designer, click the Dataport button. 
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3. Click the New button. 

 

 
 

4. C/SIDE opens the Dataport Designer. Select the first DataItem field 
(by clicking it), and select the G/L Account table from the lookup 
form that you open by clicking the Lookup button. The Name is set 
by default to the name of the table. You do not have to change it in 
this dataport. 
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5. Open the Property Sheet for the dataport (not for the data item). To 
do this, select VIEW→PROPERTIES while the dataport is selected (you 
can select the dataport either by clicking in an empty line in the 
Dataport Designer, or by using EDIT→SELECT OBJECT. 

 

 
 

6. Set these properties: 

 Import − set it to No to create a dataport that exports data. 

 FileFormat − set it to Fixed. 

 The remaining properties can be left at their default settings. 

7. Select the G/L Account data item by clicking it in the Dataport 
Designer. 

8. Select VIEW→DATAPORT FIELDS. 

9. When the Dataport Field Designer is open, select VIEW→FIELD MENU. 

10. Now, select the fields to be exported. Here, the fields No., Name, 
Balance at Date and Net Change have been selected. You may have 
to scroll the Field Menu in order to select these fields, depending on 
how the Field Menu window is currently sized. 
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11. Click the Dataport Field Designer. You are asked if you want to 
append the selected fields. Click Yes. 

 

 
 

12. Go to the Property Sheet of the G/L Account data item. 

 

 
 

13. In the CalcFields property, click the Assist button to open the Field 
List. Then, select those fields from the data item that must be 
calculated when they are exported, that is, the FlowFields. In this 
case, it is the Balance at Date and Net Change fields. Close the 
Field List form by clicking OK. 
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Now, you are ready to run the dataport. You can run it before saving it by 
clicking File, Run. If you want to save the dataport first, you are prompted for a 
name and a number as with other objects. 

About inserting dataport fields  
When the dataport fields have been inserted from the Field Menu, check the 
settings of the StartPos and Width properties of all the fields in the Dataport Field 
Designer form (accessed by clicking VIEW→DATAPORT FIELDS). They look like 
this: 
 

 
 
Both StartPos and Width have been filled out for you. They are assigned values 
according to these rules: 
 

 
 
Close the dataport and save it as follows: 
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Running the dataport  
When you run the dataport, the default request form appears. The first tab is of 
little interest, but the second one, Options, is important. Here you can state the 
name of the external file to write to. 
 
When you have stated the name of the file, click OK to run the dataport. The 
default status window shows you the progress. When the run is over, you can 
look at the file in a text editor: 
 

 
 

Refined Version 
This simple dataport could be more user-friendly. Depending on what the 
dataport is to be used for, several things could be changed. The following are 
examples of what you can do: 
 

• The first tab in the request form should not be shown, as we do not 
want the user to set filters and keys. 

• Only accounts where the Account Type is Posting or End-Total 
should be exported. 

• The numbers must be formatted as thousands. There must be no 
thousand separators, no decimals and the sign should be prefixed. 
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Changing the request form 
You must not set the UseReqForm property to No in order to remove the request 
form. Doing so makes it impossible for the user to set the name of the file to 
write the data to. In fact, since no filename has been set, the dataport provokes a 
runtime error. 
 
Instead, you can keep the Options tab and remove the data item tab by setting a 
DataItemTableView for the data item. When this property is set − as opposed to 
being left undefined − the user cannot change key or sort order and cannot set a 
table filter, and the corresponding tab is removed by the system. 
 

1. Open the Object Designer and Select Dataport. 

2. Design Dataport 123456750. 

3. Open the Property Sheet for the data item. 

4. Click the AssistButton in the DataItemTableView property to open 
this form: 

 

 
 

5. Fill out at least one of the fields. In the preceding picture, Key has 
been set to No. and Order has been set to Ascending. 

Selecting specific account types 
In order to select only some account types you must set a table filter. This can be 
done in the DataItemTableView property. Continue from step 3 above: 
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1. Click the AssistButton in the Table Filter field to open the 
following form: 

 

 
 

2. Set the values of Field, Type and Value as shown in the preceding 
picture. This creates a table filter that selects records where Account 
Type is Posting or End-Total (the character between the two values 
is a | (pipe) which means OR.) 

3. Click OK to close the Table Filter form and the Table View form. 

Changing the formatting of numbers 
To export the decimal fields, Balance at Date and Net Change as thousands (so 
that the number 1,444,723.67 is exported as 1444), you have to use the 
SourceExpr property of these fields: 
 

1. Go to the Property Sheet of both the Balance at Date and Net 
Change dataport fields. 

2. Enter this expression as the SourceExpr property of the first dataport 
field: 
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FORMAT(ROUND("Balance at Date"/1000,1,'='),0,1) 

 

 
 

 In the C/AL statement, the Balance at Date field is first divided by 
1000. The result is rounded by the ROUND function, and then 
FORMAT is used to render the return value from ROUND in format 
1 (which for a decimal value means <Sign><Integer><Decimals>). 

3. Enter this expression as the SourceExpr of the second dataport field: 

 
FORMAT(ROUND("Net Change"/1000,1,'='),0,1) 

 
The file that is created by this dataport could look like the following imported 
into a spreadsheet: 
 

 
 

Page 387 



 

 

Microsoft Navision Development I − C/SIDE Introduction 

Exporting − Variable Format 
This sample dataport exports the same records as in the previous example, but in 
a variable format. Each dataport field in a record is delimited by characters that 
you define and only has the width of the actual data of the dataport field in each 
of the records. 
 
Very few changes are required to create this dataport instead of the dataport with 
fixed width format. You must specify the right set of options for the data item. 
 

1. From the Object Designer, Design Dataport 123456750. 

2. Open the Properties Window, and make changes to the FileFormat, 
FieldStartDelimiter, FieldEndDelimiter and FieldSeparator as 
follows: 

 

 
 
The FileFormat property is set to Variable, and the FieldSeparator property is set 
to ; (semicolon). The FieldStartDelimiter and FieldEndDelimiter properties are 
both set to <None>. The RecordSeparator and the DataItemSeparator properties 
have been left at their default settings, which means that records are separated by 
new lines, and data items by two new lines (which is not of real interest here, 
because we have only one data item in this dataport.) 
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The exported file could look like the following in a text editor: 
 

 
 
The semicolon was used as FieldSeparator because the dataport fields include 
both space characters and commas. Another solution would have been to use the 
delimiters − in that case, the FieldSeparator could also have been a comma, but 
what you choose should really depend upon the target application for the 
exported file, and which formats that application supports when it is importing 
text files. 

Importing − Fixed Format 
Creating a dataport that imports data is not very different from creating one that 
exports data. You must, however, take into consideration how the imported 
records should be inserted in the database table that lies under the data item. This 
is especially relevant if the table already contains records with the same primary 
key as some of the records to be imported have.  
 
This first example assumes that the table is empty (or that other actions have 
been taken to ensure that no conflicts occur). 
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The file that we are going to import records from looks as follows in an editor: 
 

 
 
In this case, we import the records into a newly created table. The table has this 
layout: 
 

 
 

Page 390 



 

 

Chapter 19: Dataports 

This means that we must decide how the lines in the import file − each line 
becomes a record in the data item − are broken down into dataport fields. The 
lines have a fixed format, and by carefully looking at the layout of the lines, these 
field starting positions displayed in the bottom line can be deduced: 
 

 
 
This tells us that the dataport fields must have the following properties: 
 

 
 
Once it has been established how the lines in the import file are organized, 
creating the dataport is straightforward: 
 

1. Create a new dataport as described earlier. 

2. Open the Properties form. 

3. Set the Import property to Yes and the FileFormat property to Fixed. 

4. Save the new Dataport as follows: 
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5. In this example, the preceding table is used. A data item must be 
created for Table 123456752 − "Dataport Test Table". This table is 
provided in the DataportTestTable.fob file on your class CD. 

6. Add all the fields from the table to the dataport by using the Dataport 
Field Designer and the Field Menu as described earlier. At this point, 
the dataport fields are set up with sizes (and corresponding starting 
positions), as deduced from the table design. It looks like this: 

 

 
 

7. You must change the setting of StartPos and Width to the values that 
are appropriate for the actual file you are going to import data from. 
In this example, the values should be set as follows (as described 
earlier): 

 

 
 

8. The dataport can now be run.  

9. Close and Save the dataport. 
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10. Run the dataport from the Object Designer. 

After running the dataport so that records actually are imported into the database, 
the table looks like this: 
 

 
 
Note that because Field No. is the primary key of the table, the records are 
displayed in an order determined by this field − which, incidentally, is not the 
same order as they appeared in the import file. 

Possible errors  
It is easy to make errors when deciding how to "cut up" the lines in the import 
file. In some cases, this gives a runtime error when the dataport is run. Consider, 
for example, if we made an error in setting up the Field No. dataport field so that 
it had been assigned a width that is one character too wide. For most of the 
import file, this would make no difference at all − the resulting trailing space 
would be ignored. But the line beginning with "112Oven..." would provoke a 
runtime error when C/SIDE read 112O instead of 112. The "O" (upper case "o") 
cannot be inserted into an integer field. 
 
You might consider it fortunate that the error actually provoked a runtime error. 
In other cases, the error might not have been detected by C/SIDE, for example, if 
the "cut" between two text fields was placed incorrectly. If you have the 
opportunity, test your imports carefully before using them for production. 
 
HINT: In some cases, the order of the fields you want in your table does not 
correspond to the order of the dataport fields in the import file. If this is the case, you 
can just design the dataport fields to reflect the order that you need, by adding the 
fields individually. You have to set the StartPos and Width manually. 
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Importing − Variable Format 
Changing the importing dataport to deal with an external file in variable format is 
not very difficult. Suppose the file looks like this: 
 

 
 
The data is exactly the same as in the file with fixed format which we imported 
from above, but here the dataport fields are separated by commas. The only 
differences in creating the dataport are: 
 

1. Set FileFormat to Variable. 

2. Set FieldSeparator to a comma. 

3. Set the delimiters to <None>. 

The properties of the dataport should look like this when you have finished:  
 

 
 
These are the only differences between the fixed format dataport and variable 
format dataport. The result of running this dataport is the same as running the 
dataport with a fixed format. 
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HINT: If the order of the dataport fields in the import file is different from the order of 
the dataport fields in the data item, you cannot use the same method to move the 
dataport fields around as you would if the file had a fixed format. Instead, you can 
change the order of the dataport fields in the Dataport Field Designer. 

 
Suppose the import file had the following format instead: 
 

 
 
Suppose the table has this layout (same as before): 
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In this case, you can add the dataport fields in the Dataport Field Designer in the 
order in which they appear in the import file: 
 

 
 
Note that because the dataport fields have been added one-by-one from the Field 
Menu (instead of all-at-once), StartPos and Width have not been calculated by 
the designer. It does not matter, however, because these properties are not used in 
a dataport with a variable format. 
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Test Your Knowledge − Dataports 
1. What is different between the description of a report and the 

description of a dataport? 

 

2. What can you not do with a data item in a dataport that you could do 
with a data item in a report? 

 

3. The dataport fields that you create in the Dataport Field Designer 
must match what for an import dataport? 

 

4. In an import dataport, if you set AutoSave to No and AutoUpdate to 
Yes, what does the dataport do with the records from the file?  

 

5. When must you use the StartPos and Width properties of a dataport 
field? 

 

6. True or False. Every dataport field must be bound to a real field in 
the data item. 

 

7. What does the Calcfields property do on a data item? 

 

8. When exporting, which dataport file type lines up the information in 
columns? 

 

9. When exporting, which dataport file type creates the smallest 
possible file? 

 

10. When importing, which dataport properties can you set so that the 
user does not see the options tab? 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 20: XMLPORTS 
XMLports are used to export and import data to and from external XML 
document files. These are similar to dataports, only the XMLport encapsulates 
the data in XML format. This allows you to exchange information between 
different computer systems in a streamlined way. 

Training Objectives 
In this chapter, you learn about: 
 

• XMLport Fundamentals 
• Designing XMLports 
• Sample XMLports 

Page 399 



 

 

Microsoft Navision Development I − C/SIDE Introduction 

XMLport Fundamentals 
XMLports enable you to import data received in XML format to the Microsoft® 
Business Solutions−Navision® database and export data in XML format from the 
Microsoft Navision database. You only need a basic knowledge of XML to 
design and work with XMLports. 
 
You design XMLports in the XMLport Designer, which you open from the 
Object Designer. 
 
The following diagram shows the components of the XMLport object: 
 

 
 
The diagram shows how a XMLport is composed of a number of different 
components. The following is a short description of each component. 

XMLport Description 
This is the complete description of the XMLport − how data is collected, how 
data is formatted when written to the output file and so on. The XMLport 
description is stored in the database. 

TagName 
In a TagName field, you enter the XML tag name of the XML element or 
attribute. You must enter tag names in the order in which they appear in the XML 
document. Parent elements must precede their child elements. You indent the tag 
names of child elements under their parent elements using one indentation per 
level. You list attributes under the elements that they define and you indent them 
to the child level. 

TagType 
You use this field to specify whether the name in the TagName field represents 
data of the type element or attribute. The drop-down list in a TagType field 
contains two options: Element and Attribute. The default setting is Element. 

SourceType 
You use this field to specify the data structure that the tag name corresponds to in 
the Microsoft Navision database. The SourceType field contains a drop-down list 
containing three options: Text, Table, and Field. The default setting is Text. 
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• Text: Select this option when the XML data cannot be mapped 
directly to the database or when the database does not need the 
information. The value of the Text field is put into a text variable 
with the name you have specified in the VariableName property 
(otherwise the tag name is used by default). The text variable acts 
like a normal global C/AL text variable. You can also turn the text 
source type into a big text variable by setting the TextType property 
to BigText. 

• Table: Select this option to indicate that the tag name is equivalent to 
a table or that a table record must be initialized. As with the Text 
option, you can specify a variable name for the table, which also acts 
like a global record variable. By default, the variable name is the 
name of the table. 

• Field: Select this option to indicate that the tag name is equivalent to 
a field in the database. However, for this selection to be valid, you 
must first have declared a table as the parent of the field. Failure to 
do so causes an error to occur when you try to compile the XMLport 
object. 

 
A DataSource field has the following interactions with the SourceType field: 
 

• If you have specified Table as the source type, clicking the 
AssistButton in the DataSource field opens the Table List window. 
You can also select a table by setting the SourceTable property. If 
you have defined a variable name for the table to be used, the format 
of the value shown in the DataSource field is 
TableVariableName(tablename). If you have not defined a variable 
name, the format of the value is shown as <tablename>(tablename). 

• If you have specified Field as the source type, clicking the 
AssistButton in the DataSource field opens the Field Lookup 
window. Here you can select a field from one of the tables you have 
specified in the XMLport. The format of the value is shown as 
tablevariablename::fieldname. 

 

Saving, Compiling, and Running a XMLport 
When you have designed an XMLport, you must save and compile it before you 
can use it. Normally, you do this when you have finished designing the 
XMLport. However, you may want to save an XMLport that is not yet finished 
and therefore cannot be compiled. You can also test-compile an XMLport 
without closing or saving it. 

Saving and Closing an XMLport 
When you close the XMLport Designer, you close the XMLport. 
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To save an XMLport: 
 

• When you close an XMLport, C/SIDE asks whether or not you want 
to save your changes. If it is a new XMLport (an XMLport that has 
not been saved before), and you choose to save, you have to assign 
an ID and a name to the object. The ID must be unique and must 
follow the rules for numbering objects. Your Microsoft Business 
Solutions partner provides you with this information.  

• Hint: If you set up the ID and Name XMLport properties, their 
values are automatically used, and you therefore are not prompted 
for ID and Name information when you close the XMLport. 

• The option field Compile is by default set to True (displayed as a 
check mark). If the XMLport that you have designed is not yet ready 
to be compiled, remove the check mark by clicking the field. 

• Click OK to save the XMLport. 
 
You can save an XMLport without closing it by choosing Save or Save As from 
the File menu. By using Save As, you can rename an existing XMLport. Note 
that you can copy an XMLport by opening and saving it with a new name. 

Compiling an XMLport 
XMLports, like other objects in C/SIDE, must be compiled before they can be 
run. As described previously, you can choose to compile an XMLport whenever 
you save it. 
 
While you are designing an XMLport, you may want to test-compile it to find 
possible errors. You can test-compile an XMLport during design by choosing the 
Compile option in the Tools menu. 

Running an XMLport 
XMLports are always called from other objects. They cannot run alone. While 
you are designing an XMLport, you may often want to run it before it has been 
integrated into an application to check that it functions as you intended. To do so, 
you can create a test-run codeunit that calls the XMLport and either streams data 
to or from a file depending on whether you are importing or exporting data.  
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Here is an example of a test-run codeunit that calls an XMLport to import data 
from an XML file: 
 

 
 
The four functions in the OnRun section perform the following: 
 

• Open the Import.xml file. 
• Create an InStream object so that the XML data can be streamed 

from the file. 
• Load a specific XMLport object and give it the source from which it 

shall read and parse the incoming XML data stream. 
• Close the Import.xml file. 

 
For more information about streaming data to and from files or from automation 
components, see the C/SIDE Reference Guide online Help and the Development 
Guide for Communication Components online Help. The latter is available on the 
Microsoft Navision product CD and is installed as part of the Microsoft Navision 
Application Server. 

Designing XMLports 
An XML document contains XML tags, which identify the nature of the content 
that they contain. To create an XMLport to import the data in an XML document, 
specify all the XML tag names and indicate the type of each, that is, whether it 
represents an element or an attribute. Then map these tag names to corresponding 
data structures (tables, records or fields) in the Microsoft Navision database. At 
runtime, when an XMLport object is called to handle an incoming XML 
document, it reads the incoming data stream and performs the processing and 
database actions. 
 
When you want to create an XMLport to export data from the Microsoft 
Navision database in XML format, the XMLport Designer enables you to build 
the tag structure of the XML document and map the data. At runtime, the 
XMLport object reads the required data from the database, add the necessary 
XML tags to form the XML document and write the document to a data stream. 
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XMLports do not handle XML documents that: 
 

• Modify existing data in the database 
• Find and delete data in the database 
• Query the database for data (item catalog information, for example) 

 
If you need to work with an incoming document of one of these types, you can 
do so using C/AL code and by carrying out the database manipulation necessary 
to achieve the desired result. 

XMLport Properties 
This set of properties describes the XMLport in general, and this is also where 
you specify the format of the external file. 
 
Note that Import and FileName can be set and reset dynamically. For example, 
you can create a XMLport where the user can select whether to import or export, 
or select the name of the external file to read from or write to (or you can 
generate a filename automatically once the XMLport is run) 
 

 
 

TagName Properties 
This set of properties describes the TagName items of the XMLport, which 
defines the structure of the XMLport. 
 
Property Meaning 
Indentation Sets the indentation level of an element or attribute in 

the XMLport designer. 
TagName Specifies the name of a tag in an XML document. 

This is inserted in the TagName field of the element 
or attribute in question. 
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Property Meaning 
TagType Specifies whether an XML object is an element or an 

attribute. 
SourceType Use this to specify what a particular tag in the 

XMLport designer corresponds to in the Microsoft 
Navision database. 

SourceTable This tells the system the table to which you want to 
map (import) XML data or the table from which you 
want to export XML data.  

SourceField Selects the field that you want to map XML data to. 
TextType Specifies which type of text this element or attribute 

contains. 
FieldValidate Specifies whether or not the values in the source field 

should be validated by the OnValidate trigger for the 
field. 

VariableName Used to specify a variable name for the table that you 
have specified in the SourceTable property. Also used 
to specify a variable name for the text if that was 
specified in the SourceType property. 

SourceTableView Use this to filter the data in the table set as the source 
for this XML item. 

CalcFields Automatically calculates the information for 
FlowFields entered here. 

AutoCalcField Used to determine whether or not the value in the 
FlowField should be recalculated before the field is 
exported. 

LinkTable Only used for SourceType of Table, this determines to 
which table the XML item should be linked. 

LinkTableForceInsert Use this to specify whether or not data from the linked 
table should be forcibly inserted into a table in order 
to prevent the system from generating an error. 

LinkFields Use to specify the fields from the two tables that are 
linked by the LinkTable property. This is only 
available for XML items with Table as their data 
source. 

Temporary Creates a temporary table in the XMLport. 
MinOccurs Specifies the minimum number of times that an 

element can occur. 
MaxOccurs Specifies the maximum number of times that an 

element can occur. 
Occurrence Used to specify whether or not an attribute must occur 

in the data being imported or exported. 
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Sample XMLports 
We now create a couple of simple XMLports to get you familiar with the basics. 
More complex examples can be found in Chapter 21 of the version 4.0 
Application Designers Guide. 

Simple Export 
The first exercise is very basic. Start by creating an XMLport that exports some 
basic customer information. 
 

1. On the Tools menu, click the Object Designer. 

2. In the Object Designer, click the XMLport button. 

3. Click on the New button. The following screen appears: 

 

 
 

4. Fill in the XMLport as shown on the following screen. Remember 
the following rules: 

– Use the indent buttons at the bottom of the form for proper 
indentation. 

– Make sure the TagName "Customer" has a SourceType of Table 
and a DataSource of "Customer". 
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– Use the Field Lookup form to verify your field selections  
 

 
 

5. From the XMLport Properties form, change the "Direction" property 
to Export. 
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6. Close the XMLport Designer and save as XMLport 123456750 − 
"XML Export − Basic Customer". 

 

 
 
If you remember, XMLports cannot run in a standalone manner − they must be 
run from another object. For that reason, we create a codeunit to run our 
XMLport. Since we have not yet covered codeunits in this manual, this is very 
basic and straight-forward. 
 

1. On the Tools menu, click the Object Designer. 

2. In the Object Designer, click the Codeunit button. 

3. Click on the New button. 

 The following screen appears: 
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4. In the OnRun trigger, enter the code to appear as follows: 

 

 
 

 
 

5. Add the following Global variables: 

6. Finally, save the new codeunit as follows: 

 

 
 

 Notice that, using C/SIDE code, we have now linked the XMLport 
123456750 to the codeunit 123456751. 
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 Also, please note that this codeunit is designed to create a new text 
file "C:\XML_Customer.xml". If this is not acceptable on your 
system, please make the necessary modifications. 

7. Next, run the codeunit. When finished, the following message 
displays: 

 

 
 

8. Finally, locate the new file "C:\XML_Customer.xml" on your 
system. Double-clicking this file should open it in your browser 
(Internet Explorer window). 
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Simple Import 
Now that we have created an XML document, it is imported back into Microsoft 
Navision. 
 
We really do not want to import directly back into the customer table, so we 
create a new "XML Import" table for this information.  
 
The "XML Import" table (123456753 XML Import − Basic Customer) should be 
provided on your class CD in the XMLport .fob file. If this is not available, then 
proceed as follows: 
 

1. Using what you have learned from Chapter 2, open the Object 
Designer and create a new table. Enter the information as follows: 

 

 
 

2. Now, save your table. 

 

 
 

3. Open the existing XMLport 123456750 in designer mode. From the 
Tools menu, select FILE→SAVE AS, and enter the following 
information: 

4. Now, Design the new XMLport 123456751 and change the Direction 
property to "Import".  

5. Select the "Customer" TagName, and change the SourceTable 
property to "XML Import − Basic Customer" (Table 123456753). 
This corresponds to the new table we created for XML imported 
information. 

Page 411 



 

 

Microsoft Navision Development I − C/SIDE Introduction 

6. You now have to re-validate each of the Field Elements. The 
DataSource has changed from the Customer table to the new XML 
Import table. Your results should look as follows: 

 

 
 

7. Save your changes to the XMLport. 

 Now, we have to create a new codeunit for this XMLport. Again, 
since we have not covered codeunits in this manual, we take you 
through this step by step: 

8. On the Tools menu, select Object Designer. 

9. From the Object Designer, click on the Codeunit button. 

10. Click on the New button. 
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11. Once a new codeunit screen appears, enter the following code and 
global variables: 

 

 
 

12. Close the codeunit and save as 123456752 − "XML Import − Basic 
Customer". 

13. Finally, you are ready to run the codeunit and XMLport. After 
executing the codeunit, you should get the following message: 
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Now, go back into Object Designer and select "Tables". Locate our XML Import 
table (123456753) and press the Run button. Your results should appear as 
follows: 
 

 
 
You have now successfully Exported and Imported Microsoft Navision 
information using XMLports. 
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Test Your Knowledge − XMLports 
 

1. What is the major difference between a Dataport and an XMLport? 

 

2. The XML tag name information is stored in what field? 

 

3. Which field would you use to specify whether the name in the 
TagName field represents data of the type element or attribute? 

 

4. Which field specifies the data structure that the tag name 
corresponds to in the Microsoft Navision database? 

 

5. How are XMLports called? 

 

6. True or False. An XMLport cannot modify existing data in the 
database. 

 

7. What is the purpose of the "Direction" property of an XMLport? 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 

 

 

 

 
 

Page 416 



 

 

Chapter 21: Codeunits 

CHAPTER 21: CODEUNITS 
This chapter explains what a codeunit is and how to create one. It also shows you 
how to use the functions in a codeunit from other application objects within 
Microsoft® Business Solutions−Navision®. 

Training Objectives 
In this chapter, you learn about: 
 

• The C/SIDE Codeunit 
• Creating Codeunits 
• Using Codeunits 
• Chapter Review 
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The C/SIDE Codeunit 
You may have seen examples of C/AL code in forms and reports. In fact, C/AL 
code can be stored in a form, report, or other object. In simple applications, the 
normal approach is to place the code in the object that calls the functions, but as 
your application grows you often find that you use the same functions repeatedly. 
Instead of declaring the same functions over and over again, it would be useful if 
you only had to define them once. This is where the codeunit becomes useful. 
Think of a codeunit as a container for C/AL code that you want to use in many 
application objects. In codeunits you can define: 

Functions  
A function is a sequence of C/AL statements, which you define in order to create 
new functionality. Within each function, you can define local variables, that is, 
variables whose scope is limited to the function in which they are defined. 

Global variables  
A global variable is a variable whose scope covers all the functions in the 
codeunit. 

Temporary tables  
A temporary table is a table that is not stored in the database. Temporary tables 
are mainly used as structured variables that hold data temporarily while you work 
on it. Refer to Defining and Using a Temporary Table in Chapter 2 for a 
description of how to create a temporary table. 
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Each function you add to a codeunit is shown in a separate section when you 
view the file in the C/AL editor. 
 

 
 
All codeunits include two default triggers called Documentation and OnRun. In 
the Documentation section, you can add optional information about the code such 
as the purpose of the codeunit, a version number and so on. In the OnRun 
section, you can include code that you want the system to execute when the 
codeunit is run. 
 
NOTE: Codeunits contain functions but can also be run. Besides being a container for 
functions that can be run individually, a codeunit can itself be run by writing 
<CodeunitVariableName>.Run. When you run a codeunit, it is the code in the OnRun 
section of the codeunit that is run. 

 

Creating Codeunits 
You create a new codeunit or modify an existing codeunit in the same way you 
create and modify other application objects, that is, by using the Object Designer. 
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To create a codeunit: 
 

1. From the menu bar, choose TOOLS→OBJECT DESIGNER. C/SIDE opens 
the Object Designer. 

 

 
 

2. Click the Codeunit button in the Object Designer. 

3. Click New to create a new codeunit. C/SIDE opens the C/AL editor, 
where you can create functions. 

To modify an existing codeunit: 
 

1. Click the Codeunit button in the Object Designer. 

2. Select the codeunit you want to modify. 

3. Click the Design button. C/SIDE opens the C/AL editor, where you 
can modify the codeunit by changing existing functions or adding 
new functions. 

Using the C/AL Editor 
The C/AL editor is where you view and edit your code. This editor is designed to 
make it easy for you to create and modify C/AL code. When you are in the 
editor, you have access to the C/AL Symbol Menu that helps you define C/AL 
functions. When you use the C/AL Symbol Menu, you can get help about all 
C/AL functions. Select the C/AL function name in the column to the right and 
press F1. 
 
When you create a codeunit, the window shows the two default sections 
described above (the Documentation and the OnRun section). 
 
From the Object Designer you can open as many codeunits as you like. Each 
time you create a new codeunit or open an existing one, it is displayed in a 
separate window. This makes it easy to cut and paste lines of code between the 
codeunits. 
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If you have tried to use other Microsoft® Windows® editors, you may find the 
C/AL editor easy to use. You can access the editing functions both from the Edit 
menu and from the toolbar. 
 

  

Use the Cut, Copy 
and Paste functions 
to edit the C/AL 
code. 
Write 
documentation for 
the codeunit here. 
 
Add your own 
functions here 

 
 
 Paste 

 
 
 

Cut   Copy  
When you are working in the C/AL editor, you can use a number of shortcut 
keys: 
 
To Press 
Cut the selected text to the clipboard. CTRL + X 
Copy the selected text to clipboard. CTRL + C 
Paste the text at the clipboard into the codeunit at the cursor 
position. 

CTRL + V 
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Defining Variables, Text Constants and Functions in 
Codeunits 
When you have created a new codeunit, the next step is to define the global 
variables, text constants and functions you need in the codeunit. You use the 
C/AL Globals tool for this. 
 
To access the C/AL Globals tool: 
 

1. Make sure that focus is on the C/AL editor. From the View menu, 
choose C/AL Globals. C/SIDE displays the C/AL Globals window: 

 

 
 

2. In the C/AL Globals window, you select whether you want to add a 
global variable or a function. 

 
To add a global variable: 
 

1. Click the Variables tab in the C/AL Globals window. 

2. Add a name and a type. If the type you select corresponds to an 
application object, you also have to add a subtype, that is, the name 
of a specific object in the database. If you select text or code, you 
have to define a length for the variable (the default length is 10 
characters for code, and 30 for text). If you select OCX or 
Automation, you also have to add a subtype. 
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To add a Text Constant: 
 

1. Click the Text Constants tab in the C/AL Globals Window. C/SIDE 
displays: 

 

 
 

2. Enter the name for each Text Constant you want to add. 

 
To add a function: 
 

1. Click the Functions tab in the C/AL Globals window. C/SIDE 
displays: 

 

 
 

2. Enter a name for each function you want to add. 

Page 423 



 

 

Microsoft Navision Development I − C/SIDE Introduction 

3. Press the Locals button to define the parameters, return value and 
local variables for each function. C/SIDE displays the C/AL Locals 
window: 

 

 
 

4. For each parameter you have to specify the calling method, a name, 
and a data type. You can specify a subtype and a length, but this is 
optional. 

 The calling method can be specified as Var, which means that the 
parameter is passed by reference rather than by value. The value of a 
variable can only be changed by a function when it is passed to the 
function by reference. When the parameter is not specified as Var, 
only a copy of the variable is passed to the function. If the function 
changes that value, the change affects only the copy and not the 
variable itself. 

 If the type you select corresponds to an application object, you also 
have to add a subtype, that is, the name of a specific object in the 
database. If you select text or code you have to define a length for it 
(the default length is 10 characters for code, and 30 for text). 

Page 424 



 

 

Chapter 21: Codeunits 

5. Click the Return Value tab to define the return value for your new 
function. C/SIDE displays: 

 

 
 

6. Enter a name for the return value and select a data type from the 
drop- down list. You can also select a length, but only if the type is 
text or code. 

7. Click the Variables tab in order to define local variables. C/SIDE 
displays: 
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8. For each local variable, you must add a name and a type. If the type 
you select corresponds to an application object, you also have to add 
a subtype, that is, the name of a specific object in the database. If you 
select text or code, you have to define a length for the variable (the 
default length is 10 characters for code, and 30 for text). 

 

 
 

9. Click the Text Constants tab to define those that may be used in this 
function. C/SIDE displays: 

10. Enter the Text Constant codes and values as necessary. 

Using the C/AL Symbol Menu 
When you write C/AL code in the editor, you can use the C/AL Symbol Menu to 
get an overview of: 
 

• All variables defined in the codeunit. 
• All C/AL functions. 
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The information in the C/AL Symbol Menu is divided into columns. The column 
to the left shows variable names (if you have defined any) and function 
categories. The second column shows the sub-categories, and the third column 
(to the right in the picture below) shows the functions in the category you have 
selected. You can see the syntax in the bottom of the window, and you can use 
the OK or the Apply button to make C/SIDE insert this string in the C/AL editor. 
 

 
 
In some cases − for example, when a control on a form is a subform or when a 
field is a BLOB field − there are more than three columns. You can use the right-
arrow button to scroll the symbol menu columns to the right (and the left-arrow 
button to scroll them back). 
 
If you use the OK button, the Symbol Menu window is closed automatically; it 
stays open if you use the Apply button. 
 
If you need help about any of the C/AL functions shown in the column to the 
right, put the focus on the function name and press F1 to activate the context- 
sensitive online C/SIDE Reference Guide. 

Compiling and Saving Codeunits 
Before the functions in a codeunit can be run, the code has to be compiled and 
saved. When you compile the code, the system checks the syntax of the 
statements. If the compiler finds any errors in the code it displays a message. 
 
To compile the code in a codeunit: 
 

1. From the Tools menu, choose Compile. 

2. If the system finds any errors in your code it displays a message. 
Correct the errors and choose Compile from the Tools menu again.  
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To save the codeunit: 
 

1. From the File menu, choose Save. C/SIDE displays: 

 

 
 

2. Enter an ID number and a name. The number is used as a unique 
identification, while the name serves as a label. If you save the 
codeunit without compiling it, you are not able to run it or call any of 
its functions. 

 
NOTE: Why Save without Compiling? If you are working on a large and complicated 
codeunit, you may want to save your work at regular intervals, even though it is not yet 
finished and cannot yet be compiled. In this case, you have to remove the check mark 
from the Compiled box before you save. 

 

Using Codeunits 
When you use codeunits, you eliminate the need to duplicate code and at the 
same time make the code easier to maintain. If you use the same code repeatedly 
in your forms or reports, you should create a function in a codeunit. When you 
have created a function in a codeunit you can access it as: 
 
<CodeunitVariableName>.<FunctionName> 

 
Example: 
 
Assume that you have created a codeunit containing two statistical functions 
named F and G. The illustration below shows how to access these functions from 
a form. 
 
Codeunit named StatisticsFunctions 
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F(x:integer) 

Begin 

 ... 

End 

 

 

G(x:integer) 

Begin 

 ... 

End 

 

Any form  
(Global variable StatFun declared as codeunit with subtype 
of StatisticsFunctions) 

 

... 

 

Result := StatFun.F(3425) + StatFun.G(346); 

 

... 

 

 
This method is generally applicable. That is, from any application object you can 
access functions in other application objects by prefixing the function name with 
the name of the application object containing the function. 
 
You can access codeunits through codeunit variables − either by explicitly 
declaring a variable with the data type codeunit or by setting the RunObject 
property on forms to a codeunit. A codeunit variable does not contain a codeunit, 
but only a reference to a codeunit. More than one codeunit variable may refer to 
the same codeunit. See the figure below. 
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Codeunits contain internal variables that are defined as global variables. These 
variables are not accessible directly from code outside the codeunit, but they can 
be accessed through user-defined functions on the codeunit. 
 
Whenever a codeunit variable is used for the first time, a new instance of the 
codeunit is created, that is, a new set of internal variables is initialized so that 
different codeunit variables use different sets of internal variables. 

Codeunit assignment  
Codeunits can be treated as objects − one codeunit variable can be assigned to 
another codeunit variable, which creates a new reference to the same codeunit 
instance. In other words, the codeunit variables then use the same set of internal 
variables. 
 
Example: 
 
Codeunit 50000 has two functions SET and GET. Set sets an internal variable to 
the value of the parameter given. GET returns the value of the internal variable. 
 
VAR 

 CoMIC1: Codeunit 50000; 

 CoMIC2: Codeunit 50000; 

 

//codeunit 50000 is a standard codeunit 

BEGIN 

 CoMIC1.Set(1); 

 CoMIC2.Set(2); 

 //both codeunit variables are instantiated - they have 

 //different instances 

 

 CoMIC1.Get(); 

 CoMIC2.Get(); 

 //CoMIC1 returns 1; CoMIC2 returns 2 

 

 CoMIC2 := CoMIC1; 

 //CoMIC2 is assigned to CoMIC1 and they now both use  

 //the same instance 

 

 CoMIC1.Get(); 

 CoMIC2.Get(); 

 //both codeunit variables return 1 

END; 
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CLEAR on codeunits  
When you use the function CLEAR on a codeunit variable that has a reference to 
a codeunit instance with two or more references, CLEAR only deletes the 
reference to the codeunit and not the actual codeunit instance. In other words, the 
codeunit stays intact and can still be used by other codeunit variables that may 
have been assigned a reference to this codeunit. To delete a codeunit instance, 
you must clear all references to the codeunit with the function CLEAR. If you 
need to clear the internal variables in a codeunit, you must call CLEARALL from 
a user-defined function within the codeunit. When a local codeunit variable goes 
out of scope, meaning that it is no longer used by the codeunit, it is automatically 
cleared. 

Single Instance Codeunit 

In some cases, the situation requires that only one instance of a codeunit exist. 
This means that all codeunit variables of a particular codeunit use the same set of 
variables. By setting the SingleInstance property for the codeunit to Yes, all 
codeunit variables of that codeunit use the same instance, thus allowing the 
developer to create global variables. 
 
NOTE: It is recommended that you avoid using global variables for most types of code. 
However, in certain situations, it may be necessary to use them, for example, to make 
sure that you are only using one instance of an external variable. 

 
A single instance codeunit is instantiated when you use it for the first time. 
Normal codeunit instances (codeunits that do not have the SingleInstance 
property set) are deleted whenever the last codeunit variable that uses that 
codeunit instance goes out of scope. However, single instance codeunits remain 
instantiated until you close the company. 
 
Example: 
 
Codeunit 50001 has two functions, SET and GET Function SET sets an internal 
variable to the value of the parameter given. Function GET returns the value of 
the internal variable. Codeunit 50001 has the SingleInstance property set. 
 
VAR 

 CoSIC1: Codeunit 50001; 

 CoSIC2: Codeunit 50001; 

 

//codeunit 50001 is a single instance codeunit 

BEGIN 

 CoSIC1.Set(7); 

 //a codeunit instance is created if one did not exist 
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 CoSIC2.Get(); 

 //returns 7 - CoSIC2 uses the same instance as  

 //CoSIC1, so they use the same internal variables 

END; 

 

 
NOTE: It is possible to use a single instance codeunit across objects and not only 
within the same object. 

 

Limitations on Codeunits 
Global variables and temporary tables in a codeunit cannot be accessed directly 
from other application objects. The only way to access these values is through the 
functions you have created in the codeunit. 
 
All C/AL functions can be used in a codeunit. Notice, however, that you cannot 
create a function with the same name as a built-in function. Neither can two or 
more user-defined functions have the same name (unless they are part of different 
application objects). 
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Test Your Knowledge 
 

1. What triggers are available in every codeunit? 

 

2. What key can you press to open the Symbol Menu? 

 

3. To call a function in a codeunit from another object, what must be 
done first? 

 

4. Can two codeunit variables refer to the same instance of a codeunit? 

 

5. Can two codeunit variables declared in the same object refer to 
different instances of a codeunit? 

 

6. How would you change a codeunit variable to point to the same 
instance of a codeunit as another codeunit variable? 

 

7. What function can you use to make a codeunit variable point to a 
new instance of a codeunit? 

 

8. If a codeunit is designed as a single instance codeunit, can two 
codeunit variables refer to different instances of that codeunit? 

 

9. How would you address a global variable of a codeunit from an 
object that has a variable, called CU, for that codeunit? 

 

10. Can you create a function called Power in a codeunit? 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 22: MENUSUITES 
This chapter describes the MenuSuite object, which contains the menu suite 
content that is displayed in the Navigation Pane and in the Navigation Pane 
designer. 
 
It should be noted that, although the MenuSuite is classified as a Microsoft® 
Business Solutions−Navision® object, it cannot be referenced programmatically. 

Training Objectives 
In this chapter, you learn about: 
 

• MenuSuite Fundamentals 
• Customizing a MenuSuite 
• Exporting a MenuSuite Object 
• Upgrading MenuSuite Content 
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Menu Suite Fundamentals 
The MenuSuite object contains the main menu content that is displayed in the 
Navigation Pane and in the Navigation Pane Designer. A menu suite is a set of 
menus. Each menu contains content for a specific departmental area, for 
example, Finance or Manufacturing. 

Creating and Designing MenuSuite Objects 
To create a new MenuSuite object or design an existing one, you click the 
MenuSuite button in the Object Designer, and then click New or Design. 
 

 
 

Clicking New 
This opens a dialog asking you to specify which design level you want to create 
an object for. If you have already created a MenuSuite object for all the levels 
you have permission to, a message appears informing you of this. Once you have 
made a selection, the Navigation Pane Designer opens. The MenuSuite object 
level that you are working on is shown in the header section of the Navigation 
Pane Designer. 

Selecting a MenuSuite object and then clicking Design 
This opens the Navigation Pane Designer with the chosen menu suite content 
displayed. The MenuSuite object level that you have selected is shown in the 
header section of the Navigation Pane Designer. 
 
You also have the following options: 
 

• You can select the FILE→IMPORT/EXPORT and TOOLS→TRANSLATE→ 
IMPORT/EXPORT OPTIONS. 

• You can compile MenuSuite objects (F11 or TOOLS→COMPILE). It is 
the object references that are compiled. If the MenuSuite object 
contains a reference to a nonexistent form, report, batch job, dataport 
or codeunit, a compilation error occurs. 
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The Run button in the Object Designer is disabled when you click the 
MenuSuite button because a MenuSuite object cannot be run. 

Customizing a Menu Suite 
You customize a menu suite in the Navigation Pane Designer. In the following, 
you can read about the design options that are available for developers. You 
access design options by right-clicking on menu buttons, menu groups, menu 
items, or anywhere in the content pane area. 
 
Refer to the Microsoft Navision online Help for information about the design 
options for administrators, which can also be used by developers. 

Creating Menu Items 
To create a menu item, you right-click in the content pane area or on a menu 
group or menu item, and select Create Item. The Create Item window opens in 
which you specify the menu item's object type, object ID, caption and captionML 
(Multilanguage caption). An example is shown in the following: 
 

 
 
For example, if you have created a new report and want to add it as a menu item 
to a particular menu, then you select Report in the drop-down in the Object Type 
field, and use the lookup in the Object ID field to select the report from the 
Report List. When you then click the Caption field, the name of the report is 
automatically filled in. You can rename it here if necessary. 
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The CaptionML field by default shows the code for the language that you use on 
your computer and the name of the menu item. If you have designed a menu item 
that is used in different languages by different users, you must give the menu 
item a name in each language. When you click the AssistButton in the field, the 
Multilanguage Editor window opens where you can enter a menu item name for 
each language code: 
 

 
 

Setting Properties 
There are four properties that you can set for a menu item in the Item Properties 
window; Object Type, Object ID, Caption and CaptionML. You open this 
window by right-clicking a menu item and selecting Properties. 
 

 
 
Property Description 

Object 
Type 

In the Object Type field, you can make a selection in the drop-
down box. The following object types are available: Table, 
Form, Report, Batch Job, Codeunit, and Dataport. 
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Property Description 

Object ID You use the lookup in the Object ID field to select a specific 
object from a list. For example, if you had selected Report as 
the Object Type, clicking the lookup displays the Report list. 

Caption By default, the Caption field contains the name that has been 
assigned to the menu item. You can rename it here if you want. 

CaptionML The CaptionML field contains the code for the language that 
you use on you computer and the name of the menu item, for 
example, ENU=General Journals. If the menu item is used in 
different languages by different users, you must give the menu 
item a name in each language. When you click on the 
AssistButton in the CaptionML field, a window opens where 
you can enter a menu item name for each language code. 

 

MenuSuite Object Levels 
Microsoft Business Solutions provides a generic MenuSuite object, which we 
call the Microsoft Business Solutions level. This object is changed in various 
ways before end users see its content. These changes are applied at different 
levels, which are categorized as Region, Country, Add-on, Partner and Company. 
For example, the MenuSuite object is changed when the application undergoes 
localization changes, which takes place at the Country level. If you are a 
developer working at a Microsoft Business Solutions partner, you customize a 
MenuSuite object at the Partner level. You can also configure a MenuSuite object 
at the Company level, which is the level that administrators work on. 
 
Changes that are made to a MenuSuite object are stored as the differences 
between the previous MenuSuite object level and the current one. For example, 
when a company administrator configures a MenuSuite object at the Company 
level, the modifications are stored as the differences between the Company level 
and the Partner level, which was the previous level. If you export a MenuSuite 
object in text format and then open the text file, information is shown about the 
changes that you have made seen in relation to the previous level. 
 
With the exception of the Add-on MenuSuite object for which a maximum of 10 
instances is allowed, there can only be one MenuSuite object for each level. 
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Exporting a MenuSuite Object 
You can export a MenuSuite object in Microsoft Navision object format (*.fob) 
or in text format. The text file contains information about the changes that have 
been made to the object since the previous level. In the following you can see an 
example of a text file that contains the changes that have been made to a 
MenuSuite object at the Company level. 
 
Example: 
 
When an administrator makes configuration changes to a menu suite, these 
changes are saved at the Company level. When this Company-level MenuSuite 
object is exported in text format, the text file contains information about the 
changes that have been made to the object since the previous level, which in this 
case would be the Partner level. Let us suppose that an administrator has made 
the following changes to his company's menu suite: 
 

• In the Finance menu, he has deleted a menu group called Setup, 
which contained one menu item called Accounting Periods. 

• He has added a new menu item, G/L Account Card, to the General 
Ledger menu group in the Finance menu. 

• He has moved the G/L Account Card menu item so that it is placed 
between the Chart of Accounts and Bank Accounts menu items in 
the General Ledger menu group. 

 
The text file would contain the following information: 
 
OBJECT MenuSuite 70 Company 

{ 

OBJECT-PROPERTIES 

{ 

Date=19-04-04; 

Time=16:04:10; 

Modified=Yes; 

Version List=; 

} 

PROPERTIES 

{} 

MENUNODES 

{ 

{ MenuItem ;[{FA8395A4-7A0B-4524-B0FD-20436D9711A4}] 
;Name=G/L 

Account Card; 
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CaptionML=ENU=G/L Account Card; 

MemberOfMenu=[{F8D2429D-034B-4C58-9B5E-81BE962DB1BC}]; 

RunObjectType=Form; 

RunObjectID=17; 

ParentNodeID=[{B12180CF-0EFB-43AD-9118-7765E953AAFD}]; 

Visible=Yes; 

NextNodeID=[{7A5B6DDE-B44B-41A0-95DA-69B7109F0E32}] } 

{ ;[{1BB06483-AFFD-4750-BF62-3ABA035E11B7}]; 

Deleted=Yes} 

{ ;[{DF601C8A-07F7-4841-8929-9F2065BCB302}]; 

Deleted=Yes} 

{ ;[{8AC7917D-2C91-457D-80D6-A24B42F71AE7}]; 

NextNodeID=[{FA8395A4-7A0B-4524-B0FD-20436D9711A4}]} 

} 

} 

 
The content of a MenuSuite object can be described as having the following 
characteristics: 
 

• It consists of a set of menus. 
• A menu contains a collection of menu nodes, which are displayed in 

the Navigation. 
• Pane/Navigation Pane Designer in a tree structure. 
• A menu node can be either a menu group or a menu item. 
• A menu node has a globally unique identifier (GUID) and various 

properties. 
• A menu group contains a collection of menu nodes. 
• A menu item is the lowest level in the tree. When you click a menu 

item, its associated form, report, batch job, dataport or codeunit is 
run. 

 

Upgrading MenuSuite Content 
Menus in a menu suite that are inherited from the previous MenuSuite object 
level have the symbol ">>" on the menu button to the left of the menu name. 
These menus are upgraded when you upgrade the corresponding MenuSuite 
object. Any changes that you have made to these menus are merged into the new 
menu suite when you upgrade. For example, a menu item that you have added to 
a menu group − but where the menu group's contents now have changed after an 
upgrade − is placed as the last menu item in the menu group. 
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However, there are cases where a straightforward merge cannot be carried out. 
For example, if you have added a menu item to a menu group that is no longer a 
part of the menu after an upgrade, then no merge can be made. Instead, the menu 
item is placed in a Lost Items group at the bottom of the menu tree. Another 
example would be if you had added one or more menu items to a menu that is no 
longer present in the menu suite after an upgrade. In such a situation, the menu 
items are placed in a Lost Items menu. 
 
After an upgrade, you can take action on the menu items in a Lost Items group or 
menu − either by inserting them somewhere in the current menu (in the case of 
the Lost Items group), in another menu or by deleting them. A Lost Items group 
or menu is not visible in the Navigation Pane at runtime. 
 
New menus that you have created are not affected by an upgrade. If there are new 
menu items available after the upgrade that you would like to insert in these 
menus, you have to add them manually. 
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Test Your Knowledge 
 

1. True or False. A MenuSuite cannot be accessed programmatically. 

 

2. What is the name of the design area used to work with MenuSuites? 

 

3. With the exception of the Add-on MenuSuite object, how may 
instances of a MenuSuite can there be for each Design Level? 

 

4. How many instances per Design Level can there be for an Add-on 
MenuSuite? 

 

5. What are two ways to open the Navigation Pane Designer? 

 

6. True or False. You can run a MenuSuite object from the Design 
menu. 

 

7. When you are creating a new item in a MenuSuite and select 
"Report" as the Object Type, what is displayed when you select the 
lookup button on Object ID? 

 

8. Name the six selections available in the Object Type property field. 

 

9. What are the five Object Levels of which a MenuSuite can be 
categorized? 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 23: USING ODBC 
In this section, we introduce you to the Microsoft® Business 
Solutions−Navision® NODBC driver. However, it is recommended that you read 
and go through the exercises that are part of the NODBC guide. In this chapter 
we discuss the following: 

Training Objectives 
In this chapter, you learn about: 
 

• Using ODBC 
• Why Use ODBC with Microsoft Navision 
• Installation and Setup of the NODBC Driver 
• Accessing Data From the Database Queries 
• Writing Data Back to Microsoft Navision 
• Limitations of the NODBC Driver 
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Using ODBC 
NODBC is Microsoft Navision Software's implementation of Open DataBase 
Connectivity (ODBC). NODBC lets you transfer data between Microsoft 
Navision databases and any program that supports ODBC. 
 
NODBC simply provides other applications that support ODBC a method of 
communicating with Microsoft Navision. Hence applications such as a 
spreadsheet or word processing program can retrieve needed data by 
communicating with Microsoft Navision through NODBC driver. 
 
The ODBC driver operates in a variety of environments including all Microsoft® 
Windows® platforms (9x and higher) and even UNIX (AIX). In these 
environments, it can function either as a stand-alone or as a client in a 
client/server configuration. 

ODBC Architecture 
The ODBC architecture has four components:  
 

• Application − Performs processing and calls ODBC functions to 
submit Microsoft® SQL® statements and retrieve results.  

• Driver Manager − Loads and unloads drivers on behalf of an 
application. Processes ODBC function calls or passes them to a 
driver.  

• Driver − Processes ODBC function calls, submits SQL requests to a 
specific data source, and returns results to the application. If 
necessary, the driver modifies an application's request so that the 
request conforms to syntax supported by the associated DBMS.  

• Data source − Consists of the data the user wants to access and its 
associated operating system, DBMS, and network platform (if any) 
used to access the DBMS.  
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The following illustration shows the relationship between these four components. 
 

 
 
Note the following about this diagram. First, multiple drivers and data sources 
can exist, which allows the application to simultaneously access data from more 
than one data source. Second, the ODBC API is used in two places: between the 
application and the Driver Manager, and between the Driver Manager and each 
driver. The interface between the Driver Manager and the drivers is sometimes 
referred to as the service provider interface, or SPI. For ODBC, the application-
programming interface (API) and the service provider interface (SPI) are the 
same; that is, the Driver Manager and each driver have the same interface to the 
same functions. 

Why Use ODBC with Microsoft Navision 
Integration with other applications is the main reason for using ODBC with 
Microsoft Navision. Through the use of ODBC you can use other applications 
such as a word processing program to create mail merge documents or a 
spreadsheet application to pull in account information that you wish to graph. 
 
There are a few facts that you must understand in order to determine when you 
would use the NODBC driver with Microsoft Navision. First in order to use the 
NODBC driver, you must have purchased the NODBC granule. Secondly, you 
can connect to Microsoft Navision either through a server connection or through 
a local connection. Regardless of the method you use to connect, the NODBC 
driver uses a connection, as does each person who also uses a NODBC session. 
Furthermore, if using a local connection you must remember that you can only 
have one connection to the database file at a time. Please ensure that the local 
license file (fin.flf) located in the client folder contains the NODBC granule. 
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Sessions are used by each: 
 

• ODBC connection  
• C/Side connection (That is, the On-line user using the Microsoft 

Navision client)  
 

Installation and Setup of the NODBC Driver 
Before you install NODBC the Microsoft Navision client must be installed. By 
default the NODBC driver is not installed when you install the Microsoft 
Navision client.  
 

1. Start the setup program. Select Tools. 

2. The following dialog box appears: 

 

 
 

3. Select NODBC and choose Installation. The following window 
appears: 
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 Click Next. The following dialog box appears. In order to avoid 
problems it is recommend that you install this application for anyone 
who uses this computer. 

 

 
 

 Click Next. This dialog box appears: 
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4. Enter the appropriate User and Organization information and Click 
Next. The following appears: 

 

 
 

5. Click Install. The program installs NODBC. The necessary files are 
copied to your system, NODBC is registered and a sample NODBC 
data source is installed. The installation is finished when the Setup 
Completed dialog box appears. Click Finish one last time to close 
the dialog box. 
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Setting Up a Data Source 
Once you have installed all the files, you are now ready to create a DSN. In order 
to set up a DSN you must go to the control panel and click the Administrative 
Tools option and select Data Sources (ODBC). Please note that the name is 
different depending on the Version of Windows that you are using. You should 
see the following: 
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Determine what type of DSN you wish to set up. The User DSN is used when 
you only want certain users on this machine to see the DSN. A User DSN (in this 
example, "Microsoft Navision Database") is what's created by the NODBC 
example that gets installed. However, we shall use a System DSN because it is 
available for all users on this machine. Click on the System DSN tab and then 
click on the Add button, which should display the window below: 
 

 
 
Select the Microsoft Navision Driver and click the Finish button. You are 
prompted to enter information about the setup. Please configure your driver as 
shown below: 
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If you refer to the NODBC Setup window above, notice that we are configuring 
this to connect to a local database. It is important that you specify the path to the 
Microsoft Navision fin.exe in the Program Path so that you are able to connect. 
 
NOTE: The client and the NODBC version must be the same. 

 
Please note that we've filled in the company name for the example; however, if 
you wanted to be prompted for the company that you want to connect to then you 
would leave the company blank.  
 
We have also not entered the User ID or Password because our database does not 
have security. However, in situations where Security is an Issue, it is 
recommended that the User ID and Password be left blank in NODBC setup. 
Therefore, the user is required to enter in his or her ID and Password whenever 
accessing data from outside Microsoft Navision, which ensures that only users 
you wish to connect to Microsoft Navision are allowed to connect. Furthermore, 
Microsoft Navision ensures that the users only have access to those areas that 
you have granted them access. 
 
Here's a brief overview of security with NODBC. Microsoft Navision uses the 
defined security permissions whether accessing the database from within, or 
outside of Microsoft Navision using NODBC. If a user does not have read 
permission for specific table-data, they cannot read that table from either 
Microsoft Navision, or from NODBC. In addition to setting up security for users, 
you also need to create a group for NODBC users.  
 
As originally set up, only SUPER users can use NODBC to retrieve data from 
Microsoft Navision using outside applications. This is because System 
permission is not assigned to other users. To allow other users to operate 
NODBC a new group should be set up. Call the new group NODBC, or some 
other self-explanatory name. Assign the following permissions to this group: 
 

Object Permissions 
Type ID Name Read Insert Modify Delete Execute 
Table Data 2000000006 Company Yes    Yes 
System 9130 NODBC Yes Yes Yes Yes Yes 

 
These permissions allow users to execute the NODBC Drivers and retrieve data 
using applications outside Microsoft Navision. The only way to grant the System 
9130 permission is to grant full Read, Insert, Modify, Delete and Execute 
Permissions. These Permissions do not allow a user access to any table data. 
Therefore, the NODBC users need to be granted read permission to table-data 
from other groups.  
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In order to configure the options, click on the Options button and the following 
window appears. 
 

 
 
When you set up the NODBC driver, think over the options that can influence the 
performance of NODBC. First make sure the Commit Cache is checked and that 
you have set a large number to the DBMS cache in order to improve the 
performance. You also want to remove the check mark from Enable BLOB fields 
if you are not going to be moving blobs fields as in our example. 
 
The options in the Identifiers field control the way identifiers (table names and 
field names) are transferred from Microsoft Navision to an external program. The 
choice you make affects the way you use identifiers in external programs and the 
way you must write SQL statements. As an example, Microsoft Query does not 
support identifiers with dots (for example, the No. field in many tables). To have 
Microsoft Query handle these names correctly, use a data source with the All 
Except DOT option in the Identifiers field. Furthermore, we must use quoted 
identifiers when writing our SQL statements. You can read about this in the 
NODBC manual. 
 
Finally click OK on the NODBC Options window and the NODBC Setup 
windows. 
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The System DSN has just been created. 
 

 
 

Accessing Data from the Database Queries 
After you have configured your NODBC driver, you are able to query the 
Microsoft Navision database. Our example is a Customer Delinquent report. 
We've been instructed to pull the following columns for the report: 
 
Customer No_, Due Date, Document Type, Document No_, Document Date, 
Amount, Open. You must also calculate the Age of the account in a column that 
is called Age. 
 
Shown below are the steps that you would take: 
 

1. Start Microsoft® Excel and make sure that you have a new 
Worksheet. 
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2. Click on DATA→GET EXTERNAL DATA→NEW DATABASE QUERY. Select 
the new "Microsoft Navision ODBC Sample" you just created. Click 
OK to be connected to the data source (Microsoft Navision 
database). The Query Wizard appears prompting you to select the 
columns from the table(s) that you are using. We use the Customer 
Ledger Table in this example. 

 

 
 

 Choose the columns as shown above and click Next. 

3. Next you need to determine what data to filter out. Since you only 
want to see open entries we set our filter as shown below. Please 
note that False = 0 and 1 = True. 

 

 
 

 After entering the Filter Data, click Next. 
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4. Now determine how you want the data sorted. You want to sort by 
the Customer No and the Due Date. Therefore, we set the sort order 
as shown below and click on the Next button. 

 

 
 

5. You are now ready to finish the query; select View data or edit query 
in Microsoft Query and click Finish. 
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 You have the option of editing the SQL statement to remove the 
Open column from the select statement. The SQL statement that you 
would want would be: 

 
SELECT "Cust_ Ledger Entry"."Customer No_", "Cust_ Ledger 
Entry"."Due Date", "Cust_ Ledger Entry"."Document Type", 
"Cust_ Ledger Entry"."Document No_", "Cust_ Ledger 
Entry"."Document Date", "Cust_ Ledger Entry".Amount 

FROM "Cust_ Ledger Entry" "Cust_ Ledger Entry" 

WHERE ("Cust_ Ledger Entry".Open=1) 

ORDER BY "Cust_ Ledger Entry"."Customer No_", "Cust_ Ledger 
Entry"."Due Date" 

 

 
6. After you have verified the query click on FILE→RETURN DATA TO 

MICROSOFT EXCEL as shown below: 

 

 
 
You can now add a new column called Age to show the number of days past the 
due date that the account is delinquent. 

Writing Data Back to Microsoft Navision 
The example that we are looking at is very simple and requires no programming. 
We are using Microsoft® Access® 2003 (for this courseware) and we are creating 
links into Microsoft Navision. The course assumes that you have knowledge of 
Microsoft Access. 
 

1. Open up Microsoft Access and select Blank Database. 
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2. Click on the FILE→GET EXTERNAL DATA→LINK TABLES.  

3. Click Files of type and select ODBC Databases() and the window 
below appears. Click the Machine Data Source tab. 

 

 
 

 Select the Data Source Name that you have created (Microsoft 
Navision ODBC Sample) and click OK. 

4. Link Tables window should appear. Select Location and click OK. 
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5. You are now ready to select and open the linked table. See the 
window below: 

 

 
 

6. Select the Unique Record Identifier (Code) and Click OK. The 
following window appears: 

 

 
 

 Select the Location field and click Open (or Double-click on the 
Location field) to see the following: 

 

 
 

Page 460 



 

 

Chapter 23: Using ODBC 

7. Next add the Location BLACK as shown below with the following 
information: 

 
Code = BLACK, Name = Black Warehouse, 

Address = 2 Late St, City = Atlanta 

Country = USA, Post Code = 30096 

Contact = Joe B. Cool 

 
Once you have closed your ODBC session, you can open your Microsoft 
Navision client and verify that your data was actually entered. 
 
NOTE: Data entered through ODBC is not validated. Therefore, it is very important 
that you ensure the data entered meets with the Microsoft Navision data type for that 
field. Furthermore, any fields that might get automatically filled in while in Microsoft 
Navision has to be manually populated. 

 
When using the NODBC driver, it is recommended that you store data first in a 
holding table. You would then have C/AL code to actually process data that you 
have imported. Another option is to have a person go through and validate the 
data. However, as you can imagine, this is a slow process and leaves the 
possibility of something being overlooked. 
 
Now, if you bring up Microsoft Navision and click on WAREHOUSE MANAGEMENT 
→ SETUP→LOCATIONS. Next, look up the BLACK location that we created. 
Luckily most fields in this particular table do not have relationships to other 
tables. However, the Country field does have a relationship. See the BLACK 
Location Card below:  
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If you were to click in the field, notice that we have stored the wrong data in this 
field. The Country Code should = US. Correcting the Country Code is easy since 
the data already exists. However, observe that there is also a lookup for the Post 
Code. If you look up in this field, notice there is no entry. Therefore, you must 
manually create the entry. As this short example has shown you must be careful 
when importing data using the NODBC driver. Furthermore, since manual 
checking of the data is so resource intensive, we recommend again that you store 
the data into a holding table and use a C/AL code to process the data and validate 
the information. 

Limitations of the NODBC driver 
You are not allowed to validate any fields while using NODBC. Therefore, the 
data is not checked against the Business rules when writing data in a Microsoft 
Navision Database through NODBC. 
 
Note that setting flow filters and ordering on certain versions causes Microsoft 
Navision to drop the filters. 
 
The NODBC driver doesn't support outer joins. 
 
NODBC doesn't work with SQL Server; however, you can use the Microsoft 
SQL ODBC driver. Note that while the Microsoft ODBC driver allows you to 
run SQL statements, it does not calculate flow fields for you because of the way 
they are stored on the SQL Server. However, you can access the table the flow 
field is based on and use it to calculate the value. 
 
SQL DTS uses are OLE-DB functions and our NODBC driver is not OLE-DB 
compliant. Therefore, when attempting to insert data in Microsoft Navision and 
linked servers you may receive the following error. "Expected lexical element 
not found", which indicates a syntax problem (i.e. the SQL statement is not 
formatted correctly). 

Common Problems 
One of the most common issues that occurs is forgetting that the user needs 
granule 1700. Furthermore, as shown earlier in this chapter, the NODBC user 
must be given access to Microsoft Navision. Some other common setup issues 
that most people encounter are: 
 

• The version of the ODBC driver is different than the version of the 
executables being used. Typically this causes the NODBC setup 
window to pop-up whenever you try to connect using the NODBC 
connection? You can check the version by clicking on the drivers tab 
and ensuring that the NODBC driver version and the version of 
Microsoft Navision that you are using are the same. 

• The Program Folder path hasn't been filled or is incorrect on the 
NODBC setup window. 
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• Trying to connect to a multi-part database and only having the first 
part of the database name. Please note that if a database consists of 
several parts (files), you must enter all the file names, separated by 
plus signs (+). However, if you open with the client first specifying 
the parts, then you shouldn't encounter this problem. 

• Trying to move images or other blob data when the field "Enable 
BLOB Fields" is unchecked on the NODBC options window, which 
means that BLOB fields are hidden. Click in this field to enable 
BLOB fields to be seen from ODBC. 

 
There are also common usage issues that are shown below: 
 

• Wanting to be able to select the company when opening the NODBC 
connection. The solution is to leave the company name blank on the 
DSN setup. 

• Forgetting that the each user or application using NODBC uses a 
session. 

• Trying to connect to more than one company at a time in the same 
database. You cannot do this because each data source that you 
create should point to a unique database and you can only open one 
company at a time. Furthermore, you are still limited to one company 
even if you use a separate DNS because it points to the same driver. 
Therefore, to access multiple companies you would have to use more 
than one C/Front connection. 

• Forgetting to set up permissions 
 
Since so many users try and use the NODBC driver with Microsoft Access we've 
included a few issues that you should be aware of, which are: 
 

• When trying to blank out a value in a field (for instance "Name 2"), 
an error is displayed about trying to assign a Null value to a variable 
not being a variant. This is a known problem with Microsoft Access. 
From Microsoft's Knowledge Base, the following information was 
found: 

• Microsoft Access supports zero-length strings. NODBC does not 
convert the zero-length string to a value that can be used by the 
Microsoft Navision Database, therefore, the zero-length string is 
interpreted as a NULL value and the error message is returned. 

 
The work around if you issue SQL Modify statements from VBA code in 
Microsoft Access is the data cannot be blank. 
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• Microsoft Access has a problem with linking an external ODBC 
table as a File Data source. Microsoft Access (Microsoft Jet) reports 
the following error: 

 
 

Reserved error code (-7778) 

 

This reserved error code means that MS Jet cannot find the 
DSN= in the connection string to the ODBC driver.  

 

The solution is to use the ODBC Administrator to add a new 
(NODBC 32-bit) System DSN, here named CODBC SDSN, 
containing the setup you want. Next, add an empty (NODBC 
32-bit) File Data Source, here named CODBC FDSN. Finally, 
edit the File Data Source with a text editor. (The File 
Data Sources are normally placed in C:\Program Files\Common 
Files\Odbc.) 

 

File CODBC FDSN.dsn 

 

[ODBC] 

DRIVER=NODBC 32 bit 

 

change to 

 

[ODBC] 

DSN=CODBC SDSN 

 

The File Data Source now uses the setup from the CODBC 
SDSN. Please note that if you edit the File Data source you 
actually edit the System Data Source. 

 

 

Other Access and Linking Tables issues 
One of the reasons there are so many problems with Microsoft Access is because 
Microsoft Navision's ODBC driver does not support parameter fields, which 
Microsoft Access uses when external tables are linked. 
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Consider the following SQL Statement: 
 
 

SELECT * FROM Customer 

 

This statement retrieves all the records in all columns 
from the Customer table. However, when you link a table in 
Microsoft Access, the program creates a SQL statement that 
look like: 

 

SELECT * FROM Customer WHERE Field1 = ? OR  

 Field2 = ? OR Field 3 = ? … etc. 

 

 
Microsoft Access always retrieves 10 records at a time, so the above statement 
contains 10 question marks. The question marks point to memory addresses that 
are updated each time you request a new page of data in Microsoft Access. The 
values in the memory addresses for the first statement is 1,2,3,4,5,6,7,8,9,10 if 
the first 10 customers are numbered sequentially from 1 and upwards. This way 
the SQL statement becomes dynamic in that Microsoft Access only has to update 
the memory addresses with the values for the next 10 records. However, as 
previously mentioned, our ODBC driver does not support dynamic fields 
(parameter fields). 
 
The work around involves changing an entry in the Window's registry. 
 
Find the following key in the registry: 
 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Jet\<Version>\Engines 

 
Where <Version> is the version of the Jet engine that you are using such as 4.0. 
 

1. Create a new key named ODBC, if it doesn't exist already. 

2. Create a new DWORD named SnapshotOnly with value=1 in the 
ODBC, if it doesn't exist already. 

 
Finally since Microsoft Query is used when trying to connect from Microsoft 
Excel or Microsoft® Word®, we have included the following common error 
explanation and tip. 
 

• Why do I receive the message "Connection in use" when I change 
the data source from one NODBC to another without terminating 
Microsoft-Query? 
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Microsoft-Query does not close the data source before connecting to a new one. 
Therefore, in order to solve the problem, set Microsoft-Query to AutoDisconnect 
by changing the MSQUERY.INI file, located in the Windows directory. 
 
[Microsoft Query] 

 

  AutoDisconnect=1 

  

 
Some common questions are: 
 

• Why is the NODBC driver unable to access some of the C/SIDE 
tables? The answer is that access to some of the C/SIDE virtual 
tables has been masked out because they contain a very large 
quantity of virtual data (the Integer table, for example). The tables 
can be seen in the table list but cannot be accessed. 

• Where can you find the error messages that the ODBC driver 
returns? You can find all the error messages that the ODBC drivers 
return in the CODBC.ETX or NODBC.ETX file (depending on 
product). They are placed in your \WINDOWS\SYSTEM directory 
for Windows 9X users and \WINNT\SYSTEM32 for Windows 
NT/2000 users after installation. 

• Is NODBC case sensitive? As a rule yes. However, it depends on the 
type of the field you want to filter on. Option fields are not case 
sensitive but Text and Code fields are case sensitive. So, if you 
always consider the filter field as case sensitive, your query 
succeeds. 
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Test Your Skills 
 

1. In order for your client to use NODBC with Microsoft Navision you 
must: (Select three of the options below) 

a. Install Microsoft's ODBC driver 
b. Purchase the NODBC granule 
c. Set up permissions for the NODBC users 
d. Set up a DSN 

 

2. True or False. You can use any NODBC version to open up any 
Microsoft Navision database? 

 

3. True or False. Microsoft Navision uses Microsoft's ADO for all 
connections. 

 

4. True or False. Microsoft Navision's ODBC driver supports outer 
joins? 

 

5. True or False. Entering data through ODBC is validated just as if you 
are in Microsoft Navision? 

6. True or False. Entering data through ODBC is validated just as if you 
are in Microsoft Navision? 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 24: USING C/FRONT 
In this section you are introduced to Microsoft® Business Solutions−Navision® 
C/FRONT. C/FRONT is a very complex Application Program Interface that 
requires not only a knowledge of an additional programming language, but also a 
working knowledge of C commands. For this reason, we only provide an 
introduction to C/FRONT in the Development I manual. 
 
However, do not skip this chapter. C/FRONT must be installed in order to 
perform the exercises in succeeding chapters. 

Training Objectives 
In this chapter, you learn about: 
 

• C/FRONT 
• Installation and Setup of the C/FRONT System. 
• Limitations of C/FRONT. 
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C/FRONT 
C/FRONT is an application programming interface that can be used to access a 
C/SIDE database. C/FRONT facilitates high-level interaction with the C/SIDE 
database manager, and allows C developers to manipulate any C/SIDE database. 
 
The central component of C/FRONT is a library of C functions. These functions 
give you access to every aspect of data storage and maintenance, and allow you 
to integrate both standard and custom applications with your C/SIDE database. 
 
Since C/FRONT is a front end to Microsoft Navision, you might want to use 
C/FRONT to add, delete or view data in your own applications. C/FRONT is 
much faster than using the N/ODBC driver and is as close to the native 
connection as you can get with Microsoft Navision However, in order to use 
C/FRONT, you must use some other programming language such as C++, C, or 
Visual Basic. C/FRONT provides two methods of accessing Microsoft Navision 
which is either through a C style DLL or through the use of the OCX interface. 

Installation and Setup of the C/FRONT System 
C/FRONT can be installed through the use of the installation program. 
 

1. Insert the CD and the following screen should automatically appear. 
If not, run "startCD.exe" from the root directory of the CD. 
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2. Select Tools as shown in the above picture and when the next screen 
appears, scroll down and select C/FRONT (under Microsoft 
Navision SDK) as shown below: 

 

 
 

3. Once you click on chosen C/FRONT, you are directed to the 
Microsoft Navision SDK menu. Click on Navision SDK under 
Installation. 
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4. After a running through a few pre-installation screens, the following 
appears: 

 

 
 

5. Press Next to continue. The following screen appears. Complete as 
necessary and press Next to continue. 

 

 
 

6. You are now prompted for a "Complete" or "Custom" installation. 
We recommend selecting "Complete" for first time installations. 
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7. Next, you are prompted to continue with the installation. 

 

 
 

8. Select Install to continue. 

 Once complete, the final screen appears. 
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9. Press Finish. You have now successfully installed the Microsoft 
Navision SDK system, including C/FRONT. 

 
NOTE: When you install C/FRONT, the installation contains two .dll files − cfront.dll 
and cfrontsql.dll. Copy both files to the directory specified above. Make sure that you 
set the CfrontDllName property to the name of the DLL that you are using. If you are 
running on Microsoft® SQL Server®, select the cfrontsql.dll, otherwise, select cfront.dll.

 
Normally, the C/FRONT library cfront.dll/cfrontsql.dll) reads the registry in 
order to locate the Microsoft Navision DBMS system. However, if multiple 
Microsoft Navision systems are installed or if Microsoft Navision is not present 
on the system, the function SetNavisionPath in the cfront.dll/cfrontsql.dll library 
must be called specifying the path to the directory where Microsoft Navision is 
installed or to a directory containing the following files from Microsoft Navision. 
 
After installing Microsoft Navision, the following files must be copied from the 
Microsoft Navision client to the C/FRONT directory: 
 
dbm.dll 

nc_netb.dll 

nc_tcp.dll 

slave.exe 

fin.etx 

fin.stx 

fin.flf 

 

 

List of C/FRONT Files 
C/FRONT consists of the following files: 
 
File name Description 
cfront.dll C/FRONT C-API library for Navision Server 
cfrontsql.dll C/FRONT C-API library for SQL Server 

cfront.ocx C/FRONT OCX 
cf.h C/FRONT header file 
libload.c Source file containing functions to load and 

unload cfront.dll 
dberror.txt Database error/return codes 
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Examples that are also installed. 
 
File name Description 
sample.c C/FRONT sample application 
sample.exe Runable sample application 
sample.fdb Navision sample database 
sample.fbk Navision backup of the sample database 
sample.txt Document describing how to build and run the 

C/FRONT C-API sample application 
cfront.chm C/FRONT OCX online help file 
cfront.xls C/FRONT OCX Microsoft Excel sample 

application 
mfc42.dll Microsoft Foundation Classes Library 
msvcrt.dll Microsoft Visual C Run-Time Library 
readme.txt Readme file containing last minute information 

 

Limitations of C/FRONT 
 

• Microsoft® Windows® does not go in to standby or hibernation if 
there is an open server connection from C/FRONT. 

• Entries made by C/FRONT does not fire triggers to execute any code 
validation. 

• C/FRONT is very particular and looks in different places at different 
times for a license. Check and make sure you have the license loaded 
everywhere it needs to be, that is client, server, and so on. 

• Besides the limitations, a common misconception that many have is 
that C/FRONT can be used in place of multiple sessions. However, 
this is not the case. Every connection in C/FRONT is treated as a 
session. As with regular Microsoft Navision, the client and ODBC, 
the versions of CFRONT must match the version of the SERVER 
that you are trying to connect to. 

• Keys can be active or inactive. You cannot activate keys from within 
C/FRONT; therefore, only active keys are available to C/FRONT. 
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Test Your Skills 
 

1. What is C/FRONT? 

 

2. Does C/FRONT use a session?  

 

3. Can you activate keys from within C/FRONT? 

 

4. C/FRONT does not require any files from the Microsoft Navision 
client directory.  True or False. 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 25: USING OCX CONTROLS 
Training Objectives 

In this chapter, you learn about: 
 

• Custom controls and using an OCX control 
• Installing and Registering the OCX 
• Creating a Sample with OCX controls 
• Common problems and limitations 
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Custom Controls and Using an OCX Control 
Custom Controls are (or were) also known as OLE Controls and Microsoft® 
ActiveX® Controls. Because they often have the file name extension .ocx, they 
have also been called OCXs. It is important to note that custom controls can 
either have the extension of DLL or OCX. 
 
An OCX allows you to take advantage of code that has been made commercially 
available or allows you to write code once and have the ability to call that code 
from any program that supports custom controls. 
 
The reason that you would want to use custom controls is to save on development 
time and reduce costs. 

Installing and Registering the OCX 
In order to use a custom control, it must be loaded on the computer that is being 
used for development as well as all other computers that utilize the OCX that you 
are integrating into your code. Therefore, an important part of using an OCX that 
was not developed by your company is to ensure that you are licensed to 
redistribute the OCX. Once you have resolved any licensing issues concerning 
using an OCX, you must install the OCX on each machine that needs to utilize 
your code. After the OCX has been copied to the machine, Microsoft® Business 
Solutions–Navision® has developed an easy method to allow you to register a 
control.  
 
In order to demonstrate the ease of registering and using a custom control in 
Microsoft Navision, we look at the C/FRONT OCX that is included on the 
Development I Class CD. We later use this control to create a form that connects 
to a server, opens a database, and then opens a company of your choosing and 
returns the number of records in a table that you specify. This new form has 
access to the functions and properties supported by the C/FRONT OCX. 
 
The first requirement for using a control is that it is physically installed on the 
target machine. But a control also has to be registered with the operating system 
in order to be used. 
 
If the control has been installed physically by copying it to the hard disk, but has 
not yet been registered, you can follow this procedure to register the control from 
within C/SIDE: 
 

1. Copy the control from the distribution media to the hard disk.  
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2. On the menu bar, click TOOLS→CUSTOM CONTROLS to open this 
window: 

 

 
 

3. Click CONTROL→BROWSE to open the following window: 
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4. When you have located the control, select it and click Open. This 
registers the control with the system. You receive a confirmation 
message once the registration is complete. Click OK to return to the 
Custom Controls form. You can verify that the control was added by 
closing this form and clicking TOOLS→CUSTOM CONTROLS again.  

 

 
 

Creating a Sample with OCX Controls 
When you want to use a control, you define a variable (global or local) of type 
OCX and reference the control as the subtype of this variable. The only controls 
that appear in the list are those controls that have been registered on the computer 
that you are currently using for development. 
 
NOTE: If you aren't able to select OCX as a data type, it means that you do not have 
the C/OCX granule in your license. 
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Declaring the Control as a Variable 
Follow these steps to declare the control as a variable: 
 

1. Start by creating a new form using the Object Designer. On the menu 
bar, click VIEW→C/AL GLOBALS to open the following window: 

 

 
 

2. Give the variable a name (this example uses cfront), and select OCX 
as the type. In the Subtype field, click the AssistButton to open the 
following window: 

 

 
 

3. Find the control on the list and select it. Then click OK.  
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4. Now the C/AL Globals form should look like the following. The 
CLSID of the C/FRONT control has been entered in the Subtype 
field: 

 

 
 

5. When you move the cursor out of the Subtype field, the name of the 
control replaces the CLSID (which is rather cryptic): 
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6. Declare the following variables: 

 
Name DataType Length 

TableNo Integer   

MyCompany Text 50 

MyDatabase Text 50 

MyServerName Text 50 

Driver Option   
 

7. The C/AL Globals window should look something like this: 

 

 
 

8. Select the variable called Driver and open the Properties window 
(SHIFT+F4). In the Value field of the OptionString property enter 
NDBCS,NDBCN. 
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 All these variables have now been added to the C/AL Symbol Menu 
and you now have access to all the methods and properties contained 
in the C/FRONT OCX. To check this, click View, C/AL Symbol 
Menu (f5) to open the C/AL Symbol Menu window: 

 

 
 

 As you see the C/FRONT methods and properties are now available. 
If help text is available for this OCX, it can be displayed by selecting 
one of the methods or properties (in the right hand panel) and 
pressing F1. 

9. Now, create the text constants that our form uses. Open the C/AL 
Globals window and create the following text constants: 
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10. Close and save the new form. Save as Form 123456757 Sample 
OCX Form. 

 

 
 

Designing the Form 
The first step in designing the form is to add the fields that you want the form to 
contain. 

ADDING THE FIELDS 
 

1. Design Form 123456757. 

2. Open the Toolbox and add four text boxes and two option buttons to 
the form. 

3. Add labels to the text boxes and the first option button and name 
them Server, Database, Company, Table Number and Server Type, 
respectively. 

4. The form should look something like this when you are finished: 
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 You can always reposition the fields to suit your design. 

5. Select the server text box and click VIEW→PROPERTIES (SHIFT+F4) 
to open the Properties window. 

6. In the Value field for the SourceExpr property, click the 
AssistButton and the C/AL Symbol Menu window opens. 

7. Select MyServerName and ensure that the Paste Arguments check 
box is not selected and click OK. 

 The text box on the form should now contain the following text: 
<=MyServerName> 

8. Repeat this procedure for the other three text boxes adding the 
MyDatabase, MyCompany and TableNo variables to the 
corresponding text box. 

9. Select the first option button and in the Properties window enter the 
following values: 

 
Property Value 

Caption SQL 

SourceExpr Driver 

OptionValue NDBCS 
 

10. Select the second option button and in the Properties window enter 
the following values: 

 
Property Value 

Caption Navision 

SourceExpr Driver 

OptionValue NDBCN 
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The form should now look something like this: 
 

 
 
Before we continue, lets save the form. Press CTRL+S and save as: 
 

 
 

Adding the Code to the Form 
Now that you have created the basic form it is time to add the code that makes it 
work. 
 
In this example, you are placing most of the code in the OnPush trigger of a 
command button at the bottom of the form. 
 

1. The form should still be open in the designer. If not, open the form in 
the form designer and add a command button to the form. 

2. Select the command button and open the Properties window 
(SHIFT+F4) and enter Connect as the name and the caption. 

3. Select the command button and click VIEW→C/AL CODE (F9) to open 
the C/AL Editor. 
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4. Enter the following code in the OnPush trigger: 

 
CLEAR(cfront); 

cfront.ConnectServerAndOpenDatabase(FORMAT(Driver),MyServer
Name,'tcp 

',MyDatabase,0,FALSE,TRUE,'',''); 

cfront.OpenCompany(MyCompany); 

IF cfront.OpenTable(TableNo,TableNo) THEN 

MESSAGE(text002,cfront.RecCount(TableNo),cfront.TableName(T
ableNo)); 

cfront.CloseTable(TableNo); 

MESSAGE('Table closed'); 

cfront.CloseCompany(); 

MESSAGE('Company Closed'); 

cfront.DisconnectServer(); 

MESSAGE('Disconnect') 

 
To enter the C/FRONT functions open the C/AL Symbol Menu window and 
select the method or property that you want to use. Ensure that there is a check 
mark in the Paste Arguments check box and click OK. The C/FRONT function 
is then pasted into the C/AL Editor and all you have to do is adjust the 
parameters. 
 
This code uses the C/FRONT functions to connect to a server and open a 
database that you specify in the form. It uses the TCPIP protocol. It then opens 
the company that you specify in the MyCompany field. Next it opens the table 
whose number you specify and counts the number of records that the table 
contains. It then displays a message telling you how many records the table 
contains. When you click OK in the message window it closes the table, the 
company and disconnects from the server. 
 
NOTE: This form only uses Microsoft® Windows® Authentication to connect to the 
server. This is specified in the 7th parameter of the ConnectServerAndOpenDatabase 
function. If you want to use Database Authentication you must set this parameter to 
False and enter your user ID and password in the 8th and 9th parameters respectively. 
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The form could look something like this when it is finished: 
 

 
 

Test Your New Form 
Enter a valid Server (if necessary), Database and Company. Select your Server 
Type, and enter “18” for the Customer Table in the Table No. field. 
 
Pressing the Connect button should return something similar to the following: 
 

 
 

Common Problems and Limitations 
Common Problems 
A common problem that occurs is not having the OCX object registered on the 
computer. One method of registering an OCX on your computer is covered under 
“Installing and Registering the OCX”.  
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A second common problem occurs when an object is modified and that object 
depends on an OCX that is not registered on the development computer. If the 
development version of the OCX is not loaded on the computer, the object does 
not compile. Therefore, you need to determine whether you need to modify this 
object or whether to implement your modification in some other object. If you 
decide to modify the object, you need to load the development files and tools 
necessary for you to be able to compile the object. If you didn’t mean to modify 
the object, then you need to export the unmodified object from a clean version in 
FOB format and then import the unmodified object into your Microsoft Navision 
database. 
 
Developers need to remember that strings are limited to 1024 characters in 
Microsoft Navision (older versions may be limited to 250 characters). Therefore, 
you need to make sure that the custom control being used needs to return the 
appropriate string value based on the version of Microsoft Navision being used. 
 
A common license problem encountered is when the license doesn’t include the 
OCX granule. Furthermore, if you do not have this granule as part of your license 
then you are not even able to see the OCX data type in the drop down list for data 
types. It is important to note that you only need the OCX granule for 
development. The customers who run the objects that you have compiled, do not 
need the OCX granule, they only need the compiled object loaded on their 
computers along with the custom control that needs to be registered. 
 
A common implementation problem that occurs is forgetting to grant the proper 
security. Therefore, if you want to limit who has permissions to run an object that 
works with an OCX, you can create a role whose permission has access the 
object type of System and object ID 9140, which is C/OCX. 

Limitations 
There are two limitations placed on using COM technologies (OCX and 
Automation) within Microsoft Navision, which are: 

Only non-visual controls are supported 
This means you cannot add graphical elements to a C/SIDE object (for example, 
you cannot add a third party control to a form). However, you can use controls 
that display information and interact with the user in a window of its own. 

Exception Handling 
C/SIDE does not allow the retrieval of information about exceptions from a 
control or automation server through the Invoke method of the IDispatch 
interface and the EXCEPINFO structure. There are ways that you can work 
around this limitation. There is also a limitation that you are not able to respond 
to events within Microsoft Navision (that is, C/SIDE doesn’t support callback for 
OCXs).  
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Test Your Skills 
 

1. Why might you use an OCX control? 

 

 

2. What must you do before you can use an OCX control? 

 

 

3. Why might you not be able to select OCX as a data type? 

 

 

4. Is calling a method or setting properties of an OCX any different 
from any other standard Microsoft Navision object? 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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CHAPTER 26: AUTOMATION SERVER 
Training Objectives 

In this chapter, you learn about: 
 

• Automation 
• Creating the Variables. 
• Creating a Report with Automation 
• Responding to Events 
• Common Problems and Limitations. 
• Automation Exercise 
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Automation 
The main purpose of Automation is to provide a seamless interface to outside 
applications without user intervention. An example would be to automatically 
create a letter in Microsoft® Word whenever certain conditions occurred, such as 
a welcome letter when the customer record is created. A second reason for using 
Automation is to save development time, which also reduces the cost of 
development.  
 
In order to use automation, the program that you want to automate must be an 
automation server. Examples of automation servers include Microsoft Word, 
Microsoft® Excel, and Microsoft® Outlook®. 
 
The following description outlines the procedures for using an automation server 
from C/SIDE. There are very few steps required that are specific to C/SIDE 
(C/AL). Using an automation server consists of five steps: 
 

1. Declare the top-level interface (class) of the automation server as a 
variable of type Automation. 

2. Declare all the other interfaces (classes) as variables of type 
Automation. 

3. Use the C/AL function CREATE on the variable declared in step 1. 
Do not use CREATE on any other variables. 

4. Use the methods and properties of the automation server in your 
C/AL code. 

You can CLEAR (destroy) the top-level object if you want. Otherwise, it is 
destroyed automatically when the variable goes out of scope. 
 
Write most of your code during step 4 using the methods and the properties of 
the automation server. The syntax and the semantics of these methods and 
properties are documented in the documentation for each automation server. 
Using these methods and properties in C/AL does not involve any new or 
changed syntax. 
 
There are two major concerns when deciding where to place code that uses 
automation. The first is the fact that an object that uses automation can be 
compiled only if the automation server is installed on the machine where the 
compilation takes place. This means that if an object is to be recompiled and 
modified on a machine where the automation server is not installed, you have to 
modify the code drastically in order to compile it again. Therefore, it is 
recommended that you isolate code that uses automation in separate code units. 
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The second concern is performance. There is some overhead involved in creating 
an automation server (using the CREATE system call). If the automation server 
is to be used repetitively, it gives better performance if you arrange your code so 
that the server is created only once (as opposed to a series of CREATE/CLEAR 
calls). 
 
With that said it is obvious that these two concerns sometimes clash and you may 
have to make some trade-offs based on the actual context in which your code is 
used. 

Creating the Variables 
When you want to control an automation server, you define a variable (global or 
local) of type Automation and reference the Automation Server the subtype of 
this variable. The only Automation Servers that appear in the list are those that 
are loaded on the development machine. 
 
Once you have selected the Automation Server, you are able to see a list of all 
the classes available for that automation server. Typically, the application is the 
first class chosen. Afterwards you would declare variables for all the other 
interfaces (classes) that you wished to control or interact with your code. 
 
Determining what classes you need to define, depends upon your understanding 
of the automation server. If these are Microsoft programs that you are wishing to 
control then it is easy to determine what each class does by viewing the 
Microsoft® Visual Basic® help. The Visual Basic help for each is found under 
Tools, Macros, and then Visual Basic Editor. However, if you aren't familiar with 
the classes, you can still usually figure out which classes to call if you just think 
about the application. For example, if you wanted to call Microsoft Word, you 
would quickly think of the application and then the document. Likewise, if you 
wanted to call Microsoft Excel, you would think of the application, the book, the 
sheet, and the Range of cells. 
 
We work through an example that uses Microsoft Excel to graph our top ten 
customers and create a report to accomplish this task. 
 
Let's begin by creating a new report and declaring an automation control as a 
variable: 
 

1. From the Object Designer, create a new report (not using the Report 
Wizard). 
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2. On the menu bar, click VIEW→C/AL GLOBALS to open the following 
window: 

 

 
 
Give the variable a name (Excel), and select Automation as the DataType. In the 
Subtype field, click the AssistButton to open the following window: 
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In the window above Automation Server field, click the AssistButton to open 
the following window: 
 

 
 
After selecting the Automation Server for the Microsoft Excel Object Library, 
you would then select a class (choose Application) as shown below: 
 

 
 
Once you have declared the variable, you can access the Methods and Properties 
that exist for the control from C/AL. You can explore these methods and 
properties in the C/AL Symbol Menu. 
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1. Click VIEW→C/AL SYMBOL MENU or press F5 to open this window. 
Note that whenever a method or a property is selected (they are in 
the column on the right), you can see a short syntax description at the 
bottom of the window. If there is a Help file for the control, you can 
access it by pressing F1 while the method or property you are 
interested in is selected. 

 

 
 

2. When you click OK or Apply in the C/AL Symbol Menu, a 
"template" statement with the method or property is pasted into the 
C/AL Editor (provided that the editor is open) at the current insertion 
point: 

 

 
 

 As you can see from the picture above, checking the Paste 
Arguments does make a difference in what's returned to the editor. 
When the Paste Arguments is checked, you get the method or 
property returned along with the arguments that are expected. 
Otherwise, only the property or method is returned. 
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 You can see that there is almost no difference in using a method or a 
property of an Automation versus a Microsoft Navision method or 
property. The only difference that you generally encounter is with 
the data types and knowing how to convert these types to Microsoft 
Navision data types. Knowing the corresponding relationship 
between the COM data types allows you to properly call a method or 
property. Furthermore, it helps alert you to the fact that certain 
methods or properties are not able to be utilized in Microsoft 
Navision if there is no corresponding data type within Microsoft 
Navision for the data type that is expected. 

 Additional information on COM data types can be found in the 
Application Designers Guide. 

3. Close your test report without saving. 

Creating a Report with Automation 
Getting Started 
 

1. Open the Object Designer, and click Report. 

2. Click New to create a new report. 

3. You then enter Customer for the data item. 

Declaring Variables 
The next series of steps involve defining the necessary variables: 

 
4. On the menu bar, click VIEW→C/AL GLOBALS. 

5. Define a Record variable that has the Customer Amount table as 
Subtype. Here, we have called it CustAmount. On the properties set 
the Temporary property to Yes. 

6. Define an Automation variable with Microsoft Excel 11.0 Object 
Library as Automation Server and Application as Automation 
Object. Call it Excel. 

7. Define an Automation variable with Microsoft Excel 11.0 Object 
Library as Automation Server and Workbook as Automation Object. 
Call it Book  

8. Define an Automation variable with Microsoft Excel 11.0 Object 
Library as Automation Server and Range as Automation Object. Call 
it Range. 

9. Define an Automation variable with Microsoft Excel 11.0 Object 
Library as Automation Server and Worksheet as Automation Object. 
Call it Sheet.  
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10. Define an Automation variable with Microsoft Excel 11.0 Object 
Library as Automation Server and Chart as Automation Object. Call 
it Chart. 

11. Define three variables of type text. Call the first one CustFilter and 
give it a length of 250. Call the second variable CustDateFilter and 
give it a length of 30. Call the third variable j and give it a length of 
30. 

12. Define a variable as Option with the values Sales (LCY),Balance 
(LCY). Call it ShowType. 

13. Define two variables of type Integer. Call the first 
NoOfRecordsToPrint and the second is called i. 

14. Define a variable of type Decimal and call it MaxAmount. 

 
After these steps, the C/AL Globals form should look like this: 
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Creating the Report − Initial Steps 
Before we continue, let's save the Report. Press CTRL+S and enter the following: 
 

 
 

Changing Properties 
In Object Designer, Select Report 123456755 and Design it. Open the Properties 
window and change ProcessingOnly to "Yes" as shown on the screen below. 
 

 
 
Close the Properties window. 

Coding the Report 
The code itself is quite simple. First, on the report we receive any filters that have 
been set and also get the filter on the "Date Filter". At this time add the code 
below to the OnPreReport trigger. 
 
To access the OnPreReport trigger, move to a blank line on the DataItem window 
and press F9. Add the following code: 
 

 
 

Page 503 



 

 

Microsoft Navision Development I − C/SIDE Introduction 

On the OnPreDataItem trigger, you initialize and calculate some values. To get to 
the OnPreDataItem trigger, select the "Customer" DataItem and press F9. Enter 
the following code: 
 

 
 
We now create Microsoft Excel. Note that CREATE has an optional argument, 
NewServer, which by default is FALSE. This means that an already running 
instance of the automation is reused. If we had set NewServer to TRUE, as in 
CREATE(wdApp, TRUE), we would have requested a new instance of Microsoft 
Excel. Note that ultimately the automation server itself can control whether it can 
be reused or not (see the documentation for the server in question if this aspect is 
important for your application.) 
 
Add this code to the OnPreDataItem trigger: 

 
CREATE(Excel); 

 
Next, make Microsoft Excel visible. Add this to the OnPreDataItem trigger: 
 
Excel.Visible(TRUE); 

 
Microsoft Excel produces a General Protection Fault error when you close a new 
Excel worksheet created while Microsoft Excel is invisible. To solve the 
problem, you can make Microsoft Excel visible immediately after you create a 
new worksheet. Alternatively, you can make Microsoft Excel visible just before 
you create a new Excel worksheet and then make it invisible again immediately 
after creating the new Excel worksheet. 
 
Next, we add a new workbook to Microsoft Excel. Add the following to the 
OnPreDataItem trigger: 
 
Book:=Excel.Workbooks.Add(-4167); 

Sheet:=Excel.ActiveSheet; 

Sheet.Name := 'TOP 10'; 
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Your code should now look like this: 
 

 
 
In the "Book :=" line, we use the Add method of the Workbooks collection to 
return a new workbook. Then we use the ActiveSheet property of the Application 
class to make sure that what we do next affects the active sheet of the new 
workbook. In the third line, we give the sheet a name. Note that we are passing 
the number -4167.  
 
We now need to add code to the OnAfterGetRecord trigger. Again, select 
DataItem "Customer", and press F9. On the OnAfterGetRecord trigger we need 
to first call the CALCFIELDS function to get the values for "Sales (LCY)" and 
"Balance (LCY)". Add the following to the OnAfterGetRecord trigger: 
 
CALCFIELDS("Sales (LCY)","Balance (LCY)"); 

 
If both fields equal zero then skip this record. Otherwise, initialize the 
CustAmount record, fill the record with the Customer No. and then assign the 
amounts based on what ShowType the user has selected. Please note that we take 
the negative value of what is stored so that our graph displays upright. 
 
The following should be added to the OnAfterGetRecord 
trigger: 

  

IF ("Sales (LCY)" = 0) AND ("Balance (LCY)" = 0) THEN 

 CurrReport.SKIP; 

 

CustAmount.INIT; 

CustAmount."Customer No." := "No."; 

IF ShowType = ShowType::"Sales (LCY)" THEN BEGIN 

 CustAmount."Amount (LCY)" := -"Sales (LCY)"; 

 CustAmount."Amount 2 (LCY)" := -"Balance (LCY)"; 

END ELSE BEGIN 

 CustAmount."Amount (LCY)" := -"Balance (LCY)"; 

 CustAmount."Amount 2 (LCY)" := -"Sales (LCY)"; 

END; 
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Insert the record. Next, if the NoOfRecordsToPrint equals zero or the value I is 
less than the NoOfRecordsToPrint, then increment I; otherwise, find the last 
record and delete it. The reason for doing this is that as a record is inserted, the 
records are placed in order from highest to lowest and we only want to keep the 
number specified. Add to the OnAfterGetRecord Trigger: 
 
CustAmount.INSERT; 

IF (NoOfRecordsToPrint = 0) OR (i < NoOfRecordsToPrint) 
THEN 

 i := i + 1 

ELSE BEGIN 

 CustAmount.FIND('+'); 

 CustAmount.DELETE; 

END; 

 
The final OnAfterGetRecord Trigger should look as follows: 
 

 
 

Page 506 



 

 

Chapter 26: Automation Server 

On the OnPostDataItem trigger, set the column names as shown below. The 
OnPostDataItem trigger is located below the OnAfterGetRecord trigger. 
 
Sheet.Range('A2').Value := 'No.'; 

Sheet.Range('B2').Value := 'Name'; 

Sheet.Range('C2').Value := 'Sales (LCY)'; 

 
Next, determine if there are any records in the CustAmount table. If so, then set 
the variable j to '3'. You then loop through all the records in the CustAmount 
table. As you loop through, you try and find that record in the Customer table. 
First, SETRANGE on the "No." equal to the CustAmount."Customer No.". If you 
aren't able to find the record, an error message appears and this report ends. 
However, since you had just added the records, you shouldn't encounter the error. 
Finally, add the values (Customer No., Customer Name, and Amount (LCY) 
to the Sheet that we have created. This also goes in the OnPostDataItem trigger. 
 
IF CustAmount.FIND('-') THEN BEGIN 

 j:='3'; 

 REPEAT 

  Customer.SETRANGE("No.",CustAmount."Customer No."); 

  Customer.FIND('-'); 

  Sheet.Range('A'+j).Value := CustAmount."Customer No."; 

  Sheet.Range('B'+j).Value := Customer.Name; 

  Sheet.Range('C'+j).Value := -CustAmount."Amount (LCY)"; 

  j:=INCSTR(j); 

 UNTIL CustAmount.NEXT = 0; 

END; 

 
Now you are ready to chart the information inserted into Excel. Set a range based 
on the columns and rows that we utilized. Next, add a new chart and call the 
ChartWizard to plot the information for us. Using the ChartWizard provides a 
fast and simple way of accomplishing our goal. You can more tightly control the 
design of the graph by setting it up using the methods and properties of the 
various Chart objects (ChartArea, Legend, and so on). 
 
First, define a range for the data for the graph. The following should be placed in 
the OnPostDataItem trigger of the Customer DataItem: 
 
Range:=Sheet.Range('B3:C12'); 

 
Then, add a new chart sheet and give it a name (also in the OnPostDataItem 
trigger): 
 
Chart:=Book.Charts.Add; 

Chart.Name := 'Top 10 Customers - Graph'; 

 

Page 507 



 

 

Microsoft Navision Development I − C/SIDE Introduction 

Finally, this call creates the graph for us: 
 
Chart.ChartWizard(Range,-4100,2,2,1,0,0,'Top 10 
Customers','Customer','Sales (LCY)'); 

 
The resulting code should appear as follows: 
 

 
 
Use the first eight of the optional arguments of the ChartWizard method: 
 
Argument Description Value 
Source The range that 

contains the source 
data for the new chart 

xlRange − the object 
returned by 
xlSheet.Range('A2:C3'). 

Gallery The chart type -4100 − the enumerator for 
the Stacked Column with 3D 
effect. See "Finding an 
enumerator value" in the 
chapter "Using COM 
Technologies in C/SIDE" of 
the application designers' 
guide. 

Format The option number 
for the built-in 
autoformats 

We found this one by trial 
and error, because the 
Microsoft Excel 
documentation does not say 
much about it. 

PlotBy Specifies whether the 
data for each series is 
in rows or columns 

2 − the enumerator for the 
xlRows XlRowCol 
enumerator. 
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Argument Description Value 
CategoryLabels An integer specifying 

the number of rows or 
columns within the 
source range that 
contain category 
labels. 

1 − we have one row with 
category labels  

SeriesLabels An integer specifying 
the number of rows or 
columns within the 
source range that 
contain series labels 

1 − we do not have series 
labels in our data 

HasLegend TRUE to include a 
legend 

0 − for some reason this 
value works well. There is a 
possible error in either 
Microsoft Excel or the 
documentation here. 

Title VARIANT with the 
title of the chart 

We pass a string, 'Top 10 
Customers' This works well 
and the run-time conversion 
will succeed. 

ValueTitle VARIANT Value (X) 
Axis Title 

'Customer' 

Extra Title VARIANT Category 
(Z) Axis Title 

'Sales (LCY)' 

 
Close and save the report. Locate the report in the Object Designer and press the 
Run button. 
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After selecting the Preview option, your Excel spreadsheet should appear similar 
to the following: 
 

 
 
Also, you should have a chart to go with this: 
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Responding to Events 
C/SIDE can receive events from the components (automation servers and OCXs) 
that it controls. When you declare a global variable of the type Automation, you 
can specify whether you want to receive events. You do so by setting the 
WithEvents property for the variable to Yes. This automatically generates AL 
triggers for the events that the component provides. A trigger name consists of 
the name of the automation variable followed by "::<Event name>." For 
example, if you declare an automation variable with the name MyEventVar, and 
the component provides the event MessageReceived(...), the name of the trigger 
is MyEventVar::MessageReceived(...).  
 
For more information about responding to events, please refer to the chapter 
Receiving Events in C/SIDE in the Application Designer's Guide. 
 
NOTE: If you delete a global variable to which event triggers are associated, the 
event triggers and their code is also deleted. Furthermore, if you change the DataType 
or SubType for a global variable from an Automation type to another DataType, then 
all the event triggers and their code is deleted. 

 

Common Problems and Limitations 
Common Problems 
A common problem that occurs when an object is modified is that the object 
depends on an automation server that is not registered on the development 
computer. Therefore, you need to determine whether you need to modify this 
object or whether to implement your modification in some other object. If you 
decide to modify the object, you need to ensure that the automation server is 
loaded on the machine so that you are able to compile the object. If you didn't 
mean to modify the object, then you need to export the unmodified object from a 
clean version in FOB format and then import the unmodified object into your 
database. 

Limitations 
A few limitations of using automation are:  
 
Exception Handling. C/SIDE does not allow the retrieval of information about 
exceptions from a control or automation server through the Invoke method of the 
IDispatch interface and the EXCEPINFO structure. There are ways that you can 
work around this limitation.  
 

• C/SIDE only supports the default outgoing, that is, source interfaces, 
which are defined by the automation variable. If more than one 
outgoing interface is defined by the automation server for a coclass, 
only event triggers for the default outgoing interface are generated in 
the AL code. 
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• There can be a maximum of 39 parameters in function calls. 
• There can be a maximum of 1024 characters in prototype text strings 

for functions. 
• The connectable object strategy in COM is used to connect 

Microsoft Navision and the automation server. The Sink object 
defined in this strategy and implemented in Microsoft Navision only 
supports the IDispatch interface (and IUnknown). It is therefore 
expected that the automation server calls on IDispatch when 
executing events. 

• Parameter names are truncated to a maximum of 30 characters. 
• There are no return values on event triggers. 
• The variable name along with "::" and the event trigger name is 

truncated to a maximum of 30 characters. 
 

Restrictions on Incoming Data 
 

• Incoming data of the types float and double (that map to the C/AL 
data type Decimal) and are squeezed into the range of -1E15 to 
1E15. No error message appears. 

• Incoming data of the type string (that maps to the C/AL data type 
Text) are truncated to a maximum size of 1024 characters (excluding 
the termination character). No error message appears. 
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Automation Exercise 
Create a codeunit that pushes out G/L Account information to Microsoft Excel 
and creates a simple chart. The customer has specified that they only wish to see 
a summary of the income accounts. 
 

1. Create a codeunit. 

2. Create the following variables as shown in the picture below: 

 

 
 

 The rest of the code is on the OnRun trigger. 

3. First we need a filter on the income accounts. Next we need to look 
only at the Account Types with the option of End-Total because they 
contain the balances. 

 
WITH GLAccount DO BEGIN 

 // We only want to look at look at the Income Accounts 

 SETRANGE("No.", '6000', '6995'); 

 

 //We want to only look at the totals for each category 

 SETRANGE("Account Type", GLAccount."Account Type"::"End-
Total"); 
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4. We want to make sure that some accounts exist in our table based on 
our condition. If so, we want to create the automation server and 
make sure that we set it to visible. We also want to create our sheet 
where we put our account information and label the sheet. 

 
 // Make sure there are records in the GLAccount table 

 IF FIND('-') THEN BEGIN  

  CREATE(Excel); 

  Excel.Visible(TRUE); 

  Book:=Excel.Workbooks.Add(-4167); 

  Sheet:=Excel.ActiveSheet; 

  Sheet.Name := 'Account Information'; 

 
5. We want to assign our column names and prepare to copy the 

account information to the proper row. Since we do not know exactly 
how many rows that we end up with, we need to initialize our 
counter. Next, as we are writing out our account information, we 
count the number of rows that we write out so that we can determine 
the range of cells to pass to the chart wizard. Note that we want to 
switch the sign on our balance since it is stored as a negative number 
within Microsoft Navision.  

 
  Sheet.Range('A1').Value := 'No.'; 

  Sheet.Range('B1').Value := 'Name'; 

  Sheet.Range('C1').Value := 'Balance'; 

 

  RowNo :='3'; 

  TotalRows := 0; 

  REPEAT 

   CALCFIELDS(Balance); 

   Sheet.Range('A'+RowNo).Value := GLAccount."No."; 

   Sheet.Range('B'+RowNo).Value := GLAccount.Name; 

   Sheet.Range('C'+RowNo).Value := -GLAccount.Balance; 

   RowNo :=INCSTR(RowNo); 

   TotalRows := TotalRows + 1; 

  UNTIL NEXT = 0; 

 END; 

END; 

 

Page 514 



 

 

Chapter 26: Automation Server 

6. Finally, we want to set the range for which we wish to graph, create 
and label our chart, and then call the chart wizard to create our graph. 
Lastly, clear the automation server variable. 

 
LastRow := FORMAT(3 + TotalRows); 

Range:=Sheet.Range('B3:C'+LastRow); 

Chart:=Book.Charts.Add; 

Chart.Name := 'Income - Graph'; 

Chart.ChartWizard(Range,-
4100,2,2,1,0,0,'Income','Account','Balance'); 

 

CLEAR(Excel); 

 
7. Close and save the codeunit. 

 

 
 

8. Run the codeunit. The Excel file and graph should appear as follows: 

 

 

Page 515 



 

 

Microsoft Navision Development I − C/SIDE Introduction 
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Test Your Skills 
1. Why might you need to use Automation in Microsoft Navision? 

 

2. Yes or No. Is it possible to respond to Automation Events in 
Microsoft Navision? 

 

3. True or False. You must first use the CREATE command before you 
can use an Automation object? 

 

4. True or False. You would use the FREE command to release the 
automation object from memory. 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 

 

 

 

 
 

Page 518 



 

 

Chapter 27: Implementation Methodology 

CHAPTER 27: IMPLEMENTATION METHODOLOGY 
Training Objective 

In this chapter, you learn about: 
 

• Implementation Methodology 
• Version Control 
• Development Documentation 
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Implementation Methodology 
As an important part of the training for a Microsoft Navision Reseller, Microsoft 
Navision Software teaches a specific way to sell, consult with, set up, install and 
maintain Navision customers. We call this the Microsoft Navision 
implementation Methodology. As a Microsoft Navision Developer, you play a 
key role in two parts of this Methodology; Data Conversion and Customizations. 
Here is a more detailed look at the Microsoft Navision Implementation 
Methodology. 
 
The ultimate result of using this methodology is a Microsoft Navision Solution 
that fits the client’s business, delivered on time and on budget. 

Phases within the Methodology 
Development Includes Iterative Processes for Design, Code and Test 
 

 
 
The Microsoft Navision Methodology uses a phased approach to implementation. 
Each rectangle in the chart above represents one of these phases, and they are 
described as follows: 

Sales Phase 
The customer is not a customer yet. The Microsoft Navision representative leads 
the process of assessing the potential customer's needs and how they can be met 
by the Microsoft Navision Reseller. This is where the contact decides to become 
a Microsoft Navision Customer. 
 
Technically part of the Sales Methodology, the Sales Phase is tightly integrated 
with the implementation process allowing for a smooth, quick transition after the 
sale. Clearly defined sales deliverables, such as the Client Profile Worksheet, 
enable a clean handoff to the Implementation Consultant. 
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The Critical Needs Assessment is a flexible process ensuring Microsoft Navision 
is a good fit for the client. The size, complexity and risk of the project are factors 
that help determine the extent of the assessment. Certain key business challenges 
and needs are identified, and those are concentrated on. 
 
During this phase, the Developer occasionally plays a role in building a prototype 
as a proof of concept, or to answer technical questions. For the most part, though, 
the Developer is not involved in this phase. 

Concept Phase 
From this point forward, we are working with a customer. They may not have 
made a product purchase decision, but they are at least a consulting customer. 
 
Unarguably, the Concept Phase is the most important phase in the process. With 
proper planning, analysis and design, the project has a much higher chance of 
being successful. Here, the customer's needs, including the Critical Needs, are 
defined fully, and the plans are made for meeting those needs. For example, 
decisions are made as to which Microsoft Navision granules are to be purchased. 
 
Project Management guidelines for establishing project roles & responsibilities 
and communication methods assure the project starts on the right foot. 
 
The Developer works with and assists the Analyst / Consultant in two activities 
during this phase, Data conversion and Customizations. 

Development Phase 
All purchase decisions have been made; it is time to start implementation. The 
Development Phase includes the Detailed Design, Coding and Testing of 
modifications. It also includes the preparation of the User Documentation and 
data conversions. 
 
Often, the development phase can get out of control from a time & cost 
standpoint, due to frequent changes or inaccurate estimates. The methodology 
contains tools to help manage the development. 
 
The Developer takes the lead during this phase for the Data Conversion and 
Customization activities. However, the Analyst / Consultant still works with him, 
especially during the Detailed Design activity. 

Infrastructure and Technical Setup Phase 
The Setup Phase includes the hardware and software installation and 
configuration tasks. The methodology contains many Setup Checklists that 
enable the client’s staff to understand how and why the software is configured a 
certain way. 
 
The Developer plays a minimal role here, normally just to answer questions. 
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Training Phase 
End User Training can be executed using different approaches such as group 
training classes, one-on-one training or train-the-trainer. 
 
The Developer plays a minimal role here, normally just to answer questions. 

Deployment Phase 
This is sometimes called the “Turnover” or “Go Live” phase. Successful 
Deployment depends largely on the previous phases; however, a Deployment 
Checklist is included that helps to assure all the important details are 
remembered. 
 
The Developer plays a backup role during this phase; they normally only take 
part if something goes wrong at the last minute. Good planning and good testing 
minimizes this. 

Roles in the Customization Activity 
Customization is a team effort. There are four roles to fill on this team. It is 
possible that you have to play one or more roles in this process depending on 
your training, experience, special skills and the needs of the customer. However, 
for our purposes, we concentrate on the Developer's role in Customizations. 
The four roles are: 

The Microsoft Navision Implementer's Role 
The person filling this role is normally a Microsoft Navision Certified 
Implementation Specialist. He or she leads the process of developing the 
customer's total solution. This is the key player in the Training and Testing phase 
of development. 
 
Also, once the Analyst / Consultant and the Developer have finished their jobs, 
the Implementer actually installs the customization at the user site. For an 
installation, this is normally done just before they "Go Live" with the new 
system. 

The Customer's Role 
The person filling this role is normally the Controller or one or more other Key 
Users employed by the customer. He works with the Analyst, the Implementer 
and the Developer to specify their needs for the system, approve of any 
customizations, interim and final testing of the results. 

The Microsoft Navision Analyst / Consultant's Role 
The person filling this role is normally a Microsoft Navision Certified 
Implementation Specialist, although a senior Developer, depending on the 
business practices at your company, can also fill it. This person analyzes the 
needs of the customer, matches those needs with existing Microsoft Navision 
functionality, and determines which additional needs must be customized. He or 
she works with the Customer to design the customizations, resulting in a Concept 
Document. They also work with the Developer to design the customizations. 
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The Microsoft Navision Developer's Role 
The person filling this role is normally a Microsoft Navision Certified Solutions 
Developer. The Developer gets the Concept Document from the 
Analyst/Consultant, and with his help, creates detailed Design Specifications. He 
or she then program the customizations, test them, and deliver them to the 
Implementer for installation. 

The Phases of the Customization Activity 
The process of customization involves almost every phase in the Implementation 
Methodology. Here is how those phases relate to the Development phases. 
 
Throughout all phases, project management practices apply. The developer, like 
all project participants, must be concerned with and follow team practices with 
regard to the management of work scope, time, cost, risk, communication, 
quality, and customer satisfaction. 

Project Orientation 
From the standpoint of the Reseller and the Customer, the whole customization 
work, indeed the entire implementation, is one project. However, from the 
development point of view, a Project is a smaller entity. 
 
For development purposes, a "Project" is a set of development tasks whose 
results are all delivered together. In other words, all of the parts of one project are 
deployed at the same time, and before that time, no parts of the project are 
deployed. 
 
During the Concept Phase, a list of customer Requirements is developed. Each 
development project implements one or more Requirements, each of which is 
either one feature, or a closely related set of features. Each of these development 
projects are delivered separately, possibly at different times. 

Phase 1 – The Concept Phase 
During the concept phase, Microsoft Navision Consultant(s) interview selected 
client personnel. The client is also asked to provide representative documentation 
of legacy systems and may be asked to schedule and participate in group sessions 
for gathering requirements. 
 
Using the information provided by the client, the consultant produces for the 
client, a detailed document describing the requirements in detail and a conceptual 
design of the solution. This document defines the functionality required to meet 
the client needs and highlights specific functionality that requires Microsoft 
Navision software modification. From this "Concept Document", the consultant 
develops a cost proposal that includes detailed pricing for hardware, software, 
media and other Microsoft Navision solution components. This proposal also 
includes a high level quote for services such as training and system modification. 
The system modification quotation is subject to revision after the design is 
completed. 
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The Focus Study 
It is also important to note that the concept phase may be performed as one 
complete project phase or as two phases. In the two-phase approach, a concept 
document, known as a Focus Study is generated for the 2-3 most critical areas to 
the customer. From this, the client and the RESELLER decides whether to go 
forward with the rest of the concept document. The client always approves the 
complete concept document before proceeding to development.  

The Developer’s Involvement 
It is important that the developer participate in the development of the concept 
document. Experienced consultants may limit this involvement to reviewing the 
conceptual design and providing a cost estimate for customization. Less 
experienced consultants may need technical advice from the developer 
throughout the concept analysis phase. 

The Conceptual Design Estimate 
Normally, the price for the development work is not provided as a fixed bid at 
this point. However, it is important that the estimate be higher than the revised 
estimates that are provided after detailed designs are complete. 
 
This way we put ourselves in a position to beat expectations. Provide a worst 
case estimate and include contingency for risks such as lack of a detailed 
knowledge of what is required, modification complexity, area familiarity, 
developer experience and industry experience. 

Conceptual Design Review 
When reviewing the conceptual design, keep in mind that the consultant is 
probably not a developer. Challenge the design if there is a lower risk way to 
solve the client’s problem, especially one that avoids development. Also, make 
sure that there is nothing in the requirements that involves development that 
wasn’t flagged. 

Conceptual Design Tips 
The Requirements need to be defined prior to developing the conceptual design. 
Each requirement is separately numbered. A conceptual design must be presented 
for each requirement. Once the developer is involved, he may need to talk with 
the key users and managers within the client organization to get a clear picture of 
particular requirements. 
 
The next step is to decide how you address the client’s needs with Microsoft 
Navision Software. Again, you need to do this for each requirement. Here are 
some of the possibilities, in order of ease of development: 
 

1. Already Included - The need can be addressed by Microsoft 
Navision software without modification. Perhaps all you need to do 
is see that they purchase the appropriate granule(s) and specify how 
the software is configured to provide the solution. 
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2. Available Code- The customer may have a need that can be handled 
by an existing Microsoft Navision enhancement, an ISV developed 
Add-on, or objects and code from your own reseller’s application 
library. In this situation, you need to show the customer the solution 
and sell it to them. Even so, you still might need to customize it. 

3. Minor Change - The customer wants pretty much what the base 
application or an add-on does, but just needs it changed a little. 
Sometimes this means adding a field or two, sometimes it just 
requires a name change (to a table or field or label), and sometimes it 
means changing the presentation on a form or a report. These kinds 
of changes are easy to do and easy to maintain as long as you follow 
Microsoft Navision guidelines. 

4. Brand New - The customer wants a feature that is nothing like what 
it provided with Microsoft Navision software. You may be adding an 
entirely new module, or maybe just a new report. It probably has to 
be integrated with Microsoft Navision, but does not require any 
modification of the base application or the add-ons. It may take a lot 
of work to create this feature, but when new releases of the base 
application come out, it does not take a lot of work to upgrade this 
feature (probably no work at all). It is important to follow Microsoft 
Navision architectural guidelines when developing these solutions. 

5. Major Change - This is what you want to avoid. The customer 
wants something that would require a major change to the base 
application. Not only is this going to be a lot of work now, but would 
also be a lot more work later when the base application is updated to 
a new release. Changes would be required to the posting routines, or 
to the basic table relations. If you find that this is what the customer 
needs, try to rethink it. Perhaps you can turn this into something 
brand new that you can integrate with the base application. Or 
possibly, with a little imagination and discussion with the customer, 
you can turn this into a minor change with special training. Of 
course, sometimes you are stuck, and you have to make a major 
change to meet the customer's needs. Just be sure to point out to the 
customer that this is expensive now and expensive in the future. 
Perhaps the customer comes up with an alternative, once they see the 
cost. 

 
The client is asked to approve each modification for detailed design work. The 
concept document is then modified to only include the approved modifications. 
Normally, some higher risk modifications are postponed to a second project to 
follow the initial implementation. Once the Concept Document is approved, we 
can begin detailed design work. 
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The Add-on Option 
One additional consideration is whether you want to develop the solution as an 
add-on to be re-sold by other Microsoft Navision resellers. This requires a 
serious discussion between you and the person responsible for strategy and 
marketing in your company. Market demand and risk are key considerations 
here. You must be familiar with the rules regarding the commercial Microsoft 
Navision Add-on Program, have sufficient time for the extra effort involved, and 
possibly be willing to underwrite part of the development cost based on the 
expected returns from the product. 

Concept Approval 
Client acceptance of the Concept Document signifies approval to go forward on 
setting up the system and performing detailed design for development work. 

Phase 2 – The Detailed Design Phase 
For development purposes, the Development Phase of the Implementation 
Methodology is broken out into two phases: the Detailed Design Phase and the 
Programming Phase. During the Detailed Design Phase, customizations are first 
designed and priced. If the client accepts the customization, then it is developed 
during the Programming Phase. 
 
Note that during the Development Phase, any Data Conversion routines are also 
developed.  
 
A development specification and a detailed development cost estimate are 
created for each product Requirement. These "Design Specifications" are 
accompanied by a User Document, which includes instructions for using the 
enhanced functionality and an exercise that serves as the acceptance test script 
for the customization and as a training tool. The Design Specification is 
developed by the developer for the developer and includes the estimate. The 
Microsoft Navision Consultant normally develops the User Document. The 
Microsoft Navision Consultant conducts a walk-through of the specification and 
User Document with the client’s key users. Each specification is signed-off 
individually by a client key user who has completed Key User training. 
 
The Consultant and the Developer together often times break up a large 
implementation into separate Development Projects, each of which can be 
delivered at a different time, or possibly at the same time. Each Development 
Project consists of one or more Requirements. All the Requirements for one 
Development Project are in the same Design Specification document, and all the 
Requirements for one Development Project are in the same User Document. 

The Design Documents 
The User Document must be readily understood by both you and your customer 
since this is the document that serves as the User Documentation, training 
manual, and customer acceptance test script. Make this as realistic and as much 
in context to the client’s operation as possible. Do include in full detail what the 
customer sees on the screen and in reports, and how the customer operates the 
features. Do not include any details on how it is developed technically. 
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It should provide: 
 

• Descriptions of the look, feel, functionality and performance of the 
application. 

• Installation and Setup steps. 
• A description of the operating process required to execute the 

application’s functionality. 
• An exercise that illustrates the process and the expected outcome. 

 
One important goal of the User Document is to get the client to object HERE to 
what we plan to do, not later after we have invested in development. 
 
Where the User Document describes WHAT is constructed from the user’s 
viewpoint. The Design Specification details HOW the solution is constructed 
from the developer’s viewpoint. The Design Specification: 
 

• Serves as Instructions to the developer. 
• Describes the business functionality to be provided. 
• Describes all changes to be made to tables, forms, reports, dataports 

and codeunits in detail. 
• Lists limitations including what you are not going to do. 
• Lists customer responsibilities. 
• Lists the objects to be modified. 
• Includes a time estimate for the work. 

 
Both documents must be complete and address what is and what is not done so 
that when the customer approves these documents, there is nothing open to 
interpretation. 
 
These documents are written with the customer. For larger modifications, you 
write and then show the customer, get feedback, and adjust the documentation 
accordingly. And remember, be specific. There should be no ambiguities in these 
documents. They only cause trouble later. 

Scheduling 
These documents may be delivered in series. That is, one may be delivered, then 
another, then another, and so on – it is not necessary to have them all completed 
before beginning development on approved designs. The developer needs to 
work with the Microsoft Navision consultant to develop an efficient “build” 
schedule for the modifications. A consideration in developing this schedule is 
that two Specifications can be worked on at the same time only if they are 
entirely independent. In other words, they can only be worked at the same time if 
there are absolutely no objects that are changed in both. 
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Prototypes 
You might want to use a prototype as a tool to communicate a conceptual or 
detailed design. A prototype is an application that looks like what the customer 
wants, but which does not actually do anything. You might create tables, fields, 
table relations and forms, but you need not create any code. You can simply tell 
the customer what happens when the development is completed. 
 
If the customer likes what you have done with the prototype, you might even 
include screen shots and such from the prototype in your Design Specification or 
User Document. However, do not let the prototype substitute for a design. You 
must still write everything up.  
 
Also, be careful when using a prototype to “sell” the remainder of the product as 
part of a Focus Study or Conceptual Design. Normally, a prototype should only 
be developed for this purpose if: 
 

• The client agrees they proceed with the project if the prototype 
successfully demonstrates the ability to satisfy the requirement. 

• All competitors are required to supply a prototype. 
• You have an experienced developer who can produce the prototype 

with little risk. 
 

Design Review 
It is usually a good idea to review your design internally before presenting it to 
the client. Check to make sure your design: 
 

• Addresses the requirements exactly – no more and no less. 
• Specifies a “least-risk” solution. 
• Is appropriately designed for reuse. 
• Follows standard Microsoft Navision Standards and System 

Architecture. 
• Follows Microsoft Navision’s coding standards. 
• Follows Microsoft Navision’s Low-Impact design guidelines. 

 
Note the areas of risk in the design and focus attention on those. If you do not 
have multiple developers to do this work but feel you need it, you might consider 
subcontracting this review to a Certified Microsoft Navision Solutions Developer 
more experienced with this type of development. 

Customer Approval 
Once you have a complete project design, you can present it to the customer for 
approval. Focus the discussion on the User Document. You and the client need a 
signed copy. You should never begin development without written customer 
approval of your modification design. 
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Programming of a customization begins immediately upon sign-off of the 
specification. 

Programming Phase 
This is the "programming" part of the development project. However, you may 
notice that it is not strictly programming. There are many things to do before, 
during and after the actual programming. At the end of this phase, you have a 
product that is ready for testing by the customer for installation on his system.  

Create the Development Database 
The next step is to create the Microsoft Navision database that is actually used to 
developing this project. There are two ways to do this.  
 
First, if this is the original implementation (first project) for this customer, you 
must create the database from scratch using the Microsoft Navision Product CD. 
Perform the following steps: 
 

1. Load an untouched database from the Product CD. 

2. Download the Latest Improvements attachment for this release, 
expand it and import the object file (.fob) into your development 
database. 

3. Load any other Improvements from the Product Database. 

4. If there are any add-ons, import them as well. Note that if there are 
multiple add-ons and they conflict with each other (update the same 
object) you have to resolve these conflicts before you can continue. 

5. Export all objects as text, and then import this text file into your 
Compare Tool as your base version. 

 Second, if this is not the original implementation for this customer, 
but is instead a follow-up project, you must start with the database 
that you ended with at the end of the last Development Project. If 
there have been changes at the customer site (either by you or by the 
customer), you must perform the following additional steps: 

6. Go to your customer site. 

7. Select all modified objects. Using the steps described in the 
Deployment phase below, give them their own Version Tag and turn 
off the Modified Flag. 

8. Export these into an object file (.fob) and bring them back to your 
office. Do not forget to tell the customer not to make any 
modifications on their own until you complete the project. 
Otherwise, they may lose these modifications. 

9. Back at your own site, import these changed objects into the 
database that you ended with at the end of the last Development 
cycle. 
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10. Now, export all objects as text, and then import this text file into 
your Compare Tool as your base version.  

Program 
Finally, we can actually start programming! Some things to keep in mind - For 
Customizations, be sure to follow your Design Specification. If you find you 
cannot, then be sure to change the Design Specification to match your actual 
implementation. 
 
All development must be done at your own site, not at the customer site, 
especially not if the customer is already live. However, for lengthy development 
tasks, you should show the customer your progress once in a while (at LEAST 
every other week) so that you can get their feedback. Either bring it to them on a 
portable computer, or invite them to your site to show it. If you get some 
feedback, check the feedback against the User Document. If you did it differently 
than the User Document says, fix it. If not, you (and the Consultant) need to 
decide what to do next: 
 

• For a larger change (or even a small one) you could decide to record 
the request and add it to another project. 

• A small change might be handled with a change order. 
 
You must do your internal documentation and your Project Log (as described in 
the Documentation part of this section) as you are programming. Do not wait 
until you are finished and then try to do this after the fact. 

Internal Testing 
You may decide you need to perform a code review prior to performing testing. 
This is intended to make sure you followed sound coding practices. Whether or 
not you performed this review, you should always test each feature as thoroughly 
as you can as you complete it. Make sure your tests include the test exercises 
included as part of your User Document. You should be testing both to find bugs 
and to make sure that the results match the User Document. If you have the 
customer's license, be sure that at least part of your testing is done using the 
customer license. 
 
Also, be sure to include some "regression" testing in your process. This means to 
test the normal, unchanged features of the product, to be sure that they still work 
correctly after your customizations. Concentrate this kind of testing in the areas 
of the product that are at risk, particularly those that are being modified and also 
those that interface with those that are being modified. 

Considerations for Multiple Programmers 
Sometimes a project is big enough where you need to have multiple programmers 
working on it at the same time. If you can possibly prevent this, do so. For 
example, you could have one programmer writing the Design Specification, 
while another programmer does the actual programming (coding) and a third 
does the testing. Once the first Requirement was designed, they could be working 
at the same time, without interfering with each other. 
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Sometimes, you just have to have multiple programmers. If this happens, you 
should use the following procedures to avoid problems. The project should be 
designed so that different Requirements can be assigned to different 
programmers. If two Requirements are to be worked on at the same time, there 
must be no objects in common. If there are objects in common, then that part 
should be treated as a separate requirement and programmed separately before 
the other requirements are assigned and worked on. 
 
Appoint one developer to be in charge of the development database. When a 
programmer is about to start coding on a feature, give them a copy of this 
database and a list of objects they are allowed to change (the Design 
Specification should already contain this). 
 
When the programmer is finished (including testing), they should filter export all 
of these objects and give them to the developer in charge as an object file (.fob). 
 
The developer then imports these changed objects into the development database. 
There should be no conflicts since the programmer only changed the objects that 
he was assigned to. Do not assign the same object to two programmers! 
 
When that programmer is ready to work on the next feature, they should again 
get a fresh copy of the development database. This is because other programmers 
may have checked in their work in the meantime, and their next feature may 
depend on the other programmer's work. 

User Documentation 
The Consultant should update the User Document during this phase as necessary. 
If you end up changing functionality, that requires documenting the changes. If 
you agreed to provide additional documentation, you should also do that during 
this phase. As each feature is completed and tested, the documentation for it 
should be written. This can include user manuals, on-line help, training materials 
and other documentation. 

Phase 3 – The Testing Phase 
Up until this point, you have been testing the objects you have developed as you 
go. In addition, you have been getting feedback from your customer. However, 
we have now reached the point where we are ready for the customer to run the 
new software on their own, at their own site, for acceptance testing. 
 
This development phase generally takes place during the Training Phase in the 
Implementation Methodology and, indeed, this is the time for the Implementer to 
train the Key Users and other actual users in the new functionality. 

Customer Acceptance Testing 
When the development phase looks complete, then bring the completed 
development database to your customer site. Set it up as local database for each 
person who needs to look at the completed system. Give the customer a short 
training course, and turn them loose on it for testing. 
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Note that you are NOT installing this on your customer's server or on any of his 
live data. This is just for testing purposes. 
 
Also note that this testing must be done with the customer's license. If you have 
delayed ordering changes to the license for cash flow reasons, the delay is now 
over. Any testing done by the customer must be done with their license, so those 
problems with the license can be uncovered. Besides, you must never leave your 
developer's license or your reseller's license at a customer site for any reason 
whatsoever. 
 
A key client user who has been through key user training must perform the test. 
Have the key user walk through the test exercise in the User Document. 
 
The customer may find some bugs. If so, review them to make sure they are 
really bugs. In other words, verify that the User Document test scripts do not run 
properly. Do not accept a change in requirements as a bug. Also, make sure all 
valid bugs are logged and tracked in the project risk/issues log and fix them at 
your site. Once rework is complete, bring the copy over again for further testing. 
It is usually a good idea to track bug rates and hour expenditures. Large numbers 
of bugs usually indicates a design, not a programming problem. 
 
Once the test executes as specified in the User Document, you should obtain 
client sign-off and move on to Deployment. Sometimes, the client waits until this 
point to decide they really wanted different functionality. If so, you should bill 
the client for your completed work and issue a change order to conduct new 
design and development work using the process described here. 
 
As with the design, you must get the customer to sign off on completion of the 
work so that you can then proceed to the Deployment Phase. You must not 
implement your changes in the customer's live system without this approval. 

Phase 4 – The Deployment Phase 
With development completed and approved on a Development Project, you are 
ready to install the new or modified object(s) on your customer's site. For live 
Microsoft Navision customers, this step is the most critical, since you can affect 
the actual live data of the customer. Until this step, nothing you did could cause 
any permanent harm. 

Getting Ready to Go On-Site 
Follow these steps to create the installation object file (.fob): 
 

1. Select and compile all objects. 

2. Filter on all objects whose Modified flag is checked. 

3. On each filtered object, add the Version Tag (see the Version 
Control part of this section) to the Version List. 

4. Now, filter on all objects whose Version List contains the Version 
Tag "*<version tag>*" 
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5. Remove the filter on the Modified Flag. 

6. Turn off (uncheck) the Modified Flag on all objects. 

7. Select all of the (filtered) objects. 

8. Export using the Microsoft Navision format into a file named 
<version tag>.fob. This is your Installation Object File. Save this 
permanently. 

9. While you still have all filtered objects selected, export using the 
Text format into a file named <version tag>.txt. OR 

10. Do a Show All (remove all filters), select all objects, and export 
using the Text format into a file named <version tag>.txt. Use this 
second alternative if the project was a large one and you are 
expecting another large project soon. 

 
Now, import this text file (created using either method) into your Compare Tool 
and generate your Change Log into a file named <version tag>.log. Save this 
permanently. 

At the Customer Site 
There are two methods of installing at the customer site. If the customer has 
never had a live Microsoft Navision database installed on site yet, you must: 
 

1. Make a complete backup of your development database. 

2. Bring the backup file (.fbk) to the customer's site. 

3. Install Microsoft Navision (both client and server) on the customer's 
server in the usual manner (see the Installation Guide for more info 
on this). 

4. Open Microsoft Navision in local mode on the server. 

5. Create a new database. Be sure to make it large enough, as the 
customer starts adding live data after this point. 

6. Restore the backup you made of your development system. 

7. Exit the client. Then, start the server, pointing it to your customer's 
new database. 

If the customer already has Microsoft Navision Software installed, you must 
select a good time to do this installation. It can take a long time and nobody must 
be on the system the whole time you are installing it. Perhaps a Friday afternoon, 
continuing on Saturday. 
 
Also, before you show up, remind the customer that any changes that were made 
to their objects since you got them in the first place are subject to being lost 
(giving them a chance to back up or document). You and the customer can go 
over the list of objects that you changed so that he or she knows which changes 
may be lost. Here are the steps you should follow: 
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1. Bring the Installation Object file (.fob) created above to the 
customer's site. 

2. Bring down the server (nobody must be on when installing any 
objects like this). 

3. Make a complete backup of the customer's database, either using the 
Microsoft Navision backup utility, or simply copying the entire 
database elsewhere. 

4. Bring up the customer's database using the client on the server 
machine. 

5. Go into the Object Designer. On the Menu Bar, select on File and 
then click on Import. Select the installation Object file you brought 
with you. 

7. There may or may not be conflicts. Even if not, be sure to bring up 
the Import Worksheet dialog. 

8. Press the Replace All button. Then press the OK button. 

 
The import process may take a while. Especially if you have added or modified 
any table keys, since these all have to be rebuilt. 
 
By the way, if you want to install your project while retaining any changes that 
have been done to the customer's database, you must follow the same procedures 
as you would for an upgrade. This is covered in another section of this course. 
 
Once you have completed your installation, go into the Object Designer, select 
all objects, and recompile them. This shows any problems between the modified 
objects and the unchanged ones. 

The Final Test – Setup and System-wide Testing 
After installation, the Consultant coaches the client through the remaining 
product setup steps and, for new installations, once all setup work is complete, 
through the implementation of a short beta and cut-over. The developer should 
not be needed during these steps but should budget a few hours of time in case 
bugs are found during integrated system testing. 
 
If a bug is found during this phase, you need to treat it exactly the same as if the 
bug were found before you installed. Again, be careful to make sure it is within 
the scope of work as described in the User Document. If it was serious, you 
should restore the customer's database from the backup you made. If not, let them 
continue to work, but it is still not considered installed. Go back, fix the bug(s) 
and re-install. Obviously this is a huge pain. But in reality, it should not happen, 
since you and the customer should have already thoroughly tested it. 
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Final Customer Approval 
The project is not considered complete until the customer has given final 
approval. However, this is due once all setup processes are signed off, all 
development is approved and all bugs are resolved. Usually, once you have final 
approval, you would bill and collect any remaining money the customer owes 
you. 

Phase 5 – The Maintenance Phase 
This phase corresponds to the Ongoing Support Phase in the Implementation 
Methodology. There are two areas of concern for the Microsoft Navision 
Developer. 

New Customer Requirements 
You may not have implemented the entire customer Requirements yet. Or the 
customer may very well come up with new requirements. Each new 
Development Project is handled as described above. It is highly recommended 
that you not make "on the fly" changes at your customer site at any time. Even if 
it seems like it would be easy to do, it causes problems in the long run. Better to 
keep it formal and keep everything well documented. 

Updating for New Release 
Microsoft Navision Software also works on improvements to the product. No 
matter whether it is a new release, a service pack or just a product improvement, 
you should try to keep your customers up to date with the latest programs from 
Microsoft Navision. When any Product Improvement or Service Pack is released, 
look it over and see if it affects anything that your customer purchased. If so, 
schedule a time to install it. If not, wait to install until something else is changed 
which your customer purchased. Then install both. Never skip an Improvement 
or Service Pack completely. They must each be installed in order so that they all 
work together properly. The only exception is that a Service Pack generally 
includes all Improvements since the previous Service Pack or Release, so you do 
not need to install both the Service Pack and the previous Improvements. 
 
When there is a new release, you should try to upgrade the executables as soon as 
possible. The application can be upgraded on a scheduled basis when you have 
time. Normally, a new release has many more changes and requires data 
conversion and so on. 
 
Of course, these update instructions only apply to those customers that are on the 
maintenance plan. With this plan, they get the new code and software for free, 
but still must pay the reseller to install the changes. There is more information on 
how to install upgrades in a later section of this course. 
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Version Control 
When you are delivering a product to a customer, you may have performed 
several modifications. You might have updated the objects with an improvement 
you obtained from Microsoft Navision. You might have an add-on that you or 
some other Reseller created. You have your own customizations for this 
customer. Plus, you might have changed the customizations for this customer. 
 
You have a lot to keep track of. This collection of changed objects is unique and 
you need to know where all of these objects came from, and that is not all. 
Suppose that installing an add-on changed an object and customizing it for your 
customer further changed it. Now, what happens when Microsoft Navision 
releases yet another improvement that affects this object? How do you know 
which object can just be loaded on and which takes more work than that? 
 
It is for these reasons that you need a method of Version Control. Fortunately, in 
Microsoft Navision, there are various tools built into C/SIDE that helps you with 
your version control. But you must know how these features work in order to use 
them effectively. This is what we are covering in this section. 

Modification Flag 
The Modification Flag is a kind of automatic version control. Whenever you 
change an object, the modification flag is automatically checked. The only way it 
is unchecked is if you deliberately uncheck it. 
 
This is an excellent tool to use while you are in the process of developing a 
project. Then, once you have completed the project, you can select all of the 
modified objects and set the version tags (see below). Once you have done that, 
you can turn the modification flags off. This way, you can tell automatically if 
anything has been done to change the objects since the project was completed. 
 
If you make modifications at the customer site, or if the customer has the design 
tools, the modification flag is a good way of telling that changes have been made 
on site. Therefore, in either of these situations, it is strongly recommended that 
you do not uncheck the modification flag. 
 
One thing to watch out for - Occasionally, the only modification you make to an 
object is to change the object name, which you can do from the Object Designer. 
If you do this, the modification flag is neither automatically set nor are the date 
and time stamps). Therefore, it is recommended that you actually call up the 
object (by pressing the Design button) and change the Name property of the 
object. Then, when you save it, it updates everything automatically. 

Version Tags 
The "version tags" are located in the Object List in the column called Version 
List. In order to work correctly with the Import Object utility within Microsoft 
Navision, the version tags require a fairly standardized format. Therefore, first 
we must cover how the Import Object utility uses the version tags. 
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Import Objects 
When importing objects, the Import Object Utility checks both the imported 
object and the matching object in the database, and checks both the Version List 
and the Modification flag. It considers the Version List to be a list of version tags 
separated by commas. Thus, NAVW13.00,NS01.01 is considered two version 
tags, the first is NAVW13.00 and the second is NS01.01. Let us first consider a 
Version List with only one version tag. 
 

 
 
Note that the Default Action of "Replace" is sometimes "Merge" when you are 
dealing with a Table Object. 
 
The situation with multiple version tags is similar, except that each version tag on 
the imported object is compared with its corresponding version tag in the existing 
object to discover the differences. If there is a version tag missing, it is 
considered to be an earlier version than one that exists. The first is compared 
with the first, the second with the second, using the above table. If there is a 
conflict with a version tag, then there is a conflict on the import. If any tag calls 
for a replace, the import calls for a replace. 

Microsoft Navision NTR Usage 
Now this is how we use version tags at the Microsoft Navision NTR level for the 
base application. The first version tag is usually the world wide base application. 
It consists of parts; if the version tag says NAVW13.10.01.25, the "NAV" is the 
product (Microsoft Navision), "W1" indicates that it is a world wide object, "3" is 
the major release, ".10" is the minor release, ".01" is the maintenance release 
(service pack), and the ".25" is the unreleased (but published) hotfix number. In 
all cases, before we publish a release or an improvement, we turn the 
Modification flag off. If a level is missing, for example, NAVW13.10, the 
numbers are left off. The major and minor release numbers are always present, 
but there may not be a service pack or hotfix as of yet. Since the import utility 
uses an ASCII compare (character by character), NAVW13.10 is considered 
earlier than NAVW13.10.01. 
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Many objects are added at the NTR during our localization process. If a base 
application object exists only in one country, it can of course be recognized by 
the fact that its object number is in the country's special range. It can also be 
recognized by the version tag, which says (for example) NAVUS3.10.01.25. 
Note that this is exactly the same as the version tag in the above world wide 
example, except for the 4th and 5th characters. The "W1", which indicated world 
wide, has been changed to "US" indicating that this base application object is 
from the United States. 
 
In addition to adding objects during localization, we also modify world wide base 
application objects during localization. In this case, there are two version tags, 
one the world wide tag, and the second the NTR tag. For example, an object 
might have NAVW13.10.01.25,NAVUS3.10.00.02 in the Version List field. The 
first (before the comma) is the world wide version tag, and the second (after the 
comma) is the NTR version tag. 
 
For each other product we create (like Commerce Portal), we create a new 
version tag as follows: CPOW12.01.02.09, where "CPO" is the three letter 
product code, "W1" indicates it is world wide, "2" is the major and ".01" is the 
minor release number, ".02" is the service pack, and ".09" is the improvement 
number. If a base application object is changed, we add the other product's 
version tag to the end of the base application version tag, separated by a comma. 
If this is a new object, we just use the other product version tag. In either case, 
we turn the modification flag off before we publish any product. 
 
If an NTR creates a separate product, the same rules hold, except that the "W1" 
would be replaced by (for example) "US", indicating the NTR. Note that in our 
examples, each of these tags has a "US" in it, to indicate that it is a United States 
object. Each country in the Microsoft Navision World uses their own two-
character country code in their version tags, like "DE" for Germany, "UK" for 
United Kingdom, and "DK" for Denmark. The worldwide version of the 
application has its own two-letter code, "W1". 

Microsoft Navision Developer Usage 
Finally, here is our recommendation on how you should use these version tags. 
You should always leave our version tags alone! As you are making changes, you 
should leave the modification flag on, and only turn it off when you have created 
a new version tag and set all changes to that tag. Never turn the modification flag 
off unless you change the version tag. If you are making minor modifications at a 
customer site, you do not even need to create a version tag: just leave the 
modification flag on.  
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If you are creating a major modification for a customer, then you should create a 
version tag for that customer. Use 2 or 3 characters to represent the customer and 
add a "00" (two zeroes) to it. Whenever your modifications are stable (working 
and you do not change it for a little while), you should filter on the modified flag 
set to yes, and add the new version tag to the Version List. If it is a base 
application object, separate your new tag from our existing one with a comma 
(no space). If it is a new object, just use your version tag (erase ours if you 
copied from one of our objects). Now, remove the filter from the modification 
flag, and add a filter to the Version List, which is your version tag preceded and 
followed by an asterisk (e.g. *XYZ00*"). You can now turn all the modification 
flags off. 
 
Then, without removing the filter, select all objects and export them all into a fob 
file named the same as your version tag (e.g. "XYZ00.FOB"). When you make a 
major upgrade for your customer, you would perform the same steps except that 
you would use the next number (e.g. "00" -> "01"). Any object that changed 
(even if it had never been changed before) would receive the new version tag. If 
one of the customer's version tags was already on the object, it would merely be 
changed to get the new number. 
 
If you are creating your own add-on product, a similar process would take place. 
The only difference would be that you would take the letters from your own 
company’s name, and the name of the add-on product, to create the version tag. 
Thus, like the base application, there is a 3 letter add-on product code, followed 
by a 3 letter company code (not 2, since it might be the same as a country code), 
followed by the version numbers as needed. For example, if your company was 
named "Computer Technology Innovators", and your add-on was named 
"Bowling Alley Management", then the first version of this add-on might have a 
version tag of "BAMCTI01". 
 
Also, we would recommend bringing your working database up to the latest 
released version of Microsoft Navision, including all published hotfixes, just 
before you put your version tags in. This way, any base application object that 
you have changed gets the latest base application version tags. Of course, if you 
have to apply the change log manually (since you already modified the base 
application object with your add-on), you must set our version tag manually as 
well. Do not forget to export all changed objects into a single fob file once you 
have set all the version tags and turned off the modification flags. This is the file 
you probably ship out to purchasers of your add-on. 
 
When you are ready to upgrade your add-on product, take your original version 
tag and increment the number for each major release. If you are making a minor 
release, add a ".01" to it for the first minor release, ".02" or the second, and so on. 
Thus, your original add-on product described above might have a version tag of 
"BAMCTI01", the first minor modification would be "BAMCTI01.01" and the 
second would be "BAMCTI01.02". The next major release would be 
"BAMCTI02". 
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When using multiple version tags, the order is quite important, since the import 
utility compares 1st with 1st, 2nd with 2nd, and so on. If the order on an 
imported object is different from the order on the existing object, the comparison 
is not done correctly. On the other hand, if the order on one object is different 
from the order on a different object, that does not matter, since each object is 
compared individually. 
 
However, for consistency and ease of updates, we ask you to use the following 
order for version tags: 
 

• Base Application version tags (first world wide, then NTR). 
• Other Microsoft Navision Product version tag. 
• Add-On version tags. The specific order is unimportant, but should 

be consistent. We suggest the following: 
– Other Company’s Add-Ons 
– Your own Add-Ons. 

• Custom modifications version tag. 
 
This is normally the order you would add them anyway, so it should be 
convenient. 
 
Here are some other examples: 
 
A released base application object from an NTR: 
NAVUS3.10 
 
The same released base application object, with hotfix number 23: 
NAVUS3.10.00.23 
 
The same object, with the 2nd upgrade of your add-on applied: 
NAVUS3.10.00.23,BAMCTI02 
 
The same object installed on your customer site and then customized for that 
customer: 
NAVUS3.10.00.23,BAMCTI02,XYZ01 

Development Documentation 
In the above discussion, we talked about many different documents that the 
developer must look at and write. Let us go into more detail on each of these. 
 
There are several kinds of documentation that we are describing here. However, 
they all have one purpose in common. This documentation is for the benefit of 
the Microsoft Navision Developers. To be more specific, the developers use this 
documentation for the following purposes: 
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• Organization - The Microsoft Navision Developer, as part of the 
development process, must organize the changes to be made, and 
organize the implementation of them. 

• Audit - To create a permanent record of what changes were made, 
who made them, when they were made, and why they were made. 

• Communication - In projects where there is more than one developer, 
your documentation is what keeps everyone on track. 

• Upgrades - When a new version is released, your documentation is  
indispensable in upgrading your customization to the new version. 

 
There are other kinds of documentation that you are reading and may be writing 
as a Microsoft Navision Developer. These include Concept Documents, User 
Documents, user manuals, proposals, quotes, and so on. These subjects are 
covered minimally in this class. We are concentrating on the documentation that 
is used strictly by and for the Microsoft Navision Developers in your 
organization. 

Project Orientation 
The documentation that you write is based on a project. When you are going 
through your Concept Document, you first divide the job into various projects. 
Each project implements one or more "Requirements" from the Concept 
Document, each of which has one feature, or a closely related set of features. In 
many cases, a set of modifications for a customer becomes a single project. In 
some cases, the modifications are so extensive and complex that you have to 
break the job into multiple projects. Each of these projects could be delivered 
separately and possibly at different times. 
 
Once you have determined what is included in your project, you then write a 
Design Specification. This is not the User Document. A Design Specification is 
used by a developer and to communicate between developers. However, the 
customer reviews this document and approves it. 
 
Once you have a Design Specification, you then start working on implementing 
your project. While you are doing this, you are creating documentation internal to 
each object and creating a Project Log. 

Concept Document 
The Concept Document is a document created by the Microsoft Navision 
Analyst/Consultant together with the customer, to specify the customer 
requirements and what the Microsoft Navision Reseller does to meet those 
requirements. It contains information on what hardware needs to be purchased, 
what Microsoft Navision granules are to be purchased, what customizations are 
to be done, along with what other services should be done. For more information 
on developing this document, refer to the Implementing Microsoft Navision 
course. 
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For the developer, the most important things here are the requirements that 
involve customizations. Each Requirement has a section number (like 4.2.7) 
which is to be used as a reference in other documents to refer to the requirement 
in the Concept Document. 
 
Depending on your organization or experience, this document is the equivalent of 
a "Functional Requirements Document" or a "Project Specification". 

User Document 
The User Document is a document created by the Microsoft Navision 
Analyst/Consultant, together with the customer, to specify what is changed in the 
product to meet the customer's Requirements. It goes into more detail than the 
Concept Document, in that it fully explains to the customer what is being 
changed, how it looks when it is done, and how the customer runs it once it is 
deployed. For more information on developing this document, refer to the 
Implementing Microsoft Navision course. Like the Design Specification (see 
below), the User Document have a different "chapter" for each individual 
customer Requirement that is being handled by a customization. The 
Requirement number used in this document is the same one that was used in the 
Concept Document, so that everything ties together. 
 
The developer should note that this document often includes "test scripts", which 
are used by the customer to verify that the customization has been done correctly. 
The developer should be familiar with the contents of the User Document (and 
probably help in developing it) so that he or she knows what the customer 
expects when the customized product is deployed. 

Design Specification 
The Design Specification is a document created by the Microsoft Navision 
Developer, together with the Consultant, to specify the exact changes that are 
made to the product in detail. It takes a different point of view than the User 
Document and Concept Document, since those are written from the point of view 
of the user. The Design Specification is written from the point of view of the 
programmer. 
 
As already mentioned, the Design Specification is used by a developer and to 
communicate between developers. Whenever you write a design specification, 
you should write it as though you were telling another programmer how to make 
the modifications, even if on this particular project you are doing it all yourself. 
A design specification must be detailed and organized, and writing it helps you 
with your thinking process. Later, when you are trying to figure out a particular 
section of code, your design specification tells you the why and how of that code. 
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A design specification can be in any format that accomplishes the primary goals 
of organization and communication. However, we have a sample format which 
accomplishes these goals, without overdoing the details. You may use it and 
adapt it to your own purposes and style. On your class CD is a Word document 
template called "DesignSpecification.dot". The best way to use this is to copy 
into your Templates directory, usually found under Microsoft® Office® on your C 
drive. Once this is done, when you create a new document, it appears as one of 
the templates and you can select it. Create a document using this template, and 
then follow along as we go through the various parts. 

Document Properties 
The first thing you should do is fill in certain document properties which are used 
in the form itself. Using the Menu Bar, select File and then Properties. 
 
On the Summary tab, the following fields are used: 
 

• In the Subject field, fill in the name of the project as a whole. This 
appears on the cover page. 

• In the Company field, fill in the name of your company. This 
appears in the heading on every page. You may just want to fill this 
in directly in the template. 

 
On the Custom tab, there is a table in the middle that lists the Name, Value and 
Type of the various properties. One of these properties is named "Client". Click 
on Client in the Properties table, and the Name, Type and Value is displayed in 
the boxes above the table. Change the Value from "Customer Name Here" to the 
name of your customer, and then press the Modify button. This name appears on 
the cover page. Press the OK button to leave the Properties dialog. 

Requirement Header 
Each Requirement in the project gets a separate section in the Design 
Specifications, each one starting on a new page. It is recommended before you 
start filling out a new section that you first make a copy of the last section, so that 
you always have a blank section on the end to use when creating the next 
Requirement. 
 
The title of the page includes the Requirement Number and Requirement 
Description. The number should be taken from the Concept Document section 
number where the Requirement is first described. The Description should be a 2 
or 3 word title, just to identify the requirement. The other parts of the 
Requirement Header should be filled in as follows: 
 

• The Summary field should have a 1 or 2 line description of the 
Requirement. 

• The Status field should indicate the current status of this 
Requirement in one word. 

• The Assigned To field should indicate the name of the developer in 
charge of this Requirement. 
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• The Hours Estimated field should be taken from the total in the 
Estimate part of this Requirement. 

• The Estimated Labor field should be the amount you expect to bill 
for labor. It could be the number of hours estimated multiplied by an 
hourly rate, or it could be a fixed bid. 

• The New Table Objects field should include the number of new 
table objects being added for this Requirement. 

• The Other New Objects field should include the total of the number 
of form, report, codeunit and dataport objects being added for this 
Requirement. 

• The New Object Cost field should be the cost to the customer of the 
above new objects. 

• The Estimated Billing field should be the sum of the Estimated 
Labor and the New Object Cost fields. 

 
Do not forget that there is a major price break for buying 10 table objects or 100 
of any other Objects at the same time. If you can take advantage of a price break, 
prorate the cost of the objects over the entire project. 

Technical Specifications 
This is the actual detailed specification portion of the document. We have 
divided it into 4 parts to remind you of the information needed, but you can set it 
up any way that works in your organization. 
 
Here is where you get down to brass tacks. On an object-by-object basis, describe 
the changes that you are making. Make sure you identify each object by type, by 
number and by name. If it is a new object, describe what it is for, what it does, 
and what the programmer does to create it. If it is an existing object, describe 
what the changes are, and what they are for. 
 
You obviously do not need to record the actual code changes (after all, you can 
always look at the finished object for that), but you should use sufficient detail 
that you could hand to an entry-level programmer and have them complete the 
programming correctly. Sometimes that means going into great detail, while 
other times it requires only one sentence to describe the changes. 

Limitations 
Here is where you specify what you are not doing, if that is necessary. You also 
describe what parts of this are being left to the customer to do. If some 
functionality is being delivered in stages, state here what parts are not available 
until another phase. 

Estimate 
Once you have completed the Technical Specification, you ought to be able to 
give a fairly accurate estimate of what the hours would be to complete this work. 
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Impact on Upgrades 
This is where you specify what the impact of these changes are when it comes 
time to install an upgrade. This is important as the customer figures out the total 
cost of ownership. Include an estimated time to upgrade. 

Approval 
Indicate to the customer how they should let you know that you can go ahead 
with your work. Some sort of written, signed approval is recommended. Once it 
is approved, attach the approval document(s) to the end and record here when it 
was approved, who approved it and where the approval document can be found. 

Objects 
As you actually program the modifications, you should enter in this section, a list 
of the actual objects changed and created. Include the Object Type, Object 
Number and Object Name. If this is a modified object, indicate the base version 
tag before you made your changes otherwise indicate "New". 

Attachments 
If there are any attachments at the end pertaining to this Requirement, include 
them here. If not, erase this part. 

Revisions 
While implementing the changes you have described, you may find that you need 
to change the design. Should this happen (and it often does), you should revise 
the Design Specification to reflect these changes. When you finish, the Design 
Specification must match the program and the program must match the Design 
Specification. 
 
If the change affects the functionality, you probably need to get customer 
approval to make the change. Try to keep these kinds of changes to a minimum. 
 
Whenever you make a revision to the Design Specification, create another Part at 
the end of your Design Specification, describing the change, when it was made, 
and why you made it. 
 
To facilitate this, you may want to take advantage of some of Word's capabilities 
in tracking changes to documents. Here is how: 
 

• Save Original Version - Go to File, Versions, and press the Save 
Now button. Enter a description indicating that this is the original 
version approved by the customer. 

• Track Changes - Go to Tools, Track Changes, Highlight Changes, 
and then check the box that says Track Changes While Editing. 

• Make Your Changes 
• Review - Print out the specification showing changes. Review with 

Consultant and/or Customer as necessary. 
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• Add Revisions Part - Add a new Part (using the Heading 2 Style) to 
the end of the Specification called Revision (whatever revision 
number it is), and describe the revision in that part. 

• Accept Changes - Go to Tools, Track Changes, Accept or Reject 
Changes, and accept all changes. 

• Turn Off Track Changes - Go to Tools, Track Changes, Highlight 
Changes, and then remove the check mark in the box that says Track 
Changes While Editing. 

• Save New Version - Go to File, Versions, and press the Save Now 
button. Enter a description indicating that this is a revision and which 
revision it is. 

 

Internal Documentation 
By "Internal Documentation", we mean the documentation that is written directly 
into the objects themselves. These include code comments, the Documentation 
Trigger of each object and Description fields in the field definitions. Note that 
there is some difference between the internal documentation for a new object, 
and that for a previously existing object. 

Documentation Triggers 
If you look at the code within each object, note that there is a Documentation 
trigger as the first trigger within the object. This trigger is never executed, so it 
does not need to contain actual code. Instead, it is designed so that you can enter 
comments about the object as a whole there. 
 
The use of the Documentation Trigger for a new object (being created for this 
project) is optional. If you use it, you should do it the same way as described 
below for an existing object. The only difference is that the "sequence number" 
should be "00". 
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For an existing object (one that was in existence before this project), you must 
create a heading in the Documentation Trigger, for each modification you make. 
Usually, this amounts to one per feature. This heading should contain some sort 
of Reference Number, the date when the modification was completed, who did 
the modification (your company’s name and individual name), the project, and a 
short description of the change. Here is an example: 
 
Note that the Reference Number (NJD01) is a combination of the initials of your 
company, the initials of the developer, and a sequence number. 
 
This sequence number should start with 01 for each object, so that the first 
modification of this object has the number 01, the second modification of this 
object has the number 02, and so on. The only exception is that, if this is a new 
object, the sequence number should be 00. 

Code Comments 
There are many theories about how to comment your code, and for normal 
purposes (explanations, and so on), you should use whatever method you think is 
best. However, for our documentation purposes, you need to mark each 
modification with a comment using a special method. This should only be done 
when you modify an existing object, not when you create a new object. 
 
The key is to mark the changed code with the same Reference Number as you 
used in the Documentation Trigger of this object. For example, if you have 
modified a single line of code, you should mark it like this: 
 
State := "Employee."Default Work State"; // NJD01 

 
If you have added or modified an entire block of code, you should mark your 
change as follows: 
 
// NJD01 Start 

State := "Employee."Default Work State"; 

Locality := "Employee."Default Work Locality"; 

"Work Type Code" := Employee."Default Work Type Code"; 

// NJD01 End 

 
If, as part of your modification, you have deleted a large block of code, you 
should mark this deletion as follows: 
 
{ NJD01 Start Deletion 

State := "Employee."Default Work State"; 

Locality := "Employee."Default Work Locality"; 

"Work Type Code" := Employee."Default Work Type Code"; 

NJD01 End Deletion } 
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Note that this keeps the old code in place, just commented out. If you have a 
standard method of commenting your code so that you can tell how the code 
works, or what it is doing, you should continue to use that method. This 
modification marking is in addition. 

Field Descriptions 
Whenever you add a new field to an existing Table Object, or modify an existing 
field in a Table Object, you should mark that field with the same Reference 
Number that was recorded in the Documentation Trigger of that same object. 
Simply entering the Reference Number into the Description property of the field 
should do this marking. Do not do this if you are creating a new Table Object. 

Project Log 
The Project Log is your record of everything that has been done for this 
customization project as a whole. It should be created while you are actually 
doing the modifications. Once you have completed your Design Specifications, 
you should create your Project Log as a plain text file and give it a header that 
contains the following information: 
 

• Name of Project 
• Your Company Name 
• Name of Project Leader 
• Customer 
• Date Started 
• Date Completed 
• Name of Design Specification document 
• Version Tag 
• Name of Change Log 
• A short description of the project (remember, this information is 

already in the Design Specifications). 
 
The Project Log Heading can be in any format you want, but here is an example 
that you may use: 
 
Multi-State Payroll  Navision  John Doe 
Customer: Acme Widgets  Date Started: 4/08/98 
Date Completed: 4/23/98 
Version Tag: NS012.01 
Design Specification: multi-state.doc 
Change Log: multi-state.log 
 
Add ability to have Employees work in multiple states. 
Add ability to have Employees work in multiple localities. 
Add ability to enter Work Types, and to have Employees 
who use multiple Work Types. 
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After this is the log itself. There is a main heading for each object, which 
includes the object type, number and name. This heading also includes the 
Version Tag of the object before it was changed, or if it is a new object, the 
words "New Object". The various object headings should be entered in order, so 
that they are easy to find. 
 
Following the object heading is the log entries. The easiest way to create these 
log entries is to copy the information that you wrote into the Documentation 
Trigger of the object and indent it. This way, you have the Reference Number, 
the programmer, the date, and a short description of the modification (you can 
erase the project name and the company name if you wish). Here is an example: 
 
Table 10077 - Time Journal Line - NS012 
 NJD01 - Navision, John Doe, 02/12/00 
  Added the new State and Locality fields. 
  Modified the trigger code to default these fields 
   whenever the Employee No. is entered. 
 
Here is an example of a new object: 
 
Table 10082 - Split Information - New Object 
 NJD01 - Navision, John Doe, 02/12/00 
  New table which links a Split Control with the 
   various Substitute Controls for a single Employee 
   or for a standard split (indicated by a blank 
   Employee No). 
 

Change Log 
A Change Log details all of the changes you made for a Project. It tells another 
developer, without any ambiguity, every single change that must be made to go 
from one version of the product to another. You must create a Change Log so 
that other developers can see exactly what was done to the objects. Even more 
important, you must have these Change Logs available when it comes time to 
upgrade your customizations to a new release of the Microsoft Navision product. 
 
There are three recommended methods of creating a Change Log. All three use 
plain text files for a simple reason - by using plain text files, it is easy to copy 
changes from the Change Log and paste them directly into a Microsoft Navision 
Object. 

Manual Change Log 
The best method for creating a Change Log is to create it manually. Using a 
manual change log, you can describe exactly how to make the changes using 
C/SIDE, plus for code changes you can copy and paste entries into C/SIDE, 
rather than using the text format. 
 

Page 549 



 

 

Microsoft Navision Development I − C/SIDE Introduction 

Naturally, the big disadvantage to a manual change log is the time that it takes to 
create one. Therefore, we only use it in house for Microsoft Navision 
Improvements, where we know that they are used many times. And for Microsoft 
Navision resellers, we only recommend a manual change log if you are making 
an Add-On product, again, where it is used many times. 

Automatic Change Logs 
We also provide two methods of making Automatic Change Logs. They both 
work using the text files that you can export from C/SIDE. They basically 
compare the text lines and print a report showing the differences between them. 
Both of these methods were developed using C/SIDE. 
 
The advantages of an automatic change log are the speed and ease of creating 
them, and the completeness of the results (as long as you know which objects 
were changed). The disadvantage is the long time it takes to actually use them 
and the difficulty in understanding them. For example, if you insert a single field 
into a tabular window, it generates many pages of changes, since each column 
had to be moved to make room for a new field. Once you are used to using these 
change logs, and you can easily read the exported text objects from Microsoft 
Navision, this disadvantage decreases. 
 
One of the two Automatic Change Logs is the Compare Tool. The Compare Tool 
is recommended whenever you are publishing a Change Log, for example if you 
are including it with an Add-On. 
 
The alternative method is the Merge Tool. Although its change logs are more 
difficult to read, the advantage of using this method is its integration with the 
merging capabilities. If the main reason for the Change Log is its help when 
installing upgrades, then this method is the best. 
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Test Your Skills 
 

1. What is the specific way that Microsoft Navision teaches to sell, 
consult with, set up, install and maintain Microsoft Navision 
customers called? 

2. Name the Implementation Methodology Phases 

3. Name the four main roles in the Customization Activity 

4. Which phase includes a consultant’s interview with the customer’s 
personnel, requesting documentation of legacy systems and group 
sessions for gathering further requirements? 

5. Which phase involves going on-site to install the new or modified 
objects? 

6. Which flag, used as a method of version control, is automatically 
checked whenever you change an object? 

7. What is the name of the Word document template (supplied on your 
class CD) that can be used to specify, in detail, what changes are to 
be made? 

8. Where should the ‘header’ documentation for all changes to an 
object be located? 

9. What is the name of the document that you should keep as part of the 
Project Log that records the detail of changes to a project? 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 

 
 
2. 

 

 

 

 

 
 
3. 
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APPENDIX A: OBJECT Q&A 

Objects 
This appendix gives the student a chance to measure what they have learned 
about Microsoft® Business Solutions−Navision® Objects. You can find the 
answers to the questions in part 2 of this appendix. 

Part 1: Object Questions 
 

1. Which of the following are not objects that you can create in 
C/SIDE? 

a. Tables 
b. Forms 
c. Reports 
d. Code Groups 

 

2. True or False. C/SIDE is an object oriented programming 
environment. 

a. True 
b. False 

 

3. A Table description is made up of Fields and what? 

a. Indexes 
b. Table Relations 
c. Dataports 
d. Keys 

 

4. Which of the following properties would not be available for a 
normal code field? 

a. CharAllowed 
b. Length 
c. Calcformula 
d. Data Type 
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5. Which property would you use to keep a user from pasting records 
into a table? 

a. AllowCutPaste 
b. PasteIsValid 
c. UserPaste 
d. A user cannot paste records into a table from the clipboard 

 

6. Which property would you set to keep a field from being edited by 
the user? 

a. Editable 
b. Enabled 
c. AllowUserEdit 
d. AllowModify 

 

7. When you run a table from the Object Designer, what is displayed? 

a. Raw data from the table. 
b. The table object. 
c. The fields and keys in a table. 
d. A form that displays the data in the table. 

 

8. The primary key in a table is used for what? 

a. Sorting 
b. Keeping each record unique. 
c. Defining the default lookup form for the table. 
d. Both a and b. 

 

9. A secondary key in a table is used for what? 

a. Sorting 
b. Possibly, keeping each record unique. 
c. Defining the default lookup form for the table. 
d. Both a and b. 

 

10. True or False. The user can only use the primary key on forms. 

a. True 
b. False 
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11. Relating two tables in a "one to many" relationship requires… 

a. Changing both tables to point to the other. 
b. Relating a field in the "many" table to a field in the "one" table. 
c. Changing the table properties of the "many" table. 
d. Both b and c. 

 

12. True or False. A conditional table relation can relate its table to more 
than one other table. 

a. True 
b. False 

 

13. What happens when you change the primary key of a record that has 
other records in other tables related to it? 

a. The values in the other tables change as well. 
b. Those other records are orphaned. 
c. The other records are deleted 
d. An error occurs. 

 

14. What is required for a Sum FlowField to calculate properly? 

a. Data in both tables being summed. 
b. A ReqFilterField. 
c. A SumIndexField. 
d. A FlowFilter. 

 

15. What is required for an Exist FlowField to calculate properly? 

a. A SumIndexField. 
b. A FlowFilter. 
c. A boolean data type to put the value of the CalcFormula in. 
d. Nothing. 

 

16. What makes FlowFields and FlowFilters unlike all other fields? 

a. They are decimal. 
b. They always have a SumIndexField. 
c. The data type is FlowField. 
d. They are not stored in the table. 
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17. What would you name a master table that holds Book Information? 

a. Book 
b. Books 
c. Book Info 
d. tblBook 

 

18. What would you name a subsidiary table that holds Address 
information for customers? 

a. Address 
b. Addresses 
c. Customer Address 
d. Customer Addresses 

 

19. A document is represented by what kinds of tables? 

a. A Header table. 
b. A Lines table. 
c. A Header and a Lines table. 
d. Document and Document History tables. 

 

20. What is the name of the primary key field(s.of a Ledger table? 

a. Entry No. 
b. Customer No., Entry No. 
c. Line No. 
d. Customer No., Line No. 

 

21. What property of a form binds it to a table? 

a. TableNo 
b. TableID 
c. SourceTable 
d. BoundTable 

 

22. True or False. It is better to start all forms with the form wizard. 

a. True 
b. False 
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23. What is the property that you must set on a data control? 

a. Lookup 
b. SourceExpr 
c. Drilldown 
d. DataField 

 

24. Card forms… 

a. Display one record from a table. 
b. Have tabs across the top. 
c. Are used for editing records. 
d. All of the above. 

 

25. Tabular forms… 

a. Display many records from a table. 
b. Have tabs across the top. 
c. Are always non-editable. 
d. All of the above. 

 

26. A tablebox can usually be found on a 

a. Tab of a Card form. 
b. The center of a Card form. 
c. Tab of a Tabular form. 
d. The center of a Tabular form. 

 

27. True or False. Option fields can be displayed using a Textbox or 
Option buttons. 

a. True 
b. False 

 

28. What type of button would you usually add to the bottom of a card 
form? 

a. Command Button 
b. Menu Button 
c. Option Button 
d. You do not; the wizard adds all the buttons for you. 
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29. What can you use to easily add fields to a form? 

a. Field Menu 
b. C/AL Editor 
c. Menu Designer 
d. Symbol Menu 

 

30. What control allows you to display one form within another form? 

a. Tablebox 
b. Textbox 
c. Matrixbox 
d. SubForm 

 

31. What name could you use for a Tabular form that displays 
information from the Book table? 

a. Book 
b. Books 
c. Book Card 
d. Book List 
e. Both a and b 
f. Both b and d 

 

32. What is the difference between a List form and a Tabular form? 

a. A tabular form displays only one record. 
b. A List form displays only one record. 
c. A tabular form is not editable. 
d. A List form is not editable. 

 

33. What is the difference between a Worksheet form and a Tabular 
form? 

a. A tabular form displays only one record. 
b. A worksheet form displays only one record. 
c. A tabular uses AutoSplitKey. 
d. A worksheet uses AutoSplitKey. 
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34. What Function key is used to Post records? 

a. F5 
b. F9 
c. F11 
d. SHIFT + F5 

 

35. What Function key is used to open the Card form from a List form? 

a. F5 
b. F9 
c. F11 
d. SHIFT + F5 

 

36. What Function key is used to open the Statistics form from a Card 
form? 

a. F5 
b. F9 
c. F11 
d. SHIFT + F5 

 

37. In a report description, you design data items and what? 

a. Sections 
b. The Request Form 
c. Only data items 
d. Both a and b 

 

38. Which of these is not a data item property in a report? 

a. PrintOnlyIfDetail 
b. AutoUpdate 
c. ReqFilterFields 
d. CalcFields 
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39. A section in a report is most like what? 

a. A data item 
b. A control 
c. A form 
d. A codeunit 

 

40. Which of the following can you do with data items in a report? 

a. Indent them 
b. Link them 
c. Change the order of them 
d. All of the above 

 

41. What property is used to tell the report to group on fields? 

a. TotalFields 
b. GroupTotalFields 
c. GroupFields 
d. None of the above 

 

42. What property is used to tell the report to total on fields? 

a. TotalFields 
b. GroupTotalFields 
c. GroupFields 
d. None of the above 

 

43. To cause a tab for a data item not to show on the request form you 
must… 

a. Clear the TotalFields property 
b. Simply set the ShowTab property to No 
c. The tab always shows on the request form. 
d. Set the DataItemTableView property to sort the data item 

 

44. True or False. If the Options tab appears on the request form, it is 
always the last tab. 

a. True 
b. False 
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45. Which of the following is not a type of Report? 

a. Financial report 
b. Transaction report 
c. Document report 
d. Posting report 

 

46. Which of the following can you do with data items in a dataport? 

a. Indent them 
b. Link them 
c. Change the order of them 
d. All of the above 

 

47. Dataport fields describe what? 

a. The layout of the table. 
b. The layout of the report. 
c. The layout of the form. 
d. The layout of the file. 

 

48. If AutoSave is set to No, what property must you set to get the 
dataport to update existing records? 

a. AutoInsert 
b. AutoModify 
c. AutoUpdate 
d. If AutoSave is set to No, the dataport does not save any records 

automatically. 
 

49. Which of the following triggers are available in a codeunit? 

a. onRun 
b. onInsert 
c. onAfterGetRecord 
d. All of the above 

 

50. True or False. You can assign one codeunit variable the instance of 
another codeunit variable. 

a. True 
b. False 
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Part 2 - Questions/Answers 
 

1. Which of the following are not objects that you can create in 
C/SIDE? 

a. Tables 
b. Forms 
c. Reports 
d. Code Groups 

 

2. True or False. C/SIDE is an object oriented programming 
environment. 

a. True 
b. False 

 

3. A Table description is made up of Fields and what? 

a. Indexes 
b. Table Relations 
c. Dataports 
d. Keys 

 

4. Which of the following properties would not be available for a 
normal code field? 

a. CharAllowed 
b. Length 
c. Calcformula 
d. Data Type 

 

5. Which property would you use to keep a user from pasting records 
into a table? 

a. AllowCutPaste 
b. PasteIsValid 
c. UserPaste 
d. A user cannot paste records into a table from the clipboard 
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6. Which property would you set to keep a field from being edited by 
the user? 

a. Editable 
b. Enabled 
c. AllowUserEdit 
d. AllowModify 

 

7. When you run a table from the Object Designer, what is displayed? 

a. Raw data from the table. 
b. The table object. 
c. The fields and keys in a table. 
d. A form that displays the data in the table. 

 

8. The primary key in a table is used for what? 

a. Sorting 
b. Keeping each record unique. 
c. Defining the default lookup form for the table. 
d. Both a and b. 

 

9. A secondary key in a table is used for what? 

a. Sorting 
b. Possibly, keeping each record unique. 
c. Defining the default lookup form for the table. 
d. Both a and b. 

 

10. True or False. The user can only use the primary key on forms. 

a. True 
b. False 

 

11. Relating two tables in a "one to many" relationship requires… 

a. Changing both tables to point to the other. 
b. Relating a field in the "many" table to a field in the "one" table. 
c. Changing the table properties of the "many" table. 
d. Both b and c. 
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12. True or False. A conditional table relation can relate its table to more 
than one other table. 

a. True 
b. False 

 

13. What happens when you change the primary key of a record that has 
other records in other tables related to it? 

a. The values in the other tables change as well. 
b. Those other records are orphaned. 
c. The other records are deleted 
d. An error occurs. 

 

14. What is required for a Sum FlowField to calculate properly? 

a. Data in both tables being summed. 
b. A ReqFilterField. 
c. A SumIndexField. 
d. A FlowFilter. 

 

15. What is required for an Exist FlowField to calculate properly? 

a. A SumIndexField. 
b. A FlowFilter. 
c. A Boolean data type to put the value of the CalcFormula in. 
d. Nothing. 

 

16. What makes FlowFields and FlowFilters unlike all other fields? 

a. They are decimal. 
b. They always have a SumIndexField. 
c. The data type is FlowField. 
d. They are not stored in the table. 

 

17. What would you name a master table that holds Book Information? 

a. Book 
b. Books 
c. Book Info 
d. tblBook 
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18. What would you name a subsidiary table that holds Address 
information for customers? 

a. Address 
b. Addresses 
c. Customer Address 
d. Customer Addresses 

 

19. A document is represented by what kinds of tables? 

a. A Header table. 
b. A Lines table. 
c. A Header and a Lines table. 
d. Document and Document History tables. 

 

20. What is the name of the primary key field(s).of a Ledger table? 

a. Entry No. 
b. Customer No., Entry No. 
c. Line No. 
d. Customer No., Line No. 

 

21. What property of a form binds it to a table? 

a. TableNo 
b. TableID 
c. SourceTable 
d. BoundTable 

 

22. True or False. It is better to start all forms with the form wizard. 

a. True 
b. False 

 

23. What is the property that you must set on a data control? 

a. Lookup 
b. SourceExpr 
c. Drilldown 
d. DataField 
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24. Card forms… 

a. Display one record from a table. 
b. Have tabs across the top. 
c. Are used for editing records. 
d. All of the above. 

 

25. Tabular forms… 

a. Display many records from a table. 
b. Have tabs across the top. 
c. Are always non-editable. 
d. All of the above. 

 

26. A tablebox can usually be found on a 

a. Tab of a Card form. 
b. The center of a Card form. 
c. Tab of a Tabular form. 
d. The center of a Tabular form. 

 

27. True or False. Option fields can be displayed using a Textbox or 
Option buttons. 

a. True 
b. False 

 

28. What type of button would you usually add to the bottom of a card 
form? 

a. Command Button 
b. Menu Button 
c. Option Button 
d. You do not; the wizard adds all the buttons for you. 

 

29. What can you use to easily add fields to a form? 

a. Field Menu 
b. C/AL Editor 
c. Menu Designer 
d. Symbol Menu 
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30. What control allows you to display one form within another form? 

a. Tablebox 
b. Textbox 
c. Matrixbox 
d. SubForm 

 

31. What name could you use for a Tabular form that displays 
information from the Book table? 

a. Book 
b. Books 
c. Book Card 
d. Book List 
e. Both a and b 
f. Both b and d 

 

32. What is the difference between a List form and a Tabular form? 

a. A tabular form displays only one record. 
b. A List form displays only one record. 
c. A tabular form is not editable. 
d. A List form is not editable. 

 

33. What is the difference between a Worksheet form and a Tabular 
form? 

a. A tabular form displays only one record. 
b. A worksheet form displays only one record. 
c. A tabular uses AutoSplitKey. 
d. A worksheet uses AutoSplitKey. 

 

34. What Function key is used to Post records? 

a. F5 
b. F9 
c. F11 
d. SHIFT + F5 
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35. What Function key is used to open the Card form from a List form? 

a. F5 
b. F9 
c. F11 
d. SHIFT + F5 

 

36. What Function key is used to open the Statistics form from a Card 
form? 

a. F5 
b. F9 
c. F11 
d. SHIFT + F5 

 

37. In a report description, you design data items and what? 

a. Sections 
b. The Request Form 
c. Only data items 
d. Both a and b 

 

38. Which of these is not a data item property in a report? 

a. PrintOnlyIfDetail 
b. AutoUpdate 
c. ReqFilterFields 
d. CalcFields 

 

39. A section in a report is most like what? 

a. A data item 
b. A control 
c. A form 
d. A codeunit 
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40. Which of the following can you do with data items in a report? 

a. Indent them 
b. Link them 
c. Change the order of them 
d. All of the above 

 

41. What property is used to tell the report to group on fields? 

a. TotalFields 
b. GroupTotalFields 
c. GroupFields 
d. None of the above 

 

42. What property is used to tell the report to total on fields? 

a. TotalFields 
b. GroupTotalFields 
c. GroupFields 
d. None of the above 

 

43. To cause a tab for a data item not to show on the request form you 
must… 

a. Clear the TotalFields property 
b. Simply set the ShowTab property to No 
c. The tab always shows on the request form. 
d. Set the DataItemTableView property to sort the data item 

 

44. True or False. If the Options tab appears on the request form, it is 
always the last tab. 

a. True 
b. False 

 

45. Which of the following is not a type of Report? 

a. Financial report 
b. Transaction report 
c. Document report 
d. Posting report 
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46. Which of the following can you do with data items in a dataport? 

a. Indent them 
b. Link them 
c. Change the order of them 
d. All of the above 

 

47. Dataport fields describe what? 

a. The layout of the table. 
b. The layout of the report. 
c. The layout of the form. 
d. The layout of the file. 

 

48. If AutoSave is set to No, what property must you set to get the 
dataport to update existing records? 

a. AutoInsert 
b. AutoModify 
c. AutoUpdate 
d. If AutoSave is set to No, the dataport does not save any records 

automatically. 
 

49. Which of the following triggers are available in a codeunit? 

a. onRun 
b. onInsert 
c. onAfterGetRecord 
d. All of the above 

 

50. True or False. You can assign one codeunit variable the instance of 
another codeunit variable. 

a. True 
b. False 
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APPENDIX B: C/AL Q&A 
This appendix gives the student a chance to measure what they have learned 
about Microsoft® Business Solutions−Navision® C/AL. You can find the answers 
to the questions in part 2 of this appendix. 

Part 1: Object Questions 
 

1. Which of the following are not uses of programming code?  

a. Data Manipulation  
b. To implement business rules  
c. Data Acquisition  
d. Creation of keys in a database  

 

2. Which objects in C/SIDE have C/AL code?  

a. Tables  
b. Codeunits  
c. Reports  
d. All Objects have C/AL code  

 

3. What data type should be used to store an employee's birthday?  

a. Date  
b. Integer  
c. Text  
d. Code  

 

4. What data type should be used for an employee's name?  

a. Date  
b. Integer  
c. Text  
d. Code  
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5. What is the data type of this constant: 123197  

a. Date  
b. Integer  
c. Text  
d. Code  
e. This is not a legal constant  

 

6. What is the data type of this constant: 123197D  

a. Date  
b. Integer  
c. Text  
d. Code  
e. This is not a legal constant  

 

7. How would you address a variable named Customer Name in code?  

a. 'Customer Name'  
b. Customer_Name  
c. "Customer Name  
d. "Customer Name"  
e. Customer.Name  

 

8. What is the output of this message statement − 
MESSAGE('%1',TRUE); ?  

a. Error − Boolean values cannot be displayed  
b. Message Box with the text "TRUE"  
c. Message Box with the text "FALSE"  
d. Message Box with the text "Yes"  

 

9. An empty text variable has what value?  

a. ""  
b. ''  
c. Null  
d. Nil  
e. None of the above.  

 



 

 

Appendix B: C/AL Q&A 

Page 573 

10. An empty integer variable has what value?  

a. 0  
b. 1  
c. Null  
d. Nil  
e. None of the above.  

 

11. What happens when you type in the statement A :=15.00 where A is 
an Integer variable?  

a. A compiler error occurs when you try to compile the code.  
b. A runtime error occurs because you are trying to assign a 

Decimal value to an Integer variable.  
c. It puts the value 15 into A.  
d. A becomes a Decimal.  

 

12. What happens when you type in the statement A :='Word' where A is 
a Code variable?  

a. A compiler error occurs when you try to compile the code.  
b. A runtime error occurs because you are trying to assign a Text 

constant value to a Code variable. 
c. It puts the value 'WORD' into A.  
d. A becomes a Text variable.  

 

13. What happens when you type in the statement A :='Word is too long' 
where A is a Text variable of length 4?  

a. A compiler error occurs when you try to compile the code.  
b. A runtime error occurs because you are trying to assign too 

many characters to A.  
c. It puts the value 'Word' into A.  
d. A becomes a longer.  

 

14. True or False. You can assign the value −1 to an option variable.  

a. True  
b. False  
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15. Which part of the statement C := A + B is the expression?  

a. C := A + B  
b. A + B  
c. C  
d. C :=  

 

16. What does the plus operator (+. do to text variables or constants?  

a. Concatenates the values together  
b. Does nothing, the ampersand (&. is used for concatenation  
c. There is no way to concatenate strings in C/AL  

 

17. What is the resulting data type of the following expression: 57/10  

a. Integer  
b. Decimal  
c. Date  
d. Code  

 

18. What is the resulting data type of the following expression: 2000000 
* 3000  

a. Integer  
b. Decimal  
c. Date  
d. Code  

 

19. What is the resulting data type of the following expression: 123100D 
− 010100D  

a. Integer  
b. Decimal  
c. Date  
d. Code  
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20. What is the resulting data type of the following expression: 123100D 
+ 21  

a. Integer  
b. Decimal  
c. Date  
d. Code  

 

21. Which of these is a Relational Operator?  

a. =  
b. :=  
c. DIV  
d. NOT  

 

22. Which of these is a Logical Operator?  

a. =  
b. :=  
c. DIV  
d. NOT  

 

23. Which of these is an Assignment Operator?  

a. =  
b. :=  
c. DIV  
d. NOT  

 

24. What is the resulting data type of a Relational Operator?  

a. Integer  
b. Boolean  
c. Depends on the data types being related  
d. It does not return a data type  
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25. What value does TRUE XOR FALSE result in?  

a. TRUE  
b. FALSE  
c. You cannot XOR Boolean values  
d. None of the above  

 

26. Which of the following statements are correct about an IF THEN 
ELSE statement?  

a. There is always a semicolon after the key word THEN  
b. There is always a semicolon before the key word ELSE  
c. There is always a semicolon after the key word ELSE  
d. There is always a semicolon after the end of the IF THEN ELSE 

statement  
e. None of the above are correct.  

 

27. What key words are used when you need to put more than one 
statement into an IF THEN statement?  

a. You do not need special key words  
b. BEGIN END  
c. START END  
d. You need brackets {} not key words  

 

28. Which one of the following is a valid comment?  

a. /* Comment */  
b. 'Comment  
c. { Comment  
d. //Comment  

 

29. How do I access the 5th element of an array called A?  

a. A[4]  
b. A[5]  
c. A(4.  
d. A(5.  
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30. True or False. Arrays can have up to 10 Dimensions in C/AL. 

a. True  
b. False  

 

31. Which Repetitive Statement would you use if you could determine 
before you started how many times your statement(s. would have 
to be executed?  

a. The FOR statement  
b. The WHILE statement  
c. The REPEAT statement  
d. This cannot be done.  

 

32. Which Repetitive Statement does not require a BEGIN and END to 
execute more than one statement repetitively?  

a. The FOR statement  
b. The WHILE statement  
c. The REPEAT statement  
d. They all require it.  

 

33. Which Repetitive Statement(s. test the condition at the beginning of 
each loop?  

a. The FOR statement  
b. The WHILE statement  
c. The REPEAT statement  
d. Both A and B.  
e. All of them do.  

 

34. What data types can a WITH statement be used with?  

a. Integers and Decimals  
b. Record Variables  
c. All simple data types  
d. All complex data types  
e. None of the above  
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35. True or False. The CASE statement in C/AL can only be used with 
Integer and Option data types.  

a. True  
b. False  

 

36. What is a Local Variable?  

a. a variable whose scope is limited to a single object  
b. a variable whose scope is limited to a single function  
c. a variable whose scope is limited to a single codeunit  
d. None of the above.  

 

37. There are two ways to pass parameters into a function; which are 
supported in C/AL?  

a. Pass by Integer Value  
b. Pass by Reference  
c. Pass by Record Variable  
d. Pass by Value  
e. Both B and D  

 

38. Where do you define a new function in C/AL?  

a. Go to View, Define Variables  
b. Go to View, C/AL Globals  
c. Go to View, C/AL Functions  
d. None of the above.  

 

39. What does C/AL stand for?  

a. Client/Appliance Leverage  
b. Client/Analyst Language  
c. Client/Analyst Library  
d. None of the above.  
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40. Which of the following statements is NOT a proper EXIT statement?  

a. EXIT;  
b. EXIT('Now');  
c. EXIT(Round(123.255, 0.01));  
d. IF EXIT THEN X := 1;  

Part 2: Answers 
1. Which of the following are not uses of programming code?  

a. Data Manipulation  
b. To implement business rules  
c. Data Acquisition  
d. Creation of keys in a database  

 

2. Which objects in C/SIDE have C/AL code?  

a. Tables  
b. Codeunits  
c. Reports  
d. All Objects have C/AL code  

 

3. What data type should be used to store an employee's birthday?  

a. Date  
b. Integer  
c. Text  
d. Code  

 

4. What data type should be used for an employee's name?  

a. Date  
b. Integer  
c. Text  
d. Code  
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5. What is the data type of this constant: 123197  

a. Date  
b. Integer  
c. Text  
d. Code  
e. This is not a legal constant  

 

6. What is the data type of this constant: 123197D  

a. Date  
b. Integer  
c. Text  
d. Code  
e. This is not a legal constant  

 

7. How would you address a variable named Customer Name in code?  

a. 'Customer Name'  
b. Customer_Name  
c. "Customer Name  
d. "Customer Name"  
e. Customer.Name  

 

8. What is the output of this message statement − 
MESSAGE('%1',TRUE); ?  

a. Error − Boolean values cannot be displayed  
b. Message Box with the text "TRUE"  
c. Message Box with the text "FALSE"  
d. Message Box with the text "Yes"  

 

9. An empty text variable has what value?  

a. ""  
b. ''  
c. Null  
d. Nil  
e. None of the above.  
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10. An empty integer variable has what value?  

a. 0  
b. 1  
c. Null  
d. Nil  
e. None of the above.  

 

11. What happens when you type in the statement A :=15.00 where A is 
an Integer variable?  

a. A compiler error occurs when you try to compile the code.  
b. A runtime error occurs because you are trying to assign a 

Decimal value to an Integer variable.  
c. It puts the value 15 into A.  
d. A becomes a Decimal.  

 

12. What happens when you type in the statement A :='Word' where A is 
a Code variable?  

a. A compiler error occurs when you try to compile the code.  
b. A runtime error occurs because you are trying to assign a Text 

constant value to a Code variable. 
c. It puts the value 'WORD' into A.  
d. A becomes a Text variable.  

 

13. What happens when you type in the statement A :='Word is too long' 
where A is a Text variable of length 4?  

a. A compiler error occurs when you try to compile the code.  
b. A runtime error occurs because you are trying to assign too 

many characters to A.  
c. It puts the value 'Word' into A.  
d. A becomes a longer.  

 

14. True or False. You can assign the value −1 to an option variable.  

a. True  
b. False  
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15. Which part of the statement C := A + B is the expression?  

a. C := A + B  
b. A + B  
c. C  
d. C :=  

 

16. What does the plus operator (+. do to text variables or constants?  

a. Concatenates the values together  
b. Does nothing, the ampersand (&. is used for concatenation  
c. There is no way to concatenate strings in C/AL  

 

17. What is the resulting data type of the following expression: 57/10  

a. Integer  
b. Decimal  
c. Date  
d. Code  

 

18. What is the resulting data type of the following expression: 2000000 
* 3000  

a. Integer  
b. Decimal  
c. Date  
d. Code  

 

19. What is the resulting data type of the following expression: 123100D 
− 010100D  

a. Integer  
b. Decimal  
c. Date  
d. Code  
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20. What is the resulting data type of the following expression: 123100D 
+ 21  

a. Integer  
b. Decimal  
c. Date  
d. Code  

 

21. Which of these is a Relational Operator?  

a. =  
b. :=  
c. DIV  
d. NOT  

 

22. Which of these is a Logical Operator?  

a. =  
b. :=  
c. DIV  
d. NOT  

 

23. Which of these is an Assignment Operator?  

a. =  
b. :=  
c. DIV  
d. NOT  

 

24. What is the resulting data type of a Relational Operator?  

a. Integer  
b. Boolean  
c. Depends on the data types being related  
d. It does not return a data type  
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25. What value does TRUE XOR FALSE result in?  

a. TRUE  
b. FALSE  
c. You cannot XOR Boolean values  
d. None of the above  

 

26. Which of the following statements are correct about an IF THEN 
ELSE statement?  

a. There is always a semicolon after the key word THEN  
b. There is always a semicolon before the key word ELSE  
c. There is always a semicolon after the key word ELSE  
d. There is always a semicolon after the end of the IF THEN ELSE 

statement  
e. None of the above are correct.  

 

27. What key words are used when you need to put more than one 
statement into an IF THEN statement?  

a. You do not need special key words  
b. BEGIN END  
c. START END  
d. You need brackets {} not key words  

 

28. Which one of the following is a valid comment?  

a. /* Comment */  
b. 'Comment  
c. { Comment  
d. //Comment  

 

29. How do I access the 5th element of an array called A?  

a. A[4]  
b. A[5]  
c. A(4.  
d. A(5.  
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30. True or False. Arrays can have up to 10 Dimensions in C/AL.  

a. True  
b. False  

 

31. Which Repetitive Statement would you use if you could determine 
before you started how many times your statement(s. would have 
to be executed?  

a. The FOR statement  
b. The WHILE statement  
c. The REPEAT statement  
d. This cannot be done.  

 

32. Which Repetitive Statement does not require a BEGIN and END to 
execute more than one statement repetitively?  

a. The FOR statement  
b. The WHILE statement  
c. The REPEAT statement  
d. They all require it.  

 

33. Which Repetitive Statement(s. test the condition at the beginning of 
each loop?  

a. The FOR statement  
b. The WHILE statement  
c. The REPEAT statement  
d. Both A and B.  
e. All of them do.  

 

34. What data types can a WITH statement be used with?  

a. Integers and Decimals  
b. Record Variables  
c. All simple data types  
d. All complex data types  
e. None of the above  

 



 

 

Microsoft Navision Development I − C/SIDE Introduction 

Page 586 

35. True or False. The CASE statement in C/AL can only be used with 
Integer and Option data types.  

a. True  
b. False  

 

36. What is a Local Variable?  

a. a variable whose scope is limited to a single object  
b. a variable whose scope is limited to a single function  
c. a variable whose scope is limited to a single codeunit  
d. None of the above.  

 

37. There are two ways to pass parameters into a function; which are 
supported in C/AL?  

a. Pass by Integer Value  
b. Pass by Reference  
c. Pass by Record Variable  
d. Pass by Value  
e. Both B and D  

 

38. Where do you define a new function in C/AL?  

a. Go to View, Define Variables  
b. Go to View, C/AL Globals  
c. Go to View, C/AL Functions  
d. None of the above.  

 

39. What does C/AL stand for?  

a. Client/Appliance Leverage  
b. Client/Analyst Language  
c. Client/Analyst Library  
d. None of the above.  

 

40. Which of the following statements is NOT a proper EXIT statement?  

a. EXIT;  
b. EXIT('Now');  
c. EXIT(Round(123.255, 0.01));  
d. IF EXIT THEN X := 1;  
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APPENDIX C: SOLUTIONS TO EXERCISES 

Test Your Skills − Investigating Existing Tables (CH1) 
 

1. What is the option string for the Reserve field in the Customer table?  

 Never,Optional,Always 

2. What is the difference between the calculation formulas of the 
Balance field and the Balance At Date field in the G/L Account 
table? 

 The Balance At Date field has one more filter line in the Table Filter 
that includes the Date Filter. 

3. What type of field is the Date Filter field in the G/L Account table? 

 Date, FlowFilter 

4. What is the value of the TableRelation property of the Global 
Dimension 1 Code field in the Customer table? 

 Department 

Test Your Skills − Adding Data (CH1) 
 

1. What problem did you encounter? 

 You cannot enter the second record. You get the error: The record 
already exists. 

2. Why can you not enter the second record above? 

 The Primary key is only the Model field. The first field in the table. 
And that means that the Model field must be unique for every 
record. 
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Test Your Skills − Using Secondary Keys (CH1) 
 

1. Look at the records that have a Date of Mfg. of 01/15/00. What order 
are these records in since they have the same date? 

 They are in order by Transmission, the second field in the secondary 
key. 

2. Look at the records that have the same Date of Mfg. and the same 
Transmission. What order are these records in? 

 They are in Primary Key order. 

3. What does this tell you about secondary keys? 

 If any Primary Key field is not used in the secondary key, it is 
added to the end of the secondary key. 

Test Your Skills − Simple Table with Table Relation (CH1) 
 

1. Type 'a' into the Salesperson Code field. What happens when press 
Enter? 

 The client finds the first value in the table that has an A as the first 
letter and chooses that record for you. 

2. Type 'XY' into the Salesperson Code field. What happens when 
press Enter? 

 You receive an error because XY does not exist in the 
Salesperson/Purchaser table. 

Test Your Skills − Renaming Records (CH1) 
 

1. How long did it take to change that value? Was it longer than you 
expected? 

 It took several seconds. 

 Yes. 

2. Check the data in table 123456751 (Sales Transaction) by running it. 
Did any of the records here change? Why? 

 Yes. All the records that had my initials in them changed to XXX. 

 Because the renaming of a record also changes any values that are 
related to it in other tables. 
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Test Your Skills − Filtered Table Relations (CH1) 
 

1. When you use the lookup button on the Salesperson Code field do 
you see all the records in the Salesperson/Purchaser table? If not, 
why? 

 No. The table filter on the table relation filtered out any records with 
a Commission % <= 0. 

2. Can you type in the value AH into the Salesperson Code field? If 
not, why? 

 No. The filtered table relation no longer allows AH as a valid value, 
because it does not exist in the filtered record set. 

Test Your Skills − Conditional Table Relations (CH1) 
 

1. When you use the lookup button on the No. field what form is 
displayed? What if you change the Type field? 

 The table relation now depends on the Type field. Using the lookup 
button when Type=Item displays the Item List form and so on. 

2. Try changing Type to Item and looking up an item number. Now, 
change Type to Resource. What happens? Is the value for No. valid? 

 Nothing Happens! 

 No. The value in No. is an Item No. not a Resource No. It is invalid. 

3. Now try retyping the value in the No. field after changing the Type 
as described in the previous question. What error do you get? 

 The Resource No. '70000' does not exist. 

 

Test Your Skills − Calculating the Sums Manually (CH1) 
 
Which Total Total Amount 
For JR 1050.00 
For MF 800.00 
For PS 185.00 
For ALL 2035.00 
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Test Your Skills − Testing Your Flowfield (CH1) 
 

1. What happened when you tried to run the table? 

 I received an error. 

2. What caused the error message? 

 A missing Key and SumIndexField. 

3. What do we need to change to correct the problem (hint: read the 
error message very carefully)? 

 I need to add a key to the Sales Transaction table that has the correct 
fields and a SumIndexField of Amount. 

Test Your Skills − Creating a SumIndexfield (CH1) 
 

1. Were there any errors this time? Why or Why not? 

 No. 

 It found the key and SumIndexField that it needed to calculate the 
FlowFields. 

 
Which Total Sales 
For JR 2035.00 
For MF 2035.00 
For PS 2035.00 

 
2. Do the totals seem correct? What is suspected about them? 

 No.  

 They are all exactly the same. 

3. Do they match any of the values from your manual sums? Which 
ones do they match? 

 Yes. 

 They match the total amount for the entire table. 

4. What seems to be wrong with your FlowField? 

 It is not summing the records for each Salesperson. It is summing all 
of the Salespeople together. 
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Test Your Skills − Filtering the FlowField (CH1) 
 

1. What happened when you tried to run the table? 

 I received an error. 

2. What caused the error message? 

 A missing Key and SumIndexField. 

3. What do we need to change to correct the problem (hint: read the 
error message very carefully)? 

 I need to add a key to the Sales Transaction table that has the correct 
fields and a SumIndexField of Amount. 

Test Your Skills − A Process for Creating a SumIndexField 
(CH1) 

 
1. Table Name: ___Sales Transaction________ 

 Field Name: ___Amount___________________ 

 Field Name 1: _Salesperson Code_________ 

2. Where there any errors this time? Why or Why not? 

 No.  

 The SumIndexField and FlowField matched. 

Test Your Skills − Using a FlowFilter (CH1) 
 

1. What happened? 

 An error occurred. 

2. Why did we only get the message after we set the FlowFilter? 

 Until a FlowFilter is used, a special key is not required. 

3. What is the error message that you received? 

 FlowField cannot be calculated. You must set up and activate a key. 

4. Have you seen an error message like this before? 

 Yes. Before the SumIndexField was set up. 
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5. What is the next step that you should take to correct the problem? 

 Add the Type field to the key for my SumIndexField. 

Test Your Skills − The NotBlank Property (CH1) 
 

1. What is the "name" of the record (remember that a name is the 
values of the primary key fields)? 

 Model = '', Serial No. = 0 

2. What happens if you repeat steps 2-5 above? 

 An error occurs saying that the record already exists. 

3. How could we eliminate blank records being put into the table by 
accident? 

 Force the user to enter at least the primary key fields. 

4. What happens this time? 

 I am forced to enter the Model. I cannot leave it blank. 

5. What must you do to insert a new record now? 

 I must at least fill in a value for the Model field. 

Test Your Skills − The Editable Property (CH1) 
 

1. What happened? 

 The value changed to 500.There was no error. 

2. Did the change last (if you close the table and run it again, is the 
value still 500 for PS)? 

 Yes. 

3. What is the new sum? What was the old sum (section 5.4.1)? What is 
the difference? 

 New: 500 

 Old: 185 

 Diff: 315 

4. Can you identify the line that may have changed the sum? 

 Yes. There is a new line with an Amount of 315 for PS. 
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5. Did you enter this line? How did it get entered? 

 No. 

 When the FlowField was changed, this record must have been 
inserted. 

Test Your Skills − The DecimalPlaces Property (CH1) 
 

1. Were you able to enter the amount correctly? 

 No. An error occurred. 

2. What error did you get? 

 The field can have a maximum of 2 decimal places. 

3. What happened? 

 I was able to put in the value with all three decimal places. 

4. What is displayed in the field if you enter the Amount 234.1 and 
press Enter? 

 234.10 

5. What is displayed in the field if you enter the Amount 234 and press 
Enter? 

 234.00 

6. What is displayed in the field if you enter the Amount 234.110 and 
press Enter? 

 234.11 

Test Your Knowledge Answers (CH1) 
 

1. What two major items can you define within a table description? 

 Fields and Keys. 

2. What table property defines the default lookup form for the table? 

 LookupFormID. 

3. What field property is used to force the user to enter a value into a 
primary key field? 

 NotBlank set to Yes. 

4. What number range can you use for new fields that you add to the 
customer table? 

 50000 to 99999 
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5. If you want to view customers in order by the city that they live in, 
what would you have to change in the table description? 

 Add a secondary key that contains the City field as the first field. 

6. How could you change the Salesperson Code field in the Customer 
table so that the user would only be able to look up Salespeople that 
have a Commission % larger than zero? 

 Add a table filter to the table relation property that filters the 
Salespeople where Commission % > 0. 

7. What type of table is the Customer table? 

 Master table for Sales and Receivables functional area. 

8. What type of table is the Item Vendor table? 

 Subsidiary to the Vendor and the Item tables. 

9. What type of table is the Department table? 

 Supplemental to all functional areas. 

10. What type of table is the Item Ledger Entry table? 

 Ledger for the Inventory functional area. 

Test Your Skills − Attaching a Source Table (CH2) 
 

1. What is the value in the title bar of the form (this is usually the blue 
area at the top of a form that has the Min, Max, and Close buttons on 
it)? 

 10000 The Cannon Group PLC – Blank Form 

2. What happens when you click the Next button on the toolbar? 

 It changes the title bar of the form to the next customer in the 
customer table. 

3. Is the form reading information from the source table? 

 Yes. At least enough to change the title bar. 

Test Your Skills − Answers Adding Simple Controls (CH2) 
 

1. You now have a Text Box on your form. What information does it 
display? 

 None. 
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2. Try running the form by clicking File, Run. What happens? 

 An error occurs: Data controls must have an expression. 

Test Your Skills − Using Add Label and Lock (CH2) 
 

1. What else was put on the form? 

 A label attached to the Textbox. 

2. What happens when you move the Text Box? 

 The label moves with it. 

3. What happens when you move the Label? 

 Only the label moves. 

4. How can you move just the Text Box (hint: look for the hand 
cursor)? 

 Select the Textbox and move the mouse over the edge of the 
selection until the hand cursor appears. With the hand cursor 
showing, you can click and drag just the Textbox. 

5. What happens if you click on the Check box button and then click 
on the form? 

 A Check box is added to the form along with a label. 

Using Lock 
 

1. How many Text Box controls did you add? 

 Four Text Boxes. 

2. Can you move any of the controls with the Lock button selected? 

 No. It simply creates a new Text box control. 

Test Your Skills − Adding Container Controls (CH2) 

Using a Tab Control 
 

1. What happened to the Tab control? 

 Three new tabs were added Test, Frame and Table Box. 

Adding Controls to a Tab 
 

1. What happens if you click on the General tab and back to the Test 
tab? 
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 The control disappears when the General tab is selected and 
reappears when the Test tab is selected. 

2. Edit the PageNames property of the Tab control so that it looks like 
General,Frame,Table Box. Where is the label control now? 

 On the Frame tab (the second tab in the Tab control). 

3. Move the label control to the bottom of the form (off of the Tab 
control). What happens when you change to the General tab and 
back now? 

 The label is always visible. 

4. Click on the General tab and move the label from the bottom of the 
form to the middle of the General Tab. What happens when you 
change to the Frame tab and back? 

 The control disappears when the Frame tab is selected and reappears 
when the General tab is selected. It is again on a page in the tab 
control. 

Adding a Frame Control 
 

1. What happens if you move the frame? 

 All of the controls in the frame move with it. 

2. What happens if you delete the frame? 

 All of the controls in the frame are also deleted. 

Adding a TableBox Control 
 

1. Run the form. What is displayed in the TableBox? 

 Several rows of records from the item table. There is a triangle in the 
gray box next to the current row. 

2. What happens to the title bar of the form if you click on another row 
in the TableBox? 

 It changes to the row selected in the table box. 

3. What happens if you maximize the form or simply make it bigger? 

 The controls all stay the same size and in the same location. 

Autosizing Controls 
 

1. Run the form. What happens now when you resize the form by 
making it bigger? 

 The tab control and the table box grow with the form. 
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Test Your Skills − Displaying Options (CH2) 
 

1. What type of button is in the Text Box? 

 A DropDown button. 

2. What happens when you click the button? 

 A short list of choices is presented below the text box. 

Using Option Buttons 
 

1. How many of the Option buttons are selected? 

 One. 

2. What happens if you try to select another one? 

 The first option button is unselected. 

3. What happens if you change the Text Box that is bound to the 
Costing Method field to Standard? 

 The third button labeled Standard is selected. 

4. What happens if you change the Text Box that is bound to the 
Costing Method field to Average? 

 None of the buttons are selected because there is no button for 
Average. 

Test Your Skills − Displaying Progress Indicators (CH2) 
 

1. Use the next button to look at many different records. What range of 
values did you notice? 

 Everything from 15% to 70%. 

2. What happens if you change the MaxValue property to 1000 and run 
the form again? 

 The values in the indicator are almost invisible. The percentage 
changes to less than 1. 

Test Your Skills − Tabular Form (CH2) 

The Tabular-Type Wizard 
 

1. What happens? 

 The Find dialog appears and begins searching for what I type. 
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2. Why is this desirable to a user? 

 The user does not have to remember how to open the Find dialog. 
They can simply click on a column and begin typing. It is faster. 

Test Your Skills − Using the Field Menu (CH2) 
Adding Fields to a Card Form 
 

1. Does the field work properly? 

 Yes. 

2. What else got placed on the form with the Text Box? 

 A label that is attached to the text box. 

Adding Fields to a Tabular Form 
 

1. Does the field work properly? 

 Yes. 

2. What was the column heading? 

 Balance. The field name. 

3. Do you think that most users need to see the Balance field on this 
form? 

 No. Only certain users use this field on this form. 

Test Your Skills − Making Columns Invisible (CH2) 
 

1. Can you see the column? 

 No. 

2. Click View, Show Column. Is the Balance field listed? Is the Net 
Change field listed?  

3. Yes. The Balance field is listed. 

 No. The Net Change field is not listed. 

4. Why is the Balance field listed while the Net Change field is not? 

 The Net Change field has not been added to the form. Only fields 
that have been added to actual form appear here. 

5 Check the box next to the Balance field and Click OK. Is the 
Balance field shown now? 

 Yes. 

Page 598 



 

 

Appendix C: Solutions to Exercises 

6. What happens if you close the form and run it again? 

 The Balance field is still on the form so the user can see it. 

Test Your Skills − Creating Command Buttons (CH2) 
 

1. What caption does the button have? 

 OK. 

2. What happens when you click the button? 

 The form closes. 

3. Run the form again. Resize the form slowly. What happens to your 
new button? 

 It stays where it is and does not stay next to the Help button. 

4. What happened to the Help button? 

 It moves. It stays in the bottom right corner of the form.  

5. What caused them to act differently? 

 The glue properties. 

6. Test the form again by resizing it. What happens to your new button? 

 It stays beside the Help button in the bottom right corner of the form. 

Test Your Skills − RunObject PushAction (CH2) 
 

1. Where is the button? Where are the OK and Cancel buttons? 

 It is exactly where it was put, but the OK and Cancel buttons are 
gone. 

 They are not visible. 

2. What happens when you click the button? 

 Nothing. 

3. What did you forget to set? 

 The PushAction property. 

4. Run the form again. What happens this time when you click the 
Card button? 

 The card form that I created is opened. 
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5. Close the card form. Select customer 50000 on the list form. Click 
the Card button. Which customer is displayed on the card form? 

 The first customer 10000. 

Test Your Skills − Linking Forms (CH2) 
 

1. What happens when you click the Card button with customer 50000 
selected? 

 It displays customer 50000 on the card form. 

2. What happens if you close the card form, select another customer 
and click the Card button, again? 

 It displays that customer (the one selected on the list form). 

3. Notice that while the card form is open, you can click back on the list 
form and choose another record. What happens to the card form 
when you change the list form in this way? 

 Nothing. It still displays the record of the other customer. 

4. Design the form and change the RunFormLinkType property of the 
Card button to OnUpdate. Save your changes and run the form. 
Now, what happens when you change the list form while the card 
form is still open? 

 It changes to the new customer as well. It stays linked every time the 
list form is updated. 

Test Your Skills − Linking Forms (CH2) 
 

1. What happens when you click the Card button with customer 50000 
selected? 

 It displays customer 50000 on the card form. 

2. What happens if you close the card form, select another customer 
and click the Card button, again? 

 It displays that customer (the one selected on the list form). 

3. Notice that while the card form is open, you can click back on the list 
form and choose another record. What happens to the card form 
when you change the list form in this way? 

 Nothing. It still displays the record of the other customer. 
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4. Design the form and change the RunFormLinkType property of the 
Card button to OnUpdate. Save your changes and run the form. 
Now, what happens when you change the list form while the card 
form is still open? 

 It changes to the new customer as well. It stays linked every time the 
list form is updated. 

Test Your Skills − LookupTable PushAction (CH2) 
 

1. What form comes up when you press the F5 function key? 

 Form 22, the normal Customer List. 

2. Why does that form come up and not your customer list form? 

 The default lookup form for the customer table is the Customer List 
form. My Customer List is not set up as the default lookup form. It is 
the LookupformID property of the customer table that tells the 
system which form to bring up. 

3. Design table 18 and change the LookupFormID property of the table 
to 123456753. Run your card form again. Now, what form comes up 
when you press the F5 function key? 

 Form 123456753, My Customer List. 

Test Your Skills − Creating the Main Form (CH2) 
 

1. Open the properties window for the Subform control and write down 
the Height and Width properties. 

 Height ______5500__________ 

 Width _______9350__________ 

2. What appears where the subform control is? 

 Nothing. 

Test Your Skills − Creating the SubForm (CH2) 
 

1. What property of the form could you use to automatically fill in the 
Line No. field for you? 

 AutoSplitKey 
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2. What purpose does the Table Name field serve? 

 This table can hold comments from many master tables. The Table 
Name changes the table relation of the No. field to the appropriate 
master table. 

Test Your Skills − Adding the SubForm (CH2) 
 

1. Now, what appears in the spot where the subform control is? 

 Form 123456755 

2. Does the Customer Comment Subform fit into the subform control 
perfectly (is it lined up with the tab control)? 

 It is not perfect. The width is not correct. The scroll bars on the right 
and bottom do not appear in the normal place. 

3. Why is there a box around the subform? 

 It is the border of the subform control. 

4. What happens when you resize the form by making it wider? 

 The subform control does not expand. 

5. What happens when you resize the form by making it taller? 

 The Tab control expands and goes under the subform control. The 
subform control still does not expand. 

6. What records show up in the subform when you change to a new 
customer on the main form? 

 All of the records for every customer. 

7. Are there any other problems with your forms? 

 No. 

8. Can you insert a new customer? 

 Yes. 

9. Can you add comments to that new customer? 

 Yes. 

10. What happens when you change to another customer? 

 The subform changes so that I only see the comments for the new 
customer. 
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Test Your Knowledge Answers (CH2) 
 

1. All forms are bound. 

 False. Some forms are not related to any table (unbound).  

2. The form wizard is not useful. 

 False. Most forms can be created with the wizard. The only 
additional items that must be added are usually buttons. 

3. Which property must you set on Command button for the 
RunObject property to work? 

 You must set PushAction to RunObject. 

4. Which control allows a form to display more than one record at a 
time? 

 Tablebox 

5. Which control allows a form to display another form? 

 Subform 

6. Which property of a Text box binds it to a field in a table? 

 SourceExpr 

7. What form property binds a form to a table? 

 SourceTable 

8. How do you turn a menu item into a submenu on a menu button? 

 Indent other menu items under it using the Right button on the Menu 
Designer window. 

9. How do you attach a label to another control so that the label follows 
the other control, if you move it? 

 Click the Add Label button on the Toolbox window before you add 
the other control. 

10. What are the steps to create a List form for a table? 

 Create a tabular form for the table using the wizard. 

 Change the Editable property of the form to False. 

 Add appropriate buttons to go to the Card, Ledger Entries, and 
Statistics. 
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Test Your Skills Answers (CH3) 
Terminology 
 

1. What is the programming language of C/SIDE called?  

 C/AL (Client Application Language) 

2. List three or more uses of programming code.  

 Data Manipulation 
Data Presentation 
Data Acquisition 
To control the execution of C/AL objects 
To implement business rules, etc. 

3. Where can programming language statements be found?  

 In Application Objects (e.g. Forms, Tables, Reports, Codeunits and 
Dataports). Also, in the triggers within those Application Objects. 

4. What do you use to modify code in an object?  

 The C/AL Editor 

5. List the three basic types of triggers. 

 Documentation Triggers, Event Triggers, Function Triggers. 

6. What is the key you press to modify code in an object (other than a 
codeunit object)?  

 F9 

Practical 
Form Objects – Note that the Form itself has triggers, and also that the individual 
controls in the Form also have triggers. 
 
Report Objects – Each DataItem has different triggers. The Report triggers are 
found when you select the blank line following the last DataItem in the Report 
Designer. 
 

Test Your Skills Answers (CH4) 
 

1. What data type should be used to store an employee's birthday?  

 Date 

2. What data type should be used for an employee's name?  

 Text 
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3. What data type should be used for an employee's weekly salary (you 
need to record it to the penny)?  

 Decimal 

4. What data type should be used to record whether or not an employee 
is income tax exempt?  

 Boolean 

5. Write down the data type of this constant: 'You must enter a positive 
value.'  

 Text 

6. Write down the data type of this constant: 123197  

 Integer 

7. Write down the data type of this constant: 327.01  

 Decimal 

8. Write down the data type of this constant: 3,498  

 This is an invalid constant, due to the comma appearing outside of 
quotes. 

9. Which complex data type is used to store bitmaps (pictures)?  

 BLOB 

10. Which complex data type corresponds to a row in a table? 

 Record 

11. What two data types would you use to read from and write to objects 
of the Automation and OCX data types? 

 Instream and OutStream 

12. Which complex data type can hold up to two gigabytes of text data? 

 BigText 

Test Your Skills Answers(CH5) 
1. Modify the code line in the Workbook Exercises codeunit to display 

the name of your second variable (YesOrNo) and its value. Run the 
codeunit and write down the resulting message here.  

 The value of YesOrNo is No 

 Note that when converted to text TRUE becomes 'Yes' and FALSE 
becomes 'No'. 

2. Do the same for Amount.  

 The value of Amount is 0 
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3. Do the same for When Was It. Do not forget to enclose the variable 
name in quotes when you use it in the third parameter.  

 The value of When Was It is  

 Note that since the date is undefined, when it is converted to a text, 
the text is empty. The code line should read: 

 
MESSAGE('The value of %1 is %2','When Was It',"When Was 
It"); 

 
4. Do the same for What Time.  

 The value of What Time is 

5. Do the same for Description.  

 The value of Description is 

6. Do the same for Code Number.  

 The value of Code Number is  

7. Do the same for Ch.  

 The value of Ch is  

 Note that when a Ch is converted to text, its zero value is converted 
to an empty text. 

8. Do the same for Color. 

 The value of Color is Red 

 Note that the first word written in the OptionString property 
corresponds to the zero value for the option. 

Test Your Skills Answers (CH6) 
 

1. What would be displayed if you displayed Amount after setting its 
value to 15.00?  

 15 

2. What if you then assigned Amount to LoopNo and then displayed 
LoopNo?  

 15 

3. What would be displayed if you set Color to the value of 4 and then 
displayed Color?  

 Blue 
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4. What if you set Color to 8 and then displayed it?  

 8 

5. What if you set Description to 'the time.', then assigned Description 
to Code Number and then displayed Code Number. What would be 
displayed?  

 THE TIME. 

6. What if you set Description to 'Now is the time.', then assigned it to 
Code Number and then displayed Code Number. What would be 
displayed?  

 A run-time error (text overflow). 

7. What would be displayed if you set Color to Green, assigned Color 
to LoopNo and then displayed LoopNo?  

 3 

Test Your Skills Answers (CH7) 
 

1. Underline the expression in this assignment statement:  

 TextA := TextB; 

2. In mathematics, the things that operators operate on are called 
"operands". What are these things called in programming 
expressions?  

 Terms 

3. What does the plus operator (+) do to text variables or constants?  

 It concatenates them.  

4. Underline the expression in this assignment statement:  

 TextA := 'The ' + TextB;  

5. Underline the operator(s) in the expression:  

 TextA := 'The ' + TextB;  

6. Underline the term(s) in the expression:  

 TextA := 'The ' + TextB; 
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Test Your Skills Answers (CH8) 
 

1. 57 * 10   Integer  570 

2. 57 / 10   Decimal 5.7 

3. 57 DIV 10   Integer  5 

4. 57 MOD 10   Integer  7 

5. 2000000 * 3000  Decimal 6000000000 

6. 9 / 4 - 9 DIV 4  Decimal 0.25 

7. (3 - 10) * -5 - 10 + 2.5 * 4 Decimal 35 

8. 02201996D + 14  Date  03051996D 

9. 02101996D - 14  Date  01271996D 

10. 01201996D - 02101996D Integer  -21 

Test Your Skills (CH9) 
 

1. FALSE:    5 * 7 > 35 

2. TRUE: 5 * -7 > -36 

3. TRUE: (3 > 5 - 1) OR (7 < 5 * 2) 

4. TRUE: (27 MOD 5 = 2) AND (27 DIV 5 = 5) 

5. TRUE: (5 > 3) XOR (7 = 7) AND (9 >= 10) 

6. FALSE: (10 > 2) AND ('10' > '2') 

7. TRUE:    NOT (11 + 7 < 15) OR ('Great' > 'Greater') AND ('Less' 
< 'Lesser') 

8. TRUE: TRUE OR FALSE = TRUE 

9. TRUE: NOT (X AND TRUE OR FALSE) = (NOT X OR 
FALSE) AND TRUE 

Explanation: Given that X is Boolean, let's look at each possibility:   

Suppose that X is TRUE:   

NOT (TRUE AND TRUE OR FALSE) = (NOT TRUE OR FALSE) 
AND TRUE 

NOT (TRUE OR FALSE) = (FALSE OR FALSE) AND TRUE 

NOT TRUE = FALSE AND TRUE 
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FALSE = FALSE Yes, this is TRUE  

Suppose that X is FALSE:   

NOT (FALSE AND TRUE OR FALSE) = (NOT FALSE OR FALSE) 
AND TRUE 

NOT (FALSE OR FALSE) = (TRUE OR FALSE) AND TRUE 

NOT FALSE = TRUE AND TRUE 

TRUE = TRUE Yes, this is also TRUE  

Test Your Skills Answers (CH10) 
 

1. Add the ability to accumulate the total quantity sold, the total 
quantity credited and the grand total quantity. 

 Add the appropriate variables into the Global Variables (make sure 
they are all Integer variables, like Quantity).  

 
Add Global Variables 

 TotalQtySold  Integer 

 TotalQtyCredited  Integer 

 GrandTotalQty  Integer 

 
 Add controls to the form to display the values of these variables.  

 Add the following code at the end of the existing OnPush code for 
the Clear button: 
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TotalQtySold := 0; 

TotalQtyCredited := 0; 

GrandTotalQty := 0; 

 
 Using the names of the variables that you created, add the following 

code at the end of the existing OnPush code for the Execute button: 

 
IF Quantity < 0 THEN 

 TotalQtyCredited := TotalQtyCredited + Quantity 

ELSE 

 TotalQtySold := TotalQtySold + Quantity; 

GrandTotalQty := GrandTotalQty + Quantity; 

 
2. Add two counters that can be incremented by 1 every time you press 

the Execute button and are set to zero whenever you press the Clear 
button. One counter should be used to count the number of sales 
(Quantity > 0) and the other should count the number of credits 
(Quantity < 0). Also, when the Execute button is pressed, use these 
counters to calculate the average quantity sold and the average 
quantity credited. 

 Create two additional global integer variables (AvgQtySold, 
AvgQtyCredited).  

 
Add Global Variables: 

 AvgQtySold   Integer 

 AvgQtyCredited  Integer 

 
 Add controls to the form to display the values of these variables. Add 

the following code to the end of the OnPush code for the Clear 
button: 

 
SalesCounter := 0; 

CreditCounter := 0; 

AvgQtySold := 0; 

AvgQtyCredited := 0; 
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 Add the following code to the end of the Execute button's OnPush 
code: 

 
IF Quantity < 0 THEN 

 CreditCounter := CreditCounter + 1 

ELSE 

 SalesCounter := SalesCounter + 1; 

IF SalesCounter <> 0 THEN 

 AvgQtySold := TotalQtySold DIV SalesCounter; 

IF CreditCounter <> 0 THEN 

 AvgQtyCredited := TotalQtyCredited DIV CreditCounter; 

 
 Note that the DIV operator is used here. If division (/) was used and 

the result contained a decimal, the result could not be assigned to an 
integer variable. 

 The final product should look something like this: 
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Test Your Skills Answers (CH11) 
 

1. Here is the same set of statements, indented correctly, with lines 
drawn from each ELSE to its corresponding IF, so that you can see 
the relationship. 

 
IF (X1 > X2) OR B3 THEN BEGIN  

 IF X7 < X2 THEN  

  A1 := (X1 + X7) / 2  

 ELSE  

  IF X6 < X2 THEN  

   A1 := (X1 + X6) / 2; 

 X7 := X6 + 1;  

END ELSE  

 IF (X1 < X2) AND B5 THEN  

  IF X6 > X7 THEN BEGIN 

   IF B2 THEN  

   A2 := X1 / 2 + X7 / 2  

   ELSE  

   A2 := X1 * 2 + X7 * 2;  

  END ELSE  

   A1 := X1  

 ELSE  

  A2 := X2; 

IF B1 THEN  

 EXIT; 

 
2. Below are the same statements that have had the commented sections 

removed and are indented correctly. 

 
A5 := 7;  

B1 := FALSE;  

B2 := TRUE;  

A1 := 11;  

A2 := 2 * A5; 

IF (A1 < A5) OR B1 THEN  

 A5 := 3 * A5  

ELSE 

 A5 := A1 + A5; 

 

 

 

A5 = 18 
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Test Your Skills Answers (CH12) 
 

1. We have a list of students, numbered from 1 to 99. Each student 
takes a test. We want to put the numeric score (from 0 to 100) for 
each student into an array, with student 1's score going in element 1, 
student 2's score in element 2, etc.  

 This works. 

2. We have a list of students, numbered from 1 to 99. Each student 
takes a test. We want to create a two dimensional array with two 
rows of 99 columns. In the first row, we would put the corresponding 
student's name, with student 1's name in element 1,1, student 2's 
name in element 1,2, etc. In the second row, we would put the 
corresponding student's numeric test score (from 0 to 100), with 
student 1's score going in element 2,1, student 2's score going in 
element 2,2, etc.  

 This does not work. Every element in an array must have the same 
data type. In this case, the student names are text and their scores are 
integers. For this to work, you must use two separate arrays. 

3. We create an array containing the number of households in each ZIP 
code. There is one array element for each five-digit ZIP code and 
each element contains the number of households in that ZIP code. 
The number of households that have a ZIP code of 30071 goes into 
element 30071, etc.  

 This works. The maximum integer is over two billion, while the 
maximum ZIP code is less than one hundred thousand. Also, the 
maximum number of elements in a single array is one million. We 
are well within the limits. 

4. We create an array containing the number of households in each 
state. There is one array element for each two-character United 
States postal state code and each element contains the number of 
households in that state. The number of households in Georgia goes 
into element 'GA', etc.  

 This does not work. Although array elements can be of any type, 
array index values must be integer. In this case, the array index is 
text or code. 
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Test Your Skills: Repetitive Statements (CH13) 
 

1. Which Repetitive Statement would you use if you could determine, 
before you started, how many times your statement(s) would have to 
be executed?  

 The FOR statement 

2. Which Repetitive Statement does not require a BEGIN and END to 
execute more than one statement repetitively?  

 The REPEAT statement 

3. Which Repetitive Statement(s) test the condition at the beginning of 
each loop?  

 The FOR statement and the WHILE statement 

4. Rewrite the following WHILE statement as a REPEAT statement. 
Describe the difference(s) in how it is executed. 

 
WHILE X > 0 DO BEGIN 

Y := A * X * X + B * X + C; 

X := X - 1; 

END; 

 

REPEAT 

 Y := A * X * X + B * X + C; 

 X := X - 1; 

UNTIL X <= 0; 

 
The difference is that if X starts out less than or equal to zero, no statements in 
the loop is executed in the case of the WHILE statement, while in the case of the 
REPEAT statement, the two statements in the loop are executed once.  
 
In the case that X starts out greater than zero, there is no difference in the way 
these are executed. 
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Test Your Skills Answers (CH 15) 
 

1. What is the value of Comma after the statement labeled Q1 is 
executed the first time?  

 19 

2. Is the value of Comma ever less than 0 in this code (see statement 
labeled Q2)?  

 No 

3. What is the value of UserInput after the statement labeled Q3 is 
executed the first time?  

 The colors are red orange, yellow, green, blue and violet. 

4. What is the value of Count when the comment line is reached the 
first time?  

 4 

5. Suppose that UserInput was redefined so that it was a Text of length 
60. Now, what is its value when the MESSAGE function after the 
comment line is reached?  

 The colors are red and orange and yellow and green and blue 

6. Although better, this was not the desired result. Why didn't it work?  

 Because a REPEAT loop is always executed at least once and the 
test was done after the variable had already been changed. 

7. Go ahead and run the above code in your test codeunit. Do not forget 
that you have to define some new variables. Now, make as simple 
change as you can to address the problem you uncovered in question 
7. Write your change here:  
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 Here is one possible answer: 

 
UserInput := 'The colors are red, orange, yellow,  

      green, blue and violet.'; 

Count := 0; 

 

WHILE (STRPOS(UserInput,',') <> 0) AND  

   (STRLEN(UserInput) + 3 <= MAXSTRLEN(UserInput))  

  DO BEGIN 

 Comma := STRPOS(UserInput,','); 

 Count := Count + 1; 

 UserInput := DELSTR(UserInput,Comma,1); 

 UserInput := INSSTR(UserInput,' and',Comma); 

END; 

 

MESSAGE('The sentence is "%1". Number of commas is 
%2.',UserInput,Count); 

 
Note that the REPEAT loop was changed into a WHILE loop. In order to do this, 
the condition had to be logically negated, since a REPEAT loop continues as 
long as the condition is FALSE, while a WHILE loop continues as long as the 
condition is TRUE. To logically negate any logical expression, you could put a 
NOT in front of it and enclose the entire expression in parentheses. Or you could 
do as we did above: Change every relational operator to its opposite  ( "=" to 
"<>" and vice versa, ">" to "<=" and vice versa and "<" to ">=" and vice versa), 
plus change every AND to an OR and every OR to an AND. 

Test Your Skills Answers (CH 17) 
 

1. How many Parameters does the LoginStart function have? 

 None (0) 

2. What type of value (if any) is returned by the ReadRounding 
function? 

 Decimal 

3. In the ReadSymbol function, is the first parameter (Token) passed by 
value or passed by reference? 

 Passed by Value 

Page 616 



 

 

Appendix C: Solutions to Exercises 

4. In the ReadSymbol function, is the second parameter (Text) passed 
by value or passed by reference? 

 Passed by Reference (the Var column is checked) 

5. In the AutoFormatTranslate function, how many local variables are 
defined? 

 3 (Currency, GLSetup, GLSetupRead) 

6. Look at the code for the AutoFormatTranslate function. How many 
lines in that trigger code could return the value of this function? 

 9 (9 different lines have the EXIT statement) 

7. Look at the code and the definition of the ApplicationLanguage 
function. Is there anything in this function that affects any data 
outside this function (not counting the return value)? If so, what? 

 No. All the variables in it are either local variables, or are formal 
parameters that have been passed in by value. 

8. Look at the code and the definition of the ReadCharacter function. Is 
there anything in this function that affects any data outside this 
function (not counting the return value)? If so, what? 

 Yes. The variables Text and Position are both passed by reference, 
which means they refer to variables outside this function. 

Test Your Skills Answers (CH18) 
 

1. All reports must print at least one page. 

 False. Some reports do not print anything. They are called processing 
only reports. 

2. List the names of the three Designers used with reports and describe 
their function. 

 Report Designer – design the data model for the report. 

 Sections Designer – design the page layout for the report. 

 Request Options Form Designer – design the Options tab of the 
request form. 

3. How many times does a Header section print on a report for an 
indented data item (assume PrintOnEvery page is turned off and 
there is data in the table)? What if the data item is not indented? 

 Once for every record in the data item that it is indented under. 

 Once for the entire report. 

Page 617 



 

 

Microsoft Navision Development I − C/SIDE Introduction 

4. What data item property can be used to remove the Data Items tab 
on the request form (assume there are no request filter fields set)? 

 DataitemTableView. You must choose a key to sort the data item. 

 What two properties of a data item must be set in order to print a sub 
total of a field on a group footer section? 

 GroupTotalFields and TotalFields. 

5. When does a Transheader section print for a data item? 

 Whenever the data item's body sections fill one page and force a new 
page to be created. It does not print if another data item causes the 
new page. 

6. What property can be set to start a new page every time a record is 
read? 

 NewPagePerRecord on the data item. 

7. What two properties can be used to print a footer at the bottom of 
every page? 

 PrintOnEveryPage=Yes and PrintInBottom=Yes for the footer 
section. 

8. Given a report that has two data items and the second is indented. 
What C/AL code could you write that would most closely resemble 
this situation? 

 Nested loops. 

     While DataItem1.GetRecord Do 

      While DataItem2.GetRecord Do; 

9. What property can be used to filter an indented data item based on 
fields in the unindented data item above it? 

 DataitemLink. 

Test Your Knowledge Answers (CH 19) 
 

1. What is different between the description of a report and the 
description of a dataport? 

 Instead of sections, the dataport has dataport fields. 

2. What can you not do with a data item in a dataport that you could do 
with a data item in a report? 

 Indent data items. 
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3. The dataport fields that you create in the Dataport Field Designer 
must match what for an import dataport? 

 The fields must match the file that you are trying to import. 

4. In an import dataport, if you set AutoSave to No and AutoUpdate to 
Yes, what does the dataport do with the records from the file?  

 Nothing. If AutoSave is no, the dataport does not insert or modify 
any records automatically. 

5. When must you use the StartPos and Width properties of a dataport 
field? 

 If the file type is Fixed. 

6. True or False. Every dataport field must be bound to a real field in 
the data item. 

 False. Dataport fields can be bound to variables or other fields in 
record variables (for exporting other values are also acceptable). 

7. What does the Calcfields property do on a data item? 

 It tells the dataport to calculate the values of FlowFields that are to 
be exported. 

8. When exporting, which dataport file type lines up the information in 
columns? 

 Fixed. 

9. When exporting, which dataport file type creates the smallest 
possible file? 

 Variable. There are no extra spaces between dataport fields. 

10. When importing, which dataport properties can you set so that the 
user does not see the options tab? 

 Filename property to the name of the file (the user cannot change it). 
Import to Yes (the user cannot change it). The options tab 
disappears. 

Test Your Knowledge Answers (CH20) 
 

1. What is the major difference between a Dataport and an XMLport? 

 While both objects are used to export data, XMLports encapsulate 
the data in XML format. 

2. The XML tag name information is stored in what field? 

 TagName. 
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3. Which field would you use to specify whether the name in the 
TagName field represents data of the type element or attribute? 

 TagType 

4. Which field specifies the data structure that the tag name 
corresponds to in the Navision database? 

 SourceType. The three options are Text, Table and Field. 

5. How are XMLports called? 

 XMLports are called from other objects. They cannot be run in a 
stand-alone mode. 

6. True or False. An XMLport cannot modify existing data in the 
database. 

 True. XMLports cannot modify existing data, they cannot find and 
delete data in the database, nor can they query the database for data. 

7. What is the purpose of the "Direction" property of an XMLport? 

 This property is used to specify whether the XMLport can Import, 
Export, or Import and Export data in XML format. 

Test Your Knowledge Answers (CH 21) 
 

1. What triggers are available in every codeunit? 

 Documentation – for documenting the codeunit. 

 OnRun – called if you run the codeunit. 

2. What key can you press to open the Symbol Menu? 

 F5 

3. To call a function in a codeunit from another object, what must be 
done first? 

 You must create a variable for the codeunit with the correct subtype. 

4. Can two codeunit variables refer to the same instance of a codeunit? 

 Yes. 

5. Can two codeunit variables declared in the same object refer to 
different instances of a codeunit? 

 Yes. 
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6. How would you change a codeunit variable to point to the same 
instance of a codeunit as another codeunit variable? 

 Assignment 

    CU1 := CU2; 

7. What function can you use to make a codeunit variable point to a 
new instance of a codeunit? 

 CLEAR(CU1); 

8. If a codeunit is designed as a single instance codeunit, can two 
codeunit variables refer to different instances of that codeunit? 

 No. 

9. How would you address a global variable of a codeunit from an 
object that has a variable called CU for that codeunit? 

 You cannot address global variables within a codeunit directly from 
outside the codeunit. You would have to add functions in the 
codeunit that returned or changed the value of the variables. 

10. Can you create a function called Power in a codeunit? 

 No. Power is already a built-in function. 

Test Your Knowledge Answers (CH22) 
 

1. True or False. A MenuSuite cannot be accessed programmatically. 

 True 

2. What is the name of the design area used to work with MenuSuites? 

 Navigation Pane Designer 

3. With the exception of the Add-on MenuSuite object, how may 
instances of a MenuSuite can there be for each Design Level? 

 One. 

4. How many instances per Design Level can there be for an Add-on 
MenuSuite? 

 10 

5. What are two ways to open the Navigation Pane Designer? 

 By selecting a MenuSuite Object in Object Designer and then 
clicking Design 
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 By choosing Tools from the Tool Menu, then Navigation Pane 
Designer 

6. True or False. You can run a MenuSuite object from the Design 
menu. 

 False. MenuSuite objects cannot be run. 

7. When you are creating a new item in a MenuSuite and select 
"Report" as the Object Type, what is displayed when you select the 
lookup button on Object ID? 

 The Report List. 

8. Name the six selections available in the Object Type property field. 

 Table, Form, Report, Batch Job, Codeunit, and Dataport. 

 What are the five Object Levels of which a MenuSuite can be 
categorized? 

 Region, Country, Add-on, Partner and Company 

Test Your Skills Answers (CH 23) 
 

1. In order for your client to use NODBC with Microsoft Navision you 
must: (Select three of the options below) 

a. Install Microsoft's ODBC driver 
b. Purchase the NODBC granule 
c. Set up permissions for the NODBC users 
d. Set up a DSN 

2. True or False. You can use any NODBC version to open up any 
Microsoft Navision database? 

 False, the NODBC driver and client versions must be the same. 

3. True or False. Microsoft Navision uses Microsoft's ADO for all 
connections. 

 False, Microsoft Navision doesn't support ADO. 

4. True or False. Microsoft Navision's ODBC driver supports outer 
joins? 

 False. 
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Test Your Skills Answers (CH 24) 
 

1. What is C/FRONT? 

 C/FRONT is an application programming interface that can be used 
to access a C/SIDE database. 

2. Does C/FRONT use a session? 

 Yes 

3. Can you activate keys from within C/FRONT? 

 No 

4. C/FRONT does not require any files from the Microsoft Navision 
client directory.  True or False. 

 False. The following files must be copied from the Microsoft 
Navision client directory: 

dbm.dll 

nc_netb.dll 

nc_tcp.dll 

slave.exe 

fin.etx 

fin.stx 

fin.flf 

 

Test Your Skills Answers (CH25) 
 

1. Why might you use an OCX control? 

 To save on development time and to reduce costs 

2. What must you do before you can use an OCX control? 

 You must load and register the OCX on each machine. If using in 
development, then you must make sure that you have got the 
required development tool. 

3. Why might you not be able to select OCX as a data type? 

 The OCX granule is not included in your license. 

4. Is calling a method or setting properties of an OCX any different 
from any other standard Microsoft Navision object? 

 No. 
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Test Your Skills Answers (CH26) 
 

1. Why might you need to use Automation in Microsoft Navision? 

 To provide a seamless interface to outside applications 

 To save on development time 

 To reduce costs 

 To automate a process 

2. Yes or No. Is it possible to respond to Automation Events in 
Microsoft Navision? 

 Yes 

3. True or False. You must first use the CREATE command before you 
can use an Automation object? 

 True 

4. True or False. You would use the FREE command to release the 
automation object from memory. 

 False, you would use the CLEAR command 
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